
 

 

 

 

 

 

 

May 2017 
 

 

 

 

 

 

 

 

  



This page is intentionally left blank 

 

 

jalbeck
Rectangle



  

May 2017 Table of Contents Page | i 

TABLE OF CONTENTS 

1 Overview .............................................................................................................................. 1-1 

1.1 Introduction ........................................................................................................................................ 1-1 

1.2 Timing Goals ........................................................................................................................................ 1-1 
Review of Signal Timing ................................................................................................................................ 1-2 

2 Data Collection and Information Needed ............................................................................. 2-1 

2.1 Data Collection .................................................................................................................................... 2-1 

2.2 Geometric Conditions ......................................................................................................................... 2-1 

2.3 Volume Studies ................................................................................................................................... 2-2 
Purpose......................................................................................................................................................... 2-2 
Types ............................................................................................................................................................ 2-2 
Counting Techniques .................................................................................................................................... 2-2 
Counting Periods .......................................................................................................................................... 2-3 
Turning Movement Counts .......................................................................................................................... 2-3 
Lane Utilization Factor.................................................................................................................................. 2-7 

2.4 Travel Time & Delay Studies ............................................................................................................... 2-7 
Definitions .................................................................................................................................................... 2-7 
Need for Travel Time or Delay Data ............................................................................................................. 2-8 
Causes of Delay ............................................................................................................................................ 2-8 
Methods for Obtaining Travel Time or Delay Data ...................................................................................... 2-8 
Intersection Delay Studies ............................................................................................................................ 2-9 
HCM Method for Direct Measurement of Prevailing Saturation Flow Rates............................................. 2-10 

3 Local Intersection Concepts .................................................................................................. 3-1 

3.1 Signal Timing Theory ........................................................................................................................... 3-1 
Cycle Length ................................................................................................................................................. 3-1 

3.2 Signal Timing Intervals and Splits ........................................................................................................ 3-3 

3.3 Signal Timing and Phasing ................................................................................................................... 3-5 
Controller Unit Timing .................................................................................................................................. 3-5 
Control Concepts .......................................................................................................................................... 3-5 
Traffic Signal Phasing .................................................................................................................................... 3-7 
Ring and Barrier Structure ............................................................................................................................ 3-8 
Dual Ring Control.......................................................................................................................................... 3-9 
Single Ring (Sequential Phases) .................................................................................................................. 3-10 
Multi-Rings and Barriers ............................................................................................................................. 3-10 
Phasing Parameters .................................................................................................................................... 3-11 

3.4 Emergency Vehicle Preemption (EVP) .............................................................................................. 3-19 
Transit Signal Priority ................................................................................................................................. 3-20 

3.5 Left Turn Phasing .............................................................................................................................. 3-20 
Protected and Permissive Left Turn Phasing .............................................................................................. 3-21 
Left Turn Phasing Sequence ....................................................................................................................... 3-21 

3.6 Flashing Yellow Arrow Display .......................................................................................................... 3-24 

3.7 Minnesota Flashing Yellow Arrow .................................................................................................... 3-24 
Variable vs. Fixed Phasing Operation Signal Heads .................................................................................... 3-24 



MnDOT Traffic Signal Timing and Coordination Manual                                     

Page | ii  Table of Contents May 2017 

Use of the Flashing Yellow Arrow Signal Head ........................................................................................... 3-25 
When Not to Operate a FYA Permissive Indication .................................................................................... 3-25 
Flashing Yellow Arrow Technical Memorandum ........................................................................................ 3-28 

3.8 Left Turn Trapping ............................................................................................................................. 3-31 
Flashing Yellow Arrow and the Left Turn Trap............................................................................................ 3-33 

3.9 Detection ........................................................................................................................................... 3-35 
Detector Labeling and Phase Assignments ................................................................................................. 3-35 
Assigning TS2 Type 1 Detector Numbers .................................................................................................... 3-36 
Common Detector Functions ...................................................................................................................... 3-38 
Summary of By Phase and By Detector Functions ...................................................................................... 3-39 
Detector Modes .......................................................................................................................................... 3-39 
Detection Design ......................................................................................................................................... 3-40 

3.10 Measures of Effectiveness ................................................................................................................. 3-56 
Degree of Saturation ................................................................................................................................... 3-56 
Delay ........................................................................................................................................................... 3-57 
HCM 2010 Notes ......................................................................................................................................... 3-59 
Stops ........................................................................................................................................................... 3-59 
Queuing ....................................................................................................................................................... 3-61 
Fuel Consumption ....................................................................................................................................... 3-62 

3.11 Critical Lane Analysis ......................................................................................................................... 3-63 
Introduction ................................................................................................................................................ 3-63 
Capacity Analysis ......................................................................................................................................... 3-66 
Summary of Critical Lane Analysis .............................................................................................................. 3-72 

4 Local Intersection Timing ..................................................................................................... 4-1 

4.1 Timing Practices ................................................................................................................................... 4-1 

4.2 Full Traffic Actuated Timing Controls .................................................................................................. 4-1 

4.3 Local Free By TOD ................................................................................................................................ 4-2 

4.4 Local Intersection Start-up Process ..................................................................................................... 4-3 

4.5 Pedestrian Timing Requirements ........................................................................................................ 4-4 
Walk .............................................................................................................................................................. 4-4 
Flashing Don’t Walk ...................................................................................................................................... 4-4 
Pedestrian Timing Recommended Practice .................................................................................................. 4-5 
Accessible Pedestrian Signals (APS) .............................................................................................................. 4-7 
Pedestrian Timing (2012 MN MUTCD).......................................................................................................... 4-7 

4.6 Initial Timing ...................................................................................................................................... 4-17 
Minimum Initial ........................................................................................................................................... 4-17 

4.7 Density Features ................................................................................................................................ 4-17 
Added Initial ................................................................................................................................................ 4-17 
Passage Time ............................................................................................................................................... 4-18 
GAP REDUCTION - Density Feature ............................................................................................................. 4-19 
Time Before Reduction ............................................................................................................................... 4-19 
Time To Reduce .......................................................................................................................................... 4-19 
Minimum Gap ............................................................................................................................................. 4-19 
Detector Extend .......................................................................................................................................... 4-19 

4.8 Maximum Green ................................................................................................................................ 4-20 



  

May 2017 Table of Contents Page | iii 

4.9 Phase Change Interval ...................................................................................................................... 4-22 
Yellow Timing ............................................................................................................................................. 4-22 
All Red......................................................................................................................................................... 4-23 

4.10 Flashing Yellow Arrow Operation ..................................................................................................... 4-26 
FYA Yellow and All-Red Times .................................................................................................................... 4-26 
Permissive Operation When Adjacent through Head is Red ..................................................................... 4-26 
Varying FYA Head between Protected, Protected/Permissive, and Permissive Operation ....................... 4-26 
Test for Protected Only Operation 24 Hours per Day ................................................................................ 4-27 
Test for FYA Operation by Time of Day ...................................................................................................... 4-27 
Definitions .................................................................................................................................................. 4-28 
FYA during Free Operation ......................................................................................................................... 4-29 
Minimum Green Times ............................................................................................................................... 4-30 
EVP Preemption Operation under FYA ....................................................................................................... 4-30 

4.11 Accessible Pedestrian Signal (APS) Operation .................................................................................. 4-33 

4.12 Guidelines for the Inspection and Operation of Railroad Preemption at Signalized Intersections .. 4-34 
Introduction ................................................................................................................................................ 4-34 
Scope .......................................................................................................................................................... 4-34 
Guidelines for Preemption ......................................................................................................................... 4-34 
Guidelines for Design ................................................................................................................................. 4-35 
Guidelines for Operation ............................................................................................................................ 4-35 
Guidelines for Inspection ........................................................................................................................... 4-36 
Annual Inspection Form ............................................................................................................................. 4-36 

4.14 Guidelines for Consideration and Timing of Advanced Warning Flashers ....................................... 4-39 
Guidelines for Installation .......................................................................................................................... 4-41 

5 Coordination Concepts ......................................................................................................... 5-1 

5.1 Cycle Length ........................................................................................................................................ 5-1 

5.2 Signal Timing Intervals and Splits ........................................................................................................ 5-1 

5.3 Offset .................................................................................................................................................. 5-1 

5.4 Progression Measures ......................................................................................................................... 5-1 
Bandwidth Efficiency .................................................................................................................................... 5-1 
Bandwidth Attainability ................................................................................................................................ 5-2 

5.5 System Measures ................................................................................................................................ 5-3 
Total Travel ................................................................................................................................................... 5-3 
Total Travel Time .......................................................................................................................................... 5-3 
Average System Speed ................................................................................................................................. 5-4 

5.6 Computer Timing Tools ....................................................................................................................... 5-4 
Timing Plan Needs ...................................................................................................................................... 5-10 

5.7 Traffic Signal Control Systems ........................................................................................................... 5-12 
System Concept .......................................................................................................................................... 5-12 
Types of Traffic Signal Control Systems ..................................................................................................... 5-12 
Time-Space Diagrams ................................................................................................................................. 5-14 
Control Philosophies for Computerized Traffic Signal Systems ................................................................. 5-15 

6 Synchro and SimTraffic ......................................................................................................... 6-1 

7 Model Calibration ................................................................................................................ 7-1 



MnDOT Traffic Signal Timing and Coordination Manual                                     

Page | iv  Table of Contents May 2017 

7.1 Computer Model Measures of Effectiveness ...................................................................................... 7-1 

7.2 Computer Model Calibration ............................................................................................................... 7-2 
Data Verification ........................................................................................................................................... 7-2 
Degree of Saturation ..................................................................................................................................... 7-3 
Timing and Lost Time .................................................................................................................................... 7-3 
Maximum Queue Length or Back of Queue ................................................................................................. 7-3 
Delay and Travel Time .................................................................................................................................. 7-4 

8 Timing Plan Implementation And Evaluation ....................................................................... 8-1 

8.1 Implementation and Field Verification................................................................................................ 8-1 

8.2 Traffic Controller Timing Inputs .......................................................................................................... 8-1 

8.3 Econolite Controller Timing ................................................................................................................. 8-2 

8.4 Post Implementation Evaluation ....................................................................................................... 8-10 
Field Conditions .......................................................................................................................................... 8-10 
Data Collection Periods ............................................................................................................................... 8-10 
Duration of Data Collection ........................................................................................................................ 8-10 
Measures of Effectiveness .......................................................................................................................... 8-11 
Sample Size Requirements .......................................................................................................................... 8-11 

 Glossary of Signal Timing Terms .......................................................................... A-1 

 Index ................................................................................................................... B-1 

 References ........................................................................................................... C-1 

 Metro Checklists .................................................................................................. D-1 

 

  



  

May 2017 Table of Contents Page | v 

Table of Exhibits 

Exhibit 2-1 Sample Turning Movement Count ......................................................................................... 2-5 

Exhibit 2-2 Lane Group Default Lane Utilization Factors .......................................................................... 2-7 

Exhibit 3-1 Basic Two-Phase Pre-timed Signal Operation ........................................................................ 3-6 

Exhibit 3-2 Traffic Signal Phasing .............................................................................................................. 3-8 

Exhibit 3-3 Common Phase Numbering Scheme ...................................................................................... 3-9 

Exhibit 3-4 Dual Ring Control .................................................................................................................... 3-9 

Exhibit 3-5 Sequential Phasing................................................................................................................ 3-10 

Exhibit 3-6 Multi-Ring Phasing ................................................................................................................ 3-10 

Exhibit 3-7 Traffic Actuated Phase Timing Diagram ............................................................................... 3-11 

Exhibit 3-8 Volume-Density Timing Diagram .......................................................................................... 3-14 

Exhibit 3-9 Right Turn Overlap Phasing .................................................................................................. 3-17 

Exhibit 3-10 Overlap Phasing ................................................................................................................... 3-18 

Exhibit 3-11 Left Turn Phasing .................................................................................................................. 3-23 

Exhibit 3-12 Lead/Lag Left Turn Trap ....................................................................................................... 3-32 

Exhibit 3-13 FYA to Eliminate Left Turn Trap ........................................................................................... 3-34 

Exhibit 3-14 Detector Labeling and Phase Assignment Diagram ............................................................. 3-35 

Exhibit 3-15 Sample Vehicle Detector Settings (Econolite Aries) ............................................................. 3-36 

Exhibit 3-16 TS2 Type 1 Detector Phase Assignment Chart ..................................................................... 3-37 

Exhibit 3-16 Common Functions By Phase or By Detector ...................................................................... 3-39 

Exhibit 3-17 Level of Service Criteria for Signalized Intersections (2000 HCM) ....................................... 3-59 

Exhibit 3-18 Level of Service Criteria for Signalized Intersections (2010 HCM) ....................................... 3-59 

Exhibit 3-19 Under-saturated Vehicle Trajectories on TSD ...................................................................... 3-60 

Exhibit 3-20 Critical Lane TVE ................................................................................................................... 3-65 

Exhibit 3-21 Critical Lane Volume Relationship to Probable Capacity ..................................................... 3-66 

Exhibit 4-1 Local Controller TOD Program Step ........................................................................................ 4-3 

Exhibit 4-2 Pedestrian Crossing Distances ................................................................................................ 4-7 

Exhibit 4-3 Detector Extend Example ..................................................................................................... 4-20 

Exhibit 4-4 Yellow Timing Values ............................................................................................................ 4-23 

Exhibit 4-5 All Red Times ........................................................................................................................ 4-24 

Exhibit 4-6 Part 1: Protected-Only Left Turn Operation 24 Hours per Day ............................................ 4-27 

Exhibit 4-7 Part 2: Permissive FYA Operation by Time of Day ................................................................ 4-28 

Exhibit 4-8 Emergency Vehicle Preemption: Protected-Only Operation ............................................... 4-30 

Exhibit 4-9 Emergency Vehicle Preemption: Protected/Permissive Operation (Option 1) .................... 4-31 

Exhibit 4-10 Emergency Vehicle Preemption: Protected/Permissive Operation (Option 2) ................... 4-32 

Exhibit 4-11 Emergency Vehicle Preemption: Protected/Permissive Operation (Option 3) ................... 4-32 

Exhibit 4-12 AWF Limited Sight Distance (> 15% Trucks) ......................................................................... 4-42 

Exhibit 4-13 AWF Limited Sight Distance (≤ 15% Trucks) ......................................................................... 4-43 

Exhibit 4-14 AWF Recommended Yellow Intervals (> 15% Trucks) .......................................................... 4-44 



MnDOT Traffic Signal Timing and Coordination Manual                                     

Page | vi  Table of Contents May 2017 

Exhibit 4-15 AWF Recommended Yellow Intervals (≤ 15% Trucks) .......................................................... 4-45 

Exhibit 5-1 Travel Time Runs in Tru-Traffic ............................................................................................. 5-10 

Exhibit 5-2 Sample Average Weekday Hourly Directional Volumes ....................................................... 5-11 

Exhibit 5-3 Sample Directional Coordinated Timing Plans ...................................................................... 5-11 

Exhibit 5-4 Sample Time Space Diagrams ............................................................................................... 5-14 
 

 



MnDOT Traffic Signal Timing and Coordination Manual 

May 2017 Overview Page 1-1 

1 OVERVIEW 

1.1 Introduction 

No other device has such a daily impact on virtually every citizen as does the common, ever-present traffic 
signal. The trip to work is punctuated by stops at traffic signals, even on uncongested routes. Drivers place 
their physical safety and that of their passengers confidently in the signal’s ability to give them the right-of-
way. 

A signal’s necessity is accepted by the citizen, and in fact demanded in some cases, to assure safety and 
mobility. The same citizen quietly assumes that the operating agency knows how to best operate the signals, 
and reluctantly reports only the most obvious failures. Inefficient signal operation, even though such 
operation is silently stealing dollars from the user’s pocket in increased fuel costs, longer trip time, etc. is 
rarely reported or noticed by the user. In the user’s view, the signals are working and if they are sub-optimal, 
it becomes a concern but not a crisis. 

The overall objective of signal control is to provide for the safe and efficient traffic flow at intersections, 
along routes and in street networks. A well timed signal system can reduce fuel consumption, eliminate 
unnecessary stops and delays, improve safety and enhance the environment.  

1.2 Timing Goals 

When signals are installed in accordance with the warrants listed in the Minnesota Manual on Uniform 
Traffic Control Devices (MN MUTCD), they can provide specific advantages in traffic control and safety. They 
can, however, also have certain negative impacts that may or may not apply at a particular location. 

Some of the advantages (goals) of signal installations include: 

 Provide for the orderly movement of traffic; 

 Reduce the frequency of certain types of crashes (i.e., right-angle and pedestrian); 

 Increase the traffic handling capacity of the intersection; 

 Provide a means of interrupting heavy traffic to allow other traffic, both vehicular and pedestrian, to 
enter or cross; 

 Provide for nearly continuous movement of traffic at a desired speed along a given route by 
coordination; 

 Afford considerable economy over manual control at intersections where alternate assignment of 
right-of-way is required; and, 

 Promote driver confidence by assigning right-of-way. 

Some disadvantages to signal installations include: 

 Most installations increase total intersection delay and fuel consumption, especially during off peak 
periods. 

 Probably increase certain types of crashes (i.e., rear end collisions). 

 When improperly located, cause unnecessary delay and promote disrespect for this type of control. 

 When improperly timed cause excessive delay, increasing driver irritation. 
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Review of Signal Timing 

The operation of the traffic signal should be observed regularly. The following is from section 9-10.01 of the 
Traffic Engineering Manual (TEM). 

 

It is the responsibility of the District Traffic Engineer to observe the operation of all traffic signals in 
the district. Any timing or operation that is not correct should be corrected. Personnel in the Central 
Office Signal Unit can assist in the determination of the timing. Unusual hardware implementations 
may require the assistance of personnel from the Central Electrical Services Unit. The District Traffic 
Engineer shall maintain a complete timing record, including all preemption timing, in the controller 
cabinet and in the District Traffic Office. In the event the District Traffic Engineer determines a traffic 
signal is to be revised by state maintenance forces, a TE Request is to be written. The TE Request 
should outline the work that is to be done. Normally, the District Traffic Office will be contacted by 
the Central, Metro, or Regional Electrical Services Unit, as appropriate, after concurrence and before 
the work is done. 

Each district should budget for payment of electrical power usage where the State has that 
responsibility.  

The District Traffic Office shall keep a current maintenance log in each controller cabinet and any 
timing change performed to that signal shall be duly recorded on that log.  

The District Traffic Office should perform an “operations check” of all district traffic control signals 
every 6 to 12 months. The operations check will review the operation of the traffic signal including 
checking all vehicle indications, pedestrian pushbuttons, detection, and other items critical for 
efficient operation of the traffic control signal. The cabinet filter should also be replaced once every 
12 months. 
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2 DATA COLLECTION AND INFORMATION NEEDED 

2.1 Data Collection 

Data collection is a vital element of the traffic signal timing process, therefore it is important to develop a 
data collection plan. The plan should outline the data to be collected, the parties responsible for collecting 
the data, and the schedule for collecting the data. 

The data should include, but is not limited to:  

 Intersection geometry, including lane usage and link distances. 

 Existing Intersection Turning Movement Counts  

 AM peak hour (minimum 2 hours - 15 minute periods) 

 PM peak hour (minimum 2 hours - 15 minute periods) 

 Off peak period or any other special traffic period 

 Count vehicles and pedestrians (Seasonal counts if required) 

 24 hour approach counts (preferably over a 7 day period) 

 Posted speed on each approach  

 Crash reports or preferably collision diagrams representing past 3 years for urban locations (consider 
5 years in rural locations) 

 Percent of heavy vehicles 

 Field Studies, including travel time runs and approach delay studies. This data will be used in the 
calibration of the computer models and for comparison to similar data collected in the “after” 
condition.  

 Signal Timing and Phasing Data 

 Existing Traffic Signal Hardware. This information should include controller equipment, 
communications details, vehicle detectors and traffic signal heads. This information can be used to 
determine the phasing/timing capabilities at each intersection. For example, could a protected left-
turn phase be added? 

 Additional Data. These may include items such as pedestrian counts, traffic counts of mid-block 
generators, early-release studies, etc. 

All data should be current and representative of the intersection. Turning movement counts used should be 
within one year of implementing the timing plan or recent enough to reflect current conditions. 

2.2 Geometric Conditions 

Intersection geometry is generally presented in diagrammatic form and must include all of the relevant 
information, including approach grades, the number and width of lanes, and parking conditions. The 
existence of exclusive left- or right-turn lanes should be noted, along with the storage lengths of such lanes.  

When the specifics of geometry are to be designed, these features must be assumed for the analysis to 
continue. State or local policies and guidelines should be used in establishing the trial design.  

In order to recreate your study area's streets and intersections in Synchro (see Chapter 6), it helps to map 
out the signalized intersections, the connecting links and the external links on paper first. One option is to 
make a photocopy of a detailed map of the study area so that you can draw on it. Another option, if you 
have a street map of your study area in a format accepted by Synchro (jpg, bmp, dxf, sid or shp), is to import 
it into Synchro to help with the map layout. If you are using accurate basemaps, the distances and angles 
can be traced on the basemap. See Chapter 6 of this book for details on importing a Synchro basemap.  
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2.3 Volume Studies 

Purpose 

Traffic volume studies are conducted to obtain factual data concerning the movement of vehicles and/or 
persons at selected points on the street or highway system. Volume data are expressed in relation to time, 
the base being determined by the type of information desired and the application in which it is to be used. 
Some typical volume studies include: 

 Annual Traffic in vehicles per year. 

 Average Daily Traffic (ADT) or Average Annual Daily Traffic (AADT) in vehicles per day. 

 Hourly Traffic in vehicles per hour. 

 Short Term Counts (covering 5, 6, 10, or 15 min. intervals) usually expanded into hourly flow rates. 

 Density of Traffic in vehicles per mile. 

Types 

The volume studies applicable to signal timing projects include: 

 Directional Counts, are used for determining signal timing and justifying traffic controls. 

 Turning Movement Counts, which count all movements at the intersection, are used in computing 
capacity and evaluating congestion. 

 Classification Counts are used to determine the various types of vehicle classes in the traffic stream 
(i.e., to determine the percent trucks for capacity analysis). 

 Pedestrian Counts are used to justify signals, time traffic signals and compute the capacity and LOS. 

Counting Techniques 

Following are some of the methods used to obtain the counts described above. 

Machine Counts are used to obtain vehicular counts at non-intersection locations. Total volumes, directional 
volumes, or lane volumes can be obtained, depending on the equipment available. 

 Permanent Counters are installed to obtain control counts on a continuous basis. Such counts are used 
to provide factors for adjusting short counts to ADT and for finding the 30th highest or other hour of 
the year. Loop detectors are the most commonly used, especially on high volume multilane roads, 
because they can distinguish vehicles in individual lanes and are generally low maintenance. 

 Portable Counters provide a permanent record of volumes by printing totals on a paper tape, by 
drawing a trace on a graph, by punching a paper tape, or by 
storing the data in memory (i.e., ITC ACE, Numetrics, etc.) for 
later direct transfer to a printer or microcomputer. A common 
means of gathering the data is through the use of rubber road 
tubes.  New technology is providing expanded capabilities in this 
area. 

 Video Counting units essentially conduct turning movement 
counts using off-line video collection and detection algorithms 
to “count” the movement volumes for the designated periods.  
Hybrid video counting equipment is also available where the 
counts are manually collected with a count board connected to 
your PC, however, done so in the office via looking at video recorded at the intersection.  

Manual Counts must be used in those studies where desired data cannot be obtained by machine counters. 
For light volumes, tally marks on a form are adequate. Manually operated tally counters are available for 
heavier volumes. Electronic intersection assemblies with memories which record and store the totals 

Volume data traditionally has 
been gathered over periods to 
bracket the peak hours (3 to 4 

hour periods). With video 
data colelction, it is now 

common to gather data over 
an extended period of time 

(24 hours or more). 
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accumulated on each of 16 manually operated counters at a 1 to 15 minute intervals for later input into 
computers are available (such as the JAMAR count boards). New technology is providing expanded 
capabilities in this area as well.  Manual counts are used for: 

 Turning and through movement studies. 

 Classification studies (however, some detectors and machine counters can classify vehicles by their 
length). 

 Pedestrian studies. 

 Other studies when the number of machine counters is insufficient. 

Counting Periods 

The time and length that a specific location should be counted also depends on the data desired and the 
application in which the data are to be used.  Data collected for signal timing projects often get used for 
other applications. 

Some of the more commonly used intervals are: 

 24-hour counts normally covering any 24-hour period between noon Monday and noon Friday. 
(Traffic on Monday mornings and Friday afternoons often varies from the normal patterns.)  If a 
specific day count is desired, the count should be taken from midnight to midnight. 

 16-hour counts usually covering 5:30 am - 9:30 p.m. or 6 am to 10 p.m. This period contains most of 
the daily flow including evening traffic. 

 12-hour counts usually covering 7 am to 7 p.m. However, these may not capture all of the major traffic 
flows. 

 Peak period counting times vary depending upon size of metropolitan area, proximity to major 
generators (such as the CBD or industrial areas), and the type of facility (freeway, radial arterial, etc.). 
Commonly used periods are 6 am - 9 am and 3 pm - 6 pm. 

 Weekend counts covering the period from noon on Friday to noon on Monday. Used to develop 
special weekend timing plans. 

Special conditions counts such as: 

 Special events (holidays, sporting events, etc.). 

 Abnormal weather conditions. 

 Temporary closure of streets affecting the volume patterns. 

Adjustment factors can be applied to the data to remove seasonal or other variations, to provide a realistic 
estimate of the average volume condition, and/or to expand a count to a volume estimate of a longer count 
period. 

Turning Movement Counts 

To fully analyze an intersection or system, turning movement counts at each intersection must be known, 
including left turns, through, right and U-turns. These data should always be obtained from field studies for 
operational or signal timing design studies. An example of typical turning movement data is shown in the 
Table on the following page. 

The data was taken over two hours during the am peak and includes the 15 minute turning movement 
volumes, the hour total volumes, the peak hour volume for each movement, the peak hour volume for the 
intersection, and the peak hour factor.  

The traffic software programs (Synchro, PASSER, TRANSYT) require that the data be converted into hourly 
turning movement counts. The example that follows illustrates two ways to present the data in peak hour 
volumes. The following defines how each are calculated and used. 
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Actual counting periods will vary by project and are typically within 1.5 to 2 hours plus and minus from the 
period (a.m., p.m., noon) peak hours. The use of video data collection techniques have greatly expanded the 
ability to gather turning movement counts over longer periods of the day. These longer periods are useful 
for determining signal timing plans and phasing operation throughout the day. For example, the use of a 
permissive Flashing Yellow Arrow (FYA) indication may be changed on a time of day basis based on the traffic 
volumes. 
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Exhibit 2-1 Sample Turning Movement Count 
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Peak Hour of Intersection - Method 1 

 Determine the highest total intersection hourly volume. This can be any four consecutive 15-minute 
periods in the count duration. For the example, it is as follows: 

Total 
271 
307 
358 
361 
316 
319 
336 
334 

 

 Calculate the hourly volume for each movement. Use the same four consecutive 15 minute periods 
as used in step a) above. For example, the peak hour volume for the westbound through movement 
is calculated as follows (start at 7:30): 

70 + 94 + 92 + 96 = 352 vph. 

 Calculate the movement and intersection Peak Hour Factors (PHF). The Peak Hour Factor is used to 
determine the traffic flow rate during the busiest 15-minute period. To determine the PHF, divide the 
peak hour volume computed in step b) by the highest 15 minute count in the peak interval multiplied 
by four. For example, the PHF for the westbound through movement is: 

Hourly Flow Rate = 352 vph 

Peak 15 minute count = 96 vph 

PHF = 352 / (96 x 4) = 0.92 

Peak 15 Minutes times Four - Method 2 

 Determine the highest total intersection hourly volume as described in step 1a) above. 

 Calculate each movement hourly volume by determining the highest 15 minute count in the peak 
interval and multiplying by four. For example, the hourly volume for the westbound through 
movement is: 

96 x 4 = 384 vph. 

 Since this method explicitly accounts for the traffic during the busiest 15 minute period, the PHF is set 
equal to 1.0 

Identifying the 15-minute period having the highest volume may require more than just counting volumes 
in each of four 15-minute periods in an hour. The ideal data collection system should include cycle-by-cycle 
counts of discharge volumes for each lane group, so that the peak 15-minute period can be selected more 
accurately than with 15-minute counts. 

When the traffic flow in a lane group is saturated, the cycle-by-cycle counts of discharge volumes should be 
supplemented by counts of the overflow queue at the end of the yellow for each cycle. Arrival volumes can 
then be computed from the cycle-by-cycle counts of discharge volumes and the number of vehicles in each 
overflow queue. 

 

Highest four consecutive 15 
minute counts = 1,354 vph. 



MnDOT Traffic Signal Timing and Coordination Manual 

May 2017 Data Collection Page | 2-7 

The following link URL is a link to the MnDOT Metro Intersection Warrant Information Website where traffic 
data can be obtained. 

http://www.dot.state.mn.us/metro/warrant/ 

Lane Utilization Factor 

When there is more than one lane in a lane group, the traffic will not use all the lanes equally. The Lane 
Utilization Factor affects the Saturated Flow Rate.  

Exhibit 2-2 Lane Group Default Lane Utilization Factors 

Lane Group Movements # of Lanes Lane Utilization Factor 

Thru or shared 1 1.00 

Thru or shared 2 0.95 

Thru or shared 3 0.91 

Thru or shared 4+ 0.86 

Left 1 1.00 

Left 2 0.97 

Left 3+ 0.94 

Right 1 1.00 

Right 2 0.88 

Right 3 0.76 

 

The lane utilization factor can be calculated as follows: 

 

See Synchro section for further details. 

2.4 Travel Time & Delay Studies 

Definitions 

 Travel Time Study. A study conducted to determine the amount of time required to traverse a specific 
route or section of a street or highway. The data obtained provide travel time and travel speed 
information but not necessarily delay. This term is often used to include speed and delay studies. 

 Delay Study. A study made to provide information concerning the amount, cause, location, duration, 
and frequency of delays as well as travel time and similar values. 

 Travel Time. The total elapsed time of travel, including stops and delay, necessary for a vehicle to 
travel from one point to another over a specified route under existing traffic conditions. 

 Running Time. That portion of the travel time that the vehicle is actually in motion. Running time is 
equal to travel time minus stopped-time delay. 

 Travel Speed. The over-all average speed along a specified route of a street or highway. Travel speed 
is computed by dividing the total distance by the travel time. 

 Running Speed. The average speed along the specified route when the stopped time is removed from 
the computations. Running speed is distance divided by running time. 

fLU =
Total App. Vol.

(No. of Lanes) x 

(High Lane Vol.)

200 vph

100 vph
   =

(100 + 200)

(2 x 200)
   = 0.75

http://www.dot.state.mn.us/metro/warrant/
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 Delay. The time lost by traffic due to traffic friction and traffic control devices. 

 Fixed Delay. The delay to which a vehicle is subjected regardless of the amount of traffic volume and 
interference present. 

 Operational Delay. The delay caused by interference from other components of the traffic stream. 
Examples include time lost while waiting for a gap in a conflicting traffic stream, or resulting from 
congestion, parking maneuvers, pedestrians, and turning movements. 

 Stopped Delay. The time a vehicle is not moving. 

 Travel Time Delay. The difference between the actual time required to traverse a section of street or 
highway and the time corresponding to the average speed of traffic under uncongested conditions. It 
includes acceleration and deceleration delay in addition to stopped delay. 

 Approach Delay. Travel time delay encountered at the approach to an intersection. 

 Total Vehicle Delay. The total time lost, in vehicle-minutes per mile, by vehicles in a traffic stream 
because the street or section does not meet the suggested minimum standards. It is obtained by 
multiplying the peak-hour one-direction volumes by the delay rate. 

Need for Travel Time or Delay Data 

Congestion can be evaluated by means of speed and delay studies. Data are obtained on the amount, 
location, and cause of delay; the delay data also indicates locations where other studies are needed to 
determine the proper remedy. 

Traffic signal timing studies often require travel time data at periodic intervals. 

Before-and-after studies may utilize these data to determine the effectiveness of a change in signal timings, 
etc. 

Causes of Delay 

Fixed Delay occurs primarily at intersections. This delay is not a result of the flow characteristics of the traffic 
stream and could occur with only one vehicle traveling the section. It may be caused for example, by traffic 
signals, stop signs, yield signs, or railroad crossings. 

Operational Delay is the result of influences by other traffic. 

 One type of operational delay is caused by other traffic movements that interfere with their stream 
flow (side friction), e.g. parking or unparking vehicles, turning vehicles, pedestrians, stalled vehicles, 
double parking, or cross traffic. 

 The second type of operational delay is caused by internal frictions within the stream flow. 

Methods for Obtaining Travel Time or Delay Data 

Test Car Technique 

The Test Car Technique utilizes a test vehicle which is driven over the street section in a series of runs. 

 The Floating Car Method. In this method the driver tries to “float” in the traffic stream passing as 
many vehicles as pass the test car. 

 The Average Speed Method. In this method the driver is instructed to travel at a speed that is judged 
to be representative of the speed of all traffic at the time.  

 Data Obtained from the test car technique frequently includes delay information. 

 Equipment Used in recording the data varies. 

 An observer with one or two stopwatches was a common method but has generally been replaced by 
new technology. The observer starts the first watch at the beginning of each run, and records the time 
at various control points along the route. The second watch (if used) measures the length of individual 
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stopped-time delays. The time, location, and cause of these delays are recorded either on data forms 
or by voice recording equipment. 

 Various recording devices have been developed to eliminate the necessity of using two persons on 
test runs. These include recording speedometers, tachometers, and the Traffic Stream Analyzer. 

 State of the practice techniques involve using a GPS and will be discussed in Chapter 5. 

 Analysis. The mean, standard deviation, and standard error of the mean of a series of test car runs 
and the significance of differences of the means of “before” and “after” studies are calculated.  

License Plate Technique 

The License Plate Technique is used when only travel-time information is desired. 

Bluetooth Technologies 

The tracking of Media Access Control (MAC) addresses via Bluetooth signals has emerged as a technology 
that offers space mean speed (segment detection) metrics. Many devices such as smartphones, headsets, 
and in-vehicle navigation systems are Bluetooth enabled and can be read by roadside readers. The MAC 
address of a device resembles a “license plate” for the particular device. Several vendors have developed 
platforms that can detect and record these addresses with timestamps in real-time. This information is then 
used to determine the travel time and delay along the route. 

Intersection Delay Studies 

Delay at intersections is a major problem in the analysis of congestion. Delay studies at individual 
intersections are valuable in evaluating the efficiency or effectiveness of a traffic control method. Other 
factors include crashes, cost of operation, and motorists’ desires. 

Factors which affect delay at intersections include: 

 Physical factors such as number of lanes, grades, widths, access control, turning provisions, transit 
stops, etc. 

 Traffic factors such as volume on each approach, driver characteristics, turning movements, 
pedestrians, parking, approach speeds, etc. 

Methods for Measurement of Intersection Delay 

 There are three measures of prime importance for describing intersection performance. 

 Approach delay per vehicle is considered to be the best single measure. However, it must be derived 
indirectly from the stopped delay field study. 

 Stopped delay per vehicle results directly from the field study. A multiplier factor is applied to the raw 
data to bring the estimate closer to the true value. 

 Percent of vehicles stopping is a third performance measure. Again, a multiplication factor is applied 
to the raw field data to achieve a better estimate of the true value. 

 Past and current procedures used to estimate or measure intersection delay fall into one of four basic 
categories. 

 Point sample is based on a systematic sample of some factor (such as the number of stopped vehicles). 

 Input-output uses an interval sample to measure some factor at both its point or time of beginning 
and ending. 

 Path trace procedures track individual vehicles while noting their actions. The use of test cars as in 
travel time studies is a type of path trace. 

 Models take into account the arrival and departure characteristics of vehicles, and many models 
incorporate some field measurements and data in the delay estimates. 
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 Field data collection consists of two items. 

 Stopped delay obtained by a point sample procedure was found to be the most practical method for 
measuring intersection delay in the field. A minimum sample of 60 measurements of the number of 
vehicles in the approach 

HCM Method for Direct Measurement of Prevailing Saturation Flow Rates 

[Source: Highway Capacity Manual] 

The Highway Capacity Manual (HCM) describes a technique for quantifying the base saturation flow rate for 
local conditions. In this manner, it provides a means of calibrating the saturation flow rate calculation 
procedure to reflect driver behavior at a local level. The technique is based on a comparison of field‐
measured saturation flow rate with the calculated saturation flow rate for a common set of lane groups at 
intersections in a given area. 

Concepts 

The default ideal saturation flow rate used in the methodology of Chapter 16 of the HCM is 1900 pc/h/ln.  
This value must be adjusted for prevailing traffic conditions such as lane width, left turns, right turns, heavy 
vehicles, grades, parking, parking blockage, area type, bus blockage, and left turn blockage.  As an alternative 
to this adjustment to the "assumed" ideal saturation flow rate, the prevailing saturation flow rate may be 
measured in the field. 

Saturation flow rate is the maximum discharge rate during the green time.  It is usually achieved after about 
10 to 14 seconds of green, which corresponds to the front axle of the fourth to sixth passenger car crossing 
the stop line after the beginning of green.  

The base saturation flow rate is defined as the discharge rate from a standing queue in a 12 foot wide lane 
that carries only through passenger cars and is otherwise unaffected by conditions such as grade, parking, 
and turning vehicles. 

The base saturation flow rate is usually stable over a period of time for similar traffic conditions in a given 
community. Values measured in the same lane during repetitive weekday traffic conditions normally exhibit 
relatively narrow distributions.  On the other hand, saturation flow rates for different communities or 
different traffic conditions and compositions, even at the same location, may vary significantly. 

Measurement Technique (Two People) 

1. Recorder   
a) Note the last vehicle in the stopped queue when the signal turns green. 
b) Describe the last vehicle to the Timer. 
c) Note which are heavy vehicles and/or turning vehicles. 
d) Record the time called out by the Timer. 

2. Timer   
a) Start stop watch at the beginning of the green and notify the Recorder. 
b) Count aloud each vehicle in the queue as its rear axle crosses the stop line. 
c) Call out the time for the fourth, tenth, and the last vehicle in the queue. 
d) Notify the Recorder, if queued vehicles are still entering the intersection at the end of the green. 

Example 

a) Take the difference in time between the 4th and last vehicle and divide by the number of vehicles 
served (seconds/veh). 

b) The prevailing saturation flow rate is: 
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3600/ seconds/veh in a = veh/h/ln 

 

 

2.5 Automated Traffic Signal Performance Measures 

Automated Traffic Signal Performance Measures (ATSPMs) provide high-resolution data to support 
objectives and performance-based maintenance and operations strategies that improve safety and 
efficiency while cutting congestion and cost. High-resolution data consist of a log of discrete events such as 
changes in detector and signal phase states. This information is used to develop a portfolio of performance 
measures. A major focus is on signal operations, considered from the perspectives of vehicle capacity 
allocation and vehicle progression. Performance measures are also presented for nonvehicle modes, 
including pedestrians, and modes that require signal preemption and priority features.  

MnDOT uses a system that was developed in conjunction with the University of Minnesota. This is called the 
SMART-SIGNAL (Systematic Monitoring of Arterial Road Traffic and Signals) system, which leverages existing 
traffic signal infrastructure, such as in-pavement sensors at vehicle-activated stoplights, to automate the 
process of collecting arterial traffic data. The system includes electronic hardware that can be installed in 
existing traffic signal control cabinets located at intersections. These data collection units record traffic data 
and relay it to a server at a traffic control center, where engineers analyze the data to detect emerging 
congestion patterns and adjust traffic signal timing accordingly. 

The performance measurement algorithms provided for in the SMART-SIGNAL include: 

 Queue length estimation 

 Identification of oversaturated conditions 

 Travel time estimation 

 

  

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

time between 4th and last veh in queue 26 27 36 36 21 22 50 46 21 24 27 11 28 44 30

# of veh between 4th and last in queue 12 13 16 21 11 9 24 27 10 12 8 9 14 26 15

2.17 2.08 2.25 1.71 1.91 2.44 2.08 1.70 2.10 2.00 3.38 1.22 2.00 1.69 2.00 2.05 s/veh

1757 veh/h/ln

what if the recorder was 1 sec high 27 28 37 37 22 23 51 47 22 25 28 12 29 45 31

12 13 16 21 11 9 24 27 10 12 8 9 14 26 15

2.25 2.15 2.31 1.76 2.00 2.56 2.13 1.74 2.20 2.08 3.50 1.33 2.07 1.73 2.07 2.13 s/veh

1694 veh/h/ln

what if the recorder was 1 sec low 25 26 35 35 20 21 49 45 20 23 26 10 27 43 29

12 13 16 21 11 9 24 27 10 12 8 9 14 26 15

2.08 2.00 2.19 1.67 1.82 2.33 2.04 1.67 2.00 1.92 3.25 1.11 1.93 1.65 1.93 1.97 s/veh

1825 veh/h/ln

run #
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3 LOCAL INTERSECTION CONCEPTS 

3.1 Signal Timing Theory 

Signalized intersections play a critical role in the safe and efficient 
movement of vehicular and pedestrian traffic. The objective of 
traffic signal timing is to assign the right-of-way to alternating traffic 
movements in such a manner to minimize the average delay to any 
group of vehicles or pedestrians and reduce the probability of crash 
producing conflicts. Some of the guiding standards to accomplish 
this objective are as follows: 

 Minimize the number of phases that are used. Each 
additional phase increases the amount of lost time due to 
starting delays and clearance intervals. 

 Short cycle lengths typically yield the best performance in 
terms of providing the lowest overall average delay, 
provided the capacity of the cycle to pass vehicles is not exceeded. The cycle length, however, must 
allow adequate time for vehicular and pedestrian movements. Longer cycles are used during peak 
periods to provide more green time for the major street, to permit larger platoons in the peak 
direction, and/or to reduce the number of starting delays. 

Cycle Length 

The cycle length is the total time to complete one sequence of signalization around an intersection. In an 
actuated controller unit, a complete cycle is dependent on the presence of calls on all phases. In a pre-timed 
controller unit (see page 3-5) it is a complete sequence of signal indications. 

One approach to determining cycle lengths for an isolated pre-timed location is based on Webster’s equation 
for minimum delay cycle lengths. The equation is as follows: 

Co   =  1.5 tL + 5 

 

Where: Co = Optimum cycle length in seconds 

  tL = The unusable time per cycle in seconds 

  Yi = degree of saturation for Phase i 

The equation above indicates that cycle lengths in the range of 0.75Co to 1.5Co do not significantly increase 
delay.  

The equation is for isolated pre-timed signal locations only. A detailed network analysis should be performed 
using a software package such as TRANSYT 7-F or Synchro for cycle length determination in a coordinated 
system. The use of computer models allows for multiple iterations of varying cycle combinations to 
determine the optimum signal timing parameters. Chapter 5 of this manual will address this issue. 

In theory, short cycle lengths 
typically yield the lowest 

overall average delay. 
Additional items must be 

considered in the 
determination of the cycle 

length, such as, minimum time 
for vehicle and pedestrian 
movements and systems 

operations. 

1.0 -Yi 
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Example : Consider the intersection shown in the figure below. Assume the adjusted saturation flow rate is 
equal to 1700 vph, and the lost time per phase is 5 seconds. 

 

Yi = Observed Flow  Saturated Flow 

Y1 = 700  1700 =  0.412 

Y2 = 400  1700 =  0.235 

Yi = 0.412 + 0.235 = 0.647 

tL = unusable time per cycle = (2 phases) x (5 seconds lost per cycle) 

     = 10 seconds 

 

1400 vph

8
00

 v
ph

Two Lane per Approach (2-way operation)

Critical Lane Volumes Approach Volumes

Phasing

Phase 1 Phase 2

1000 vph

5
00

 v
ph

700 vph

4
00

 v
ph

Co =
1.5 tL + 5

1.0 - Xi
=

1.5 (10) + 5

1.0 - 0.647 
= 56.7 seconds, use 57 seconds

1.0 -Yi 



MnDOT Traffic Signal Timing and Coordination Manual 

May 2017 Local Intersection Concepts Page | 3-3 

3.2 Signal Timing Intervals and Splits 

An interval is that portion of the cycle that signal indications do not change. There are several commonly 
termed intervals: minimum green, pedestrian clearance, yellow clearance, and all red. Timing parameters 
are applied to intervals (in other words, we can “time” the intervals).  

The sum of the green, yellow, and all red intervals typically defines an individual phase split. A split is then 
the segment of the cycle length allocated to each phase that may occur (expressed in percent or seconds).  

The primary considerations that must be given to vehicle split times are as follows: 

 The phase duration must be no shorter than some absolute minimum time, such as five to seven 
seconds of green plus the required clearance interval. If pedestrians may be crossing with this phase, 
their crossing time must also be considered and included in the minimum phase length.  

 A phase must be long enough to avoid over saturating any approach associated with it. Too short a 
time will cause frequent cycle failures where some traffic fails to clear during its phase. 

 A phase length must not be so long that green time is wasted and vehicles on other approaches are 
delayed needlessly. 

 Phase lengths should be properly designed to efficiently balance the cycle time available among the 
several phases, not just “equitably” between, say, north-south and east-west. 

The distribution of the green time for a pre-timed signal should be proportional to the critical lane volumes 
on each phase (critical lane analysis is discussed on page 3-63). The formula for determining green time for 
a two-phase pre-timed intersection is as follows: 

Gt (net green time) = C - Y1 - Y2 - nl 

Where, 

C = Optimum cycle length (see page 3-1). 

Y1 = Yellow time on Phase 1, seconds 

Y2 = Yellow time on Phase 2, seconds 

n = number of phases 

l = Lost time per cycle, seconds 
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Example: Once again, consider the intersection shown in the following figure. Assume the lost time per 
phase is 5 seconds. 

 

The Cycle length calculated is 57 seconds.  

Assume yellow change time, Y1 = Y2 = 5 seconds. 

Then, 

Gt = C - Y1 - Y2 - nl = 57 - 5 - 5 - 2(5) = 37 seconds. 

And, 

Critical lane volumes = 700 + 400 = 1,100 

 G1 =  37 * 700 / 1,100 = 23.5 seconds 

 G2 =  37 * 400 / 1,100 =  13.5 seconds 

Signal timing would then be as follows: 

 Phase 1 = 23.5 seconds green + 5 seconds yellow + lost time 

              = 33.5 seconds 

 Phase 2 = 13.5 seconds green + 5 seconds yellow + lost time 

      = 23.5 seconds 

 Cycle = Phase 1 + Phase 2 = 33.5 (59%) + 23.5 (41%) = 57 seconds 

1400 vph

8
00

 v
ph

Two Lane per Approach (2-way operation)

Critical Lane Volumes Approach Volumes

Phasing

Phase 1 Phase 2

1000 vph

5
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ph

700 vph

4
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3.3 Signal Timing and Phasing 

Controller Unit Timing 

A traffic signal controls traffic by assigning right-of-way to one traffic movement or several non-conflicting 
traffic movements at a time. Right-of-way is assigned by turning on a green signal for a certain length of time 
or an interval. Right-of-way is ended by a yellow change interval during which a yellow signal is displayed, 
followed by the display of a red signal. The device that times these intervals and switches the signal lamps 
is called a controller unit. This section will cover the operation of controller units and the various features 
and characteristics of the types currently available. 

Control Concepts 

Traffic control concepts for isolated intersections basically fall into two basic categories, pre-timed and 
traffic-actuated. 

Pre-timed signal control 

Under these conditions, the signal assigns right-of-way at an intersection according to a predetermined 
schedule. The sequence of right-of-way (phases), and the length of the time interval for each signal 
indication in the cycle is fixed. No recognition is given to the current traffic demand on the intersection 
approaches unless detectors are used. The major elements of pre-timed control are (1) fixed cycle length, 
(2) fixed phase length, and (3) number and sequence of phases. 

Advantages to pre-timed control include: 

 Simplicity of equipment provides relatively easy servicing and maintenance. 

 Can be coordinated to provide continuous flow of traffic at a given speed along a particular route, 
thus providing positive speed control. 

 Timing is easily adjusted in the field. 

 Under certain conditions can be programmed to handle peak conditions. 

Disadvantages to pre-timed control include: 

 Do not recognize or accommodate short-term fluctuations in traffic. 

 Can cause excessive delay to vehicles and pedestrians during off-peak periods. 

The left side of the following figure shows the timing operation for a basic two-phase or two-traffic 
movement pre-timed controller unit. The right side of the figure shows the timing operation for a three 
phase pre-timed controller unit. For the pre-timed controller, the length of time for each phase is fixed. 
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Exhibit 3-1 Basic Two-Phase Pre-timed Signal Operation 

 

Traffic-actuated signal control 

Traffic-actuated control attempts to adjust green time continuously, and, in some cases, the sequence of 
phasing. These adjustments occur in accordance with real-time measures of traffic demand obtained from 
vehicle detectors placed on one or more of the approaches to the intersection. The full range of actuated 
control capabilities depends on the type of equipment employed and the operational requirements. 

Advantages to actuated signals include: 

 Usually reduce delay (if properly timed). 

 Adaptable to short-term fluctuations in traffic flow. 

 Usually increase capacity (by continually reapportioning green time). 

 Provide continuous operation under low volume conditions as an added safety feature, when pre-
timed signals may be put on flashing operation to prevent excessive delay. 

 Especially effective at multiple phase intersections. 

Disadvantages to actuated control include: 

 The cost of an actuated installation is higher than the cost of a pre-timed installation. 

 Actuated controllers and detectors are much more complicated than pre-timed signal controllers, 
increasing maintenance and inspection skill requirements and costs. 

 Detectors are costly to install and require careful inspection and maintenance to ensure proper 
operations. 

Traffic actuated signal control can further be broken into the following categories: 

Semi-Actuated Control. In semi-actuated control, the major movement receives green unless there is a 
conflicting call on a minor movement phase. The minor phases include any protected left-turn phases or 
side street through phases. Detectors are needed for each minor movement. Detectors may be used on the 
major movement if dilemma zone protection is desired.  

In semi-actuated coordinated systems (referred to as Actuated Coordinated in Synchro), the major 
movement is the “sync” phase. Minor movement phases are served only after the sync phase yield point 
and are terminated on or before their respective force off points. These points occur at the same point in 
time during the background signal cycle and ensure that the major road phase will be coordinated with 
adjacent signal controllers. 

GREEN YEL. RED

RED GREEN YEL.

PHASE 1

PHASE 2

PHASE 1 SPLIT PHASE 2 SPLIT

N

CYCLE LENGTH

PHASE 1 PHASE 2
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PHASE 1 SPLIT PHASE 3 SPLIT
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PHASE 2 SPLIT

GREENRED
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PHASE 3
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In semi-actuated non-coordinated systems, the major movement phase is placed on minimum (or 
maximum) recall. The major movement rests in green until a conflicting call is placed. The conflicting phase 
is serviced as soon as a gap-out or max-out occurs on the major phase. Immediately after the yellow is 
presented to the major phase, a call is placed by the controller for the major phase, regardless of whether 
or not a major phase vehicle is present. 

Full Actuated Control. In full actuated control, all signal phases are actuated and all signalized movements 
require detection. Generally used at isolated intersections; however, can also be used at high-demand 
intersections in coordinated systems.  

Volume-density operation can be considered to be a more advanced form of full-actuated control. It has the 
ability to calculate the duration of minimum green based on actual demand (calls on red) and the ability to 
reduce the maximum allowable time between calls from passage time down to minimum gap. Reducing the 
allowable time between calls below the passage time will improve efficiency by being better able to detect 
the end of queued flow. 

Traffic Signal Phasing 

A traffic signal phase, or split, is the part of the cycle given to an individual movement, or combination of 
non-conflicting movements during one or more intervals. An interval is a portion of the cycle during which 
the signal indications do not change. 

The predetermined order of phases is the sequence of operation. This order is fixed in a pre-timed controller, 
and under certain circumstances, may be variable with an actuated controller. 

Consider Exhibit 3-2 for an example two-phase (single ring) signal with pedestrian timing. In the figure, there 
are eight intervals where the signal indications do not change. Notice that intervals 4 and 8 are all red periods 
(interval 4 is the phase 1 all red and interval 8 is the phase 2 all red). The phase 1 split is made up of intervals 
1 through 4 and the phase 2 split is made up of intervals 5 through 8. The sum of split 1 and 2 is the cycle 
length. 
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Exhibit 3-2 Traffic Signal Phasing 

 

Ring and Barrier Structure 

Ring 

A ring is a term that is used to describe a series of conflicting phases that occur in an established order. A 
ring may be a single ring, dual ring, or multi-ring and is described in detail below. A good understanding of 
the ring structure is a good way to understand the operation of multiphase controllers. 

Barrier 

A barrier (compatibility line) is a reference point in the preferred sequence of a multi-ring controller unit at 
which all rings are interlocked. Barriers assure there will be no concurrent selection and timing of conflicting 
phases for traffic movements in different rings. All rings cross the barrier simultaneously to select and time 
phases on the other side. 

Phase Numbers 

Phase numbers are the labels assigned to the individual movements around the intersection. For an eight 
phase dual ring controller (see definition of dual ring), it is common to assign the main street through 
movements as phases 2 and 6. Also, it is common to use odd numbers for left turn signals and the even 
numbers for through signals. A rule of thumb is that the sum of the through movement and the adjacent left 
turn is equal to seven or eleven.  

Exhibit 3-3 shows a typical phase numbering scheme for an east/west arterial and a north/south arterial. 
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INTERVAL 1 2 3 4 5 6 7 8

PHASE 1 PED.

PHASE 2 PED.

PHASE 1 SPLIT PHASE 2 SPLITSPLIT

PHASE 1 PHASE 2

N

CYCLE LENGTH

Sequence of Operation



MnDOT Traffic Signal Timing and Coordination Manual 

May 2017 Local Intersection Concepts Page | 3-9 

Exhibit 3-3 Common Phase Numbering Scheme 

 

Dual Ring Control 

By contrast to the pre-timed controller unit, the traffic actuated controller usually employs a “dual ring 
concurrent” timing process. The NEMA concept is illustrated in Exhibit 3-4.  

Exhibit 3-4 Dual Ring Control 

 

The dual-ring controller uses a maximum of eight phase modules, each of which controls a single traffic 
signal face with red, yellow and green display. The eight phases are required to accommodate the eight 
movements (four through and four left turns) at the intersection. Phases 1 through 4 are included in ring 1, 
and phases 5 through 8 are included in ring 2. The two rings operate independently, except that their control 
must cross the “barrier” at the same time.  

If the movements to be controlled by these eight phases are assigned properly, the controller will operate 
without giving the right-of-way simultaneously to conflicting movements. All of the movements from one 
street (usually the major street) must be assigned to the left side of the barrier. Similarly, all movements 
from the other street must be assigned to the right side. 

On both sides of the barrier there are four movements (two through and two left). Each of the four may 
proceed without conflict with two of the other three. So if the left turn in any given direction is placed in 
ring 1 along with its opposing through movement, and the remaining two movements are placed in ring 2, 
it will be possible for either movement in ring 1 to be displayed simultaneously with either movement in ring 
2 without conflict. 

DUAL RING STRUCTURE

5 6

3 41 2

7 8

RING A
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BARRIER 1
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The dual-ring concurrent operation can be shown to maximize the operating efficiency at an intersection by 
eliminating the “slack” time on each cycle (i.e., control will follow one or the other of the two paths shown). 

Modern controllers offer more flexibility in assigning traffic signal phases in order to control many complex 
or unique situations. TS2 controllers include four timing rings and up to sixteen vehicle phases and sixteen 
pedestrian phases. Each phase can be assigned to any ring. In addition, there are up to sixteen overlap 
assignments. 

Single Ring (Sequential Phases) 

Sometimes it is desirable to use a single ring and have the phases operate one at a time sequentially. Each 
phase is individually timed and can be skipped if there is no demand for it. This is called sequential or 
exclusive phasing. When using sequential phases on the left side of the barrier, phases 1-2-5-6 show in order. 
When using sequential phases on the right side of the barrier, phases 3-4-7-8 show in order. 

Exhibit 3-5 is an example of a controller using Sequential phases. North and South traffic use split phasing, 
East and West share a phase. 

Exhibit 3-5 Sequential Phasing 

 

Multi-Rings and Barriers 

A controller supporting more than eight phases and two rings would be a multi-ring controller. Any number 
of phases, up to the maximum supported by the controller, can be arranged in any number of rings. Conflicts 
between phases in different rings are specified using either barriers inserted between groups of phases, or 
phase concurrency lists. Exhibit 3-6 illustrates 16 phases in a quad-ring / quad-barrier structure. 

Exhibit 3-6 Multi-Ring Phasing 
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Phasing Parameters  

Some of the basic principles of timing the green interval in a traffic actuated controller unit are as follows: 

 There must be a minimum green time so that a stopped vehicle that receives a green signal has 
enough time to get started and partially across the intersection before the yellow signal appears. This 
time is termed the initial portion of the green interval. 

 Each following vehicle requires green time. This is called passage time, vehicle extension, or gap. Gap 
refers to the distance between vehicles as well as the time between vehicles. 

 There must be a maximum time that the green interval can be extended if opposing cars are waiting 
- this is called extension limit or maximum. 

 A timing diagram for one traffic actuated phase is shown in the figure that follows. The other phase 
or phases operate in the same manner.  

 The number of “presets” is the number of timing adjustments in the extensible portion. Each detector 
actuation starts the unit extension timing again. With no opposing calls the controller rests. Unit 
extensions continue being timed, but with no effect on the green interval. 

 However, once an actuation is received from an opposing phase, unit extension is used to expedite 
servicing that phase as follows:  if the time between actuations is greater than the preset unit 
extension or gap the extensible portion will be ended, the yellow change interval will appear and the 
next phase in sequence with demand will receive the right-of-way. This is called termination by gap 
or gap-out. 

 An actuation from another phase received in any portion of the green interval also starts another 
timing circuit. This is called the extension limit or maximum green. Even if actuations are close enough 
in time to prevent gap termination, the maximum limit will terminate the green interval when the 
preset maximum expires. This is called termination by maximum green or max-out. 

Exhibit 3-7 Traffic Actuated Phase Timing Diagram 
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Minimum Green 

The Minimum Green Interval is the shortest green time of a phase. If a time setting control is designated as 
"minimum green," the green time shall be not less than that setting. For MnDOT practice on minimum green 
(minimum initial) times, refer to page 4-7. 

Initial Intervals 

There are three types of initial intervals as follows: 

 Extensible initial 

 Added initial 

 Computed initial 

Extensible initial is the method of calculating the variable initial period commonly used in field practice. This 
method adds the time specified as “seconds per actuation” to the minimum initial (green) for each vehicle 
actuation received by a phase during the yellow and/or red signal (depending on red and yellow lock) up to 
a maximum initial time. This method is common in both 170 and NEMA controllers. 

Added initial is similar to extensible initial with the exception that the “seconds per actuation” calculation 
does not begin until a user specified number of vehicles actuations have occurred. The added initial option 
is generally used when long minimum green times are specified. 

Computed initial calculates the amount of time given to each vehicle actuation (computed seconds per 
actuation) during the red signal display of the phase based on the following formula: 

(Maximum initial interval time)  (number of actuations that can be serviced during the minimum initial 
interval) x (number or recorded actuations). The total time allowed for the computed initial interval is limited 
by both the minimum green and maximum initial interval. 

Passage Time 

Passage Time (also referred to as vehicle extension or gap time) is the time that the phase will be extended 
for each actuation. Passage time is typically set as the time it takes to travel from the vehicle detector to the 
stop line at the travel speed of the roadway for pulse loops or the average acceptable headway between 
vehicles for presence loops located close to the stop line. Therefore, the vehicle extension is related to the 
minimum and maximum gap. For MnDOT practice on passage time refer to page 4-18. 

Maximum Green 

Depending on the type and manufacturer of the controller being simulated, there can be two methods for 
calculating the maximum amount of green time allowed per phase. Method 1 or maximum green, allows 
the user to input the maximum amount of green time a phase will be allowed to be active, (i.e. display 
green.)  The max. timer in the controller begins its countdown at the receipt of a conflicting vehicle or 
pedestrian call, generally the beginning of phase green and includes any minimum green or variable initial 
period.  

Method 2, maximum green extension, is the amount of time a phase will be allowed service after the 
minimum green and variable initial have timed out. While some controller manufacturers still allow 
maximum green extension, it is more commonly found in older isolated NEMA and Type 170 controllers. 
Assuming that vehicle headways remain less than the vehicle extension time during the green signal display 
of the phase, Method 1 will always produce the same timing value. However, in Method 2 the total green 
time is not only dependent on vehicle headways during the phase green but also on the number of vehicles 
that arrive during the red display for the calculation of variable initial. Therefore, total green time for Method 
2 can vary from cycle to cycle irrelevant of vehicle headways. 
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If the controller is operating within a coordinated system the maximum green time specified in the controller 
may not be appropriate for the cycle/split combination selected by the master controller. In this case the 
phase can max-out early without ever reaching the force-off point (the end of the assigned phase split) for 
the phase.  

Note:  In certain manufacturers’ controllers, there will be a timing function called “MAX EXT.”  This is not the 
same as maximum extension green but the number of seconds used to extend the maximum green value 
when “MAX 3” is active. 

For MnDOT practice on maximum green times, refer to page 4-20. 

Pedestrian Phasing 

Because pedestrians move at a slower speed than vehicles, they require different treatment of the green 
interval. A pedestrian actuation, therefore, results in more green time than would be allowed for a vehicle: 
a “Walk” interval followed by a flashing “Don’t Walk” pedestrian clearance. In the absences of opposing 
calls, succeeding pedestrian actuations will recycle the pedestrian indications. 

 Pedestrian intervals result in a green interval for the parallel vehicle phase or phases. Exhibit 3-7 on 
the page 3-11 shows the timing diagram for pedestrian operation. 

 It is also possible to have an exclusive pedestrian phase. That is, no vehicle green intervals will occur. 
All pedestrian signals at an intersection could be controlled by this phase. 

Red Vehicle Clearance 

Red clearances (ALL RED) is the safety clearance interval at the end of a phase that displays red for all traffic 
movements. For MnDOT practice on red clearance intervals see page 4-23.  

Recall 

Normally a controller unit will, in the absence of actuation, rest on the last phase serviced. By means of a 
recall switch the controller unit can be forced to return to a particular phase’s green interval, even with no 
demand. 

Every phase has the capability of operation with the following types of recall: 

 Minimum Recall. When active and in the absence of a vehicle call on the phase, a temporary call to 
service the minimum initial time will be placed on the phase. If a vehicle call is received prior to the 
phase being serviced the temporary call will be removed. Once the phase is serviced it can be 
extended based on normal vehicle demand. 

 Maximum Recall. With the maximum vehicle recall active a constant vehicle call will be placed on the 
phase. This constant call will force the controller to time the maximum green. Maximum recall is 
generally used to call a phase when local detection is not present or inoperative. 

 Pedestrian Recall. This feature provides vehicle green and pedestrian walk and clearance intervals. 
After that, normal green timing is in effect except that pedestrian calls will not recycle pedestrian 
intervals until opposing phases are serviced. 

 In addition, a phase has a vehicle call placed on it if it is terminated with some passage time remaining. 
This can happen with termination by maximum. 

 If all of the active phases of a controller unit are placed on recall the controller unit will operate in a 
pre-timed mode. It should be added that unless the detectors are disconnected from a phase, that 
phase’s green interval could be extended beyond the preset minimum if the recall is to minimum. 
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Volume Density Control 

Even more sophisticated operation is possible with the volume density traffic actuated controller unit. In 
addition to the features discussed above, volume density provides two means of modifying the basic timing 
intervals. These are: 

 Variable initial is a means of extending the initial portion of the green interval. This is done on the 
basis of the number of actuations above a preset number while the phase is displaying yellow or red. 
This extended initial provides additional green time for a queue of vehicles waiting, when the green 
signal appears, to clear the intersection if the detectors are set back a distance from the stop bar and 
there are no vehicles following. 

 Gap reduction is a means of reducing the passage time or gap on the basis of the time that opposing 
vehicles have waited. In effect, it benefits the waiting vehicles by reducing the time allowed between 
vehicles arriving on the green phase before that phase is terminated. 

The timing diagram for a volume density phase is shown in Exhibit 3-8. 

Exhibit 3-8 Volume-Density Timing Diagram 

 

Gap Reduction 

Gap reduction, as the name implies, reduces the gap or allowable headways between vehicles from the 
original value (MAX GAP) to a lesser value (the MIN GAP) over a specified amount of time.  

While gap reduction is used sporadically in the field, it can be a valuable tool. For example, assume there is 
an approach to a fully actuated intersection that experiences a very sluggish “start-up” creating excessive 
headways until vehicles are moving at a more normal speed. If the gap is set where it should be for the 
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normal speeds, the phase would constantly gap-out early. If, however, the gap were set to accommodate 
the start-up vehicles, the phase would run to maximum green more times than necessary. This problem 
could be handled by providing a long minimum green time or extending the vehicle call but would also 
contribute to an inefficient signal operation. By providing a longer than normal vehicle extension (gap) time 
at the beginning of the signal phase and then reducing the gap to a more reasonable value during the vehicle 
start-up time the problem is relieved with little or no effect on efficiency. Similarly, gap reduction can take 
care of the problems experienced at intersections with large fluctuations in traffic volumes during the day. 
Generally these intersections have low vehicular volumes with long vehicle headways during off-peak travel 
times and shorter headways during peak travel periods. Gap reduction techniques could provide a longer 
gap at the beginning of the phase when volumes are low, headways are long, and an overall shorter cycle 
length is provided. The gap would then be reduced to a lesser value as volumes increase, headways decrease, 
and the cycle length increases. 

Three types of gap reduction include: 

Reduce by/reduce every 

The user can specify that the gap can be reduced by a specified amount for every user specified interval. 
(Older Type 170 controllers only allow this option.)  

Reduce by every second 

The user can specify the gap will be reduced by a given amount of time every second. 

Time to reduce to minimum gap. 

The user can specify the gap will be reduced from its original value (vehicle extension) or maximum value 
(maximum gap) to a minimum value (minimum gap) over a user specified amount of time. (This method of 
gap reduction is commonly used in field conditions and allowed by all NEMA and newer model Type 170 
controllers.) 

Note:  For any method of gap reduction in effect, the gap begins to be reduced at the receipt of a call on a 
conflicting phase. This is generally, but not always the beginning of phase green. NEMA and newer 170 
controllers allow the user to specify an amount of time from the beginning of phase green until gap reduction 
begins. This value is called Time-Before-Reduction and is commonly used in the field when gap reduction is 
active.  

For MnDOT practice of time to reduce and time before reduce see page 4-17. 

Minimum Gap 

This input is the minimum acceptable vehicle gap specified by the user. It is also used to specify the end of 
the gap reduction period when the reduce by/reduce feature is selected.  

For MnDOT practice on minimum gap see page 4-19. 

Maximum Gap 

Maximum gap defines the gap at the beginning of the gap reduction period.  

Yellow Lock 

Most NEMA and Type 170 controllers use yellow lock as a factory standard setting that cannot be changed 
by the user. Some of the terms used to define this function are LOCK, or MEMORY on/off, or LOCKING 
MEMORY on/off, or a similar term and toggle. If this memory lock toggle is “on” (active) vehicle actuation 
which occur during the yellow and red display of the signal phase are accumulated and remembered in the 
controller and used in the variable initial calculation and/or to call the phase for service. If the toggle is set 
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to “off” (inactive) it only means the controllers does not remember or count vehicle actuation or place a call 
for service on a phase that has an unoccupied detector.  

Double (Dual) Entry 

When double (dual)-entry is permitted, a vehicle call on one phase, in the absence of a call on a compatible 
phase, will automatically place a call on the primary corresponding compatible phase. For example using the 
standard NEMA phase numbering scheme, assuming the intersection being considered is under light traffic 
conditions. A call for service is received on phase 2 but there are no other calls on phase 5 or 6. With dual 
entry active the call on phase 2 would automatically place a temporary call on phase 6. When phase 2 
became active and no call was received on phase 5, phase 6 would be displayed simultaneously with phase 
2. If a call had been received on phase 5 before phase 2 became active, the temporary call on phase 6 would 
have been removed and phases 2 and 5 would have been displayed. In the standard NEMA phase numbering 
scheme, compatible dual-entry phases are 1 and 5, 2 and 6, 3 and 7, and 4 and 8. If dual-entry is not active 
a vehicle call on a phase will only allow the display of that phase in the absence of a call on a compatible 
phase. The usage of dual-entry is generally a policy decision. However, common usage is to have dual entry 
active on the NEMA standard even-number phases (through movements) and inactive on NEMA standard 
odd-number phases (left-turn movements). 

Rest in Red 

While rest in red is a phase specific input, in actuality, it is used to designate when all phases of the controller 
are allowed to rest in red in the absence of calls or recalls on any phase. Therefore, if rest in red is set to 
active for any phase it should be active for all phases. In most controllers this is a per unit function and 
generally a toggle. 

While this function is not uncommon, especially for isolated intersection with relative even traffic flows on 
all approaches, it is the more general practice to allow the controller to rest in green on the mainline 
approaches in the absence of calls. In this case, rest in red would be set to inactive for all phases. 

Lag Phase 

The lag phase setting designates which phase of a phase pair displays green first, or before the other phase. 
A phase pair is defined as adjacent phases in the same ring on the same side of the barrier on a standard 
NEMA phase diagram. Therefore, phase pairs are phases 1 and 2, 3 and 4, 5 and 6, and 7 and 8. Phase pairs 
are not NEMA compatible signal display phases such as 1 and 5, or 2 and 6. 

In a standard NEMA 8 phase configuration operating in leading dual lefts on both streets, phases 2, 4, 6 and 
8 are lag phases while phases 1, 3, 5, and 7 are leading phases. For a lead/lag sequence, phase 2 can lead, 
and phase 1 can lag. This will produce the signal display sequence of phases 2 and 5, then phases 2 and 6, 
then phases 1 and 6. It is also possible to have both left turns lagging by specifying phases 2 and 6 as leading 
and phases 1 and 5 as lagging. Lagging left-turn phases are typically only used in coordinated systems. 

Overlap Phasing 

An overlap is a right-of-way indication which allows traffic movement when the right-of-way is assigned to 
two or more traffic phases. An overlap occurs when one green signal indication is illuminated by more than 
one phase output from a controller. 

Right Turn Overlap (Controller Programmed) 

Refer to the exhibit below. In this case, the NBR is assigned as overlap A in the controller. The parent phases 
for OL A are 1 and 8.  
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Exhibit 3-9 Right Turn Overlap Phasing 

 

For this case, the yellow ball and red clearance is NOT displayed and green arrow will continue to be 
displayed during change from phase 1 to 8. 

Controller programming can omit the right turn arrow if there is a conflicting pedestrian call. 

Note: Controller Programmed Overlap is preferred over Hardwired Overlap. 

Right Turn Overlap (Hardwired)  

Refer to the image on the right. For the hardwired overlap, the NBR is wired directly with the WBL.  

For this case, the yellow ball and red clearance is displayed during change from phase 1 to 8. 

This operation cannot be used if there is a conflicting pedestrian crossing. 

The hardwired configuration is not typically used by MnDOT. 

Overlaps with U-Turns 

When a right turn overlap is used, consideration should be given to the conflicting U-
turn (WB U-turn in the image above). In some instances, it might be necessary to 
prohibit U-turns. Another option is to use a “U-Turn Yield to Right Turn” sign.  

A static sign as show to the right is not recommended when using a flashing yellow 
arrow for the left turn treatment due to the optional modes of operation for the FYA. 
In these cases, consider a no U-turn sign. An additional option would be a blank-out 
or changeable message sign. 

Close Ramp Intersections Using Signal Controller with Overlaps 

Refer to the image below. In this case, the WBT at the west ramp is assigned as overlap A in the controller. 
The parent phases for OL A are 1 and 2.  

The EBT at the east ramp is assigned overlap B in the controller. The parent phases for OL B are 5 and 6. 
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Exhibit 3-10 Overlap Phasing 

 

Red Revert 

Under very light traffic conditions and fully actuated control it is possible without red revert active for a 
phase to go from green to yellow and then back to green without ever displaying a red indication. Red revert 
timing prevents this signal display sequence by forcing the red indication to be displayed after a yellow for 
at least the red revert time. Red revert in generally factory programmed at 2 seconds.  

Phase Hold 

During coordinated operation, a “hold” can be placed on user-selected phases to prevent these phases from 
terminating before their force-off point is reached. This is desirable when lead-lag left-turn phasing 
combinations are used to maximize two-way progression. Placing a “hold” on a lagging left-turn phase 
prevents that phase from premature “gap-out” and ensures that the phase does not terminate until its force-
off point is reached. This prevents the concurrent through phase from terminating prematurely and 
shortening the progression band in that direction.  

The lag phase hold input is commonly used in closed-loop systems that do not have local intersection vehicle 
detection. Once the phase is initialized, by either minimum recall or maximum recall, it will continue to 
display green not terminating until its force-off point is reached. All maximum green or vehicle extensions 
will be ignored if detection is used.  This function should not be confused with the controller function “Inhibit 
Max Termination.”  The Inhibit Max termination function allows the controller to “gap-out” or be “forced-
out” but not “max-out.”  The lag phase hold to force-out function will only allow the simulated controller to 
be “forced-out” and has no impact on controllers which are not operating within a coordinated system. 

Simultaneous Gap-Out 

Both NEMA and 170 operational logic specifies that both controller rings, ring 1 and ring 2, must cross the 
barrier at the same time. This can be accomplished by each of the phases 2 and 6 “gapping-out,” “maxing-
out,” or “forcing-off.”  With simultaneous gap-out not active, one ring can gap-out and the other can max-
out. Additionally, once a phase gaps-out it will stay in that condition, irrelevant of any future vehicle 
actuations until the phase in the opposite ring either gaps-out or maxes-out and then both phases cross the 
barrier. With simultaneous “gap-out” active, each of the phases cannot cross the barrier until both phases 
have been terminated in the same manner, by either “gap-out” or both “max-out.”  Additionally, if a phase 
initially “gaps-out” and then, due to increased vehicle demand, vehicle arrivals are less than the extension 
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time, the “gap-out” flag for that phase is removed. With simultaneous “gap-out” active, the vehicle 
headways on both phases must currently be exceeding the gap-in-effect. The inactive status for this function 
generally produces a quicker reacting signal and shorter cycle lengths. 

Twice Per Cycle Left Turns 

A common problem experienced during long cycle lengths is when the queue from a left-turn lane backs up 
into a through lane and reduces the capacity of the through movement. Twice Per cycle Left-Turn (TPCLT) 
operation reduces this left-turn "spill-over" problem on an as needed basis by servicing the protected left-
turn movement as a leading AND a lagging left-turn. This allows the left-turn bay to empty during the lead 
left-turn movement and recharge during the through movements before being serviced again as a lagging 
left-turn. TPCLT operation is even more effective for dual-left-turn lanes that are effectively reduced to a 
single lane when the spillback extends into the through lane of traffic. 

TPCLT operation differs from conditional-service which only allows a protected left-turn phase to be re-
serviced if the opposing through movement gaps out.  TPCLT ensures that the lagging left-turn is serviced 
even during congested periods when the through phases are maxing out.   

Conditional Service 

When a heavy left-turn demand exists at an intersection (generally not coordinated), it may be desirable to 
service one of these left-turn phases twice in the same controller cycle. The conditional service entry, under 
a specific set of circumstances, allows the left to be serviced first as a leading phase and then as a lag phase. 
Specifying this feature will allow the controller to operate in this manner under the following circumstances: 

 There is a call for service on a leading left-turn phase. 

 The controller is operating in the non-coordinated mode. 

 There is a conflicting call on the opposite side of the barrier. Otherwise the left-turn phase will 
automatically be serviced next by standard controller logic unless the anti-backup controller feature 
is active. 

 The through phase of the phase pair with the left-turn call for service has gapped-out. 

 The time remaining on the active through phase’s maximum timer exceed the conditional service 
phase’s minimum conditional service time. Conditional service time is generally equal to or greater 
than the minimum green of the left turn phase to be conditionally serviced. 

3.4 Emergency Vehicle Preemption (EVP) 

Emergency vehicle preemption (EVP) is a system installed on authorized emergency vehicles and at traffic 
signals which allows the authorized emergency vehicles to travel through signalized intersections in a safe 
and timely manner. Also refer to the operation of EVP with FYA found on page 4-30. 

The system works as follows: 

 An authorized emergency vehicle approaching a signalized intersection enroute to a call has an 
activated emitter (an infrared LED or a visible strobe light oscillating at a specified frequency).  

 The oscillations are detected by an EVP detector mounted on the signal mast arm.  

 The detector may be located elsewhere to increase the range.  

 The signal controller terminates any conflicting phases to bring up the through phase for the 
authorized emergency vehicle.  

 Indicator lights mounted on the mast arm indicate that preemption is in operation. 
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Care must be taken when considering the operation of EVP with permissive left turns (see page 3-20 for a 
discussion on permissive left turns) to prevent left turn trapping (see page 3-31). Using EVP with a flashing 
yellow arrow will prevent the trap problem as discussed on page 3-33. 

Transit Signal Priority 

Bus priority or transit signal priority (TSP) is a name for various techniques to improve service and reduce 
delay for mass transit vehicles at intersections (or junctions) controlled by traffic signals. TSP techniques are 
most commonly associated with buses, but can also be used along streetcar, tram, or light rail lines that mix 
or conflict with general vehicular traffic. 

Transit signal priority techniques can generally be classified as active or passive. Passive TSP techniques 
typically involve optimizing signal timing or coordinating successive signals to create a “green wave” for 
traffic along the transit line’s route. Passive techniques require no specialized hardware (such as bus 
detectors and specialized traffic signal controllers) and rely on simply improving traffic for all vehicles along 
the transit vehicle's route. 

Active TSP techniques rely on detecting transit vehicles as they approach an intersection and adjusting the 
signal timing dynamically to improve service for the transit vehicle. Unlike passive techniques, active TSP 
requires specialized hardware: the detection system typically involves a transmitter on the transit vehicle 
and one or more receivers (detectors), and the signal controller must be “TSP capable”, i.e. sophisticated 
enough to perform the required timing adjustments. This operation requires special coordination 
programming of the controller that is separate from EVP and regular coordination programming.  

Active strategies include: 

 Green Extension: This strategy is used to extend the green interval by up to a preset maximum value 
if a transit vehicle is approaching. Detectors are located so that any transit vehicle that would just 
miss the green light ("just" meaning by no more than the specified maximum green extension time) 
extends the green and is able to clear the intersection rather than waiting through an entire red 
interval.  

 Early Green (aka red truncation): This strategy is used to shorten the conflicting phases whenever a 
bus arrives at a red light in order to return to the bus’ phase sooner. The conflicting phases are not 
ended immediately like they are for emergency vehicle preemption systems but are shortened by a 
predetermined amount. 

 Early Red: If a transit vehicle is approaching during a green interval, but is far enough away that the 
light would change to red by the time it arrives, the green interval is ended early and the conflicting 
phases are served. The signal can then return to the transit vehicle’s phase sooner than it otherwise 
would. Early red is largely theoretical and is not commonly used in practice. 

 Phase Rotation: The order of phases at the intersection can be shuffled so that transit vehicles arrive 
during the phase they need. 

 Actuated Transit Phase(s): These are phases that are only called if a transit vehicle is present. These 
might be seen along streetcar lines or on dedicated bus lanes.  

 Phase Insertion: This strategy allows a signal controller to return to a critical phase more than once 
in the same cycle if transit vehicles that use that phase are detected.  

3.5 Left Turn Phasing 

There are five options for the left-turn phasing at an intersection: permissive only, protected only, protected-
permissive, split phasing, and prohibited. Phasing can have a significant impact on signal system 
effectiveness for a number of reasons, including:  
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 Permissive only left turn operation may reduce delay for the intersection, but may adversely affect 
intersection safely, because it requires motorists to choose acceptable gaps. 

 Protected only left-turn phases may reduce delay for turning vehicles but are likely to increase overall 
intersection delay. 

 Protected-permissive left turn phases can offer a good compromise between safety and efficiency but 
could limit available options to maximize signal progression during coordination unless innovative 
displays are used. 

 Split phasing may be applicable with shared lanes, but could increase coordinated cycle length if both 
split phases are provided a concurrent pedestrian phase. 

 Prohibited left turns may be used selectively to reduce conflicts at the intersection. 

Protected and Permissive Left Turn Phasing 

If a protected left turn phase is to be used (left turn made without conflicts with opposing traffic) left turns 
may or may not also be permitted on a circular green or Flashing Yellow Arrow (see page 3-24) indication 
with opposing traffic. 

In general, it is desirable to allow this permissive left turn movement unless there are overriding safety 
concerns which make such phasing particularly hazardous. 

 Use of a permissive left turn can significantly reduce overall intersection delay as well as delay to left 
turners.  

 Use of permissive left turn phasing may reduce the required length of left turn storage on the 
approach and allow an approach with substandard left turn storage to operate more efficiently. 

Certain situations exist where safety considerations generally precluded the use of permissive left turns. In 
these cases, left turns should be restricted to the exclusive left turn phases. Such situations include: 

 Intersection approaches where crash experience or traffic conflicts criteria are used as the basis for 
installing separate left turn phasing. 

 Blind intersections where the horizontal or vertical alignment of the road does not allow the left 
turning driver adequate sight distance to judge whether or not a gap in on-coming traffic is long 
enough to safely complete his turn.  

 High-speed and/or multilane approaches may make it difficult for left turning drivers to judge gaps in 
oncoming traffic. Such locations should be evaluated on an individual basis. 

 Unusual geometric or traffic conditions may complicate the driver’s task and necessitate the 
prohibition of permissive left turns. An example of such conditions is an approach where dual left 
turns are provided. 

 When normal lead-lag phasing is used (due to left turn trapping). 

Some of the issues noted above that preclude the use permissive left turns may only be applicable during 
certain times of the day. Traditionally, this would require protected only operation for the entire day. The 
use of the FYA display (see page 3-24) would allow the indication to operate as protected only during some 
times of the day and permissive or protected/permissive during others. The use of the FYA display can also 
eliminate the left turn trapping problem that is discussed in the next section.   

Left Turn Phasing Sequence 

A critical element to the operation of a traffic signal is the determination of the appropriate phasing 
sequence. At signalized intersections where traffic volumes are heavy or speeds are high, vehicles 
attempting to turn left across opposing traffic may constitute significant safety and capacity problems. Based 
on this, there are additional considerations for determining the left turn phasing alternative. These include: 
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 Heaviest Left Turn Protected -  This is a leading left phase scheme in which the left-turning vehicles 
from only one approach are protected and move on an arrow indication proceeding the opposing 
through movement; or a lagging left when the protected left turn follows the through movement 
phase. 

 Both Left Turns Protected (Without Overlap) - When the opposing left turns move simultaneously 
followed by the through movements, it is called a “lead dual left”. If the left turns follow the through 
movement, it is called a “lag dual left”. 

 Both Left Turns Protected (With Overlap) - In this operation, opposing left turns start simultaneously. 
When one terminates, the through movement in the same direction as the extending left movement 
is started. When the extended left is terminated, the remaining through movement is started. When 
this type of phasing is used on both streets, it is termed “quad left phasing”. 

 Lead Lag - This phasing is combined with a leading protected left in one direction, followed by the 
through movements, followed by a lag left in the opposing direction. It is sometimes used in systems 
to provide a wider two-way through band. 

 Directional Separation (Split) - First, one approach moves with all opposing traffic stopped, then the 
other approach moves with the first approach stopped. 

Exhibit 3-11 shows the above basic left turn phasing schemes. 

Whether or not separate left turn phasing should be provided is a decision that must be based on 
engineering analysis. This analysis may involve serious trade-offs between safety, capacity, and delay 
considerations. 

 Separation of left turns and opposing traffic may reduce crashes that result from conflicts between 
these movements, and may increase left turn capacity. However, through traffic capacity may be 
reduced. 

 Left turn phasing may reduce peak period delay for left turners, but may increase overall intersection 
delay. Off-peak left turn delay may also increase. 
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Exhibit 3-11 Left Turn Phasing 

 

Heaviest Left Turn Protected

This is a leading left phase scheme in which the 

left-turning vehicles from only one approach are 

protected and move on an arrow indication 

proceeding the opposing through movement; or a 

lagging left when the protected left turn follows the 

through movement phase.

Both Left Turns Protected (Without Overlap) 

When the opposing left turns move simultaneously 

followed by the through movements, it is called a 

“lead dual left”.  If the left turns follow the through 

movement, it is called a “lag dual left”.

Directional Seperation (Split) 

First, one approach moves with all opposing traffic 

stopped, then the other approach moves with the 

first approach stopped.

- OR -

Leading Left

Lagging Left

- OR -

Lag Dual Lefts

Lead Dual Lefts

Both Turns Protected (with Overlap) 

In this operation, opposing left turns start 

simultaneously.  When one terminates, the through 

movement in the same direction as the extending 

left movement is started.  When the extended left is 

terminated, the remaining through movement is 

started.  When this type of phasing is used on both 

streets, it is termed “quad left phasing”.

Lead Lag phasing is combined with a leading 

protected left in one direction, followed by the 

through movements, followed by a lag left in the 

opposing direction.  It is sometimes used in 

systems to provide a wider two-way through band.

.

- OR -

Quad Left (Leading) Phasing

Quad Left (Lead Lag) Phasing
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3.6 Flashing Yellow Arrow Display 

The Flashing Yellow Arrow (FYA) head is a signal that uses a flashing yellow arrow indication 
for permissive left turns instead of using a green ball.  A 7-year national study determined 
that the 4-section FYA signal head with a red arrow on top, followed by a steady yellow 
arrow, a flashing yellow arrow, and then a green arrow on the bottom was the best and 
safest type of left-turn signal head based on driver confirmation and field implementation 
studies.   

The FYA head is now the recommended left turn head in the Federal 2009 Manual of Uniform 
Traffic Control Devices (MUTCD). This version of the MUTCD includes language on the use of 
the flashing yellow arrow for permitted left turns that states: 

“Vehicular traffic, on an approach to an intersection, facing a flashing YELLOW ARROW signal 
indication, displayed alone or in combination with another signal indication, is permitted to cautiously 
enter the intersection only to make the movement indicated by such arrow, or other such movement 
as is permitted by other signal indications displayed at the same time. 

Such vehicular traffic, including vehicles turning right or left or making a U-turn, shall yield the right-
of-way to: 

a) Pedestrians lawfully within an associated crosswalk, and 
b) Other vehicles lawfully within the intersection. 

In addition, vehicular traffic turning left or making a U-turn to the left shall yield the right-of-way to 
other vehicles approaching from the opposite direction so closely as to constitute an immediate 
hazard during the time when such turning vehicle is moving across or within the intersection.” 

MnDOT does encourage the use of FYA whenever appropriate. Additional details on the FYA can be found 
by visiting: 

http://www.dot.state.mn.us/trafficeng/signals/flashingyellowarrow.html 

http://mutcd.fhwa.dot.gov/resources/interim_approval/ia_10_flashyellarrow.htm 

http://www.fhwa.dot.gov/publications/research/safety/09036/index.cfm 

Refer to Page 3-28 for a handout technical memo on the use of the FYA in Minnesota.  

3.7 Minnesota Flashing Yellow Arrow  

The section on “Flashing Yellow Arrow Display” in the 
previous section discusses the FYA from a national and Federal 
MUTCD perspective. The following sections discuss the use of 
the FYA within Minnesota.   

Variable vs. Fixed Phasing Operation Signal Heads 

Traditionally, the operation of the left turn signal was 
considered fixed. That is, if a protected left turn head was 
installed, then this signal would operate in protected operation 
for the entire day. It may be that a protected left is desirable 
for a specific time of day (i.e., heavy opposing flow is the 
reason for the protected operation), but this may “penalize” 
the other twenty-three hours of the day that do not require protected-only operation. One advantage to 

The discussions in this section 
“Minnesota Flashing Yellow Arrow” are 

current at the time of printing this 
publication. However, the items 
mentioned are anticipated to be 

continually changing. Please be sure to 
constently check the MnDOT website for 

updates (See 
www.dot.state.mn.us/trafficeng/). 

http://www.dot.state.mn.us/trafficeng/signals/flashingyellowarrow.html
http://mutcd.fhwa.dot.gov/resources/interim_approval/ia_10_flashyellarrow.htm
http://www.fhwa.dot.gov/publications/research/safety/09036/index.cfm
http://www.dot.state.mn.us/trafficeng/
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the FYA signal indication is that it can change the mode of operation on a time of day (TOD) basis. In 
summary: 

 The FYA head is a “variable phasing operation” head that can operate with either protected, 
protected/permissive, or permissive phasing operation by time-of-day settings.   

 Standard 3-section protected and 3-section permissive heads are “fixed phasing operation” heads 
that can only operate in one phasing operation 24 hours a day. 

 Given that the FYA head can operate protected 24 hours a day, if desired, the standard 3-section 
protected head will soon become obsolete as there is no reason to install a 3-section protected head 
and not have the ability to change the phasing operation in the future.  

 Standard 5-section heads are “flexible phasing operation” heads, but only with either 
protected/permissive or permissive operation by time-of-day settings.  

TEM Information on Flashing Yellow Arrows 

The information on the following page is a handout from the Traffic Engineering Manual (TEM) regarding 
the use of the FYA.  
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June 2015                                           Traffic Engineering Manual                                                                Chapter 9

9-8 

use a non-intrusive means of vehicle detection, such as microwave or video detection.  In all other ways, a 

Temporary signals are meant to be in place for only a short time, from a few months up to a few years. Most 

information to the driver. This information or message is portrayed by selective illumination of one or more 
colored indications.

A signal indication is made up of a Light-Emitting Diode (LED) array, and housing with a visor. Signal indications 
are 12 inches in diameter, are red, yellow, or green, and can be circular or arrows.  They can be found on the 
MnDOT approved products list

indications and heads are covered in more detail in the MN MUTCD, Part 4. LED signal indication modules 

warrants replacement.

MN MUTCD provides more detail regarding the design 
and application of countdown pedestrian signals.

Vehicle and pedestrian signal heads are attached to poles and pedestals by mounting assemblies that support 
the signal heads and serve as a wire way for the electrical conductors. There are two primary mounting 

MnDOT approved products list for signals. There are 
MnDOT Standard Plates 

8110 and 8111.

1. 
Geometric Design of Highways and Streets”).
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9-9 

2. 
option.

3. If it has been determined that the signal will always operate protected-only, based on engineering 

and controller.

designer to be aware of, this information shall be provided by the signal designer on the signal plan.

protected-only phasing had been the only operational option.

Additional guidelines for the operation can be found in the 
Manual MnDOT Signal Design Manual. 

steel for structural strength and for protecting the wiring to the signal heads.

Mast Arm

Typical PA Pole and Mast Arm
The typical PA pole and mast arm, shown on Standard Plate
tapered octagonal shaft positioned on a cubical transformer base. A mast arm is attached near the top of 

Typical BA Pole and Mast Arm
Standard Plates 8133 and 8134, consists of a tapered round 

shaft positioned on a cubical transformer base. A mast arm is attached near the top of the shaft, which is 

Signal Pedestals

practical. Signal pedestals are shorter, do not have mast arms, and are not used for overhead signal 

Standard Plate 8122.
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Flashing Yellow Arrow Technical Memorandum 

The information on the following page is a handout from Technical Memorandum No. 12-10-T-03.  The 
purpose of the technical memorandum is to require the installation of the flashing yellow arrow (FYA) left 
turn indication on all new traffic signal dedicated left turn lane approaches on the State trunk highway 
system unless the left turner has limited intersection sight distance (as defined in Chapter 9, Table 9–14 of 
the 2011 AASHTO “A Policy on Geometric Design of Highways and Streets”), or conflicting (i.e. overlapping) 
left turn paths are present. 
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MINNESOTA DEPARTMENT OF TRANSPORTATION 

Engineering Services Division 
Technical Memorandum No. 12-10-T-03 

November 28, 2012 
 

 
 
To: Electronic Distribution Recipients 
 
From: Jon M. Chiglo, P.E. 
 Division Director, Engineering Services 
 
Subject:   Flashing Yellow Arrow Traffic Signal Indication on MnDOT Trunk Highways 
 
 
Expiration 
This is a new Technical Memorandum and will remain in effect until November 28, 2017 unless it is 
superseded by a new Technical Memorandum or included in the MnDOT Traffic Engineering Manual.  
 
Implementation 
This policy shall be effective immediately. 
 
Introduction 
The purpose of this technical memorandum is to require the installation of the flashing yellow arrow (FYA) 
left turn indication on all new traffic signal dedicated left turn lane approaches on the State trunk highway 
system unless the left turner has limited intersection sight distance (as defined in Chapter 9, Table 9–14 
of the 2011 AASHTO “A Policy on Geometric Design of Highways and Streets”), or conflicting (i.e. 
overlapping) left turn paths are present. 
 
The National Cooperative Highway Research Program (NCHRP) Report 493 has shown the flashing 
yellow arrow indication is more understandable and operationally more efficient than traditional 
protected/permissive left turn indications such as a 5-section indication.  MnDOT’s experience since the 
first such installation in 2006 confirms the study results. It has also proved to be significantly more 
operationally efficient than the protected-only left turn indication.  The 2011 Minnesota Manual on Uniform 
Traffic Control Devices (MnMUTCD), Section 4D.20, explains the definition, placement and operation of 
the flashing yellow arrow indication.  The 2011 MnMUTCD has also changed the head placement for a 
green ball, which is no longer allowed over the center of a dedicated left turn lane. 
 
The traditional Protected Permissive Left Turn (PPLT) Guidelines are still provided in the 2012 Signal 
Design Manual for agencies that have not adopted the FYA.  When operated properly by time of day, the 
flashing yellow arrow can be used in many situations where protected-only phasing had been the only 
operational option. If conflicting left turn paths are present, the signal must be operated in a split-phase 
operation, and it should be noted on the plan to be sure the signal operator is aware of the conflicting 
lanes.  Documented sight distance issues should also be noted on the plans. 
 
Purpose 
To provide additional safety and operational efficiency at traffic signals using a flashing yellow left turn 
arrow. 
 
Guidelines 

Policy 
This policy refers to all signals on the trunk highway system. This includes both mainline and 
cross-street dedicated left turn lanes. A 4-section head using a red arrow, yellow arrow, flashing 
yellow arrow and green arrow shall be used. Any agency doing work on the trunk highway system 
shall install the flashing yellow arrow for dedicated left turn lanes on all signal designs for new 
and reconstructed signal installation with the following exceptions.  

  

Page | 3-29



  MnDOT Traffic Signal Timing and Coordination Manual 
 

June 2015  Local Intersection Concepts 

 

 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

 

• If a sight distance deficiency is documented per definition above, the flashing yellow 
arrow should not be installed.   

• The flashing yellow arrow should not be installed when there are conflicting left turn 
paths.   

• If it has been determined that the signal will run protected only based on engineering 
judgment related to multiple turn lanes, high volumes and high speeds (all three 
present), a traditional protected-only 3-section red, yellow, green arrow indication may 
be used in place of the flashing yellow arrow.  If a flashing yellow arrow is not installed 
based on the above criteria, the system shall be designed to easily accommodate a 
change to a flashing yellow arrow in the future, including length of mast arm, wiring, 
cabinet and controller.   

 
If the flashing yellow arrow is not installed at a location because it has conflicting left turn lanes 
or, a sight distance deficiency, or if there is other information that is important for the signal 
operator or future signal designer to be aware of, this information shall be provided by the 
signal designer on the signal plan. Additionally, if conflicting left turns are present, the signal 
must be operated split phase 24 hours a day or with conflicting left turns as “no serve phases”.  
If multiple turn lanes and high volumes exist and the posted speed is such that the signal will 
only be operated in a protected-only phase 24 hours a day, the installation of a protected-only 
3-section signal head will be allowed.  However, the flashing yellow arrow may still be installed 
under these conditions and operated in a permissive mode when conditions allow.  
 
Consideration can be given to left turn lanes that have a shared use such as a shared left/thru 
lane or split-phase operation. This Technical Memorandum does not require the use of a 
flashing yellow arrow with a shared-use left turn lane or split-phase operations. 
 
Consideration can also be given to existing signal revisions. Costs can be high for retrofitting 
the flashing yellow arrow into an existing signal; therefore signal revisions do not fall under this 
Technical Memorandum. Consideration may be given if signal design and operational 
components support the use of the flashing yellow arrow.  
 
With the flashing yellow arrow indication, left turn operations can vary between protected, 
protected/permissive and permissive operations by time-of-day programming in the signal 
controller. It should be noted that, with the flashing yellow arrow, the operator must pay 
particular attention to how the signal is operated by time of day to achieve the highest level of 
efficiency and safety. Additional guidelines for the operation can be found in the 2011 MnDOT 
Traffic Signal Timing and Coordination Manual, page 3-24.  

 
Scope 
The policy contained in this technical memorandum applies to MnDOT roadways.  

 
Questions 
For information on the technical contents of this memorandum, please contact Sue Zarling, Traffic 
Electrical Systems Engineer at (651) 234-7052 or Jerry Kotzenmacher, Signal Specialist at (651) 234-
7054. 
 
Any questions regarding publication of this Technical Memorandum should be referred to the Design 
Standards Unit, DesignStandards.DOT@state.mn.us.  A link to all active and historical Technical 
Memoranda can be found at http://techmemos.dot.state.mn.us/techmemo.aspx. 
 
To add, remove, or change your name on the Technical Memoranda mailing list, please visit the web 
page http://techmemos.dot.state.mn.us/subscribe.aspx 
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3.8 Left Turn Trapping 

As noted earlier, the combination of a permitted left turns with lead-lag creates a situation commonly called 
the “left-turn trap” (when no FYA is used).  

Consider Exhibit 3-12 for an eastbound leading left scenario. There is no real problem with the westbound 
situation here; these left turners are presented in stage 2 with a green ball after a period of obvious opposing 
flow. It is clear they must yield to the eastbound through traffic. In stage 3 this movement is protected and, 
again three is no problem. The transition is given by green ball direct to green arrow, but even if a yellow 
ball was displayed at the end of stage 2, there is no problem.  

The problem is with the eastbound left turns. If this scenario is allowed, any left turner who had not been 
able to find a gap during the stage 2 green would be presented with a yellow indication at its end. Since 
these drivers see a yellow indication on all facing displays (through and left), they may incorrectly presume 
that the westbound through is likewise receiving a yellow indication and is about to stop. When the signal 
turns red (eastbound) the turner will:  1) at best be stuck (now illegally), in the middle of the intersection 
with nowhere to go, or 2) at worst commit the left turn thinking the opposition is stopping creating a serious 
safety issue. 

Refer to page 3-33 for information on how the flashing yellow arrow can eliminate the left turn trap 
condition.  
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Exhibit 3-12 Lead/Lag Left Turn Trap 

 

 

Stage 1: Phase 5 eastbound (EBL) shows a 
protected left turn arrow while phase 2 
eastbound shows a green ball. The opposing 
WB movements are stopped.  

No issues during this stage; the left turn 
vehicles have a protected movement. 

 

 

Stage 2: The EBL and WBL now operate as 
permitted lefts (sees a green ball indication). 
During this stage, the EBL may creep into the 
middle of the intersection looking for gaps in 
the opposing traffic. Note that the EBL is 
actually operating as Phase 2 permitted. 

At the end of this stage is when the problem 
occurs. Phase 2 indications will change to 
yellow. The EBL vehicle now has to consider 
how to clear the intersection and may falsely 
assume the opposing through is seeing a 
yellow indication and is about to stop. In 
fact, the WBT remains green since phase 1 
WBL is up next.  

 

 

Stage 3: Now, phase 1 WBL shows a green 
arrow (protected) operation while phase 6 
WBT remains green. The EBL may have 
assumed the WBT was stopping and 
attempts to sneak through the intersections 
creating a crash situation.  

 5

 2

 2

 2

 6

 6

Vehicle Creeps into Middle 
of Intersection Looking for 

Gaps

At this point, phase 2 changes to yellow while phase 6 remains 
green. The EBL is now seeing a yellow signal indication. 

 6

 1

Vehicle is now in middle of 
intersection looking at a 

red signal indication
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Flashing Yellow Arrow and the Left Turn Trap 

Exhibit 3-12 illustrates a left turn trap with traditional lead/lag phasing (i.e., a green ball indication is used 
for the permitted left turns). Using a FYA indication can eliminate the trap condition illustrated in this exhibit.  

Once again, consider the EBL vehicle. During stage 1, the EBL receives a green arrow and proceeds under the 
protected movement. During stage 2, the EBL shows the flashing yellow arrow indication and the movement 
operates as a permissive movement.  In stage 3, the EBL remains a flashing yellow arrow indication instead 
of turning red. The EBL FYA actually operates as an overlap to phase 6. Therefore, the EBL and opposing WBT 
terminate at the same time as expected by the driver. 

Exhibit 3-13 illustrates the signal operation of the FYA even under the “soft-trap” condition and how this 
can be eliminated.   
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Exhibit 3-13 FYA to Eliminate Left Turn Trap 

 

 

Stage 1: During this stage, normal 
leading protected and opposing left turn 
phases operate. This is the typical 
operation even with a traditional 5-
section signal indication.  

At the end of this stage, phase 1 clears 
the intersection with a solid yellow 
arrow. 

  

 

 

Stage 2: During this stage phase 2 begins 
green as phase 5 continues green in 
normal operation. The opposing left 
turn is operated as a FYA. In a traditional 
5-section operation, the opposing left 
turn would be red.   

 

 

Stage 3: In this stage, phase 2 and 6 
throughs receive a green ball indication. 
The opposing lefts are operated as an 
FYA overlap with the opposing through. 
This will ensure that the left turn clears 
(turns yellow) and then red with the 
opposing through, thus eliminating the 
left turn trap. 

  

 5

 2

 6
The EBL is operated as 

an overlap with the 
opposing phase 6

 6

 1

EBL now shows a FYA 
(permitted) operation and 

EBT sees a Red 

 6

 1

 5

 2 The WBL is operated as 
an overlap with  
opposing phase 2

 2

 2

 6

 2

 6
The EBL is operated as 

an overlap with the 
opposing phase 6

 6

 1

EBL now shows a FYA 
(permitted) operation and 

EBT sees a Red 

 6

 5

 2 The WBL is operated as 
an overlap with  
opposing phase 2

 2

 2

 6

 6
The EBL is operated as 

an overlap with the 
opposing phase 6

 6

 1

EBL now shows a FYA 
(permitted) operation and 

EBT sees a Red 

 6

 2

 2

 6
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3.9 Detection 

The section discusses the functions available for traffic signal detectors. The design and layout of detectors 
at an intersection is discussed in the Traffic Signal Design Manual. Refer to page 3-40 for information from 
the Signal Design Manual. 

Detector Labeling and Phase Assignments 

In loop detector design, detectors are labeled on the plan set according to the following rules: 

Number detectors per phase as you approach the intersection and from right to left with Number 1 usually 
a detector back from the stop line and Number 2 to the left. At the stop line, Number 3 would be in the right 
lane with Number 4 to the left as you proceed to the intersection. These numbers should be proceeded by 
a D and the controller phase number (an example D8-1, D8-2, etc.). Also, if there is more than one detector 
in the left lane, Number 1 would be the first detector as you approach the intersection and Number 2 the 
second. 

For controller functions, detectors will have a single unique number from 1 to 32. Therefore, the detector 
will have two labels; one for the plan sheet (i.e. D1-1) and one for the controller functions (i.e. Detector #1).  

Refer to the Exhibit 3-14. At this intersection there are 8 phases. Each detector is labeled with the plan sheet 
label and local detector (LD) number. For instance, the northernmost detector is for phase 4 SBT. On the 
plan set, this is indicated as D4-1. For the LD Phase Assignment this is Detector #13.  

Exhibit 3-14 Detector Labeling and Phase Assignment Diagram 

 

1 5'

D1-2, D5-2 2 5' & 35'

D4-3, D8-3 2 5' & 20'

D6-1, D6-2 1 400'

D4-2, D8-2

Designation No. of Loops Location

Loop Detector Chart

D3-2, D7-2 2 5' & 35'

D1-1, D5-1 2 20' & 50'

D4-1, D8-1 1 300'

D2-1, D2-2 1 400'

D3-1, D7-1 2 20' & 50'

D6-1, #7

D6-2, #8

D1-1, #1

D1-2, #2

D2-2, #6

D2-1, #5

D4-2, #14D5-2, #4

D5-1, #3

D3-2, #10

D8-1, #16

D8-2, #17

N

50 mph

4
5
 m

p
h

 1

 6

 2

 5


 3


 8


 4


 7

Phase Assignments
(NBL/SBL Prot + Perm)

D8-3, #18

D3-1, #9

D4-1, #13

D4-3, #15

D7-1, #11

D7-2, #12

Not to
Scale
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Assigning TS2 Type 1 Detector Numbers 

As noted above, the signal operator will label each detector with a unique number from 1 to 32. This is done 
by filling out the TS2 Type 1 Detector Phase Assignment list found at the following link: 

www.dot.state.mn.us/trafficeng/signals/signalworksheets.html  

The detector layout shown in the section above is used as an example to fill out the TS2 Type 1 Detector 
Phase Assignment in Exhibit 3-16. 

In this example, detector D4-1 and D8-1 are set at 300’ and D4-3 and D8-3 are at 20’ back from the stop bar 
(per Figure 2 of the Signal Design Manual). At 45 mph, a vehicle takes 4.23 seconds to travel 280’ (the 
distance between the detectors). However, it is not desirable to have detector D4-3 and D8-3 extend the 
phase 4.23 seconds. So, the vehicle extension can be set to 1.0 seconds. Then, detector D4-1 and D8-1 can 
have a detector extend of 3.23 seconds. This will allow the phase to extend the full 4.23 seconds between 
detectors but only 1.0 second after leaving phase D4-3 and D8-3. 

Note that the Detector Phase Assignment Chart may be necessary for multiple times of days. That is, it is 
possible to have different Vehicle Detector Plans on a time of day basis. For instance, during one time period, 
the detector could operate with a delay time, but may have no delay time at different times of day. 

Exhibit 3-15 Sample Vehicle Detector Settings (Econolite Aries) 

 

http://www.dot.state.mn.us/trafficeng/signals/signalworksheets.html
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Exhibit 3-16 TS2 Type 1 Detector Phase Assignment Chart 

 

TE# System I.D.#

Intersection:                                                         

Zone Rack 1 BIU Address 9 Initals

1 2 3 4 5 6 7 8 9 10 11 12

D1-1 1 0 x 0 0

D1-2 2 0 x 0 0

D5-1 3 0 x 0 0

D5-2 4 0 x 0 0

D2-1 5 0 x 0 0

D2-2 6 0 x 0 0

D6-1 7 0 x 0 0

D6-2 8 0 x 0 0

D3-1 9 0 x x 0 0

D3-2 10 0 x x 0 0

D7-1 11 0 x x 0 0

D7-2 12 0 x x 0 15

D4-1 13 0 x 3.23 0

D4-2 14 1 x 0 15

D4-3 15 0 x 0 0

D8-1 16 0 x 3.23 0

1 2 3 4 5 6 7 8 9 10 11 12

D8-2 17 1 x 0 15

D8-3 18 0 x 0 0

19

20

21

22

23

24

25

26

27

28

29  

30  

31

32

*Types Note:

0 = Normal

1 = extend/delay

S = system Detector assingments should be done in the following order:

1. All main line left turns

2. All main line thru lanes

3. All cross street left turns

4. All cross street thru lanes

5. All other detection (Overlaps, System Detectors)

3/20/2007

Local  Detector
Detector       

#
*Type*

TS2 Type 1  Detector Phase Assignment

Detector       

#
*Type*Local  Detector Delay

TH 1 and Main St.

Phase

Each rack is wired to support 4 additional channels of EVP or Pedestrian 

detection not shown above.

Date:

Phase
Extend Delay

Rack 2 BIU Address 10

Extend

S
A

1
S

A
2

S
A

3
S

A
4

S
A

1
S

A
2

S
A

3
S

A
4
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Common Detector Functions 

Below is a list of the common by detector functions that can be used. 

1. CALL & EXTEND  Upon actuation the detector immediately places a call on its associated phases 
at all times. The detector shall also immediately cause the controller to extend 
the green time for the actuating vehicle only during the green interval of that 
phase. The controller phase and the individual detector may be in Lock or Non-
Lock mode. 

2. DELAY CALL - 
IMMEDIATE 
EXTEND 

 When actuated during the yellow and red interval of its associated phase, the 
detector delays its output call for a pre-determined length of time during the 
extended presence actuation. After the time delay expires, the call remains 
active at the controller unit as long as the detector stays actuated. The detector 
shall also immediately cause the controller unit to extend the green time for the 
actuating vehicle only during the green interval of that phase. The controller 
phase and the individual detector may be in Lock or Non-Lock mode. 

3. EXTEND ONLY  The detector immediately registers actuation at the Controller unit only during 
the green interval for that phase thus extending the green time before the 
actuating vehicles. The controller phase and the individual detector may be in 
Lock or Non-Lock mode. 

4. SYSTEM  Any type of vehicle detector used to obtain representative traffic flow 
information. 

5. CALL ONLY  Upon actuation the detector immediately places a call on its associated phase 
only during the red interval of that phase. This call remains active as long as the 
detector is actuated. The controller phase or individual detector may be in Lock 
or Non-Lock mode. 

6. QUEUING  The detection of vehicles on one or more intersection approaches solely for the 
purpose of modifying the sequence and/or length of a phase. 

7. CALL ONLY 
DENSITY 

 Upon actuation the detector immediately places a call on its associated phase 
only during the red interval of that phase. This call is inactivated when the 
controller unit outputs a check. This allows the use of density functions on this 
phase but necessitates the use of detector memory (lock) on the controller unit. 

8. DELAY CALL 
DENSITY ONLY 

 When actuated during the red interval of its associated phase, the detector 
delays its output call for a pre-determined length of time during the extended 
actuation. This call is inactivated when the controller unit outputs a check and 
the time delay unit is not reset until after that phase has been served. This allows 
the use of density functions on this phase but necessitates the use of detector 
memory (lock). 

9. CARRY-OVER 
CALL & EXTEND 

 Upon actuation the detector immediately places a call on its associated phase at 
all times and continues to output the call for a pre-determined length of time. 
The detector shall also immediately cause the controller unit to extend the green 
time for the actuating vehicle during the green interval of that phase and shall 
continue its output for a pre-determined length of time following an actuation. 
The controller unit may be in Lock or Non-Lock mode. 
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10. DELAY CALL 
ONLY 

 When actuated during the red interval of its associated phase, the detector 
delays its output call for a pre-determined length of time during the extended 
presence actuation. After the time delay expires, the call remains active at the 
controller unit as long as the detector remains actuated. The controller phase or 
individual detector may be in Lock or Non-Lock mode. 

11. STOP BAR  Calls are accepted when the phase is not green and are held during green until 
the detector is empty, the detector is then disconnected.  Additional Stop Bar 
functions are available where a timer can allow additional time before 
disconnect. 

 

Summary of By Phase and By Detector Functions 

As detailed throughout this manual, the signal operation has a variety of functions that can be applied by 
phase and/or by detector. The functions give the operator flexibility in controller the variable green time 
(the time between the minimum green and the maximum green).  

The table below is a summary of some of the common functions available by phase and/or by detector. The 
list is not all inclusive of the functions available for each controller manufacturer.  

Exhibit 3-17 Common Functions By Phase or By Detector 

Function By Phase By Detector Definition 

Minimum Green X  Refer to page 3-12 and page 4-17 

Passage, Vehicle 
Extension, Gap 

X X Refer to page 3-12 and page 4-18 

Maximum Green X  Refer to page 3-12 and page 4-20 

Volume Density 
Control (gap 
reduction, added 
initial, computed 
initial) 

X  Refer to page 3-14 and page 4-17 

Recall X  Refer to page 3-13  

Lock Call X X Refer to page 3-15 and below 

Delay Call  X Refer to page 3-38 

Stop Bar  X Refer to page 3-38 

 

Detector Modes 

Detectors can be operated in a pulse or presence mode. In pulse Mode the detector produces a short output 
pulse when detection occurs. In presence Mode the detector output continues if any vehicle (first or last 
remaining) remains in the zone of detection.  

Detectors can also be operate with a lock or non-lock feature. The lock feature means that a vehicle call is 
held by the controller (even after the vehicle has left the detection area) until the call has been satisfied. 
This type of detection memory is usually associated with point detection such as one 6' X 6' (1.8 m X 1.8 m) 
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loop or a magnetometer. It has the advantage of minimizing detection costs, but is incapable of screening 
out false calls. 

In the non-lock mode of memory, a waiting call is dropped by the controller as soon as the vehicle leaves 
the detection area. Non-lock detection memory is associated with large areas of detection at the stop line. 
This type of operation can reduce delay by screening out false calls, but has greater installation costs due to 
the large areas of detection needed. 

Detection Design 

The information following this page is a handout taken from the Minnesota Department of Transportation 
Signal Design Manual. The most current version of the Signal Design Manual can be found at: 

www.dot.state.mn.us/trafficeng/publ/index.html 

It is recommended that you review all original reference material. 

 

 

http://www.dot.state.mn.us/trafficeng/publ/index.html
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CHAPTER 4. DETECTION 
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4.4 VEHICLE DETECTION TYPES 

The different types of vehicle detectors available include but are not limited to the following types: 

 Magnetic/Magnetometer detects moving ferrous metal objects – pulse. 
 Photo electric/Infrared detects a break in a beam of light – presence or pulse. 
 Radar/Microwave detects moving objects by sending and receiving electronic pulses – pulse. 
 Ultrasonic detects sound with a microphone – presence or pulse. 
 Inductive loop detects a change in resonant frequency by the introduction of a ferrous metal in the magnetic 

field of the detection zone. 
 Video detects a change in a video pixel range – presence or pulse. 
 Microloop detects a change by moving ferrous metal in the earth’s magnetic field – pulse. 

4.5 TYPES OF VEHICLE DETECTION 

The Figure at the right is a classification of types 
of detection for traffic actuated controllers. 

Some detectors record vehicles whether stopped 
or in motion. Others require that the vehicle be 
moving at a speed of at least 2 or 3 mph. 

1. Normal loop or magnetic detectors will 
operate in either the pulse mode or 
presence mode. The magnetic detector 
produces a short output pulse when 
detection occurs, no matter how long the 
vehicle remains in the detection area. The 
normal loop is intended to produce a 
detector output for as long as a vehicle is 
in the field of detection. 

2. An extended-call detector has a “carryover output”, meaning that it holds or stretches the call of a 
vehicle for a period of seconds that has been set on an adjustable timer incorporated into the 
controller or detector. 

3. A delayed-call detector does not issue an output until the detection zone has been occupied for a 
period of seconds that has been set on an adjustable timer incorporated into the controller or 
detector. Hybrid detector designs incorporating both delay and extension are now relatively common. 

Current industry standard traffic signal controllers extend the capabilities of the normal detector/controller 
hardware. This controller functionality employs auxiliary timers and monitors circuits. This functionality allows 
the enabling and disabling of selected detectors, control of the yield of green, and the activation of “Hold-in 
Phase” circuits in order to supplement controller timing. 

1. Examples of controller functionality are; locking memory, non-lock, delay call, extend (stretch) call, 
and stop bar. 

2. Another type of detection is the “speed analysis system”. This system is a hardware assembly 
composed of two loop detectors and auxiliary logic. The two loops are installed in the same lane a 

Detector Output Types 

Vehicle 

Detectors

Detection 

With Auxiliary 

Logic

Normal Designs

Extended-Call Stretch Detectors

Delayed-Call Detectors

Hybrid Designs with Both Delay and Extension

Pulse Mode

Presence Mode

Green Extension Systems

Speed Analysis Systems

Traffic Actuated Control Detection
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precise distance apart. A vehicle passing over the loops produces two actuations. The time interval 
between the first and the second actuation is measured to determine vehicle speed. 

4.5.1 Inductive Loop Detectors 

The most common type of vehicle detection device in use today is the inductive loop. This is a loop of wire 
imbedded in the pavement (saw cut in existing concrete or Rigid PVC loop in new concrete) carrying a small 
electrical current. When a large mass of ferrous metal passes over the loop, the magnetic field is disturbed 
and generates, or induces, a change in resonant frequency in the wire. This change in frequency is then 
recognized by the detector amplifier and signals the controller that a vehicle is present. 

4.5.2 Microwave Radar Detectors 

Development of microwave radar during World War II enabled this technology to be applied to detection of 
vehicular traffic. The principles of operation involve microwave energy being beamed on an area of roadway 
from an overhead antenna, and the vehicle's effect on the energy detected. The antennas capture a portion 
of the transmitted energy reflected toward them by objects in the field of view. By direct comparison of 
transmitted energy with reflected energy from a moving vehicle, a Doppler beat note can be detected which 
in turn can be used to operate an output device. Use of continuous wave (CW) transmission and reliance on 
the use of a Doppler signal from the return wave eliminates the need for any gating or distance measurement, 
and, thereby, provides a simple detector responsive to vehicles moving through the field. By appropriate 
processing of information in the received energy, direct measurements of vehicle presence, occupancy, and 
speed can be obtained.  

4.5.3 Video image processing 

Vehicle detection by video cameras is one of the most promising new technologies for non-intrusive large-
scale data collection and implementation of advanced traffic control and management schemes. This concept 
provides real-time vehicle detection and traffic parameter extraction from images generated by video 
cameras. Major worldwide efforts have been directed at development   of a practical device for image 
processing. Under FHWA sponsorship, a wide-area, multi-spot Video Imaging Detector System (VIDS) was 
developed at the University of Minnesota and is commercially available. 

A video image processing system typically consists of the following components: 

 Image hardware - The imaging sensor is an electronic camera (conventional TV camera or an infrared camera) 
that overlooks a section of the roadway and provides the desired image information. 

 Processor - A processor determines vehicle presence or passage from images received by the camera. It also 
provides other traffic parameters preferably in real-time. 

 Software - Advanced tracking system software performs operations, detector programming, viewing of 
vehicle detections, and roadway surveillance. 

Image processing detection systems can detect traffic in many locations (i.e., multiple spots) within the 
camera's field of view. These locations can be specified by the user in minutes using interactive graphics, and 
can be changed as often as desired. This flexible detection is achieved by placing detection lines along or 
across roadway lanes on a TV monitor displaying the traffic scene (not physically placed in the pavement). 
Each time a vehicle image crosses these lines, a detection signal (presence or passage) is generated. The result 
is similar to that produced by loop detectors. 
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VIDS are advantageous in traffic detection since: 

 They are mounted above the road rather than in the road, providing multi-lane coverage along with 
installation and servicing advantages of traffic flow maintenance and personnel safety during detector repair. 

 Placement of vehicle detection zones on the road is not limited to a particular detection configuration. The 
configuration can be controlled and adjusted manually (by an operator with a computer terminal) or 
dynamically (by software) at any time, as a function of traffic flow. 

 The shape of the detection zone can be programmed for specific applications, such as freeway incident 
detection, detection of queue lengths (that cannot easily or economically be derived by conventional devices) 
and detection of turning patterns on city arterials. 

Video detection design is not covered in this class. Work with the vendor on the proper design of video 
detection. 

4.6 MNDOT VEHICLE DETECTION PRACTICES 

4.6.1 Definition of Terms 

CALL A registration of a demand for the right-of-way by traffic at a controller unit. 

CHECK An outgoing circuit of the controller unit that indicates the existence of an unanswered 
call. 

DETECTOR A device for indicating the presence or passage of vehicles. 

ACTUATION The operative response of any type of detector. 

DETECTOR The retention of an actuation for the future utilization by the controller unit. 

NON-LOCKING A mode of actuated-controller-unit operation which does not require detector 
memory. 

Depending on the controller type, the function may or may not be used. 
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4.6.2 Loop Detector Placement Design 

1. Guaranteed Green. By detector design and functioning, all vehicles except right turn on red (RTOR) 
vehicles will be guaranteed service of a green light within a cycle. A positive call will be placed to the 
controller in advance of the stop line to give service to 100% of the vehicles that need a green. If right 
turns can be segregated from thru and right turn movements, a lock operation can be used with 
special detector functioning to guarantee a green. If right turn segregation is not possible, and a non-
lock operation must be used, ample front detection must be provided to assure all vehicles are given 
a green at variable stopping locations. 

2. Safety. Consideration must be given to winter as well as summer conditions. Advanced detection 
(passage) must be provided at all posted speeds at or above 35 mph (55 km/hr). Advanced detection 
will greatly reduce : 1. Vehicles skidding into the intersection, 2. rear end accidents, 3. right angle 
accidents, 4. delay. Detection that doesn't guarantee required greens will cause drivers to take 
chances and have accidents. 

3. Failsafe. Alternatives must be provided for when a primary detector fails so that non mainline phases 
do not have to be placed on recall. Typically an advanced (passage) detector will become the primary 
detector when a stop bar detector fails and the phase is placed in the lock mode. In other situations 
detector delay times can be removed. With left turn detectors, faulty detectors can be unspliced from 
multiple detectors. Fixed time recalls should be avoided. 

4. Maintenance. Detectors should be located in a good roadbed, if the surface is in a very poor condition 
it should be replaced. Multiple "Home Runs" (loop lead ins) should be avoided when crossing multiple 
lanes, as it will cause pavement failure and possibly crosstalk. Conduits should be installed to eliminate 
long home runs when possible. Consideration should be given to installing non-intrusive detectors to 
reduce maintenance complexity.” 

5. Operation. Detectors should provide operation that is logical to the driving public. Drivers should not 
feel that they were "cut off ", overly delayed, or have to make quick decisions. The average driver in 
the United States spends six months of his or her life waiting at traffic signals. 

4.6.3 Loop Detector Cable Lead-ins 

A typical MnDOT signal controller cabinet detector rack will have space for 32 detectors (6 - four channel 
detector cards), two EVP cards (2- two channel) and a one 4 channel or 2 two channel Pedestrian Isolator 
cards. The new cabinets will support 8 - 4 channel or 16 - 2 channel detectors. Adding EVP does not reduce 
the number of loop detector channels. 
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4.7 VEHICLE DETECTOR EXHIBITS 

The exhibits on the following pages (4-27 to 4-36) are typical detector layouts for a variety of situations. They 
are arranged as shown below. 

Exhibit Page Comments 

Exhibit 4-1  Detector Placement Chart 
– Decision Zones 

4-27 Shows the placement of a detector considering vehicle 
decision zones. 

Exhibit 4-2  Major Approach 4-28 These are developed based on the decision zones. Chart 
includes an optional mid-point detector. 

Exhibit 4-3  Minor Approach with Right 
Turn Lane (RTOR Allowed) 

4-29 Typical minor street arrangement with permissive only 
left turn movements. 

Exhibit 4-4  Minor Approach Protected 
/ Permissive Left - 1 Through Lane 

4-30 Minor street arrangement with a protected / permissive 
operation (or FYA) and 1 through lane. 

Exhibit 4-5  Minor Approach Protected 
/ Permissive Left - 2 Through Lanes 

4-31 Minor street arrangement with a protected / permissive 
operation (or FYA) and 2 through lanes. 

Exhibit 4-6  Protected Permissive and 
FYA Left Turn 

4-32 Exclusive left turn lane, 4-loop configuration used for a 
protected / permissive left (includes a FYA). 

Exhibit 4-7  Protected Left Turn - Lock 
Operation 

4-33 Exclusive left turn lane with raised median, 2-loop 
configuration used for a protected left turn using lock 
mode. 

Exhibit 4-8  Protected Left Turn - Non 
Lock Operation 

4-34 Exclusive left turn lane with raised or painted median, 4-
loop configuration  

Exhibit 4-9  Minor Approach 4-35 Minor approach with no exclusive turn lanes. This 
configuration would not be typically used for a new 
intersection. 

Exhibit 4-10  Leading Protected / 
Permissive Left Turn from a Through 
Lane 

4-36 Approach with no exclusive turn lanes and a protected / 
permissive left turn operation. This configuration would 
not be typically used for a new intersection. 

These charts are generally intended for new signals designs and may not be feasible for a rebuild/modification. 
If the design is a rebuild or modification, these charts can act as guidance, but engineering judgment should 
be applied. 
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Exhibit 4-1  Detector Placement Chart – Decision Zones 
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Exhibit 4-2  Major Approach 

    

625' (191 m)

240' (75 m)
275' (84 m)
315' (96 m)

120' (37 m)
180' (55 m)
250' (76 m)
300' (92 m)
400' (122 m)
475' (145 m)

65*

50
55
60* 550' (168 m)

30
35
40
45

1
1
1
1
1
1
1
1

6' x 6' (1.7m x 1.7m) LOOP

D2-1

SPEED (MPH) LOCATION

LOCATION = DISTANCE FROM STOP BAR TO LOOP DETECTOR
* ONLY APPLY TO DIVIDED 4-LANE ROADWAY

LOOP DETECTOR PLACEMENT

MAJOR APPROACH

OPTIONAL 2 
POINT LOOP 

THE LOOP DETECTOR FUNCTION IS CALL AND EXTEND.
NOTES:

1)

ONE LOOP FOR EACH APPROACH LANE. AN EFFORT TO EXTEND TURN LANES BEYOND DETECTOR 
LOCATIONS WILL ENHANCE OPERATIONS EFFICIENCY.

2)

4) CONTROLLER PHASE SHALL BE ON VEHICLE RECALL.

5) CONTROLLER PHASE DENSITY FUNCTION (ADDED INITIAL GREEN) SHALL BE USED.

OPTIONAL 2 POINT SPACING MAY BE USED FOR 2 LANE ROADWAY WITH SPEED LIMITS OF 45 MPH 
OR GREATER. SEE CHART FOR LOCATION OF ADDITIONAL LOOP DETECTOR.

6)

7) OPTIONAL STOP LINE DETECTION MAY BE CONSIDERED FOR SHORTENED MINIMUM GREEN TIME.

FIGURE 1

3) IF USING MID-POINT DETECTORS, ENSURE THE LEFT AND RIGHT TURN POCKETS BEGIN BEFORE 
THE MID-POINT DETECTOR.

FUNCTION

LOOP DETECTOR FUNCTIONS
1 = CALL AND EXTEND
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Exhibit 4-3  Minor Approach with Right Turn Lane (RTOR Allowed) 

  

D4-1
D4-2
D4-3
D4-4
D4-5

6' x 6' (1.7 x 1.7 m)
6' x 6' (1.7 x 1.7 m)
6' x 6' (1.7 x 1.7 m)

2-6' x 6' (1.7 x 1.7 m)
2-6' x 6' (1.7 x 1.7 m)

1
1
7
1
1

30 120' (37 m)
35 180' (55 m)
40 250' (76 m)

LOOP DETECTOR PLACEMENT
MINOR APPROACH

WITH RIGHT TURN LANE (RTOR ALLOWED)

CONTROLLER PHASE CAN OPERATE IN NON-LOCKING MODE.

NOTES:

1)

D4-5

D4-4
D4-3

D4-1

D4-2

SPEED (MPH) LOCATION

LOCATION = DISTANCE FROM STOP 
BAR TO LOOP DETECTOR

NUMBER FUNCTION

LOOP DETECTOR FUNCTIONS
1 = CALL AND EXTEND
7 = DELAY CALL - IMMEDIATE EXTEND

SIZE

FIGURE 2

DETECTOR D4-3 COULD BE LARGER (6' X 10', 6' X 12', ETC.) TO ACCOUNT FOR LARGER RIGHT 
RADIUS. 

2)
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Exhibit 4-4  Minor Approach Protected / Permissive Left - 1 Through Lane and Right Turn Lane (RTOR 
Allowed) 

  

D7-1 1
D7-2 1

D4-1 1
D4-2 7
D4-3 1

20' (6 m) & 50' (15 m)
5' (1.5 m) & 35' (11 m)

6' x 6' (1.7 x 1.7 m)
6' x 6' (1.7 x 1.7 m)
6' x 6' (1.7 x 1.7 m)

2-6' x 6' (1.7 x 1.7 m)
2-6' x 6' (1.7 x 1.7 m)

120' (37 m)
180' (55 m)
250' (76 m)

SEE LEFT
5' (1.5 m)

5' & 20' (1.5 & 6 m)
30
35
40

LOOP DETECTOR PLACEMENT
MINOR APPROACH PROTECTED/PERMISSIVE LEFT

1 THROUGH LANE & RIGHT TURN LANE (RTOR ALLOWED)

CONTROLLER PHASE CAN OPERATE IN NON-LOCKING MODE.

NOTES:

1)

D7-2

D4-3
D4-2

D4-1

SPEED (MPH) D4-1 LOCATION

LOCATION = DISTANCE FROM 
STOP BAR TO LOOP DETECTOR

NUMBER FUNCTION

LOOP DETECTOR FUNCTIONS
1 = CALL AND EXTEND
7 = DELAY CALL - IMMEDIATE EXTEND

SIZE

FIGURE 3

D7-1

LOCATION

THE LEFT TURN LOOPS WILL CROSS SWITCH WITH THE THROUGH PHASE.2)

SEE FIGURE 5 FOR ADDITIONAL NOTES ON PROTECTED/PERMISSIVE OPERATION.3)

DETECTOR D4-2 COULD BE LARGER (6' X 10', 6' X 12', ETC.) TO ACCOUNT FOR LARGER RIGHT 
RADIUS. 

4)
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Exhibit 4-5  Minor Approach Protected / Permissive Left - 2 Through Lanes and Right Turn Lane (RTOR 
Allowed) 

 

D7-2 1 2-6' x 6' (1.7 x 1.7 m) 5' (1.5 m) & 35' (11 m)

D4-4 1 2-6' x 6' (1.7 x 1.7 m) 5' & 20' (1.5 & 6 m)
D4-5 1

D4-3 7 6' x 6' (1.7 x 1.7 m) 5' (1.5 m)

D7-1 1 2-6' x 6' (1.7 x 1.7 m) 20' (6 m) & 50' (15 m)
2-6' x 6' (1.7 x 1.7 m) 5' & 20' (1.5 & 6 m)

D4-1 1 6' x 6' (1.7 x 1.7 m) SEE LEFT
D4-2 1 6' x 6' (1.7 x 1.7 m) SEE LEFT30 120' (37 m)

35 180' (55 m)
40 250' (76 m)

LOOP DETECTOR PLACEMENT
MINOR APPROACH PROTECTED/PERMISSIVE LEFT

2 THROUGH LANES & RIGHT TURN LANE (RTOR ALLOWED)

CONTROLLER PHASE CAN OPERATE IN NON-LOCKING MODE.

NOTES:

1)

D7-2

D4-4
D4-3

D4-1

SPEED (MPH) D4-1 LOCATION

LOCATION = DISTANCE FROM 
STOP BAR TO LOOP DETECTOR

NUMBER FUNCTION

LOOP DETECTOR FUNCTIONS
1 = CALL AND EXTEND
7 = DELAY CALL - IMMEDIATE EXTEND

SIZE

FIGURE 4

D7-1

LOCATION

THE LEFT TURN LOOPS WILL CROSS SWITCH WITH THE THROUGH PHASE.2)

D4-2

D4-5

SEE FIGURE 5 FOR ADDITIONAL NOTES ON PROTECTED/PERMISSIVE OPERATION.3)

DETECTOR D4-3 COULD BE LARGER (6' X 10', 6' X 12', ETC.) TO ACCOUNT FOR LARGER RIGHT 
RADIUS. 

4)
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Exhibit 4-6  Protected Permissive and FYA Left Turn – Separate Left Turn Lane 

   

2-6' x 6' (1.7 x 1.7 m) 20' (6 m) & 50' (15 m)
D4-2 2-6' x 6' (1.7 x 1.7 m) 5' (1.5 m) & 35' (11 m)

1
7

D4-1

LOOP DETECTOR PLACEMENT
PROTECTED/PERMISSIVE AND 
FLASHING YELLOW LEFT TURN

SEPARATE LEFT TURN LANE

NOTES:

1)

FIGURE 5

LOCATION = DISTANCE FROM STOP BAR TO LOOP DETECTOR

NUMBER FUNCTION

LOOP DETECTOR FUNCTIONS
1 = CALL AND EXTEND

SIZE

USE BACK UP PROTECTION TO PREVENT LEFT TURN TRAP IF THERE ARE OPPOSING LEFT TURNS.2)

DESIGN SPEED IS 25 MPH.3)

D1-2

D1-1

LOCATION

EACH NUMBERED LOOP DETECTOR SHALL HAVE A SEPARATE LEAD-IN CABLE AND SEPARATE AMPLIFIER.4)

DETECTOR CROSS SWITCHING MAY BE USED.

5) IF USING NMC LOOPS, A SINGLE LARGER LOOP CAN REPLACE THE DUALS.

6)

9' (2.7 m) - TYP. FOR PRESENCE DETECTION

CONTROLLER PHASE AND DETECTOR FUNCTION SHALL BE NON-LOCK MEMORY WITH NO RECALL.

USE THIS FIGURE IF INSTALLING A FLASHING YELLOW ARROW (FYA).7)
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Exhibit 4-7  Protected Left Turn - Lock Operation – Raised Median 

 

D1-2
1 6' x 6' (1.7 x 1.7 m)
1 6' x 6' (1.7 x 1.7 m)

D1-1
10' (3 m) 40' (12 m)

LOOP DETECTOR PLACEMENT
PROTECTED ONLY LEFT TURN
LOCK OPERATION - RAISED MEDIAN

NO DENSITY FUNCTIONS ARE USED.

NOTES:

1)

D1-1D1-2

FIGURE 6

FRONT LOOP 

LOCATION = DISTANCE FROM STOP BAR TO 
LOOP DETECTOR

BACK LOOP 
NUMBER FUNCTION

LOOP DETECTOR FUNCTIONS
1 = CALL AND EXTEND

SIZE

THE DESIGN SPEED IS 25 MPH.2)

EACH NUMBERED LOOP DETECTOR SHALL HAVE SEPARATE LEAD-IN CABLE AND SEPARATE 
AMPLIFIER.

3)

LOCKING MEMORY SHALL BE USED BY PHASE OR DETECTION FUNCTION. NO CONTROLLER 
RECALL.

4)

THIS CONFIGURATION MAY BE CONSIDERED FOR A FYA OPERATION RETRO-FIT PROJECT.5)
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Exhibit 4-8  Protected Left Turn - Non Lock Operation – Painted and Non-Raised Median 

 
 

1
1

6' x 6' (1.7 x 1.7 m)
6' x 6' (1.7 x 1.7 m)

20' (6 m) & 50' (15 m)
5' (1.5 m) & 35' (11 m)

D1-1
D1-2

LOOP DETECTOR PLACEMENT
PROTECTED LEFT TURN

NON LOCK OPERATION - PAINTED & NON-RAISED MEDIAN

NO DENSITY FUNCTIONS ARE USED.

NOTES:

2)

FIGURE 7

LOCATION = DISTANCE FROM STOP BAR TO LOOP DETECTOR

NUMBER FUNCTION

LOOP DETECTOR FUNCTIONS
1 = CALL AND EXTEND

SIZE

THE DESIGN SPEED IS 25 MPH.3)

EACH NUMBERED LOOP DETECTOR SHALL HAVE SEPARATE LEAD-IN CABLE AND SEPARATE 
AMPLIFIER.

4)

D1-2

D1-1

LOCATION

IF LOOPS ARE USED FOR COUNTING, ONE LOOP ON D1-1, THREE LOOPS ON D1-25)

USE IN LOCATIONS WHERE VEHICLES PUT IN FALSE CALLS DUE TO CROSSING OVER 
DOUBLE YELLOW LINES.

1)

IF USING NMC, MAY COMBINE DUALS AS LARGER LOOPS.6)

9' (2.7 m) - TYP. FOR PRESENCE DETECTION

THE CONTROLLER PHASE AND DETECTION FUNCTIONS SHALL BE ON NON-LOCK WITH NO RECALL.7)
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Exhibit 4-9  Minor Approach 

 

D4-3 7 OR 9 2-6' x 6' (1.7 x 1.7 m)
D4-4 1 OR 8 2-6' x 6' (1.7 x 1.7 m)

D4-1
D4-2

3 6' x 6' (1.7 x 1.7 m)
1 6' x 6' (1.7 x 1.7 m)

5' (1.5m) & 20' (6m)
5' (1.5m) & 20' (6m)
5' (1.5m) & 20' (6m)
5' (1.5m) & 20' (6m)
5' (1.5m) & 20' (6m)
5' (1.5m) & 20' (6m)

30
35
40
45
50
55

120' (37 m)
180' (55 m)
250' (76 m)
300' (92 m)
400' (122 m)
475' (145 m)

LOOP DETECTOR PLACEMENT

MINOR APPROACH

THE ADDED INITIAL DENSITY FUNCTION IS NOT NECESSARY BECAUSE OF FRONT DETECTORS. THE GAP 
REDUCTION DENSITY FUNCTION MAY BE CONSIDERED.

NOTES:

1)

9' (2.7m) - TYP. FOR PRESENCE DETECTION

D4-1

D4-2

SPEED FRONT LOOP 

LOCATION = DISTANCE FROM STOP BAR TO 
LOOP DETECTOR

NUMBER FUNCTION

LOOP DETECTOR FUNCTIONS
1 = CALL AND EXTEND
3 = EXTEND ONLY
7 = DELAY CALL - IMMEDIATE EXTEND
8 = STOP BAR
9 = STOP BAR WITH DELAY CALL

SIZE

D4-3

D4-4

BACK LOOP 

CONTROLLER PHASE AND DETECTOR FUNCTION SHALL BE NON-LOCK MEMORY WITH NO RECALL.2)

PROVIDE GOOD COVERAGE FOR FRONT DETECTION FOR VARIABLE STOPPING LOCATIONS. USE 
ANY COMBINATION OF 6' x 6' (1.7m x 1.7m) OR 6' x 10' (1.7m x 3m) LOOP DETECTORS.

3)

IF USING NMC LOOP, MAY COMBINE DUAL LOOPS.4)

ADVANCED DETECTION IS OPTIONAL.5)

FIGURE 8

USED WITH PRESENCE DETECTION.6)
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Exhibit 4-10  Leading Protected / Permissive Left Turn from a Through Lane 

 

2-6' x 6' (1.7 x 1.7 m)
6' x 6' (1.7 x 1.7 m)

D1-1 5
D1-2 3

LOOP D1-1 SHALL HAVE A 1 - 2 SECOND DELAY, 2 SECOND STRETCH (EXT.), AND IS ONLY ACTIVE 
DURING PHASE RED.

NOTES:

1)

2 - 6' x 6' (1.7 x 1.7m) OR
1- 6' X 20' (1.7 X 6m) LOOP  

D1-1

NUMBER FUNCTION

LOOP DETECTOR FUNCTIONS
3 = EXTEND ONLY
5 = DELAY CALL ONLY

SIZE

D1-2

LOOP D1-2 WILL ONLY EXTEND IT'S OWN PHASE (GREEN ARROW).2)

USE BACK UP PROTECTION TO PREVENT LEFT TURN TRAP IF THERE ARE OPPOSING LEFT TURNS.3)

CONTROLLER PHASE DENSITY FUNCTIONS SHALL NOT BE USED.4)

CONTROLLER PHASE AND DETECTOR FUNCTION SHALL BE ON NON-LOCK MEMORY.5)

FIGURE 9

LOOP DETECTOR LOCATION:
D1-1 IS LOCATED 1.5m (5') FROM STOP BAR.

D1-2 IS LOCATED OPPOSING THROUGH LANE, 
CENTERED IN THE TURNING RADIUS OF LEFT 
TURNING VEHICLES.

THE DESIGN SPEED IS 20 MPH.6)

IF NO OPPOSING LEFT TURN, NOTE 3 IS NOT NECESSARY.7)

LOOP DETECTOR PLACEMENT
LEADING PROTECTED/PERMISSIVE LEFT TURN

FROM A THROUGH LANE
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3.10 Measures of Effectiveness 

All traffic signal timing and analysis models produce at least some estimates of performance, or measures 
of effectiveness (MOEs). There are two general classes of MOEs: 1) estimates of performance measures that 
allow the analyst to evaluate the quality of the system, and 2) performance measures which in fact serve as 
the explicit objective function of the optimization. Only optimization models are concerned with the later 
type. 

The exact way each of the models derive these estimates varies, so this discussion is general. 

Degree of Saturation 

Degree of Saturation is defined as:  

 X = vC / sg 

where, 

X = degree of saturation expressed as a decimal value or multiplied by 100 to form a percentage, 

v  =  volume in vph, 

C =  cycle length in seconds, 

s  =  saturation flow in vphg, and 

g  = effective green (split time - lost time). 

You may notice that moving the cycle length to the denominator results in sg/C, which is the capacity, so the 
degree of saturation is also commonly called the volume-to-capacity (v/c) ratio. 

If the program says you have a “X” that is approaching or exceeding saturation (100%) and you know this is 
not actually occurring, several things could be wrong. Any of the four input elements may have been mis-
coded, so you will need to check and correct your input data. If the data checks out, your saturation flow 
rate is probably wrong. If you estimated it, you should now do a field study to pin it down more accurately. 
Another possibility is your lost time was too high--again do a study (see computer model calibration section). 

On the other hand, if the approach really is saturated, for evaluation purposes you will have to do some 
extra analysis. 

Another related ratio is the so-called “flow ratio (Y),” 

  Y= v / s 

where all terms have been defined. 

This is the proportion of time that must be available to satisfy the particular movement(s) represented by 
the v and s. Decisions on critical movements are generally made based on the Y values. 

You may also identify all of the critical, conflicting movements and sum their Y values. If the result exceeds 
1.0 (or even a little less, because some part of each cycle is lost time as discussed earlier), no amount of 
signal timing can solve the saturation problem at this intersection. Only more concrete or asphalt, or less 
traffic, will avoid saturation. 

Example – Degree of Saturation Calculation: Assume the following: 

Northbound through volume = 600 vph 

Cycle length = 60 seconds 
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Green Split = 35 seconds 

Lost time = 5 second 

Adjusted saturation flow = 1700 vphg 

Then, 

X = vC / sg = (600 vph)(60 sec) / (1700 vphg)(35-5 sec) 

X = 0.71 or 71% 

Delay 

All of the standard computer models have this MOE in one form or another; indeed it is often part of the 
optimization objective. You will need to review the respective user documentation to see how delay is 
calculated. 

All optimization models effectively deal in the equivalent of a single cycle. They recognize that, for particular 
conditions, traffic characteristics tend to repeat similarly for successive cycles. This is especially true in a 
coordinated system, which depends on the uniformity of repeated cycles. In most models even today, delay 
is estimated using a method introduced by Webster years ago, or variations of this model.  

In the 2000 Highway Capacity Manual (HCM), the average control delay per vehicle is estimated for each 
lane group and averaged for approaches and the intersection as a whole. The average control delay per 
vehicle for a given lane group is given by: 

d = d1PF + d2+ d3 

d1 = 0.50C [1-g/C]2/{1-[Min(1,X)](g/C)} 

d2 = 900T {(X-1) + [(X-1)2 + (8kIX/cT)]0.5} 

d3 = [1800Qb(1+u)t]/cT, or zero 

Where:  

d = average control delay, sec/veh; 

 d1 = uniform control delay, sec/veh; 

 d2 = incremental delay, sec/veh; 

 d3 = residual delay, sec/veh; 

 PF = uniform delay progression adjustment factor; 

 X = v/c ratio for lane group; 

 C = cycle length, sec; 

 c = capacity of lane group, vph; 

 g = effective green time for lane group, sec;  

 m = incremental delay calibration term representing the effect of arrival type and degree of 
platooning; 

 Qb = initial unmet demand at the start of period T, veh; 

 T = duration of analysis period, hr; 

 I  = upstream filtering/metering adjustment factor; 
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 k = incremental delay factor that is dependent on controller settings; 

 t = duration of unmet demand in T, hr; and 

 u = delay parameter 

d1 gives an estimate of delay assuming perfectly uniform arrivals and stable flow. It is based on the first term 
of Webster’s delay formulation and is widely accepted as an accurate depiction of delay for the idealized 
case of uniform arrivals. Note that values of X beyond 1.0 are not used in the computation of d1. 

d2 estimates the incremental delay due to nonuniform arrivals and temporary cycle failures (random delay) 
as well as that caused by sustained periods of oversaturation (oversaturation delay). It is sensitive to the 
degree of saturation of the lane group (X), the duration of the analysis period of interest (T), the capacity of 
the lane group (c), and the type of signal control as reflected by the control parameter (k). The formula 
assumes that there is no unmet demand causing residual queues at the start of the analysis period (T). 
Finally, the incremental delay term is valid for all values of X, including highly oversaturated lane groups. 

d3 is applied when a residual demand from a previous time period causes a residual queue to occur at the 
start of the analysis period (T), additional delay is experienced by the vehicles arriving in the period, since 
the residual queues must first clear the intersection. If this is not the case, a d3 value of zero is used. This 
procedure is also extended to analyze delay over multiple time periods, each having a duration (T) in which 
a residual demand may be carried from one time period to the next. 

It must be emphasized that every model uses a different method to calculate delay (and other MOEs for that 
matter). You cannot compare the measures from one model to another. Also, microscopic simulation models 
usually include mid-block speed perturbations as delay, while macroscopic models ignore this. Naturally, 
you should expect to see similar trends among models, but the absolute values cannot be compare across 
models, thus only compare MOEs developed by one model for different scenarios.  

Level of Service 

Level of service for signalized intersections is defined in terms of delay, which is a measure of driver 
discomfort, frustration, fuel consumption, and lost travel time. The delay experienced by a motorist is made 
up of a number of factors that relate to control, geometrics, traffic, and incidents. Total delay is the 
difference between the travel time actually experienced and the reference travel time that would result 
during ideal conditions: in the absence of traffic control, in the absence of geometric delay, in the absence 
of any incidents, and when there are no other vehicles on the road. Control delay includes initial deceleration 
delay, queue move-up time, stopped delay, and final acceleration delay. In contrast, in previous versions of 
the HCM (1994 and earlier), delay included only stopped delay. Control delay may also be referred to as 
signal delay.  

Specifically, LOS criteria for traffic signals are stated in terms of the average control delay per vehicle, 
typically for a 15-min analysis period. The criteria are given in the table below. Delay is a complex measure 
and is dependent on a number of variables, including the quality of progression, the cycle length, the green 
ratio, and the v/c ratio for the lane group in question.  
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Exhibit 3-18 Level of Service Criteria for Signalized Intersections (2000 HCM) 

Control Delay Per Vehicle (Sec) Level Of Service 

< 10.0 A 

> 10.0 and < 20.0 B 

> 20.0 and < 35.0 C 

> 35.0 and < 55.0 D 

> 55.0 and < 80.0 E 

> 80.0 F 

HCM 2010 Notes 

The Transportation Research Board (TRB) recently updated the methods in the Highway Capacity Manual. 
This is the 2010 Edition and is the fifth major revision to the HCM. This edition of the 2010 HCM incorporates 
years of new research and integrates a multimodal approach. The 2010 HCM is divided into four (4) volumes. 
The first three volumes are printed chapters and the fourth volume is electronic only.  

Of relevance to this Traffic Signal Timing and Coordination Manual are the new 2010 HCM Chapters 18 on 
Signalized intersections and Chapter 31 as a supplement to Chapter 18.  These chapters present a new delay 
method and structure changes reflecting modern actuated control. 

 The updated LOS table for the HCM 2010 methods is presented below.  

Exhibit 3-19 Level of Service Criteria for Signalized Intersections (2010 HCM) 

 Level Of Service by v/c Ratio1 

Control Delay Per Vehicle (Sec) v/c ≤ 1.0 v/c > 1.0 

< 10.0 A F 

> 10.0 and < 20.0 B F 

> 20.0 and < 35.0 C F 

> 35.0 and < 55.0 D F 

> 55.0 and < 80.0 E F 

> 80.0 F F 
1Note: For approach-based and intersection wide assessments, LOS is defined solely by control delay. 

Additional details can be found in the 2010 Highway Capacity Manual.  

Stops 

Stops have a much more significant effect on traffic performance than might intuitively be expected. This 
measure is calculated by the various models in several ways, so it is not appropriate to present a particular 
method here. Suffice it to say that stops are significantly different under normal operations, vs. saturated 
conditions. Consider the figure that follows, which is a time-space diagram of a single approach showing 
individual vehicle trajectories. 
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Exhibit 3-20 Under-saturated Vehicle Trajectories on TSD 

 

 

Under saturated Conditions 

The vehicle arriving during the red and, indeed, early in the green, clearly must stop. This is depicted by the 
flat slope of their trace lines. Those arriving when the queue is nearly dissipated, however, do not come to 
a complete stop, thus their traces never fall completely flat, but rather lie at a slope representing a reduced 
speed.  

This figure is also significant from an academic perspective. The trace of points (in mathematical terms, the 
locus) in time and space at which arriving, queuing vehicles stop (points “A”) is shown by the line “L(A) “ in 
the figure. The slope of this line is the arrival rate in vehicles per unit time. If this figure was indeed accurately 
scaled, the arrival rate could actually be quantified. Likewise, the trace (locus) of points of vehicles departing 
the queue (“B”) has a slope that represents the departure rate. Since this is the maximum departure rate, it 
is also the saturation flow rate, as defined earlier.  

Also, in mathematical sense, the area inside the triangle formed by the horizontal axis and L(A)-L(B) 
constitutes the uniform delay as defined by Webster. This points out an intuitively obvious fact:  where there 
are stops, there is delay. Some models, however, actually look at this from the opposite perspective: if a 
vehicle is delayed, it must have been stopped (e.g., TRANSYT-7F).  

A typical deterministic model for deriving the number of stops under pre-timed control is expressed as 
follows: 

 

where Ps  = percentage of vehicles stopped, which is multiplied by the volume to obtain the number of 
vehicles stopped; 

r = length of effective red for the movement, sec; 

s = saturation flow rate, vphg; 

C = cycle length, sec; and 

v = volume of the movement, vph. 

Ps =
rs

C(s-v)

L(A) 

C - Max. Back of Queue 

SLT 

TIME 

L(B) 

Max. Veh. 

D
IS

TA
N

C
E 
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Example Percentage of Vehicles Stopped  

Assume the following: 

Northbound through volume = 600 vph 

Cycle length = 60 seconds 

Green Split = 35 seconds 

Lost time = 5 second 

Adjusted saturation flow = 1700 vphg 

Then, 

g = Split - Lost time = (G + Y) - L 

r = C - g  = C – (Split - Lost Time) = 60 - 35 + 5  = 30 seconds 

Ps = rs/[C(s-v)] = (30 sec)(1700 vphg) / [(60 sec)(1700 - 600 vph)] = 0.77 or 77% 

Other deterministic models use different models for this purpose. PASSER II’s model, for example, adjusts 
for the platooning of vehicles. See their user guides for more details. 

TRANSYT-7F, being a simulation model, expressly considers the full stop vs. the partial stop. This is explained 
further in the TRANSYT-7F Users Guide.  

Saturated Conditions 

The second condition is when the approach is saturated. In reality, vehicles arriving at the back of the queue 
will normally not reach the intersection in one cycle. They advance their position in the queue, but stop 
again. NO macroscopic model deals with multiple stops and the other effects of saturation (other than a 
loose estimate of the added delay). Microscopic models (such as SimTraffic and CORSIM) deal more properly 
with this, and this is one of their main advantages. 

Queuing 

It is not surprising that stops and queuing are even more closely related than stops and delay. A vehicle 
stopped, or nearly stopped, adds to the queue length. Conceptually, the queue is the vertical “distance” 
between L(A) and L(B) in the previous figure. The maximum length of the queue actually occurs at the 
beginning of effective green. At that point the departure rate “L(B)” is greater than the arrival rate “L(A),” 
so the vertical “distance” between the dashed lines diminishes thereafter. Notice that the convergence of 
the arrival/departure traces at point C represents the point in time and space at which the queue itself has 
ended, or dissipated. Now notice where this is--at the maximum distance upstream of the stop line. 

This is referred to as the “maximum back of queue (MBQ)” and is reported in Synchro and TRANSYT. All 
other macroscopic models (e.g., SOAP, PASSER II, etc.) report the maximum queue length, if they report 
queuing at all. The MBQ is clearly more important, because it shows how far upstream the queue will extend, 
potentially spilling over into intersections, or backing out of turn bays and blocking the through lane. 

Unfortunately, TRANSYT-7F does not deal with the effect of spillover, as explained in its Users Guide. As of 
release 6, however, TRANSYT-7F does consider the excess maximum back of queue it its optimization 
process. It is important to note that if spillover actually does occur, the signal timing models do not give 
realistic results. The results of the simulations will not be reliable as long as spillover is a distinct possibility. 
In the case of TRANSYT-7F, you can, however, approximate the effect of the spillover. The special technique 
is described in its Users Guide. 
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Synchro 6 and later includes a method for queue delay. Refer to the Synchro section for further details. 

In contrast to the macroscopic models, the microscopic simulation models explicitly deal with queuing. 

Fuel Consumption 

Fuel consumption models developed for signal timing methods generally meet the following criteria: 

 The model predicts fuel consumption based on the MOEs produced by the program. 

 The model accounts for the fact that the optimization can alter the numerical relationship between 
delay and stops. 

 The model is simple and easy for researchers to calibrate. 

The MOEs used in typical fuel consumption models are the following: 

 Total travel in vehicle-miles (vehicle-kilometers)/hour. 

 Total delay in vehicle-hours/hour, 

 Total stops in vehicles/hour, and 

 Cruise speed on the approach, or link. 

Most macroscopic fuel models have been empirically calibrated by field studies where data were analyzed 
by stepwise multiple regression, resulting in the following model form: 

Fi = Ki1  TTi  + Ki2  Di  Ki3 Si 

where,  

Fi = fuel consumed on link I, in gallons (liters) per hour; 

TTi = total travel in veh-mi (veh-km) per hour; 

Di = total delay in veh-hr per hour; 

Si = total stops in vph; and 

Kij = model coefficients which are functions of cruise speed (Vi) on each link I: 

Kij = Aj1  + Aj2 Vi + Aj3 Vi2 

 where Ajk = regression coefficients. 

This is the “classic” model form used by TRANSYT-7F. The coefficients in the TRANSYT-7F fuel model have 
been calibrated to generalize the model to be representative of the distribution of sales by vehicle size; 
although, these are not always very current.  

The TRANSYT-7F fuel model is also used in Synchro and PASSER II. It is important that users of the TRANSYT-
7F fuel model understand its limitations, which are obviously common to other versions of similar models, 
albeit for somewhat different reasons: 

 The model parameters were determined from studies conducted with only one test vehicle, but the 
model coefficients were adjusted to be representative of an “average” vehicle in the fleet. The last 
update to this, however, was 1983. 

 No explicit consideration was given to factors such as traffic congestion, vehicle type mix (i.e., trucks 
and diesel engines) or geometric and environmental factors such as road gradient, curvature, surface 
quality, temperature and other factors. 

These limitations suggest that the conclusions about the absolute values of the fuel estimates be used with 
appropriate caution. On the other hand, the relative estimates from the existing signal timing plan to the 
optimized timing plan should reasonably reflect the trend that can actually be expected to occur, except 
when saturated conditions exist. 
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3.11 Critical Lane Analysis 

Introduction 

Critical lane analysis is a simple planning and operational tool intended in sizing the overall geometrics of 
the intersection or in identifying the general capacity sufficiency of an intersection. The basic procedure is 
as follows: 

 The capacity of a point where intersecting lanes of traffic must cross is equal to 1,400 vehicles per 
hour (vph). In the example shown below, if 1,000 vph is the demand on the eastbound approach, then 
the northbound volume cannot exceed 400 vph. 

 This procedure does not consider the detail of lane width, parking conditions, or other features, nor 
does it consider the number of trucks and buses in the traffic stream. 

 Critical Movement Analysis identifies critical movements by individual lanes. Thus hourly approach 
volumes must be assigned by lane. 

 Where exclusive turning lanes are present, all turns are assigned to the appropriate turning lane. 

 For shared and/or through lanes when permissive left turns are not present, volume is distributed 
equally among the available lanes. 

 

1000 vph
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0
0

 v
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h
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Lane Volume =

1000 + 400 = 

1400 vph
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Example:  Given the following intersection geometrics and hourly traffic movements: 

 

The Lane Volumes are assigned as follows: 

 

 When permissive left turns are included in shared lanes, vehicles are assigned to available through 
and shared lanes in equal numbers of through vehicle equivalents. All right turning traffic and through 
vehicles have a through vehicle equivalent (TVE) of 1.00, while permissive left turns have the following 
values: 
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Exhibit 3-21 Critical Lane TVE 

Opposing Through and Right-Turn 
Volume, Vo (vph) 

Through Vehicle Equivalent 
(TVE) 

0-100 1.0 

100-199 1.1 

200-599 2.0 

500-799 3.0 

800-999 4.0 

 1000 5.0 

 

This distribution is subject to the requirement that all left turns be assigned to the left-most shared lane. 

Example:  Given the figure below, determine the distribution of traffic on the northbound approach of the 
following intersection: 

 

First, convert the 100 left turners to through vehicle equivalents: 

 Opposing volume = 900 (850 + 50) 

 Each left turner = 4.0 TVE or 

 100 x 4.0 = 400 TVE 

Next, load up lanes equally with remaining volume plus through vehicle equivalents: 

 500 through + 100 right + 400 TVE = 1000 

 1000/2 = 500 
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Of the 500 vehicles in the inside lane, 400 are through vehicle equivalents that represent left turners. 
Therefore, the remaining 500 - 400 = 100 vehicles in the inside lane are actually through vehicles. 

Now, distribute traffic in actual traffic movements: 

 

Capacity Analysis 

The capacity analysis is carried out by identifying a critical lane volume for each signal phase, and summing 
these critical lane volumes. 

 The sum of the critical lane volumes can be compared with the values in the following table to obtain 
a general evaluation of probable traffic conditions at the intersection. 

Exhibit 3-22 Critical Lane Volume Relationship to Probable Capacity  

Sum of Critical Lane Volumes, vph Relationship to Probable 
Capacity 

0 - 1200 Under Capacity 

1201 - 1400 Near Capacity 

 1400 Over Capacity 

 Capacity will vary considerably with the cycle length, number of phases, grades, lane widths, 
presence of heavy vehicles, and numerous other factors. The values in this table represent a range 
of normally-occurring situations, including: 

a.  Cycle lengths from 30 to 120 seconds, 

b.  Percent heavy vehicles from 0% to 10%, 
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c.  Level terrain, and, 

d.  Standard lane widths from 10 ft to 12 ft. 

 For this range of conditions, critical volumes of less than 1,200 vph will virtually always be below 
the capacity of the intersection, while values greater than 1,400 vph will be more than the 
capacity of the intersection in most cases. For critical volumes between 1,200 and 1,400 vph, 
judgment is difficult, as the specific characteristics notes above will be important in determining 
whether or not capacity is exceeded. For such cases, the only possible general evaluation is that 
the volume is “near” capacity of the intersection, and could be less than or more than capacity 
depending upon prevailing conditions. 

 However, it may be noted that in general, a traffic operational scheme that produces a lower sum 
of critical lane volumes will result in better intersection operations than an alternative that 
produces a higher sum. 

 If left turns are served only on protected left turn phases, then the critical lane volume for each phase 
is simply identified as the highest lane volume that receives a green indication on that phase. 

Example:   Assume that a 4-phase signal operation with protected lefts is used for the intersection shown 
below (from previous examples): 

 

Critical lane volumes are identified and summarized as follows: 

350

1
00

3
00

3
00

6
00

6
00

1
50

350

50

450

150

450



MnDOT Traffic Signal Timing and Coordination Manual 

Page | 3-68 Local Intersection Concepts May 2017 

 

 If left turns are allowed as a permissive movement during the same phase as opposing through traffic, 
then we have to account for the conflicts between these movements. The “critical lane volume” for a 
signal phase becomes the highest total of the through single lane volume plus its opposing left. 

 For a north-south street, critical conflicts are the NB left turn movement with the SB through 
movement and the SB left turn movement with the NB through movement. The critical lane 
volume for the north-south street is the largest sum among: 

 The NB left turn volume plus the maximum single lane volume for the SB through plus 
right turn movement, or 

 The SB left turn volume plus the maximum single lane volume for the NB through plus 
right turn movement. 

Similarly, the critical lane volume for the east-west street is the greatest among: 

 The EB left turn volume plus the maximum single lane volume for the WB through plus 
right turn movement, or 
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 The WB left turn volume plus the maximum single lane volume for the EB through plus 
right turn movement. 

The total critical lane volume for the intersection is the sum of the critical lane volumes for the 
north-south and east-west street. 

Example: Once again, use the following intersection. This time, however, assume two-phase signal operation 
with permissive lefts. 

 

Critical lane volumes are identified and summarized as follows: 

 

 This critical lane volume procedure gives us an evaluation of the overall operational level of the 
intersection, but does not evaluate the need for special phasing (particularly for left turning traffic). 

 In the previous example perhaps the 100 northbound left turners that are opposed by the 
southbound 1200 through and right turning vehicles may need a separate phase. 

The maximum left turn volume that can be accommodated as a permissive movement (i.e., 
without a left turn phase) can be computed as the maximum of: 
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 CLT = (1400 - Vo) (g/C)PLT 

or: 

 CLT = 2 vehicles per signal cycle 

where: 

 CLT = capacity of the left turn permissive phase, vph, 

 Vo = the opposing through plus right turn movement, vph, and 

 (g/C)PLT = the effective green ratio for the permissive left turn phase. 

 The g/C ratio for each phase is normally assumed to be proportional to the highest approach lane 
volume for the phase when compared with approach lane volumes for the other phases. For 
simplicity, we generally do not include the opposing left turn volumes in calculating this 
proportion. For a two-phase signal, we can estimate g/C for phase 1 as: 

 

 

 

For a multiphase signal, we can estimate g/C for phase 1 as: 

 

 

where: 

(g/C)1 = the effective green ratio for phase 1, 

V1 = the highest approach lane volume moving on phase 1 

V2 + V3 + …. + VN = The highest approach lane volumes moving on each of the other phases. 

Example: Using the previous example, determine if potential left turn phases are required 

(g/C)1  = 
V1  

V1 + V2 

(g/C)1  = 
V1  

V1 + V2 + V3 + …. + VN 
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For the NB left turns, 

CLT = (1400 - Vo) (g/C)NB 

where: 

 Vo = 600 + 600 = 1200 

 (g/C)NS = 600 / (600 + 450) = 0.57 

CLT = (1400 - 1200) (0.57) = 114 > 100 NB left turners  

In addition, as a minimum left turn capacity, we can count on an average of two left turns on the clearance 
period following each permissive phase, even when opposing traffic volumes are so heavy that no left turns 
can occur on the green indication. Therefore, minimum NB left turn capacity, 

CLT = (2 x 3600 sec/hr) / (cycle length in sec.) 

If a 60 second cycle is used, CLT = (2 x 3600) / 60 = 120 left turns. 
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Summary of Critical Lane Analysis 

A summary of the critical lane method for evaluating the adequacy of a signalized intersection is as follows: 

 Assign traffic volumes to lanes. 

1. Separate turn lanes accommodate their respective turning movements. 

2. Right turns are equivalent to through movements if a separate turn lane is not provided. 

3. If separate left turn lanes are not used, lane distribution is attained through the use of through 
vehicle equivalents. 

4. If there are single lane approaches, special adjustments must be made to account for the 
impeding effect of left turning vehicles. 

 Check if two-phase signal operation is feasible or if a multi-phase operation is required to provide 
protected left turn movements. 

 Identify critical movements for each signal phase. 

 Evaluate level of intersection operation based on summation of critical movements. 
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4 LOCAL INTERSECTION TIMING 

4.1 Timing Practices 

Assuming that the traffic control signal has been designed and installed in accordance with good technical 
practices, proper timing is the final ingredient to create an efficiently operating traffic control signal. The 
objective of signal timing is to alternate the right of way between traffic streams so that average total delays 
to all vehicles and pedestrians, and that the possibility of crash-producing conflicts are minimized. 

The purpose of this manual is to establish uniform guidelines for MnDOT personnel to time traffic control 
signals. It is intended to set forth accepted practices, procedures and guidelines. It should be noted that 
there are no legal requirements for the use of these practices, procedures and guidelines. The legal 
considerations are set forth in the state law and the Minnesota Manual on Uniform Traffic Control Devices 
(MN MUTCD). 

It should also be noted that these guidelines, procedures and practices are general and should be used only 
as a general guide. Many other factors at each individual intersection must be considered and good 
engineering judgment must be utilized in applying these guidelines. Field observations and timing 
adjustments must be done to maximize the efficiency and safety of the traffic control signal operation. A 
series of timing adjustments may be necessary. 

The timing values developed through these procedures may not in all cases be directly set on all traffic 
control signal controllers. Each manufacturer may have a different way of timing each timing function. Care 
must be taken in knowing the theory of operation of each traffic control signal controller and setting values 
in the traffic signal controller. 

There are basically two types of traffic signal controllers; pre-timed (fixed timed) and traffic actuated 
(variably timed). The guidelines, procedures and practices apply more directly to traffic actuated controllers, 
because the majority of MnDOT’s controllers are the traffic actuated type. 

Traffic control signal controllers can be operated in a free (isolated) or a coordinated (system) mode of 
operation. This section of this guideline will address the free (isolated) mode of operation. 

In timing a traffic signal, a good understanding of the meaning of the signal indications is necessary. The 
meaning of signal and pedestrian indications can be found in the MN MUTCD in Section 4D. 

4.2 Full Traffic Actuated Timing Controls 

The following are basic timing parameters that are necessary for a traffic signal controller to operate. These 
guidelines, procedures and practices are based on them. MnDOT uses microprocessor controllers 
manufactured to NEMA, TS2-type2 standards. There are other functions and parameters that need to be 
installed on each particular manufacturer controllers. Each manufacturer’s traffic controller manual should 
be reviewed and understood before operating the controller in a field application. Any questions as to using 
these other functions or parameters should be directed to the Traffic Signal Engineer. 

1. WALK - Establishes the length of the WALK interval. 

2. PEDESTRIAN CLEARANCE (CHANGE) - Establishes the length of flashing DON’T WALK interval. 

3. MINIMUM GREEN - Establishes the length of initial state of green interval. 

4. ADDED INITIAL - Density feature. Establishes number of seconds by which each vehicle (actuation) 
builds added initial state of green during non-green time on phase. 
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5. PASSAGE TIME - Establishes the increment of right of way (green) time extension for each vehicle 
actuation during the green interval. 

6. TIME BEFORE REDUCTION - Density feature. Establishes a preset time before allowed gap begins to 
reduce. 

7. TIME TO REDUCE - Density feature. Establishes time in which the allowed gap is reduced from 
passage time to minimum gap, after the time before reduction has expired. 

8. MINIMUM GAP - Density feature. Establishes minimum value to which allowed gap between 
actuations on phase with green can be reduced upon expiration of time to reduce. 

9. MAXIMUM GREEN - Establishes the maximum limit to which the green interval can be extended on a 
phase in the present of a serviceable demand on a conflicting phase. 

10. YELLOW - Establishes the length of yellow interval following the green interval. 

11. RED - Establishes the length of red interval following the yellow interval. 

12. MEMORY MODES - Establishes whether the controller will remember (lock) or drop (non-lock) 
vehicle actuation. 

13. RECALL MODES - Establishes whether the controller automatically returns to and provides 
right-of-way (green) on the selected phase once each traffic signal cycle, without the need for 
vehicle demand for service. There is pedestrian, minimum vehicle and maximum vehicle recall 
modes. 

4.3 Local Free By TOD 

The above section lists some of the settings required for a local intersection controller. Some of these values 
can vary based on a time of day (TOD), day of week, week of year and special holiday program. Some of the 
parameters that can be changed include: 

 Maximum time setting (Max I, Max II, Max III) 
 Dynamic Max  
 Phase omit 
 Conditional service inhibit 
 Flash 
 Red Rest 
 Alternate vehicle extension 
 Alternate sequence 
 Vehicle recall 
 Vehicle max recall 
 Pedestrian recall 
 Additional features may exist based on the controller 

Flashing Yellow Arrow operation (permitted, protected, or protected/permitted) can also be run on a TOD 
basis. For details, refer to page 4-26. 

The Exhibit 4-1 illustrates that the local controller will use the clock and day information to choose the 
appropriate program and step. 
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Exhibit 4-1 Local Controller TOD Program Step 

 

Exhibit 4-1 does not address intersections running in a coordinated system. The intent is for an intersection 
running in free mode operation. Coordinated systems will be discussed in Chapter 5. 

4.4 Local Intersection Start-up Process 

Start-up of a local intersection is the sequence of operation following a dark or flash condition.   

Typical MnDOT operation once the intersection is powered up;  

 Flash All Red for 10 seconds 

 All Red for 6 seconds 

 then begin service on Phases 2 & 6 green 

 Normal sequence follows. 

Below is information from the MN MUTCD, section 4D.31.  

       

Local Controller 
Clock/Calendar
- Time of Day (TOD)

- Day of Week
- Week of Year
- Holiday or not

TOD Program Steps (Max I, Max2, etc.)

Step 1
Step 2

Step 3
Step 4

Step X

Select

Program 1

Program X
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4.5 Pedestrian Timing Requirements 

This section will cover the WALK and PEDESTRIAN CLEARANCE (flashing 
DON’T WALK) parameters. 

The MN MUTCD requires that pedestrians should be assured of sufficient 
time to cross the roadway at a signalized intersection. This must be shown 
with the vehicle and/or pedestrian indications. In the absence of 
pedestrian indications, the minimum green + yellow + all red time must be 
equal to pedestrian timing (walk + pedestrian clearance). 

The MN MUTCD meaning of pedestrian signal indications are summarized 
as follows: 

 WALK indication, means that pedestrians may begin to cross the 
roadway in the direction of the indication.  

 flashing DON’T WALK indication, means that a pedestrian shall not 
start to cross the roadway in the direction of the indication, but that 
any pedestrian who has partly completed their crossing shall 
continue to a sidewalk, or to a safety island.  

 steady DON’T WALK indication, means that a pedestrian shall not enter the roadway in the direction 
of the indication. 

Walk 

The MN MUTCD states, "Under normal conditions, the WALK interval should be at least 4 to 7 seconds in 
length so that pedestrians will have adequate opportunity to leave the curb before the clearance interval is 
shown."  Research indicates that queues (more than 24 people) requiring more than 7 seconds to discharge 
occur very rarely and will usually be found only in certain sections of large metropolitan areas. The minimum 
WALK interval under low volume (less than 10 pedestrians per cycle) conditions could possibly be lowered 
to 4 - 5 seconds but the importance of the inattentiveness factor should be also weighted in this decision. 

Flashing Don’t Walk 

The duration of the pedestrian clearance time should be sufficient to allow a pedestrian crossing in the 
crosswalk who left the curb or shoulder at the end of the WALKING PERSON (symbolizing WALK) signal 
indication to travel at a walking speed of 3.5 feet per second to at least the far side of the traveled way or 
to a median of sufficient width for pedestrians to wait. 

The flashing DON’T WALK interval is determined by the following formula: 

flashing DON’T WALK = D/R 

D   = Distance from the near curb or shoulder to at least the far side of the traveled way or to a 
median of greater than 6 feet. 

R   = Walking rate of 3.5 feet per second assumed walking rate unless special conditions (school kids, 
elderly or handicapped) require a slower walking rate. 

When determining the distance, consideration should be given to the pedestrian's normal walking path. 
Pedestrian timing should consider the pedestrian walking to the nearest pedestrian and/or vehicle indication 
following a marked or unmarked crosswalk.  

On median divided roadways, consideration should be given to providing sufficient time to the pedestrians 
to cross both roadways. A pedestrian's goal is to cross the total roadway and does not expect to stop at the 

Signal controllers used 
by MnDOT do not time 

the yellow vehicle 
indication concurrent 

with the flashing DON’T 
WALK. Because of this, a 

portion of the yellow 
interval may be included 

in the pedestrian 
clearance time (i.e., the 

pedestrian clearance 
time is equal to flashing 

DON’T WALK interval 
plus the yellow interval) 
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dividing median and wait till the next cycle. If the median is less than 6 feet wide the pedestrian should be 
provided sufficient time to cross both roadways as a median less than 6 feet wide is not considered a safe 
refuge island. 

Normal walking speed is assumed to be 3.5 feet per second. This is as cited in the 2009 Federal MUTCD and 
will be the walking speed used in the pending update to the MN MUTCD. In selecting a walking rate, 
consideration must be given to the type of pedestrians, volume of pedestrians, intersection location and 
geometrics and overall signal operation. 

Signal controllers used by MnDOT do not time the yellow vehicle indication concurrent with the flashing 
DON’T WALK. This is assuming minimum vehicle green time. The steady DON’T WALK is displayed at the 
onset of yellow to encourage any pedestrians still in the street to complete the crossing without delay. 
Because of this and a MN MUTCD Ruling No. IV-35, Pedestrian Clearance Interval Calculation, the yellow 
interval may be included in the pedestrian clearance time (i.e., the pedestrian clearance time is equal to 
flashing DON’T WALK interval plus the yellow interval). The flashing DON’T WALK interval could then be 
determined by the following formula: 

 flashing DON’T WALK = (D/R) - Yellow 

However, the ruling also states, "Discretion should be used in utilizing the latitude afforded by Section 4E”. 
Therefore, as a general practice, this should not be followed unless it is necessary to minimize the pedestrian 
timing. By subtracting the yellow interval, pedestrians may receive the steady DON’T WALK before they 
reach the far side of the farthest traveled lane. Engineering studies and judgment should be exercised in 
determining walking rates, distances and utilizing the yellow interval as part of the pedestrian clearance 
interval. 

Pedestrian Timing Recommended Practice 

Pertinent sections of the Federal MUTCD can be found on page 4-7.  

For single roadways, and divided roadway with median island less than 6 feet wide and pedestrian 
indications on each side, the pedestrian will be provided time to cross from the near side curb or shoulder 
to the far side of the traveled way. 

WALK = 7 seconds 

(this may be reduced to 4 seconds if it is necessary to minimize pedestrian timing considering the other 
factors) 

flashing DON'T WALK = (D/R) 

(time should not be less than WALK time and the time may be reduced by the yellow interval if it is necessary 
to minimize pedestrian timing considering other factors) 

D =  Distance from the near curb or shoulder to at least the far side of the traveled way. 

R = Walking rate of 3.5 feet per second is the assumed walking rate unless special conditions (school 
kids, elderly or handicapped) require a slower walking rate. 
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Divided Roadways 

A divided road is one with a median island over 6 feet wide and includes a pedestrian pushbutton in the 
median. If a pushbutton is not in the median, the recommended practice above must be used (i.e., the 
pedestrian clearance interval must cross them completely from near side curb to far side curb). 

Option 1 - Cross to Median Only 

(Pedestrian indications present) 

The WALK and flashing DON’T WALK should be determined as above. The crossing distance should be 
determined by using the longest distance from the curb or shoulder to the median. The pedestrian will be 
provided time to cross to the median on one cycle and time to cross the other side on the next cycle when 
the pedestrian push button is activated. 

Option 2 - Cross Completely 

In order for the pedestrian to cross the total roadway, the WALK indication must take the pedestrian past 
the median island before the flashing DON’T WALK is displayed. If the flashing DON’T WALK is displayed 
before the pedestrian reaches the median island, the pedestrian should stop at the median island and wait 
till the next WALK indication. The following special timing should allow the pedestrian to cross both 
roadways. 

This timing also provides for a pedestrian that may start to cross the first roadway at the end of WALK. This 
pedestrian is provided enough flashing DON’T WALK to reach the median island and finish the crossing on 
the next WALK indication. 

WALK = D1/R  

flashing DON’T WALK = (D2/R) 

(this time may be less than the WALK time and the time may be reduced by the yellow time if it is necessary 
to minimize the pedestrian timing considering other factors) 

Refer to Exhibit 4-2 for D1 and D2 determination.  
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Exhibit 4-2 Pedestrian Crossing Distances 

 

Example: Consider the intersection shown below. 

 

Assume a walking speed of 3.5 feet per second with no special pedestrian requirements. 

The pedestrian clearance would then be, FDW = 65 feet / 3.5 feet per second = 19 seconds 

Accessible Pedestrian Signals (APS) 

Refer to Section 4.11 on page 4-33 for information on APS. 

Pedestrian Timing (MN MUTCD) 

The following information is from the MN MUTCD. The latest information can be found by visiting the OTST 
website, www.dot.state.mn.us/trafficeng/publ/mutcd/index.html.   

  

Curb to Curb
distance = 65'

http://www.dot.state.mn.us/trafficeng/publ/mutcd/index.html
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During the yellow change interval, the UPRAISED

HAND (symbolizing DON'T WALK) signal indication may

be displayed as either a flashing indication, a steady

indication, or a flashing indication for an initial portion of

the yellow change interval and a steady indication for the

remainder of the interval.

Figure 4E-2 illustrates the pedestrian intervals and their

possible relationships with associated vehicular signal phase

intervals.

Except as provided above, the pedestrian clearance time

should be sufficient to allow a pedestrian crossing in the

crosswalk who left the curb or shoulder at the end of the

WALKING PERSON (symbolizing WALK) signal

indication to travel at a walking speed of 3.5 feet per second,

to at least the far side of the traveled way or to a median of

sufficient width for pedestrians to wait. 

A walking speed of up to 4 feet per second may be used

to evaluate the sufficiency of the pedestrian clearance time

at locations where an extended pushbutton press function

has been installed to provide slower pedestrians an

opportunity to request and receive a longer pedestrian

clearance time. Passive pedestrian detection may also be

used to automatically adjust the pedestrian clearance time

based on the pedestrian's actual walking speed or actual

clearance of the crosswalk.

The additional time provided by an extended pushbutton

press to satisfy pedestrian clearance time needs may be

added to either the walk interval or the pedestrian change

interval.

Where pedestrians who walk slower than 3.5 feet per

second, or pedestrians who use wheelchairs, routinely use

the crosswalk, a walking speed of less than 3.5 feet per

second should be considered in determining the pedestrian

clearance time.

GUIDANCE:GUIDANCE:

OPTION:OPTION:

OPTION:OPTION:

SUPPORT:SUPPORT:

GUIDANCE:GUIDANCE:

Pedestrian signal head indications should be conspicuous

and recognizable to pedestrians at all distances from the

beginning of the controlled crosswalk to a point 10 feet from

the end of the controlled crosswalk during both day and

night.

For crosswalks where the pedestrian enters the crosswalk

more than 100 feet from the pedestrian signal head

indications, the symbols should be at least 9 inches high.

If the pedestrian signal indication is so bright that it

causes excessive glare in nighttime conditions, some form of

automatic dimming should be used to reduce the brilliance

of the signal indication.

4E.5 Location and Height of

Pedestrian Signal Heads

Pedestrian signal heads shall be mounted with the bottom

of the signal housing including brackets not less than 7 feet

nor more than 10 feet above sidewalk level, and shall be

positioned and adjusted to provide maximum visibility at the

beginning of the controlled crosswalk.

If pedestrian signal heads are mounted on the same

support as vehicular signal heads, there shall be a physical

separation between them.

4E.6 Pedestrian Intervals and Signal
Phases

At intersections equipped with pedestrian signal heads,

the pedestrian signal indications shall be displayed except

when the vehicular traffic control signal is being operated in

the flashing mode. At those times, the pedestrian signal

indications shall not be displayed.

When the pedestrian signal heads associated with a

crosswalk are displaying either a steady WALKING

PERSON (symbolizing WALK) or a flashing UPRAISED

HAND (symbolizing DON'T WALK) signal indication, a

steady or a flashing red signal indication shall be shown to

any conflicting vehicular movement that is approaching the

intersection or mid-block location perpendicular or nearly

perpendicular to the crosswalk.

When pedestrian signal heads are used, a WALKING

PERSON (symbolizing WALK) signal indication shall be

displayed only when pedestrians are permitted to leave the

curb or shoulder.

STANDARD:

GUIDANCE:GUIDANCE:

STANDARD:

A pedestrian change interval consisting of a flashing

UPRAISED HAND (symbolizing DON'T WALK) signal

indication shall begin immediately following the

WALKING PERSON (symbolizing WALK) signal

indication. Following the pedestrian change interval, a

buffer interval consisting of a steady UPRAISED HAND

(symbolizing DONT WALK) signal indication shall be

displayed for at least 3 seconds prior to the release of any

conflicting vehicular movement. The sum of the time of the

pedestrian change interval and the buffer interval shall not

be less than the calculated pedestrian clearance time (see

the following paragraphs starting with the first Guidance
paragraph and ending with the second Standard
paragraph). The buffer interval shall not begin later than

the beginning of the red clearance interval, if used.

Compliance Date:  June 13, 2017
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4E-4December, 2011

Except as provided in the option below, the walk interval

should be at least 7 seconds in length so that pedestrians will

have adequate opportunity to leave the curb or shoulder

before the pedestrian clearance time begins.

If pedestrian volumes and characteristics do not require a

7-second walk interval, walk intervals as short as 4 seconds

may be used.

The walk interval is intended for pedestrians to start their

crossing. The pedestrian clearance time is intended to allow

pedestrians who started crossing during the walk interval to

complete their crossing. Longer walk intervals are often

used when the duration of the vehicular green phase

associated with the pedestrian crossing is long enough to

allow it.

SUPPORT:SUPPORT:

OPTION:OPTION:

The total of the walk interval and pedestrian clearance

time should be sufficient to allow a pedestrian crossing in

the crosswalk who left the pedestrian detector (or, if no

pedestrian detector is present, a location 6 feet from the face

of the curb or from the edge of the pavement) at the

beginning of the WALKING PERSON (symbolizing

WALK) signal indication to travel at a walking speed of 3

feet per second to the far side of the traveled way being

crossed or to the median if a two-stage pedestrian crossing

sequence is used. Any additional time that is required to

satisfy the conditions of this paragraph should be added to

the walk interval.

GUIDANCE:GUIDANCE:

Figure  4E-2.   Pedestrian Intervals

15
Walk

Interval

7 seconds
minimum **
7 seconds
minimum **

Relationship to associated vehicular phase intervals:

Yellow Change Interval = Buffer Interval

Yellow Change Interval
+ Red Clearance Interval = Buffer Interval

Part of Yellow Change Interval
+ Red Clearance Interval = Buffer Interval

Red Clearance Interval = Buffer Interval

Associated Green Interval extends
beyond end of Buffer Interval

* The countdown display is optional for Pedestrian Change Intervals of 7 seconds or less.

** The Walk Interval may be reduced under some conditions (see Section 4E.6).

*** The Buffer Interval, which shall always be provided and displayed, may be used to help
satisfied the calculated pedestrian clearance time, or may begin after the calculated
pedestrian clearance time has ended.

Pedestrian
Change Interval

Calculated pedestrian clearance time ***
(see Section 4E.6)

Buffer
Interval

3 seconds
minimum

Red

Red

Red

Red

Red

Y

Y R

R

RY

RY

Legend

G = Green Interval

R = Red Clearance Interval

Y = Yellow Change Interval
(of at least 3 seconds)

Red = Red because
conflicting traffic has
been released

G

G

G

G

G

Pedestrian
Intervals

Pedestrian
Signal
Display

Steady Flashing with countdown * Steady Steady

“Zero” point of
countdown display

Y
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4E-5 July, 2012

If a leading pedestrian interval is used, consideration

should be given to prohibiting turns across the crosswalk

during the leading pedestrian interval.

At intersections with pedestrian volumes that are so high

that drivers have difficulty finding an opportunity to turn

across the crosswalk, the duration of the green interval for a

parallel concurrent vehicular movement is sometimes inten-

tionally set to extend beyond the pedestrian clearance time

to provide turning drivers additional green time to make

their turns while the pedestrian signal head is displaying a

steady UPRAISED HAND (symbolizing DONT WALK)

signal indication after pedestrians have had time to complete

their crossings.

4E.7 Countdown Pedestrian Signals

All pedestrian signal heads used at crosswalks where the

pedestrian change interval is more than 7 seconds shall

include a pedestrian change interval countdown display in

order to inform pedestrians of the number of seconds

remaining in the pedestrian change interval.

Pedestrian signal heads used at crosswalks where the

pedestrian change interval is 7 seconds or less may include

a pedestrian change interval countdown display in order to

inform pedestrians of the number of seconds remaining in

the pedestrian change interval.

Where countdown pedestrian signals are used, the

countdown shall always be displayed simultaneously with

the flashing UPRAISED HAND (symbolizing DONT

WALK) signal indication displayed for that crosswalk.

Countdown pedestrian signals shall consist of Portland

orange numbers that are at least 6 inches in height on a black

opaque background. The countdown pedestrian signal shall

be located immediately adjacent to the associated

UPRAISED HAND (symbolizing DONT WALK)

pedestrian signal head indication (see Figure 4E-1).

The display of the number of remaining seconds shall

begin only at the beginning of the pedestrian change interval

(flashing UPRAISED HAND). After the countdown

displays zero, the display shall remain dark until the

beginning of the next countdown.

The countdown pedestrian signal shall display the

number of seconds remaining until the termination of the

pedestrian change interval (flashing UPRAISED HAND).

Countdown displays shall not be used during the walk

interval or during the red clearance interval of a concurrent

vehicular phase.

STANDARD:

OPTION:OPTION:

STANDARD:

SUPPORT:SUPPORT:

On a street with a median of sufficient width for

pedestrians to wait, a pedestrian clearance time that allows

the pedestrian to cross only from the curb or shoulder to the

median may be provided.

Where the pedestrian clearance time is sufficient only for

crossing from the curb or shoulder to a median of sufficient

width for pedestrians to wait, median-mounted pedestrian

signals (with pedestrian detectors if actuated operation is

used) shall be provided (see Sections 4E.8 and 4E.9) and

signing such as the R10-3d sign (see Section 2B.52) shall be

provided to notify pedestrians to cross only to the median to

await the next WALKING PERSON (symbolizing WALK)

signal indication.

Where median-mounted pedestrian signals and detectors

are provided, the use of accessible pedestrian signals (see

Sections 4E.09 through 4E.13) should be considered.

During the transition into preemption, the walk interval

and the pedestrian change interval may be shortened or

omitted as described in Section 4D.27.

At intersections with high pedestrian volumes and high

conflicting turning vehicle volumes, a brief leading

pedestrian interval, during which an advance WALKING

PERSON (symbolizing WALK) indication is displayed for

the crosswalk while red indications continue to be displayed

to parallel through and/or turning traffic, may be used to

reduce conflicts between pedestrians and turning vehicles.

If a leading pedestrian interval is used, the use of

accessible pedestrian signals (see Sections 4E.09 through

4E.13) should be considered.

If a leading pedestrian interval is used without accessible

features, pedestrians who are visually impaired can be

expected to begin crossing at the onset of the vehicular

movement when drivers are not expecting them to begin

crossing.

If a leading pedestrian interval is used, it should be at

least 3 seconds in duration and should be timed to allow

pedestrians to cross at least one lane of traffic or, in the case

of a large corner radius, to travel far enough for pedestrians

to establish their position ahead of the turning traffic before

the turning traffic is released.

OPTION:OPTION:

SUPPORT:SUPPORT:

STANDARD:

GUIDANCE:GUIDANCE:

OPTION:OPTION:

GUIDANCE:GUIDANCE:

GUIDANCE:GUIDANCE:
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If pedestrian pushbuttons are used, they should be capable

of easy activation and conveniently located near each end of

the crosswalks. Except as provided in the following 2

paragraphs, pedestrian pushbuttons should be located to

meet all of the following criteria:

A. Unobstructed and adjacent to a level all-weather

surface to provide access from a wheelchair;

B. Where there is an all-weather surface, a wheelchair

accessible route from the pushbutton to the ramp;

C. Between the edge of the crosswalk line (extended)

farthest from the center of the intersection and the side

of a curb ramp (if present), but not greater than 5 feet

from said crosswalk line;

D. Between 1.5 and 6 feet from the edge of the curb,

shoulder, or pavement;

E. With the face of the pushbutton parallel to the

crosswalk to be used; and

F. At a mounting height of approximately 3.5 feet, but no

more than 4 feet, above the sidewalk.

Where there are constraints that make it impractical to

place the pedestrian pushbutton adjacent to a level all-

weather surface, the surface should be as level as feasible.

Where there are constraints that make it impractical to

place the pedestrian pushbutton between 1.5 and 6 feet from

the edge of the curb, shoulder, or pavement, it should not be

farther than 10 feet from the edge of curb, shoulder, or

pavement.

Except as provided in the following Option, where two

pedestrian pushbuttons are provided on the same corner of a

signalized location, the pushbuttons should be separated by

a distance of at least 10 feet.

Where there are constraints on a particular corner that

make it impractical to provide the 10-foot separation

between the two pedestrian pushbuttons, the pushbuttons

may be placed closer together or on the same pole

Signs (see Section 2B. 52) shall be mounted adjacent to

or integral with pedestrian pushbuttons, explaining their

purpose and use.

At certain locations, a supplemental sign in a more visible

location may be used to call attention to the pedestrian

pushbutton.

The positioning of pedestrian pushbuttons and the

legends on the pedestrian pushbutton signs shall clearly

GUIDANCE:GUIDANCE:

STANDARD:

OPTION:OPTION:

STANDARD:

OPTION:OPTION:

4E-6July, 2012

If used with a pedestrian signal head that does not have a

concurrent vehicular phase, the pedestrian change interval

(flashing UPRAISED HAND) should be set to be approxi-

mately 4 seconds less than the required pedestrian clearance

time (see Section 4E.6) and an additional clearance interval

(during which a steady UPRAISED HAND is displayed)

should be provided prior to the start of the conflicting

vehicular phase. 

For crosswalks where the pedestrian enters the crosswalk

more than 100 feet from the countdown pedestrian signal

display, the numbers should be at least 9 inches in height.

Because some technology includes the countdown

pedestrian signal logic in a separate timing device that is

independent of the timing in the traffic signal controller, care

should be exercised by the engineer when timing changes

are made to pedestrian change intervals.

If the pedestrian change interval is interrupted or

shortened as a part of a transition into a preemption

sequence (see Section 4E.6), the countdown pedestrian

signal display should be discontinued and go dark

immediately upon activation of the preemption transition.

4E.8 Pedestrian Detectors

Pedestrian detectors may be pushbuttons or passive

detection devices.

Passive detection devices register the presence of a

pedestrian in a position indicative of a desire to cross,

without requiring the pedestrian to push a button. Some

passive detection devices are capable of tracking the

progress of a pedestrian as the pedestrian crosses the

roadway for the purpose of extending or shortening the

duration of certain pedestrian timing intervals.

The provisions in this Section place pedestrian

pushbuttons within easy reach of pedestrians who are

intending to cross each crosswalk and make it obvious

which pushbutton is associated with each crosswalk. These

provisions also position pushbutton poles in optimal

locations for installation of accessible pedestrian signals (see

Sections 4E.09 through 4E.13). Information regarding reach

ranges can be found in the "Americans with Disabilities Act

Accessibility Guidelines for Buildings and Facilities

(ADAAG)" (see Section 1A.11).

SUPPORT:SUPPORT:

OPTION:OPTION:

GUIDANCE:GUIDANCE:
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4E-7 December, 2011

indicate which crosswalk signal is actuated by each

pedestrian pushbutton.

If the pedestrian clearance time is sufficient only to cross

from the curb or shoulder to a median of sufficient width for

pedestrians to wait and the signals are pedestrian actuated,

an additional pedestrian detector shall be provided in the

median.

The use of additional pedestrian detectors on islands or

medians where a pedestrian might become stranded should

be considered.

If used, special purpose pushbuttons (to be operated only

by authorized persons) should include a housing capable of

being locked to prevent access by the general public and do

not need an instructional sign.

If used, a pilot light or other means of indication installed

with a pedestrian pushbutton shall not be illuminated until

actuation. Once it is actuated, the pilot light shall remain

illuminated until the pedestrian's green or WALKING

PERSON (symbolizing WALK) signal indication is

displayed.

If a pilot light is used at an accessible pedestrian signal

location (see Sections 4E.09 through 4E.13), each actuation

shall be accompanied by the speech message "wait."

At signalized locations with a demonstrated need and

subject to equipment capabilities, pedestrians with special

needs may be provided with additional crossing time by

means of an extended pushbutton press.

If additional crossing time is provided by means of an

extended pushbutton press, a PUSH BUTTON FOR 2

SECONDS FOR EXTRA CROSSING TIME (R10-32P)

plaque (see Figure 2B-26) shall be mounted adjacent to or

integral with the pedestrian pushbutton.

4E.9 Accessible Pedestrian Signals and

Detectors - General

Accessible pedestrian signals and detectors provide

information in non-visual formats (such as audible tones,

speech messages, and/or vibrating surfaces).

The primary technique that pedestrians who have visual

disabilities use to cross streets at signalized locations is to

initiate their crossing when they hear the traffic in front of

them stop and the traffic alongside them begin to move,

SUPPORT:SUPPORT:

STANDARD:

OPTION:OPTION:

STANDARD:

GUIDANCE:GUIDANCE:

which often corresponds to the onset of the green interval.

The existing environment is often not sufficient to provide

the information that pedestrians who have visual disabilities

need to cross a roadway at a signalized location.

If a particular signalized location presents difficulties for

pedestrians who have visual disabilities to cross the

roadway, an engineering study should be conducted that

considers the needs of pedestrians in general, as well as the

information needs of pedestrians with visual disabilities.

The engineering study, should consider the following

factors:

A. Potential demand for accessible pedestrian signals;

B. A request for accessible pedestrian signals;

C. Traffic volumes during times when pedestrians might

be present, including periods of low traffic volumes or

high turn-on-red volumes;

D. The complexity of traffic signal phasing (such as split

phases, protected turn phases, leading pedestrian

intervals, and exclusive pedestrian phases); and

E. The complexity of intersection geometry.

The factors that make crossing at a signalized location

difficult for pedestrians who have visual disabilities include:

increasingly quiet cars, right turn on red (which masks the

beginning of the through phase), continuous right-turn

movements, complex signal operations, traffic circles, and

wide streets. Further, low traffic volumes might make it

difficult for pedestrians who have visual disabilities to

discern signal phase changes.

Local organizations, providing support services to

pedestrians who have visual and/or hearing disabilities, can

often act as important advisors to the traffic engineer when

consideration is being given to the installation of devices to

assist such pedestrians. Additionally, orientation and

mobility specialists or similar staff also might be able to

provide a wide range of advice. The U.S. Access Board's

(www.access-board.gov) provides technical assistance for

making pedestrian signal information available to persons

with visual disabilities (see Page i for the address for the

U.S. Access Board).

When used, accessible pedestrian signals shall be used in

combination with pedestrian signal timing. The information

provided by an accessible pedestrian signal shall clearly

indicate which pedestrian crossing is served by each device.

Under stop-and-go operation, accessible pedestrian

signals shall not be limited in operation by the time of day

or day of week.

STANDARD:

SUPPORT:SUPPORT:

GUIDANCE:GUIDANCE:
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4E-8December, 2011

Accessible pedestrian signal detectors may be

pushbuttons or passive detection devices.

At locations with pretimed traffic control signals or non-

actuated approaches, pedestrian pushbuttons may be used to

activate the accessible pedestrian signals.

Accessible pedestrian signals are typically integrated into

the pedestrian detector (pushbutton), so the audible tones

and/or messages come from the pushbutton housing. They

have a pushbutton locator tone and tactile arrow, and can

include audible beaconing and other special features.

The name of the street to be crossed may also be provided

in accessible format, such as Braille or raised print.  Tactile

maps of crosswalks may also be provided.

Specifications regarding the use of Braille or raised print

for traffic control devices can be found in the "Americans

with Disabilities Act Accessibility Guidelines for Buildings

and Facilities (ADAAG)" (see Section 1A.11).

At accessible pedestrian signal locations where pedestrian

pushbuttons are used, each pushbutton shall activate both

the walk interval and the accessible pedestrian signals.

4E.10 Accessible Pedestrian Signals and

Detectors - Location

Accessible pedestrian signals that are located as close as

possible to pedestrians waiting to cross the street provide the

clearest and least ambiguous indication of which pedestrian

crossing is served by a device.

Pushbuttons for accessible pedestrian signals should be

located in accordance with the provisions of Section 4E.8

and should be located as close as possible to the crosswalk

line furthest from the center of the intersection and as close

as possible to the curb ramp. 

If two accessible pedestrian pushbuttons are placed less

than 10 feet apart or on the same pole, each accessible

pedestrian pushbutton shall be provided with the following

features (see Sections 4E.11 through 4E.13):

A. A pushbutton locator tone,

OPTION:OPTION:

STANDARD:

GUIDANCE:GUIDANCE:

SUPPORT:SUPPORT:

SUPPORT:SUPPORT:

SUPPORT:SUPPORT:

OPTION:OPTION:

STANDARD:

B. A tactile arrow,

C. A speech walk message for the WALKING PERSON

(symbolizing WALK) indication, and

D. A speech pushbutton information message.

If the pedestrian clearance time is sufficient only to cross

from the curb or shoulder to a median of sufficient width for

pedestrians to wait and accessible pedestrian detectors are

used, an additional accessible pedestrian detector shall be

provided in the median.

4E.11 Accessible Pedestrian Signals and

Detectors - Walk Indications

Technology that provides different sounds for each non-

concurrent signal phase has frequently been found to

provide ambiguous information. Research indicates that a

rapid tick tone for each crossing coming from accessible

pedestrian signal devices on separated poles located close to

each crosswalk provides unambiguous information to

pedestrians who are blind or visually impaired. Vibrotactile

indications provide information to pedestrians who are blind

and deaf and are also used by pedestrians who are blind or

who have low vision to confirm the walk signal in noisy

situations.

Accessible pedestrian signals shall have both audible and

vibrotactile walk  indications.

Vibrotactile walk indications shall be provided by a

tactile arrow on the pushbutton (see Section 4E.12) that

vibrates during the walk interval.

Accessible pedestrian signals shall have an audible walk

indication during the walk interval only.  The audible walk

indication shall be audible from the beginning of the

associate crosswalk.

The accessible walk indication shall have the same

duration as the pedestrian walk signal except when the

pedestrian signal rests in walk.

If the pedestrian signal rests in walk, the accessible walk

indication should be limited to the first 7 seconds of the walk

interval. The accessible walk indication should be recalled

by a button press during the walk interval provided that the

crossing time remaining is greater than the pedestrian

change interval.

Where two accessible pedestrian signals are separated by

a distance of at least 10 feet, the audible walk indication

shall be a percussive tone. Where two accessible pedestrian

GUIDANCE:GUIDANCE:

STANDARD:

STANDARD:

SUPPORT:SUPPORT:
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signals on one corner are not separated by a distance of at

least 10 feet, the audible walk indication shall be a speech

walk message.

Audible tone walk indications shall repeat at eight to ten

ticks per second. Audible tones used as walk indications

shall consist of multiple frequencies with a dominant

component at 880 Hz.

The volume of audible walk indications and pushbutton

locator tones (see Section 4E.12) should be set to be a

maximum of 5 dBA louder than ambient sound, except when

audible beaconing is provided in response to an extended

pushbutton press.

Automatic volume adjustment in response to ambient

traffic sound level shall be provided up to a maximum

volume of 100 dBA. 

The sound level of audible walk indications and

pushbutton locator tones should be adjusted to be low

enough to avoid misleading pedestrians who have visual dis-

abilities when the following conditions exist:

A. Where there is an island that allows unsignalized right

turns across a crosswalk between the island and the

sidewalk.

B. Where multi-leg approaches or complex signal

phasing require more than two pedestrian phases, such

that it might be unclear which crosswalk is served by

each audible tone.

C. At intersections where a diagonal pedestrian crossing

is allowed, or where one street receives a WALKING

PERSON (symbolizing WALK) signal indication

simultaneously with another street.

An alert tone, which is a very brief burst of high-

frequency sound at the beginning of the audible walk

indication that rapidly decays to the frequency of the walk

tone, may be used to alert pedestrians to the beginning of the

walk interval.

An alert tone can be particularly useful if the walk tone is

not easily audible in some traffic conditions.

Speech walk messages communicate to pedestrians which

street has the walk interval. Speech messages might be either

directly audible or transmitted, requiring a personal receiver

to hear the message. To be a useful system, the words and

SUPPORT:SUPPORT:

OPTION:OPTION:

GUIDANCE:GUIDANCE:

GUIDANCE:GUIDANCE:

STANDARD:

their meaning need to be correctly understood by all users in

the context of the street environment where they are used.

Because of this, tones are the preferred means of providing

audible walk indications except where two accessible

pedestrian signals on one corner are not separated by a

distance of at least 10 feet.

If speech walk messages are used, pedestrians have to

know the names of the streets that they are crossing in order

for the speech walk messages to be unambiguous. In getting

directions to travel to a new location, pedestrians with visual

disabilities do not always get the name of each street to be

crossed. Therefore, it is desirable to give users of accessible

pedestrian signals the name of the street controlled by the

pushbutton. This can be done by means of a speech

pushbutton information message (see Section 4E.13) during

the flashing or steady UPRAISED HAND intervals, or by

raised print and Braille labels on the pushbutton housing.

By combining the information from the pushbutton

message or Braille label, the tactile arrow aligned in the

direction of travel on the relevant crosswalk, and the speech

walk message, pedestrians with visual disabilities are able to

correctly respond to speech walk messages even if there are

two pushbuttons on the same pole.

If speech walk messages are used to communicate the

walk interval, they shall provide a clear message that the

walk interval is in effect, as well as to which crossing it

applies. Speech walk messages shall be used only at inter-

sections where it is technically infeasible to install two

accessible pedestrian signals at one corner separated by a

distance of at least 10 feet.

Speech walk messages that are used at intersections

having pedestrian phasing that is concurrent with vehicular

phasing shall be patterned after the model: "Broadway. Walk

sign is on to cross Broadway."

Speech walk messages that are used at intersections

having exclusive pedestrian phasing shall be patterned after

the model: "Walk sign is on for all crossings."

Speech walk messages shall not contain any additional

information, except they shall include designations such as

"Street" or "Avenue" where this information is necessary to

avoid ambiguity at a particular location.

Speech walk messages should not state or imply a

command to the pedestrian, such as "Cross Broadway now."

Speech walk messages should not tell pedestrians that it is

"safe to cross," because it is always the pedestrian's respon-

sibility to check actual traffic conditions.

GUIDANCE:GUIDANCE:

STANDARD:

4E-9 December, 2011
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A speech walk message is not required at times when the

walk interval is not timing, but, if provided:

A. It shall begin with the term "wait."

B. It need not be repeated for the entire time that the

walk interval is not timing.

If a pilot light (see Section 4E.8) is used at an accessible

pedestrian signal location, each actuation shall be

accompanied by the speech message "wait."

Accessible pedestrian signals that provide speech walk

messages may provide similar messages in languages other

than English, if needed, except for the terms "walk sign" and

"wait."

Following the audible walk indication, accessible

pedestrian signals shall revert to the pushbutton locator tone

(see Section 4E.12) during the pedestrian change interval.

4E.12 Accessible Pedestrian Signals and

Detectors - Tactile Arrows and

Locator Tones

To enable pedestrians who have visual disabilities to

distinguish and locate the appropriate pushbutton at an

accessible pedestrian signal location, pushbuttons shall

clearly indicate by means of tactile arrows which crosswalk

signal is actuated by each pushbutton. Tactile arrows shall be

located on the pushbutton, have high visual contrast (light

on dark or dark on light) and shall be aligned parallel to the

direction of travel on the associated crosswalk. 

An accessible pedestrian pushbutton shall incorporate

locator tone.

A pushbutton locator tone is a repeating sound that

informs approaching pedestrians that a pushbutton to actuate

pedestrian timing or receive additional information exists,

and that enables pedestrians with visual disabilities to locate

the pushbutton.

Pushbutton locator tones shall have a duration of 0.15

seconds or less and shall repeat at 1-second intervals.

Pushbutton locator tones shall be deactivated when the

traffic control signal is operating in a flashing mode.  This

requirement shall not apply to traffic control signals or

pedestrian hybrid beacons that are activated from a flashing

or dark mode to a stop-and-go mode by pedestrian

actuations.

STANDARD:

SUPPORT:SUPPORT:

STANDARD:

STANDARD:

OPTION:OPTION:

STANDARD:

Pushbutton locator tones shall be intensity responsive to

ambient sound, and be audible 1.8 to 3.7 m (6 to 12 ft) from

the pushbutton, or to the building line, whichever is less. 

Section 4E.11 contains additional provisions regarding

the volume and sound level of pushbutton locator tones.

4E.13 Accessible Pedestrian Signals and

Detectors - Extended Pushbutton

Press Features

Pedestrians may be provided with additional features

such as increased crossing time, audible beaconing, or a

speech pushbutton information message as a result of an

extended pushbutton press.

If an extended pushbutton press is used to provide any

additional feature(s), a pushbutton press of less than one

second shall actuate only the pedestrian timing and any

associated accessible walk indication, and a pushbutton

press of two seconds or more shall actuate the pedestrian

timing, any associated accessible walk indication, and any

additional feature(s).

If additional crossing time is provided by means of an

extended pushbutton press, a PUSH BUTTON FOR 2

SECONDS FOR EXTRA CROSSING TIME (R10-32P)

plaque (see Figure 2B-26) shall be mounted adjacent to or

integral with the pedestrian pushbutton.

Audible beaconing is the use of an audible signal in such

a way that pedestrians with visual disabilities can home in

on the signal that is located on the far end of the crosswalk

as they cross the street.

Not all crosswalks at an intersection need audible

beaconing; audible beaconing can actually cause confusion

if used at all crosswalks at some intersections. Audible

beaconing is not appropriate at locations with channelized

turns or split phasing, because of the possibility of

confusion.

Audible beaconing should only be considered following

an engineering study at:

A. Crosswalks longer than 70 feet, unless they are

divided by a median that has another accessible

pedestrian signal with a locator tone;

B. Crosswalks that are skewed;

C. Intersections with irregular geometry, such as more

than four legs;

GUIDANCE:GUIDANCE:

SUPPORT:SUPPORT:

SUPPORT:SUPPORT:

OPTION:OPTION:

STANDARD:

4E-10December, 2011
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D. Crosswalks where audible beaconing is requested by

an individual with visual disabilities; or

E. Other locations where a study indicates audible

beaconing would be beneficial.

Audible beaconing may be provided in several ways, any

of which are initiated by an extended pushbutton press.

If audible beaconing is used, the volume of the

pushbutton locator tone during the pedestrian change

interval of the called pedestrian phase shall be increased and

operated in one of the following ways:

A. The louder audible walk indication and louder locator

tone comes from the far end of the crosswalk, as

pedestrians cross the street,

B. The louder locator tone comes from both ends of the

crosswalk, or

C. The louder locator tone comes from an additional

speaker that is aimed at the center of the crosswalk

and that is mounted on a pedestrian signal head.

Speech pushbutton information messages may provide

intersection identification, as well as information about

unusual intersection signalization and geometry, such as

notification regarding exclusive pedestrian phasing, leading

pedestrian intervals, split phasing, diagonal crosswalks, and

medians or islands.

If speech pushbutton information messages are made

available by actuating the accessible pedestrian signal

detector, they shall only be actuated when the walk interval

is not timing. They shall begin with the term "Wait,"

followed by intersection identification information modeled

after: "Wait to cross Broadway at Grand." If information on

intersection signalization or geometry is also given, it shall

follow the intersection identification information.

Speech pushbutton information messages should not be

used to provide landmark information or to inform

pedestrians with visual disabilities about detours or

temporary traffic control situations.

Additional information on the structure and wording of

speech pushbutton information messages is included in

ITE's "Electronic Toolbox for Making Intersections More

Accessible

SUPPORT:SUPPORT:

OPTION:OPTION:

OPTION:OPTION:

STANDARD:

STANDARD:

GUIDANCE:GUIDANCE:

4E-11 December, 2011
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4.6 Initial Timing 

Minimum Initial 

The minimum initial time is the minimum assured green that is displayed. It is established to allow vehicles 
stopped between the detector on the approach and the stop line to get started and move into the 
intersection. Therefore, timing of this interval depends on the location of the detector and the number of 
vehicles that can be stored between the detector and the stop line. Consideration must be given to 
pedestrian timing, density operations, controller type and detection design when determining this setting. 
When there are no pedestrian provisions (indications or pushbuttons), the minimum assured green must be 
equal to the minimum pedestrian timing (walk + pedestrian clearance). 

Non-density operation. In non-density operation the minimum initial green must be long enough to 
guarantee that vehicles stored between the detector and the stop line will clear the intersection before the 
clearance intervals terminate the movement. If stop line extending detection is used, the minimum initial 
green time should be set as for a density operation. 

Density operation. In density operation the minimum initial green should be set low to clear a minimum of 
vehicles expected during light volume. Density operation has another timed interval that adds initial time 
per vehicle arriving on red for that approach. The initial green should not be set to low as to display an 
unexpected short green. 

Minimum Initial (Density operation)  

Major approach     =  15 seconds 

20 seconds (45 mph or above) 

Minor approach     =  7-10 seconds (consider the lower values when split phasing is used) 

Protected Left turn =  7 seconds 

Protected/Permissive = 5 seconds 

(Non-density operation) 

Minimum initial green = 3 + 2n 

n =  Number of vehicles that can be stored between the stop line and the far detector in one lane. This is 
determined by dividing the distance between the stop line and the detector by 25. 25 is the average 
vehicle length plus headway in feet. 

4.7 Density Features 

Added Initial 

Added initial is sometimes referred to as variable initial. This feature increases the minimum assured green 
time (minimum initial) so it will be long enough to serve the actual number of vehicles waiting for the green 
between the stop line and the detector. 

This interval is generally used on phases for higher speed approaches where the detectors are placed quite 
a distance from the stop line (resulting in unacceptably long minimum initial requirements). This feature 
allows the minimum initial to be set low for light volumes. Vehicles crossing the detector when the phase is 
red will add time to the minimum assured green, so that when the phase is served, the minimum assured 
green will be long enough to serve the actual number of vehicles waiting for the green. 

The values shown here are 
guidelines. Consult your 

distritct on the values to use. 
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Consideration should be given to the number of lanes and detectors, distance from the stop line to detector, 
number of right turn vehicles, approach grades, type of controller, etc. 

Field observation is very important in determining this setting. 

Most controllers used in MnDOT utilize the function settings of “Actuations Before Added Initial” and “Added 
Initial Per Actuation” to determine Added Initial. 

This is calculated by the following: 

D/25 x 2.1 + 3 

Example:  If detector is 400’ from stop line, then  

400/25 x 2.1 + 3 = 16 x 2.1 + 3 = 36.6 seconds 

Actuations Before Added Initial (Traconex) is the number of vehicles which can be adequately served by the 
time set on the minimum initial 

 One Lane Two Lanes 

15 second Minimum Initial 6 10 

20 second Minimum Initial 8 14 

 

This is determined by: (minimum initial - 3) / 2 

Two lane is 1.75 of one lane. 

Added Initial Per Actuation is the amount of time that each vehicle crossing the detector on red should add 
to the minimum assured green. 

One Lane: 2.0 seconds per actuation 

Two Lane: 1.5 seconds per actuation 

Passage Time 

This function setting is the same for non-density and density operation. This setting should be the number 
of seconds required for a vehicle moving at the approach speed to travel from the detector to the stop line. 
The passage time serves two purposes. It is the passage time from the detector to the stop line and the 
allowable time gap between actuations that will cause the green to remain on that approach. As long as 
vehicle detections come at shorter intervals than the passage time (allowable gap), the green will be retained 
on that phase. In the density operation, the allowable gap is reduce by another timing feature. 

If the passage interval is too short, quick stops may result as well as terminating the green before the 
vehicular movement has been adequately served. If the passage interval is set too long, excessive delays will 
result as well as safety problems due to improperly timed last vehicle intervals. 

Passage Time = D/1.47S (general range is 2.0 - 8.0 seconds) 

D   =  Distance from the stop line to back detector, if single point detection. Distance (greatest 
distance) between stop line and/or detectors, if multiple detection. 

S   =  Posted speed limit in mph 
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GAP REDUCTION - Density Feature 

This feature reduces the passage time and as a result reduces the allowable time gap between actuations 
that will cause the green to remain on that approach. 

When a phase is green the time between vehicles to terminate that phase starts out at amount of time set 
for the passage time (i.e., successive actuations must be closer together than the passage time to extend 
the green). After the phase has been green for some time, it becomes desirable to terminate the phase on 
smaller distances between vehicles. This is done to reduce the probability of the phase being terminated at 
the maximum time. When a phase terminates at maximum time there is no dilemma zone protection. This 
feature is generally used on phases for higher speed approaches where the detectors are placed quite a 
distance from the stop line (resulting in long passage timing). 

Most controller used by MnDOT utilize the time setting of “Time Before Reduction”, “Time To Reduce” and 
“Minimum Gap” 

Time Before Reduction establishes the time before the passage time (allowable gap) begins to reduce. 

Time To Reduce establishes the time in which the allowable gap is reduced from the passage time to the 
minimum gap, after the time before reduction has expired. 

Minimum Gap establishes the minimum value to which the allowable gap between actuations can be 
reduced to upon expiration of the time to reduce. 

Generally the minimum gap should not be set lower than 2 seconds. This is the average headway between 
vehicles and is approximately the time it takes a vehicle to travel from the detector through the dilemma 
zone. The amount of time into the green to reduce to the minimum gap should be set at about 2/3 of the 
maximum time. The allowable gap will gradually reduce in that time frame. Therefore, the last 1/3 of the 
maximum green would be extended only by tightly spaced vehicles. 

Time Before Reduction 

This should be set for 1/3 maximum time. 

Time To Reduce 

This should be set for 1/3 maximum time. 

Minimum Gap 

Minimum Gap = Passage time minus the time in seconds between the stop line and the end of the 
dilemma zone (MnDOT uses 2.0) 

Note:  Gap reduction is normally not used when stop bar detectors exist. Gap reduction with stop bar 
detectors require special detector functions and timings. 

During moderate flow conditions a well-timed actuated signal should terminate due to gap-out rather than 
due to max-out. The goal of good green timing should be to terminate the green indication on gap out and 
to max out only under heavy traffic conditions (tightly spaced vehicles). 

Detector Extend 

The sections above discuss per phase controller settings. That is, the setting in the controller applies to the 
given movement/phase. There are also additional functions that allow this to be extended with the 
detectors. Some users will use a “per phase” extension and an additional extension “by detector”. 

Refer to the following image. In this example, the passage time is set to 2 seconds. This 2 seconds may be 
adequate to get a vehicle from Detector 1 through or to the intersection. However, the 2 seconds of time 
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may not be enough to get a vehicle from Detector 2 to Detector 1. Instead of increasing the Passage Time, 
which would be used by both detectors, a special extension of X seconds could be added to Detector 2. 

Exhibit 4-3 Detector Extend Example 

 

4.8 Maximum Green 

Careful capacity analysis must be made to control peak hour cycle lengths and phase green times. The critical 
movement analysis (CMA) procedures will be used to establish these maximum green time settings. 

Most controllers used by MnDOT can have two or more maximum green times programmed. The second 
maximum time can be put into effect by the controller time clock. 

Outlined below is the basic procedure to determine maximum green time per phase. An analysis should be 
done for both AM and PM peak hours or other peak time. 

 From the AM and PM peak hour turning movement counts, take the 15 minute peak and multiply it 
by 4 to get the adjusted peak hour volume. If only hourly volumes are available divide the hourly 
volume by the peak hour factor. If a peak hour factor is not available use a 0.9 factor. 

 Select the critical phase volume and sum them for a total intersection critical phase volume. All phase 
volumes should be per lane volumes. 

 Use this volume to select the first approximation for cycle length from the tables on the following 
page. 

 Once the cycle length has been determined, determine cycles per hour which is equal to 3600/cycle 
length. 

 Calculate the number of vehicles that are required to handle per cycle per phase. No. of vehicles = 
volume/cycles per hour 

 Apply 3 + 2.1n formula to get the required phase green time to handle vehicles. n - number of vehicles 
arrived at in step 5. The 3 factor is the start up delay (2.5 seconds is recommended by ITE) and the 2.1 
is for a 2.1 second headway per vehicle. 

 Take the calculated phase green time and multiple by 1.5 and round to the nearest 5 seconds. This 
factor is applied because these calculation apply basically to fixed time controllers and this factor 
increases the time to allow for fluctuations in vehicle demand that an actuated controller is designed 
to handle. This should allow the phase to terminate on a gap in traffic at 2/3 of maximum time as 
discussed earlier rather than maxing out. 

 Review these phase green times and adjust for intersection characteristics and how intersection 
should operate to arrive at the maximum green timing per phase. If green time demand is more than 
a 180 second cycle length, cycle length and phase green times should be reduced proportionately. 

During moderate flow conditions a well-timed actuated signal will seldom terminate the green because the 
maximum green has timed out, it should terminate on gap out. 

Stop 

Bar

Detector 1Detector 2

Phase 2 with 

2 sec of 

Passage 

Time
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Optional check on cycle length: 

The cycle length should also be compared to the Webster equation for calculation of cycle length. This 
equation for optimum cycle length that minimizes delay is as follows: 

C = (1.5L + 5) / (1.0 - Y) 

NOTE: 

C = optimum cycle length, seconds  

L  = unusable time per cycle, seconds = nl + R  

n  = number of phases  

l   = average lost time per phase, seconds 

R = Total all-red time per cycle, seconds = assumed to be the yellow and all-red  

Y = sum of critical approach volume/saturation flow in each phase, assume saturation flow rate as 
1600 vehicles per hour 

The calculated cycle should fall within range of .75C and 1.5C as determined by the Webster formula. It has 
been determined that cycle lengths within this range do not significantly affect delay. 

Consideration should be given to utilizing software in determining maximum green times.  

Approximation for Cycle Length 

Typical Maximum Green Interval 

Left turn phase    10 - 45 seconds 

Minor approach phase    20 - 75 seconds 

Density operation   30 - 75 seconds 

Major approach phase    30 - 120 seconds 

Density operation under 45 mph 45 - 120 seconds 

 45 mph and over   60 - 120 seconds 

Typical Minimum Cycle Length 

2 phase signal     45 seconds 

5 phase signal     60 seconds 

8 phase signal     75 seconds 

Typical Maximum Cycle Length = 180 seconds 
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SUM OF CRITICAL VOLUME 2 PHASE 5 PHASE 8 PHASE 

700 

800 

900 

1000 

1100 

1200 

1300 

1400 

1500 

1600 

1700 

1800 

45 

60 

60 

75 

75 

90 

105 

120 

135 

150 

165 

180 

60 

75 

75 

90 

90 

105 

120 

135 

150 

165 

180 

180 

90 

105 

105 

105 

105 

120 

135 

150 

165 

180 

180 

180 

 

4.9 Phase Change Interval 

The MN MUTCD states that the exclusive function of the steady yellow interval shall be to warn traffic of an 
impending change of right-of-way assignment. The yellow vehicle change interval should have a range of 
approximately 3 to 6 seconds. Generally the longer intervals are appropriate to higher approach speeds. The 
yellow vehicle change interval should be followed by a short all-way red clearance interval, of sufficient 
duration to permit the intersection to clear before cross traffic is released. 

Minnesota Traffic Laws state that vehicular traffic facing a yellow indication is warned that the related green 
movement is being terminated or that the red indication will be exhibited immediately thereafter when 
vehicular traffic shall not enter the intersection. Therefore, the yellow and all-red intervals advise that the 
green interval is about to end and either;  

 permits the vehicle to come to a safe stop at the stop line, or 

 allows vehicles that are to near the intersection to stop or safely clear the intersection. 

Yellow Timing 

The following formulas may be used to determine the yellow time. This is based on the Institute of 
Transportation Engineers equation for yellow clearance interval. 

     Y = t  +    1.467 v                          

     2(a + 32.2g)                                  

     English                               

Y = Yellow Interval in seconds 

t = perception-reaction time, assumed to be 1 second 

v = posted speed, miles per hour  

a =  deceleration rate, assumed to be 10 feet/sec2 

g = + or - grade of approach in percent/100 
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Exhibit 4-4 Yellow Timing Values 

 
Posted 
Speed 

 
Percent Grade 

 

 
MnDOT 

 
 

+3 
 

+2 
 

+1 
 

Level 
 

-1 
 

-2 
 

-3 
 
 

 
25 

 
2.7 

 
2.7 

 
2.8 

 
2.8 

 
2.9 

 
3.0 

 
3.0 

 
3.0 

 
30 

 
3.0 

 
3.1 

 
3.1 

 
3.2 

 
3.3 

 
3.4 

 
3.4 

 
3.5 

 
35 

 
3.3 

 
3.4 

 
3.5 

 
3.6 

 
3.7 

 
3.7 

 
3.8 

 
4.0 

 
40 

 
3.7 

 
3.8 

 
3.8 

 
3.9 

 
4.0 

 
4.1 

 
4.3 

 
4.0 

 
45 

 
4.0 

 
4.1 

 
4.2 

 
4.3 

 
4.4 

 
4.5 

 
4.7 

 
4.5 

 
50 

 
4.4 

 
4.5 

 
4.6 

 
4.7 

 
4.8 

 
4.9 

 
5.1 

 
5.0 

 
55 

 
4.7 

 
4.8 

 
4.8 

 
5.0 

 
5.2 

 
5.3 

 
5.5 

 
5.5 

 
60 

 
5.0 

 
5.1 

 
5.1 

 
5.4 

 
5.6 

 
5.7 

 
5.9 

 
6.0 

 
65 

 
5.4 

 
5.5 

 
5.5 

 
5.8 

 
5.9 

 
6.1 

 
6.3 

 
6.0 

 

Yellow Interval for Left Turns 

MnDOT will often use 25 mph (or a value of 3.0 seconds) for left turns. If timing a single point urban 
interchange (SPUI) or an intersection with a wide, sweeping radius, assume a speed of 35 mph. For 
information on the yellow interval for a FYA, refer to page 4-26. 

All Red 

The following formulas may be used to determine the red time. This is based on the Institute of 
Transportation Engineers (ITE) equation for red clearance interval. 

 

R = All red clearance interval in seconds 

w = width of intersection, stop line to center the end of the farthest conflicting lane 

l = length of vehicle, assumed to be 20 feet  

v = posted speed in mile per hour 

w + L

1.467v
R = 

w + L

0.447v
R = 

English Metric
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Exhibit 4-5 All Red Times 

 

Posted 

Speed 

 

Width of Intersection 

 

 30 40 50 60 70 80 90 100 110 

25 1.4 1.6 1.9 2.2 2.5 2.7 3.0 3.3 3.5 

30 1.1 1.4 1.6 1.8 2.0 2.3 2.5 2.7 3.0 

35 1.0 1.2 1.4 1.6 1.8 1.9 2.1 2.3 2.5 

40 0.9 1.0 1.2 1.4 1.5 1.7 1.9 2.0 2.2 

45 0.8 0.9 1.1 1.2 1.4 1.5 1.7 1.8 2.0 

50 0.7 0.8 1.0 1.1 1.2 1.4 1.5 1.6 1.8 

55 0.6 0.7 0.9 1.0 1.1 1.2 1.4 1.5 1.6 

60 0.6 0.7 0.8 0.9 1.0 1.1 1.3 1.4 1.5 

 

These formulas are general and should only be used as a guide. Other factors at an intersection (such as 
approach grades, visibility, truck traffic and local traffic characteristics) should be considered. It is important 
that approach grades and truck traffic are considered in determining the yellow and red intervals. The yellow 
interval must not be too short (causing quick stops and/or red violations) nor too long (causing regular 
“driving of the yellow”). 

The all-red should be in the range of 1 to 5 seconds. 

All Red for Left Turns 

MnDOT will often use 25 mph for left turns. If timing a single point urban interchange (SPUI) or an 
intersection with a wide, sweeping radius, assume a speed of 35 mph. 

The width of the intersection, w, for a left turn is commonly determined from a scaled intersection drawing. 
This distance (w) is measured along the path of the left turn vehicle from the stop to the end of the farthest 
conflicting lane. 

For information on the all red interval for a FYA, refer to page 4-26. 
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Example: Consider the intersection shown in the figure below.  

 

Assume the following: 

 t = 1.0 seconds 

 v = 45 mph 

 a = 10 feet per second 

 l = 20 feet 

 g = -1 percent 

 

Y + R = 1.0 +                1.467 (45)         +     60 + 20 

                              2{10 + 32.2(-0.01)}       1.467 (45) 

Y + AR = 1.0 + 3.41 + 1.21 = 5.62 seconds 

Use,  

Yellow = 4.4 seconds and All Red = 1.2 seconds 

NB Direction:

Grade = -1%

6
0 

fe
e
t
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4.10 Flashing Yellow Arrow Operation 

FYA Yellow and All-Red Times 

Yellow time for clearing the green arrow for leading or lagging left turns will be the same as the current 
agency standard for left-turn operation (see page 4-22).  

Yellow time for clearing the FYA will be the opposing through yellow time (3.5 to 6.0 sec) as the FYA will be 
driven by an overlap with the opposing through phase. 

When transitioning from a protected left turn to a permissive left turn in protected/permissive operations, 
the all-red time will be a minimum of 2 seconds with the red arrow being shown.  

Permissive Operation When Adjacent through Head is Red 

The FYA display will allow for a permissive operation when the adjacent through head is red (see Exhibit 
3-13).  This was not possible with the 5-section protected/permissive head.  This situation could occur if one 
left turn movement runs longer than the opposing left turn movement and the shorter left turn will get the 
permissive flashing yellow arrow while the opposing left turn is causing the adjacent through head to still be 
red.  

Adjacent through heads may also be red when lagging lefts are used with protected/permissive operation. 
This is also something that wasn’t possible with the 5-section protected/permissive head as it would cause 
a “left-turn trap” (See the discussion on “Left Turn Trapping” on page 3-31).  The FYA head doesn’t cause a 
left-turn trap because it is an exclusive head for left turning vehicles (see the topic “Flashing Yellow Arrow 
and the Left Turn Trap” on page 3-33).  However, it is a new operation for motorists in that they will be 
looking for gaps while yielding on the flashing yellow arrow while the adjacent through head goes yellow 
due to the opposing protected/permissive lagging left.  The flashing yellow arrow will continue to operate 
even though the adjacent head goes red and motorists will need to continue to yield to oncoming traffic. 

Varying FYA Head between Protected, Protected/Permissive, and Permissive Operation  

As discussed earlier, the FYA can be considered a variable operation signal indication. Consider the following 
items:  

 All FYA signals may vary operation between protected, protected/permissive, and permissive 
operation at various times of the day and night. 

 Each signal approach will need to be analyzed individually to determine the time-of-day FYA operation 
by considering the following criteria:  

a) Cross-product volumes of left turns and opposing throughs at various times of day 

b) Speed limit 

c) Sight distance limitations 

d) Number of opposing through lanes 

e) Double left turn lanes or single left turn lanes 

f) Opposing left turn lane offset 

g) Cross street or mainline approach  

h) Comprehensive left turn crash analysis of approaches with similar characteristics 

The following sections are general guidelines on determining when to use the various types of operation for 
the FYA indication. In all cases, engineering judgment must be exercised and the information below used as 
guidance.  
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Test for Protected Only Operation 24 Hours per Day 

In some cases, the left turn indication should run in the most 
restrictive Protected-Only mode 24 hours per day. Refer to Exhibit 
4-6 for the Protected Only Left Turn Operation Guidelines. If the 
answer to question 1 or 2 is “yes”, then protected operation 
should be used throughout the day.  

If the answer is “yes” to any of the questions in Part 1, then 
Protected-Only operation is suggested throughout the day. If the 
answer to all of the questions is “no”, then proceed to Part 2 (Exhibit 4-7) to check for permissive FYA 
operation by time of day. 

Exhibit 4-6 Part 1: Protected-Only Left Turn Operation 24 Hours per Day 

 

Test for FYA Operation by Time of Day 

Part 2 (Exhibit 4-7) should be performed for each time of day interval. Typically, the evaluation would be for 
4 or more intervals throughout the day (AM Peak, Mid-day Peak, PM Peak and Off Peak). Other intervals can 
be evaluated as warranted.  

For the Cross-Product (Question 6) use the highest hourly cross product during the interval evaluated. 

If the answer to any of the questions in Part 2 are “yes”, protected only operation is suggested. Use 
engineering judgment if a decision is made to operate permissive FYA for the evaluated time period.  

Question 6 does include a threshold volume of 240 vph for the subject left turn. However, if the opposing 
through volume is low, apply engineering judgment to determine if FYA operation could be used even if the 
left turn volume exceeds 240 vph.  

If permissive FYA operation is allowed, protected/permissive operation may be investigated. The decision to 
use protected/permissive operation should be based on a capacity analysis.  

Part 1: Protected Only Operation - 24 hrs/day Guidelines

0

0

> If the Answer is Yes to Question 1 or 2, use Protected Operation 24 hours/day

> If the Answer is No to all of the above, proceed to Part 2.

Question 1: Conflicting Left Turns
Do the opposing left turn paths conflict? > If the answer is Yes, then use 

   Protected Operation 24 hours/day. 

> If the answer is No, proceed to the 

   next question.

Question 2: Limited Sight Distance
Does the left turner have very limited sight distance as 

defined in the current AASHTO "A Policy on Geometric 

Designs of Highways and Streets"?

> If the answer is Yes, then use 

   Protected Operation 24 hours/day. 

> If the answer is No, proceed to part 2

   to check for FYA by TOD.

Yes

No

Yes

No

MnDOT is continually researching 
the criteria presented here. 

Working groups with multiple 
agencies will be involved in fine-

turning these tests. 
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Exhibit 4-7 Part 2: Permissive FYA Operation by Time of Day 

 

Definitions 

 Protected only left turn operation: signal phasing that allows left turn movements to only be made 
on an exclusive phase (green arrow). 

 Conflicting Left Turn Paths:  At some locations geometric constraints at the intersection cause the 
paths of opposing left turn vehicles to cross as overlap creating a conflict. An example is an approach 
that crosses a divided roadway with a wide median. In these locations, it may be necessary to operate 
the left turns in a lead-lag sequence or a split phase sequence, not allowing simultaneous opposing 
left turns. This operation will require protected left turns. 

 Opposing through lane (conflict): The opposing through lanes are the lanes across from, and in 
conflict with, the left turning vehicle.  Multiple lanes make it difficult for a driver to evaluate gaps in 
oncoming traffic. An opposing separate right turn lane will typically not be counted with opposing 

Part 2: Time of Day Operation of FYA
Start Time

End Time

0

0

0

0

Question 3: Number of Left Turn Lanes

> If the answer is Yes to any Question, Protected Only Operation is Suggested during this TOD (use Engineering

   Judgment if Decision to run FYA by TOD).

> If the answer is No to all Questions, FYA (permitted mode) may be used during this TOD.

Question 5: Crash History
Is protected/permissive operation in place and is there a high 

number of left turn related crashes during this time interval 

over a 3-year period susceptible to correction by protected 

only phasing?

> If the answer is Yes, Protected 

   Operation is suggested for this TOD.

> If the answer is No, proceed to the 

   next question. 

Does the left turn have two (2) or more lanes? > If the answer is Yes, Protected 

   Operation is suggested during the 

   high volume times of the day

  (use Engineering Judgment if Decision 

   to run FYA by TOD).

> If the answer is No, proceed to the

   next question.

Question 4: Number of Opposing Through Lanes
Does the left turn face three (3) or more opposing through 

lanes?

> If the answer is Yes, Protected 

   Operation is suggested during the 

   high volume times of the day

  (use Engineering Judgment if Decision 

   to run FYA by TOD).

> If the answer is No, proceed to the

   next question.

Question 6: Speed and Cross Product
Is the Speed 45 MPH or greater and the Peak Hour left turn 

volume greater than 240 vph or is the peak hour cross 

product greater than 80,000 (100,000 if 2 opposing lanes)?

> If the answer is Yes, Protected 

   Operation is suggested for this TOD.

> If the answer is No, FYA may be 

   possible during this time period. 

Yes

No

Yes

No

Yes

No

Yes

No
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through lanes unless engineering judgment indicates that the lane configuration and number of right 
turns will cause conflicts with the left turn movement. 

 Limited Sight Distance (Requirements): The minimum sight distance values necessary for the design 
vehicle volume to complete the turn movement.  Distance should be calculated from the stop bar for 
the mainline left turning vehicle.  Measurement is based on travel path, speed, and acceleration 
vehicle height.  Both the sight distance for passenger vehicles and trucks should be checked using 
heights and distance requirements per the AASHTO Geometric Design Guide.  The current reference 
at time this manual was prepared is the 2004 Guide, Chapter 9, Exhibit 9-67). 

 Dual Left Turn Lanes: Multiple left turn lanes may consist of exclusive left turn lanes or a combination 
of exclusive left turn lanes and lanes that are shared by through and left turning traffic. Both the dual 
lane and the left turn lane opposing this operation are suggested to operate with protected phasing. 
Left turn lanes without opposing traffic, such as left turns off of a one- way street, does not require 
protected only phasing based upon this criteria. It might also be possible to run the FYA in permissive 
mode during low volume times of the day. 

 Protected/permissive left turn operation: signal phasing that provides an exclusive phase (green 
arrow) followed by a permissive phase (flashing yellow arrow), time during the signal cycle where left 
turning traffic may make a left turn after yielding to oncoming traffic. 

 Left Turn Related Collisions: These are Collisions that could be corrected by protected only phasing, 
such as those between those involving a left turning vehicle and an opposing through vehicle. At 
higher speeds the crash collisions are likely to be more severe.  Therefore, a lower number of collisions 
might be used as the parameter for consideration for high-speed approaches. Because of the 
variations in collisions overtime, an average number of collisions per year over a 3- year period should 
be used if the data is available. 

 Speed:  Because it can be difficult for a driver to accurately judge available gaps in traffic approaching 
at high speeds, the engineer must exercise discretion when considering permissive or protected 
permissive left turn phasing with opposing speeds of 45 MPH or above. 

Use of posted speed limit is recommended. Non-arterial approaches may have lower speeds than the 
posted speed limit because they are often in a stop condition upon the arrival of traffic. Grades affect 
the acceleration rate of the left turner and the stopping distance and speed of the opposing through 
traffic and are therefore considered in conjunction with speeds. 

 Cross Product:  The left turn volume multiplied by the opposing through volume. The cross product 
values used are taken from the Wisconsin Department of Transportation (WisDOT) Traffic Signal 
Design Manual discussion on left turn conflicts analysis, Chapter 2, Section 3, Subject 4.  Cross product 
used represents a high frequency of conflicts for left turners looking for gaps in through traffic. 

FYA during Free Operation 

With the variable-phasing operation of the FYA head, free operation will no longer have an assigned fixed 
phasing operation.  Therefore, standard free operation will need to be set up in the signal controller so 
technicians can put signals quickly to FREE with a standard phasing operation desired at the specific time.  
Here is an example of the standard FREE operations that will need to be set up in the signal controller: 

1. All left turns protected 
2. All left turns protected/permissive 
3. All left turns permissive 
4. Mainline protected, cross street protected permissive 
5. Mainline protected, cross street permissive 
6. Mainline protected/permissive, cross street protected 
7. Mainline protected/permissive, cross street permissive 
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8. Mainline permissive, cross street protected 
9. Mainline permissive, cross street protected/permissive Minimum Green Times 

Minimum Green Times  

MnDOT currently sets the minimum green time based on the type of phasing operation where protected 
lefts have a 7 second minimum green and protected/permissive lefts have a 5 second minimum green. Given 
the FYA head is a variable phasing operation head, a decision will need to be made as to if there should be 
more than one minimum green value that changes with the phasing operation, or if a universal minimum 
green should apply to all phasing operations. 

If one minimum green is used, and if a left turn phase will ever run protected, the left turn minimum green 
should be set at 7 seconds.  If a left turn will never run protected (i.e. only run protected/permissive or 
permissive), then the left turn minimum green should be set at 5 seconds. 

EVP Preemption Operation under FYA 

A. Protected-only Operation 

 When the FYA is not allowed (protected only), the pre-emption will bring up the protected left turn 
and the adjacent through phase.  The opposing FYA will not be allowed during preemption (refer to 
Exhibit 4-8). 

Exhibit 4-8 Emergency Vehicle Preemption: Protected-Only Operation 

 

B. Protected/Permissive Operation (Note: Permissive operation is the same as protected/permissive 
operation for preemption as permissive operation is just a subset of protected/permissive operation.)  

There are currently two options for running pre-emption under protected/permissive operation and 
the option is left up to emergency-vehicle preference based on their most common response routes.  

The current two options for preemption for Protected/Permissive operation: 

1. Don’t Terminate Through Phases (preempt on through phases, FYA on, i.e. no protected 
left turn phases) - Refer to Exhibit 4-9.  
a) If the through phases in the direction of the emergency vehicle (EV) are green and 

lefts are in FYA, pre-empt keeps the throughs and FYAs on.   
b) If the through and left in the direction of the EV are green, terminate the left and 

bring up the opposing through and operate the lefts in FYA.  

EMERGENCY VEHICLE SIGNAL INDICATIONS

THROUGH GREEN

LEFT GREEN ARROW

EVP INDICATIONS
FLASHING YELLOW ARROW

STEADY

THROUGH RED

FLASHING LEFT RED ARROW

NOTE: SEE THE TEXT IN THE MANUAL FOR A DISCUSSION ON 
PHASE TERMINATION SEQUENCE ONCE EVP CALL
IS RECEIVED.

PROTECTED ONLY OPERATION
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c) If the side street throughs are green, a preempt on the main street terminates the 
side street and brings up the main street throughs and FYAs.  

Exhibit 4-9 Emergency Vehicle Preemption: Protected/Permissive Operation (Option 1) 

 

 

2. Terminate Both Through Phases (FYA off) –Refer to Exhibit 4-10. 
a) If the through phases in the direction of the EV are green and lefts are in FYA, pre-

empt terminates both through phases, and brings the through and left green arrow 
for the direction of the EV (FYA off for opposing left turn). 

b) If the left green arrow and through phase in the direction of the EV are green, pre-
empt the left green arrow and through phase and then brings up this same green 
arrow and through phase (FYA off for opposing left turn). 

c) If the left green arrow and through phase in the opposing direction of the EV are 
green, pre-empt terminates the left green arrow and through phase and brings up the 
opposing (EV direction) left green arrow and through phase (FYA off for opposing left 
turn). 

d) If the side-street is green, a pre-empt on the main street terminates the side-street 
phases and bring up the left green arrow and through in the direction of the EV (FYA 
off for opposing left turn). 

EMERGENCY VEHICLE SIGNAL INDICATIONS

THROUGH GREEN

LEFT GREEN ARROW

EVP INDICATIONS
FLASHING YELLOW ARROW

STEADY

THROUGH RED

FLASHING LEFT RED ARROW

NOTE: SEE THE TEXT IN THE MANUAL FOR A DISCUSSION ON 
PHASE TERMINATION SEQUENCE ONCE EVP CALL
IS RECEIVED.

PROTECTED/PERMISSIVE OPERATION (OPTION 1)
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Exhibit 4-10 Emergency Vehicle Preemption: Protected/Permissive Operation (Option 2) 

 

An additional Third Option with a FYA head while running lagging lefts during prot/permissive or 
permissive operation is discussed here – Refer to Exhibit 4-11. 

3. Terminate One Through Phase (preempt for through and adjacent left, opposing FYA on) 
a) If the through phases in the direction of the EV are green and lefts are in FYA, pre-

empt terminates opposing through phase, and brings up green arrow and through for 
the direction of the EV (FYA on for opposing left turn) 

b) If the left green arrow and through phase in the direction of the EV are green, pre-
empt continues the left green arrow and through phase (FYA on for opposing left 
turn) 

c) If the left green arrow and through phase in the opposing direction of the EV are 
green, pre-empt terminates the left green arrow and through phase and brings up the 
opposing (EV direction) left green arrow and through phase. (FYA on for opposing left 
turn) 

d) If the side-street is green, a pre-empt on the main street terminates the side-street 
phases and bring up the left green arrow and through in the direction of the EV (FYA 
on for opposing left turn). 

Exhibit 4-11 Emergency Vehicle Preemption: Protected/Permissive Operation (Option 3) 

 

EMERGENCY VEHICLE SIGNAL INDICATIONS

THROUGH GREEN

LEFT GREEN ARROW

EVP INDICATIONS
FLASHING YELLOW ARROW

STEADY

THROUGH RED

FLASHING LEFT RED ARROW

NOTE: SEE THE TEXT IN THE MANUAL FOR A DISCUSSION ON 
PHASE TERMINATION SEQUENCE ONCE EVP CALL
IS RECEIVED.

PROTECTED/PERMISSIVE OPERATION (OPTION 2)

EMERGENCY VEHICLE SIGNAL INDICATIONS

THROUGH GREEN

LEFT GREEN ARROW

EVP INDICATIONS
FLASHING YELLOW ARROW

STEADY

THROUGH RED

FLASHING LEFT RED ARROW

NOTE: SEE THE TEXT IN THE MANUAL FOR A DISCUSSION ON 
PHASE TERMINATION SEQUENCE ONCE EVP CALL
IS RECEIVED.

PROTECTED/PERMISSIVE OPERATION (OPTION 3)
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RR Preemption Operation 

The FYA 4-section head should help railroad preemption operations given the flexibility to operate in either 
protected, protected/permissive, or permissive modes with no concern of a left-turn trap issue. It might be 
possible to run the left turn as a FYA UNLESS railroad preemption occurs (in which case it would run in 
protected only operation). This issue is currently under development and more information is forthcoming. 
See the MnDOT OTST website listed below for the most up-to-date information. 

www.dot.state.mn.us/trafficeng/publ/index.html 

4.11 Accessible Pedestrian Signal (APS) Operation 

The MN MUTCD Section 4A.2 defines an Accessible Pedestrian Signal as “a device that communicates 
information about pedestrian timing in nonvisual format such as audible tones, verbal messages, and/or 
vibrating surfaces.” The APS provides information to the pedestrian about: 

 The existence and location of the pushbutton 

 The beginning of the walk interval 

 The direction of the crosswalk 

 Intersection street names 

MnDOT has formed an APS committee in order to standardize APS operation for consistency across the 
state. This committee was established after discussion with the North Central Institute of Transportation 
Engineering (NCITE) Intersection Traffic Control Committee stating that MnDOT felt it was important to 
establish APS operating standards that would be utilized by agencies across Minnesota to create consistency 
for users. The intent is to meet with local agencies and develop a standard to be used by all agencies.  

Currently, there are two APS buttons on the MnDOT Approved Products list (Polara Engineering, distributed 
by Brown Traffic and Campbell Company, distributed by Traffic Control Corp.). One issue with making 
recommended operational practices is that one product may offer a feature that another manufacturer does 
not.  The intent of the APS committee is not to require an operation that one of the products on the APL 
currently does not offer. This will require shop testing to assure that the committee does not make 
operational recommendations that one product can’t currently provide. 

The current operational practice standards per MN MUTCD and FHWA guidance: 

 Speech messages will be used during the walk indication when the pedestrian buttons are less than 
10’ apart. If more than 10’ apart, the audible walk indication shall be a percussive tone.  

 Speech walk messages and the percussive tone walk indication can be used on different buttons at 
the same intersection during the walk interval. 

 An audible countdown during the ped clearance interval will not be used. Per the MN MUTCD.  
“Following the audible walk indication, accessible pedestrian signals shall revert to the pushbutton 
locator tone during the pedestrian change interval.” 

 Length of “extended push” time to activate function shall be 2 seconds 

Additional details on the work of this committee and operational recommendations will be published on the 
OTST website. Refer to the website for future details (www.dot.state.mn.us/trafficeng/).   

http://www.dot.state.mn.us/trafficeng/publ/index.html
http://www.dot.state.mn.us/products/index.html
http://www.dot.state.mn.us/trafficeng/
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4.12 Guidelines for the Inspection and Operation of Railroad Preemption at 
Signalized Intersections 

Introduction 

This section provides guidelines and recommendations for the installation, operation and inspection of 
traffic signals that are preempted either by trains or by Light Rail Transit (LRT) vehicles utilizing preemption. 
Yearly inspections will be performed and submitted to the Office of Freight, Railroads & Waterways. 

Scope 

The guidelines and procedures contained in this section apply to MnDOT, and to county and city agencies 
through the state aid process. MnDOT district offices may assist local agencies in performing inspections, if 
requested. 

The responsibility for the operation of the highway/railroad preempted traffic signals remains with the 
district, county or city having operational jurisdiction. Neither an inspection nor these guidelines substitute 
for sound engineering judgment in the operation of traffic signals. 

These are general guidelines and should be used only as a guide. Other factors at each location must be 
considered in applying these guidelines. The Minnesota Manual on Uniform Traffic Control Devices (MN 
MUTCD), Traffic Control Devices Handbook, Railroad-Highway Grade Crossing Handbook (FHWA-TS-86-215), 
and the Institute of Transportation Engineers' Preemption of Traffic Signals at or Near Railroad Grade 
Crossings with Active Warning Devices should be referred to for additional guidance. 

Guidelines for Preemption 

If either of the following conditions are present, consideration should be given to interconnect the traffic 
signal and railroad grade crossing: 

A. Highway traffic queues that have the potential for extending across a nearby rail crossing.  

B. Traffic queued from a downstream railroad grade crossing that have the potential to interfere with 
an upstream signalized intersection. 

The 1991 version of the Minnesota Manual on Uniform Traffic Control Devices, specifies that the 
recommended distance between traffic signal and grade crossing for interconnection is 200 feet (65 meters). 
Recent research has found this distance to be inadequate. The following formulas provide a method for 
estimating the queue length that can be expected on the approach. If the queue length exceeds the storage 
between the intersection stop bar and 6 feet (2 meters) from the nearest rail, the railroad signal and the 
traffic signal should be interconnected. 

A method for estimating queue length (with about 95 percent certainty) is as follows:                             

L=2qrv(1+p) 

Where: L = length of queue, in feet or meters per lane;  

q = flow rate, average vehicles per lane per second;      

r = effective red time (time which the approach is red or yellow per cycle);  

v = passenger vehicle length, assume 25 feet or 7.5 meters;  

p = proportion of trucks;  

The 2 is a random arrival factor. 
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This formula provides a good estimate of queue lengths, where the volume to capacity (v/c) ratio for the 
track approach is less than 0.90. However, for v/c ratios greater than 0.90, some overflow queues could 
occur as a result of fluctuations in arrival rates. To compensate for this condition, it is suggested that one 
vehicle should be added for each percent increase in the v/c ratio over 0.90. Accordingly, in cases where the 
v/c ratio ranges from 0.90 to 1.00, the following formula applies: 

                                   L=(2qr+Δx)(l+p)v 

Where Δx = l00(v/c ratio - 0.90). Thus, for a v/c ratio 0.95,  Δx would be 5 vehicles in the above formula. This 
formula cannot be used if the v/c  

Queue lengths for through traffic and for left turns should both be checked to determine which queue is the 
most critical. 

Guidelines for Design 

When the determination has been made to preempt the traffic signal for a train, many items need to be 
considered. Some are listed here: distance between the traffic signal and the grade crossing, intersection 
geometry, track orientation, approach speed of train, train frequency, volume of vehicular traffic, vehicle 
type, pedestrian, and equipment at the intersection and grade crossing. 

Blank out no right turn signs prohibiting right turns shall be used on all new signals 
to prohibit right turns towards the highway-grade crossing during preemption. This 
blank out turn sign should typically be placed on the far side pole or mast arm. Only 
one sign is required but additional blank out signs can be considered by the 
diagnostic team. Other mounting locations for the sign can be considered. The 
approach turning right over the track must have a dedicated right turn lane. The 
blank out sign shall be an R3-1 with the word “TRAIN” underneath.  If the diagnostic 
team has determined that a blank out sign is not in the best interest of the traveling 
public, document why.  

Short distances: Where the clear storage distance between the tracks and the highway intersection stop line 
is not sufficient to safely store a design vehicle like the longest, legal truck combination, or if vehicles 
regularly queue across the tracks, a pre-signal should be considered. An engineering study should be 
performed to support this recommendation. A pre-signal may also be beneficial if gates are not provided. 
This supplemental traffic signal should be carefully designed to avoid trapping vehicles on the tracks. 
Visibility-limited traffic signals at the intersection may be needed to avoid driver conflict and confusion. The 
DO NOT STOP ON TRACKS sign (R8-8) and STOP HERE ON RED sign (R10-6) of the MN MUTCD should also be 
used. Certain situations where gates are not present may also require prohibiting turns on red. 

Guidelines for Operation 

The MN MUTCD (Section 8C-6) requires that “The preemption sequence initiated when the train first enters 
the approach circuit, shall at once bring into effect a highway signal display which will permit traffic to clear 
the tracks before the train reaches the crossing. The preemption shall not cause any short vehicular 
clearances and all necessary vehicular clearances shall be provided. However, because of the relative 
hazards involved, pedestrian clearances may be abbreviated in order to provide the track clearance display 
as early as possible. After the track clearance phase, the highway intersection traffic control signals should 
be operated to permit vehicle movements that do not cross the tracks, but shall not provide a through 
circular green or arrow indication for movements over the tracks”. 

If the traffic signal is equipped with emergency vehicle preemption, the confirmation lights shall flash for all 
approaches during the preempt sequence. 
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Guidelines for Inspection 

Existing highway/railroad preempted traffic signals shall be inspected on an annual basis. It is the 
responsibility of the roadway authority that has responsibility for the operation of the traffic signal to initiate 
the annual inspection. A copy of the completed inspection forms shall be forwarded to the Office of Freight, 
Railroads & Waterways on an annual basis. 

The District Traffic Engineer will ensure that each location under MnDOT jurisdiction is inspected. Through 
the State Aid program, cities and counties are required to perform annual inspections. 

The rail authority shall be contacted prior to inspection and a representative shall be present during each 
inspection. This joint inspection is critical, as the operation of railroad preemption systems is dependent on 
both the railroad and highway agencies. 

The inspection should be done while a train passes through the area if possible. 

During this inspection, a general review of the highway intersection and railroad crossing for proper signing, 
pavement markings, signals, sight distances, and changes in conditions should be made. 

It is also advised that all traffic signals without railroad preemption need to be reviewed when traffic 
patterns change, see if additional traffic control/RR preemption is needed. 

Annual Inspection Form 

The following information is a printout of the Railroad Preemption Timing and Annual Inspection Form (xls). 
This information is available from the MnDOT website: 

www.dot.state.mn.us/trafficeng/signals/signalworksheets.html 

 

 

 

http://www.dot.state.mn.us/trafficeng/signals/signalworksheets.html
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Version 11/21/2007

CONTROLLER MODEL: OPERATION (pretimed/actuated):

DETECTOR MODEL/TYPE:

CRITICAL PHASES TRACK CLEARANCE PHASE(S) PREEMPT HOLD OR CYCLE PHASES

Vehicle: 

Mn/DOT ANNUAL TRAFFIC SIGNAL AND RAILROAD PREEMPTION INSPECTION FORM

2. RAILROAD PREEMPTION PHASING SEQUENCE

Pedestrian: 

RR ACTIVE WARNING DEVICES:

3. RAILROAD DATA

ROADWAY CHANGES?

GATE-DOWN LOGIC INSTALLED?

4. TRAFFIC SIGNAL HARDWARE DATA

Flashers, no gates.

EVP PRESENT? CONFIRMATION LIGHTS PRESENT?

LOOPS UPSTREAM OF TRACKS (if vehicles must stop before tracks)?

NUMBER OF TRAINS PER DAY (and any helpful additional information): WORKING MANUAL PREEMPTION SWITCH IN CABINET?

MAXIMUM TRAIN SPEED (MPH): NUMBER OF TRACKS:

APPROACH AND ISLAND LENGTHS (FEET):

Island: Approaches: 

DATE OF MOST CURRENT RAILROAD PLANS (in bungalow):

TYPE OF BACKUP POWER:

HIGHWAY

RAILROAD

INSPECTION 
DATE:

5. RAILROAD EQUIPMENT PROGRAMMED TIMINGS

DOES MEASURED WARNING TIME MEET OR EXCEED MAXIMUM WARNING TIME NEEDED BY TRAFFIC SIGNAL?

8. REVIEW TEAM (INCLUDING TELEPHONE NUMBERS)

 sec.

Preempt call received at

Equipment Response (Buffer) Time:

 sec.

Minimum Warning Time:

 sec.

 sec.

 sec.

Total Warning Time (excludes 
equipment response/buffer time):

20

Extra Warning Time (overspeed 
tolerance, wide/angled crossings):

Weather Conditions:

20

Advance Preemption Time:

Train's Direction of Travel

MAXIMUM WARNING TIME NEEDED BY TRAFFIC SIGNAL: 23.2 sec

6. NOTES

7. FIELD TESTING AND INSPECTION

no gates no gates no gates

Test #

Railroad flasher activated at
Gate descent started at

Gate descent completed at

Train arrived at
End of track clearance green (start of track clearance yellow) at

Track clearance and preempt hold/cycle phases operated as expected:
Railroad equipment and lamps functioned:

1 2 3 4

no gates
no gates

Cumulative Time (sec)

no gates no gates no gates

RAILROAD COMPANY: RAILROAD INVENTORY NUMBER:

1. LOCATION DATA
CITY:

HIGHWAY INTERSECTION: Mn/DOT DISTRICT:

COUNTY: OPERATING AGENCY:

Measured Total Warning Time:
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Version 11/21/2007

9. OTHER INFORMATION/NOTES
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MnDOT Traffic Signal Timing and Coordination Manual 

May 2017 Local Intersection Timing Page | 4-39 

4.14 Guidelines for Consideration and Timing of Advanced Warning Flashers 

The following guidelines indicate when the installation of AWF for signal change interval may be considered. 
Due to the complex nature of traffic flow characteristics, these guidelines should be applied along with 
engineering judgment. Guidelines should be reviewed for each prospective installation. 

AWF should only be installed in response to a specifically correctable problem, not in anticipation of a future 
problem. Generally, AWF implementation is appropriate only at high speed locations. Before an AWF is 
installed, other remedial action should be considered. 

The following guidelines generally apply only where posted speed is 55 mph or higher. 

 

CATEGORY CRITERIA COMMENT 

1. Isolated or 
Unexpected 
signalized 
intersection 

 

Where there is a long distance from 
the last intersection at which the 
mainline is controlled, or the 
intersection is otherwise 
unexpected. 

This guideline may be applicable 
where the distance from the last 
intersection is greater than 10 miles, 
or at a freeway terminus, or at other 
locations where the intersection is 
unexpected. 

2. Limited sight 
distance 

 

Where the distance to the stop bar, 
D, with two signal heads visible is 
insufficient: 

32.2s)+0.93(a

v
+1.467vtD

2

  

Where: 

D =   distance to stop bar feet 

v = posted speed in mph  

t = reaction time, 2.5 seconds 

a = deceleration rate 

8 ft/s2  (trucks) 

10 ft/s2  (all traffic) 

s = decimal gradient 

See Graphs of Limited Sight Distance, 
Exhibit 4-12 & Exhibit 4-13. A sight 
distance falling below the lines for the 
given speed and grade indicates the 
possible need for AWF. 
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CATEGORY CRITERIA COMMENT 

3. Dilemma 
Zone 

 

Where a dilemma zone exists for all 
traffic or for heavy vehicles.  A 
dilemma zone exists if: 

s)+2(a

v
+tY

2.32

467.1
  

Where: 

Y = yellow interval in seconds 

v = Posted speed in mph  

t = 1 second 

a = deceleration rate 

8 ft/s2  (trucks) 

10 ft/s2  (all traffic) 

s = decimal gradient 

See Graphs on Minimum Yellow 
Intervals, Exhibit 4-14 & Exhibit 4-15. 

If the yellow interval is less than 
indicated, AWF may be considered 
(longer yellow should be considered 
first). 

4. Crashes 

 

If an approach has an crash 
problem, the intersection should 
be examined for existence of 
dilemma zone or sight distance 
restriction. 

If no sight distance or dilemma zone 
problems exist, AWF may not be an 
appropriate countermeasure to crash 
problems. 

5. Heavy Truck 
Volume 

Where the roadway has a grade of 
3% or greater and truck volume 
exceeds 15%. 

 

6. Engineering 
Judgment 

  

 

Combinations of above guidelines or other considerations may justify the installation of AWF. 

Engineering judgment should be based on additional data such as complaints, violations, conformity of 
practice, and traffic conflicts. Prior to installing AWF, consideration should be given to other 
countermeasures including but not limited to: adjustment of timing parameters which may include 
increasing yellow and/or all red intervals, improving detection, or modification of the signal system as by 
adding signal heads, adjusting speed limits. 
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Guidelines for Installation 

1. Advanced Warning Flasher - The Advanced Warning Flasher design details are shown on the 
web: www.dot.state.mn.us/trafficeng/signals/signaldetails.html.  The flasher shall flash 
yellow in a (inside-outside) wig-wag manner prior to the termination of the green (See 
number 3, below), and during the yellow and red periods of the signal. The flasher will also 
flash if the signal goes into flashing operation. Power shall be supplied to the AWF from the 
signal control cabinet. 

2. Advanced Warning Flasher Sign Placement - The AWF should be set back from the 
intersection in accordance with the table shown below. At locations on four lane divided 
roadway, the AWF shall be placed on both sides of the approach. 

 

Posted Speeds (mph) AWF Placement Leading Flash (seconds) 

40 560 ft 8.0 

45 560 ft 7.0 

50 700 ft 8.0 

55 700 ft 7.0 

60 850 ft 8.0 

65 850 ft 7.5 

  

3. Leading Flash - The Leading Flash is the amount of time, prior to the signal turning yellow, that the 
AWF flashes. The AWF shall flash during the Leading Flash Period and continue flashing through 
the signal's yellow clearance interval and the red. The Leading Flash time is shown in the table 
above. 

 

For existing systems where the placement is other than what is listed in the table above,  the Leading 
Flash Time can be computed by the following formula: 

Where: 

F = Leading Flash Time, seconds  

D = AWF Placement, feet 

v = posted speeds, mph 

 

4. Detector Placement - The detection of the intersection shall be determined without regard to the 
AWF. 

 

1.5-
v

0.68D
=F  

http://www.dot.state.mn.us/trafficeng/signals/signaldetails.html
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Exhibit 4-12 AWF Limited Sight Distance (> 15% Trucks) 
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Exhibit 4-13 AWF Limited Sight Distance (≤ 15% Trucks) 
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Exhibit 4-14 AWF Recommended Yellow Intervals (> 15% Trucks) 
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Exhibit 4-15 AWF Recommended Yellow Intervals (≤ 15% Trucks) 

 

 

 

 

See MN MUTCD for the Installation and Operation of Advanced Warning Flashers. 

 

  



MnDOT Traffic Signal Timing and Coordination Manual 

Page | 4-46 Local Intersection Timing May 2017 

This page is intentionally left blank 

  



MnDOT Traffic Signal Timing and Coordination Manual 

May 2017 Coordination Concepts Page | 5-1 

5 COORDINATION CONCEPTS 

5.1 Cycle Length 

The cycle length is the total time to complete one sequence of signalization around an intersection. In an 
actuated controller unit, a complete cycle is dependent on the presence of calls on all phases. In a pre-timed 
controller unit (see page 3-5) it is a complete sequence of signal indications. 

The equation presented on page 3-1 is for isolated pre-timed signal locations only. A detailed network 
analysis should be performed using a software package such as Synchro or TRANSYT for cycle length 
determination in a coordinated system. The use of computer models allows for multiple iterations of varying 
cycle combinations to determine the optimum signal timing parameters. 

5.2 Signal Timing Intervals and Splits 

The sum of the green, yellow, and all red intervals typically defines an individual phase split. A split is then 
the segment of the cycle length allocated to each phase that may occur (expressed in percent or seconds).  

The primary considerations that must be given to vehicle split times are as follows: 

 The phase duration must be no shorter than some absolute minimum time, such as five to seven 
seconds of green plus the required clearance interval. If pedestrians may be crossing with this phase, 
their crossing time must also be considered and included in the minimum phase length.  

 A phase must be long enough to avoid over saturating any approach associated with it. Too short a 
time will cause frequent cycle failures where some traffic fails to clear during its phase. 

 A phase length must not be so long that green time is wasted and vehicles on other approaches are 
delayed needlessly. 

 Phase lengths should be properly designed to efficiently balance the cycle time available among the 
several phases, not just “equitably” between, say, north-south and east-west. 

5.3 Offset 

The offset is the time relationship, expressed in seconds or percent of cycle length, determined by the 
difference between a fixed point in the cycle length and a system reference point.  

Proper determination and application of intersection offsets provide for the efficient movement of platoons 
through multiple intersections during the green indication. Properly timed offsets can significantly reduce 
delay and improve driver satisfaction with the system timing.   

5.4 Progression Measures 

All of the coordinated system analysis models have some MOEs associated with the green bands in the Time-
Space Diagram (TSD). In fact some of the models utilize progression MOEs as a component of the 
optimization objective function. The more common of these MOEs are introduced below. 

Bandwidth Efficiency 

PASSER II uses this measure as its objective function. This is simply the proportion of the cycle that is included 
in through green bands, extending the entire length of the system. A simple TSD showing perfect time-space 
progression illustrates the concept. Mathematically, efficiency is calculated as: 
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where,  

E = bandwidth efficiency, 

Bf, Br = bandwidths in the forward (f) and reverse (r) directions with respect to the arterial orientation, 
and  

C = cycle length.  

Example:  Bandwidth Efficiency 

Number of Signalized Intersections = 5 

Bandwidth (forward) = 40 seconds 

Bandwidth (reverse) = 40 seconds 

Cycle Length = 90 seconds 

Then, 

E = (Bf + Br) / 2C 

   = (40 sec + 40 sec) / (2 x 90 sec) 

   = 0.44 or 44% 

Bandwidth Attainability 

The attainability is the ratio of the total bandwidths to critical phase lengths for each of the directions on 
the arterial. Attainability is a measure of how much of the maximum available green is used for through 
progression, and is computed as: 

 

where, 

A = attainability 

Gf, Gr = the critical (or minimum) green periods (including change periods) in the two directions, and 

C = cycle length as before 

Example:  Bandwidth Attainability 

Number of Signalized Intersections = 5 

Bandwidth (forward) = 40 seconds 

Bandwidth (reverse) = 40 seconds 

Cycle Length = 90 seconds 

Intersection 1 Gf = Gr = 60 seconds 

Intersection 2 Gf = Gr = 55 seconds 

Intersection 3 Gf = Gr = 55 seconds 

E =
Bf  + Br

2C

A =
Bf  + Br

Gf  + Gr
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Intersection 4 Gf = Gr = 45 seconds 

Intersection 5 Gf = Gr = 50 seconds 

Then, 

A = (Bf + Br) / (Gf + Gr) 

   = (40 sec + 40 sec) / (45 sec + 45 sec) 

   = 0.89 or 89% 

This MOE is only reported by PASSER II. You can easily see that if attainability on a two-way street is less 
than 0.5, you can almost certainly improve the overall progression, including efficiency, by providing 
“perfect” one-way progression in the peak direction. PASSER II will not do this automatically, but you can 
instruct it to. 

5.5 System Measures 

Several other MOEs of interest are produced by most traffic operations models. 

Total Travel 

This value will be constant for any given network and demand distribution. This is simply the agreement of 
the product of link volumes and link lengths: 

TTi  = vi Li 

where, 

TTi = total travel on link i in veh-mi (veh-km) per hour; 

vi = traffic volume on link i, vph; and 

Li = length of link i in miles (km). 

This MOE will not change in any given optimization, since the basic values (flow rates and link lengths) do 
not change. 

Total Travel Time 

Similar to the total travel, this system MOE is the product of link volumes and total time spent on the links, 
including delay or: 

TTTi = vi (Li/Vi + di) 

where,  

TTTi  = total travel time in veh-hr per hour on link i; 

vi  = traffic volume on link i in vph; 

Vi = average cruise speed on link i in mph (km/hr); 

Li = length of link i in miles (km); 

di = total delay on link i in veh-hr per hour. 

This measure should obviously decrease as the network signal timing is improved to reduce delay. 
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Average System Speed 

The average speed in the system is an indication of the overall quality of flow in the network. It is simply the 
ratio of total travel (TT) to total travel time (TTT), and is thus expressed as veh-mi/veh-hr = mph (or similarly, 
km/hr). Links with zero distance (e.g. external links) or links that have been assigned zero delay and stop 
weights (e.g. non-vehicular links) should be excluded from the calculation of network average speed, as they 
are in TRANSYT-7F. 

5.6 Computer Timing Tools 

Computer models for developing optimized traffic signal timing plans have been available for over 25 years. 
The earliest versions of these programs were originally developed for mainframe computers and were often 
difficult to use. Over the years, these programs have evolved to take advantage of advances in 
microcomputer technology. In addition, the models themselves have been improved to better simulate the 
flow of traffic and make them more compatible with modern traffic control equipment.  Of course, computer 
models cannot replace good engineering practice including field observation and hardware understanding.  

Today there are more than 30 models that users can choose from for signal timing and analysis applications. 
A brief description of five widely utilized programs is provided below. 

Synchro/SimTraffic. Synchro is a complete software package for modeling and optimizing traffic signal 
timings. The key features of Synchro include: 

 Capacity Analysis. Synchro provides a complete implementation of the 2000 Highway Capacity 
Manual, Chapter 16.  

 Coordination: Synchro allows you to quickly generate optimum timing plans.  

 Actuated Signals: Synchro is the only interactive software package to model actuated signals. Synchro 
can model skipping and gap-out behavior and apply this information to delay modeling. 

 Time-Space Diagram: Synchro has colorful, informative Time-Space Diagrams. Splits and offsets can 
be changed directly on the diagram. 

 Integration with SimTraffic, CORSIM, and HCS: Synchro features preprocessor to these software 
analysis packages. Enter data once with easy-to-use Synchro, and then perform analyses with these 
software packages. 

Synchro is a macroscopic traffic software program that replicates the signalized intersection capacity 
analysis as specified in the 2000 Highway Capacity Manual (HCM). Macroscopic level models represent traffic 
in terms of aggregate measures for each movement at the intersections. Equations are used to determine 
measures of effectiveness such as delay and queue length. These models do not account for "bottleneck" 
situations where upstream traffic deficiencies reduce the amount of traffic reaching downstream 
intersections. This would be a situation where Synchro may show a delay that is worse than SimTraffic since 
all of the volume is not reaching the intersection in SimTraffic.  

A unique analysis methodology to Synchro is the “Percentile Method”. To account for variations in traffic, 
Synchro models traffic flow under five percentile scenarios, the 90th, 70th, 50th, 30th, and 10th percentile 
scenarios based on a Poisson distribution. If 100 cycles are observed, the 90th percentile cycle will represent 
the 10 busiest cycles. Each of these scenarios will represent 20% of the cycles actually occurring. This feature 
is discussed in more detail in Chapter 6. 

When it comes to SimTraffic, this is a microscopic simulation model. SimTraffic has the capability to simulate 
a wide variety of traffic controls, including a network with traffic signals operating on different cycle lengths 
or operating under fully-actuated conditions. Most other traffic analysis software packages do not allow for 
a direct evaluation of traffic conditions operating under varying cycle lengths and traffic control. 
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Each vehicle in the traffic system is individually tracked through the model and comprehensive operational 
measures of effectiveness are collected on every vehicle during each 0.1-second of the simulation. Driver 
behavior characteristics (ranging from passive to aggressive) are assigned to each vehicle by the model, 
affecting the vehicle's free-flow speed, queue discharge headways, and other behavioral attributes. The 
variation of each vehicle's behavior is simulated in a manner reflecting real-world operations. 

Since SimTraffic is a microscopic model, the full impact of queuing and blocking would be measured by the 
model. This is a situation where SimTraffic could show more delay when compared to Synchro. 

The intention is to use Synchro and SimTraffic as companion models. Use Synchro to determine macro level 
LOS and delays (similar to the 2000 HCM), and use SimTraffic to simulate and animate to determine the 
'problems' that may not be fully realized with a macro-level model.  

Within Windows, Synchro is capable of drawing street layouts and networks onto a map background which 
can be imported as a DXF file, JPG image, or BMP image which can result in powerful animation graphics for 
public viewing. Synchro also serves as a preprocessor to the CORSIM, and the HCS programs. This means 
that users are required to enter input data just once for subsequent analysis is multiple software packages. 
Synchro can also illustrate time-space diagrams. Chapter 6 of this manual contains detailed information 
about Synchro 6.  

TRANSYT-7F. TRANSYT-7F (Traffic Network Study Tool) is a macroscopic traffic signal model originally 
developed in the United Kingdom by the Transportation and Road Research Laboratory and later modified 
by the University of Florida Transportation Research Center for the Federal Highway Administration (FHWA). 
The basic premise of the analysis procedures used in TRANSYT-7F is the macroscopic, step-wise modeling of 
platoon progression and dispersion as it travels through a series of adjacent intersections. The TRANSYT-7F 
software has been designed to serve two primary functions. The first of these is the simulation of traffic as 
it flows through an arterial or network. The second is the development of optimized traffic signal timing 
plans. In both cases, it is required that all signals operate with consistent cycle lengths, though double cycling 
can be incorporated. 

When using TRANSYT-7F to simulate traffic operations, input data requirements are similar to those required 
for the analysis detailed in the HCM methodology. User inputs include volumes and turning percentages, 
cycle and phase durations, and roadway geometries. Unlike the HCM analysis methods, saturation flow rates 
for various lane groups must also be input by the user, rather than intrinsically calculated within the model. 
Therefore, it is essential that an accurate estimate of saturation flow rates be obtained, through either field 
measurements or some other analytical means.  

When using TRANSYT-7F for system optimization, much of the input data requirements are the same as 
those discussed above. Specifically, TRANSYT-7F requires that the user input phase sequences and minimum 
splits. It has the ability to optimize other signal settings, such as cycle length, phase lengths, and offsets. 
These values are optimized through either minimization or maximization of a user selected objective 
function, or performance index (PI). Options for this PI include minimization of a disutility index (DI) which 
is a linear combination of delays, stops, fuel consumption, and, optionally, excessive queuing; minimization 
of excess operating cost; or optimization of “forward progression opportunities”, which may also be done in 
combination with the disutility function. 

Output reports produced by TRANSYT-7F, like the HCM, indicate both degree of saturation and delay for 
each lane group. TRANSYT-7F delay, like delay calculated with the HCM methodology, is a combination of 
uniform delay and random plus saturation delay. To calculate uniform delay, TRANSYT-7F simulates traffic 
flow, step by step throughout the cycle, to develop queue lengths. TRANSYT-7F then uses an algorithm to 
estimate uniform delay from these simulated queue lengths. When conducting the simulation, TRANSYT-7F 
accounts for the arrival pattern, due to upstream intersections and platoon dispersion, as well as lane group 
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start-up lost time and extension of effective green. Thus, unlike the HCM methodology, TRANSYT-7F 
calculates uniform delay based on simulation of the traffic flow. Therefore, no delay factor is necessary to 
account for the impacts of progression, since it is intrinsic in the flow profiles. 

The second portion of delay, random plus saturation delay, is computed using the same algorithm found in 
the HCM for d2. The delay calculated by TRANSYT-7F is total delay, rather than stopped delay. To equate 
TRANSYT-7F delay to HCM level of service, HCM level of service thresholds should be increased by a factor 
of 1.3. 

Where the HCM methodology computes these measures of effectiveness based on a peak 15 minute flow 
period, TRANSYT-7F simulates only one cycle. Therefore, the MOEs should be viewed as an average for the 
analysis period. Thus, TRANSYT-7F, like the HCM methodology cannot account for effects of queues which 
develop over time during periods of oversaturated flows. For lane groups whose V/C exceed 0.95, calculated 
delays should be used cautiously. TRANSYT-7F, unlike the HCM, does have the ability to determine another 
MOE, maximum back of queues (MBQ). This MBQ is based on arrivals on red, also incorporating vehicles 
that may join the back of the queue as the queue dissipates during the allotted green time. While TRANSYT-
7F cannot model the effects of spillback, this value provides a good indication of whether it is occurring.  

TRANSYT-7F produces various other measures of effectiveness that are useful in evaluating intersection 
performance. These include total travel and total travel time, stops, and fuel consumption. In addition to 
these intersection MOEs, TRANSYT-7F outputs also provide route and system MOEs. These include total 
travel and travel time; uniform, random, total, average, and passenger delays; stops; speeds; fuel 
consumption; operating costs; and performance index. 

Refer to http://mctrans.ce.ufl.edu/featured/TRANSYT-7F/ for additional details. 

PASSER II. PASSER II-90, or Progression Analysis and Signal System Evaluation Routine, is not a simulation 
model like TRANSYT-7F or NETSIM, but rather utilizes a discrete, macroscopic, deterministic traffic analysis 
and signal timing model. (Although a simulation mode has been added as part of this version for analyzing 
uncoordinated operation.) This program is capable of handling isolated intersections or arterials only; it does 
not model signal grid networks. 

In general, PASSER II-90 combines algorithms developed for this, and other, model(s) with HCM 
methodologies to analyze and optimize signals along an arterial. In particular, PASSER II-90 utilizes Webster’s 
method as part of the optimization of cycle length and splits. Instead of simulation, PASSER II-90 uses 
algorithms to determine probability of queue clearance, percent green within the band, and all MOEs. 
PASSER II-90 is designed to select an arterial wide cycle length (it does not consider double cycling), 
intersection phase sequences which best serve progression, phase length, and offsets. One issue that many 
users may need to consider is that this version utilizes methodologies from the 1985 HCM, not the 1994 
update to the HCM. MOEs estimated by PASSER include degree of saturation (v/c ratio), delay, stops, 
maximum queue length, fuel consumption, minimum delay cycle, bandwidth efficiency and attainability, and 
Levels of Service. 

The main thrust of PASSER II-90 is to optimize a series of signals, allowing for the greatest possible 
bandwidth, for either one- or two-way flow, depending on the user’s specifications. This goal differs from 
that of Synchro and TRANSYT-7F, which develop their optimization procedures around delay. The best cycle 
determined by PASSER II-90 is chosen to give the highest bandwidth efficiency, which may or may not 
correspond to the lowest delay. Unlike TRANSYT-7F, PASSER II-90 does consider different possible lead/lag 
and overlap phasing when optimizing. 

PASSER II-90 calculates delay using variations of the uniform and random delay terms found in the 1985 
HCM. Calculation of uniform delay is fundamentally the same as the HCM equation for dl, with an adjustment 

http://mctrans.ce.ufl.edu/featured/TRANSYT-7F/
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made to account for progression allowing platoon arrivals during green, and queue formation and 
dissipation. Random delay is calculated as in the 1985 HCM, with the exception that the calculation may be 
performed for either a one hour or fifteen minute period. Random delay, as calculated in the HCM, is for a 
fifteen minute period only. The PASSER II-90 delay model calculates the total, or approach, delay, not 
stopped delay as defined in HCM level of service. HCM level of service threshold values are increased by a 
factor of 1.3 to account for this difference between stopped and approach delay.  

PASSER II-90 also incorporates other areas and factors of the 1985 HCM. One such item is an assistant 
function which aids the user in calculating saturation flows based on HCM adjustment factors. Also, PASSER 
II-90 contains an algorithm that roughly models shared lanes. This includes whether the lane will operate as 
a “de facto” left turn lane, as in the HCM. There are also various methods in which PASSER II-90 may model 
permitted movement. The user is allowed to use the HCM (1985) model, their own, or several other 
developed models. If the user wishes to stay as close to HCM methodologies as possible, he/she should be 
aware that the default method used is not the HCM model, but the TEXAS A&M model. 

PASSER II-90 also calculates the volume to capacity (v/c) ratio in the same manner found in the HCM. While 
saturation flow may be calculated using HCM methodologies, the importance of accuracy in this value 
cannot be overstated. As with the other models discussed, an incorrect saturation flow can have a 
measurable effect on the quality of results and recommended timing and offsets. Saturation flow in one 
crucial area where engineering judgment must be keenly used, through field studies or other methods, to 
assure accurate reflection of local, existing conditions. Users must also be cautious in saturated conditions, 
since spillback is not directly modeled and will not be taken into account. 

Refer to http://ttisoftware.tamu.edu/fraPasserII_02.htm for additional details. 

TSIS-CORSIM. The CORSIM (TRAF-NETSIM) model, originally named UTCS-1S, was developed in the early 
1970’s under the direction of FHWA. Originally designed for mainframe usage, TRAF-NETSIM was later 
converted to a microcomputer version and became part of the TRAF-family of models. The TRAF family of 
models is a set of simulation models, each representing a particular traffic environment, that when 
combined may represent an entire traffic system. NETSIM’S role in the TRAF family is to model the urban 
traffic environment (i.e. intersections), including signalization, stop signs, yield signs, buses, pedestrians, etc. 
In general, NETSIM is a surface street network (urban traffic) microscopic stochastic simulation model. 
NETSIM has no direct optimization feature.  

Briefly, a microscopic model is one which models each vehicle as a separate entity, contrasted to the 
macroscopic models discussed which model groups or platoons of vehicles. Microscopic models tend, by 
their nature, to provide a more detailed model of the traffic environment and vehicle interaction. Stochastic, 
according to Webster’s Dictionary of the English Language, is defined as “pertaining to chance or 
conjecture..., random”. Therefore, NETSIM accounts for the randomness of the traffic, the mix of car and 
driver types, in an attempt to reflect the “real world”. 

An understanding of the stochastic nature of NETSIM is crucial in gaining insight into the nature, operation, 
and methodology of the model and how it relates to the HCM. First, recall that the HCM provides a set of 
equations where a specific set of traffic, roadway, and signal conditions will always result in the same 
capacities and delays. In NETSIM, the same traffic conditions will not always result in the same MOE values. 
By utilizing the randomness of the model, the traffic stream may be “re-mixed”. NETSIM stochastically 
assigns turn movements, free-flow speeds, queue discharge headways, and vehicle and driver attributes, 
allowing for the same “traffic” to yield varying MOES. To account for this randomness of the model, it may 
be necessary to perform a statistically sufficient number of runs, averaging the results, to better reflect real 
world variation. It is readily realized that an arterial will not operate identically on any two days. One Friday 
is different from the next, which is different from the next, etc. 

http://ttisoftware.tamu.edu/fraPasserII_02.htm
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Vehicle movement in the model is based on car following and lane changing logic, and response to traffic 
control devices and other demands. NETSIM accounts for “driver behavior characteristics” (i.e. passive or 
aggressive), vehicle characteristics (up to 16 different vehicle types with different operating and 
performance characteristics), vehicle interactions, traffic control devices (pre-timed and actuated signals, 
stop and yield signs), street system geometry, buses, pedestrians, etc. NETSIM also allows for the traffic 
environment characteristics to change over time, such as changes in signal timings and traffic volumes.  

Unlike the other models discussed, NETSIM does not utilize the HCM delay or critical degree of saturation 
equations. Whereas HCS is an attempt to use traffic attributes (volumes, signal timing, geometries, etc.) to 
predict the capacities, delays, queues, etc. with a set of equations and factors, NETSIM uses these traffic 
attributes to generate a simulation of the traffic flow, from which the MOEs are directly measured. That is, 
the amount of delay experienced by each car is physically measured, from which an average is determined 
(both stopped and approach). The MOEs of the simulation may be thought of as being measured in much 
the same manner as field measurements would be performed.  

As stated, NETSIM has been in use since the early stages of transportation modeling, and has been used by 
many people to successfully and accurately reflect traffic flow. While NETSIM uses direct measurements, 
rather than predictions, to determine MOEs, any measurements are only as accurate as the simulation from 
which they are based. Therefore, calibration and validation of the simulation are crucial in the creation of 
an accurate model. This cannot be overstated for this or any other model. Items such as queue discharge 
characteristics, driver types, length of entry links, etc. may require study and engineering judgment when 
developing a model. 

Refer to http://mctrans.ce.ufl.edu/featured/TSIS/ for additional details. 

Highway Capacity Software (HCS). The HCS implements the procedures defined in the 2000 Update to the 
Highway Capacity Manual (HCM) from the Transportation Research Board (TRB). The software includes 
analysis modules on (1) Basic Freeway segments, (2) Weaving areas, (3) Ramps, (4) Multilane Highways, (5) 
Two-Lane facilities, (6) Signalized intersections, (7) Unsignalized intersections, (8) Arterials segments, (9) 
Transit, and (10) Freeway facilities analysis. 

HCS-2000 and HCS+ were developed by the McTrans Center at the University of Florida as a typical Windows 
(all operating systems versions) installation.  

The HCS Signalized Intersection module entry screen has been organized to consolidate data entry with the 
factors affected in the analysis. In this arrangement, the results of changing input data are readily apparent. 
The Report Pane will produce output similar to the HCM and previous versions of HCS which follow the 
Volume, Saturation Flow, Capacity and Level of Service worksheets. 

Operational analyses will typically solve for Level of Service (LOS) for a given set of operational and geometric 
conditions. This type of analysis is oriented toward the evaluation of an existing facility or specific design 
proposal. The methodology uses the HCM Chapter 16 procedures. 

Tru-Traffic (formerly Tru-Traffic) is a worksheet for drafting time-space or platoon-progression diagrams. It 
allows the user to see the entire diagram in colorful, high resolution on the screen. Although Tru-Traffic 
offers some automatic optimization options, it was developed with the idea that some decisions in signal 
timing are based on factors that cannot be quantified easily or accurately for a computer (e.g., driver 
perception, citizen complaints, queue length, local policies, etc.) and therefore must be made by a human.  

Tru-Traffic allows the user to see one or more diagrams, easily modify any parameter (phase sequence, 
offset, cycle length, splits, etc.) for any intersection, and instantly see the effects of the change. Thus, the 
user can quickly optimize the parameters. On time-space and time-location diagrams, it automatically 
adjusts the green bands to show the traffic flow. On platoon-progression diagrams, it shows the flow density 

http://mctrans.ce.ufl.edu/featured/TSIS/
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and queue lengths, much like the diagrams of PPD, the TRANSYT-7F post processor (except that the 
parameters may be changed interactively with the mouse or cursor keys, and the diagrams are displayed on 
the screen rather than just on the printer). 

Tru-Traffic handles signalized networks or intersecting arteries by allowing multiple diagrams, each in its 
own diagram window, and each representing a different artery. The common intersections are "linked" 
across diagram windows so that the user may edit the parameters in any diagram window, and Tru-Traffic 
ensures that the common parameters between linked intersections stay concurrent. 

Using a GPS Receiver connected to your computer will allow Tru-Traffic to track position and speed. The 
collected information may be used to: 

 Calculate the distance between intersections,  

 Lay out the Network View with high accuracy,  

 Display your current location in time and space on the diagram window and in the Network View,  

 Predict whether you will arrive at the next signal during the green time, and  

 Record Trip Logs of travel along the artery. Trip Logs can be  

 Plotted as trajectories on the diagram windows, graphically showing where delay occurs, which signals 
you're stopped at, and where you enter or leave the green bands. Before and after trip logs may be 
recorded in the same diagram data file, and you may select which ones are visible at any moment. 

 Used to prepare comparative Travel Time and Delay Reports (before vs. after runs), which can easily 
be copied and pasted into word-processing documents or spreadsheets for detailed analysis. These 
can be very powerful tools of analysis for determining the effectiveness of a timing plan.  

 Plotted as Speed vs. Distance or as Time vs. Distance plots  

 Used to measure the actual travel distance between intersections.  

 Used to calculate the "optimal" relative offset between intersections for a given direction of travel.  

 Used to calculate the actual average speed between intersections 
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Exhibit 5-1 Travel Time Runs in Tru-Traffic 

 

Timing Plan Needs 

In order for a traffic signal system to operate under coordinated traffic responsive (TR) or time of day (TOD) 
control, it is necessary to develop various signal timing plans. For traffic responsive operation, the traffic 
control plan is selected based on the actual traffic demand along the corridor. System detectors transmit 
volume and occupancy data to the master controller which then selects the timing plan based on 
predetermined threshold values for various volume levels and directional preferences.  

For TOD operation, the timing plan for varying volume levels and directional preferences is selected based 
on the time of day, day of week, and week of year. Traffic responsive operation has the advantage that it 
can change the timing plan to account for varying conditions if the traffic demand is different than that 
predicted for use in the TOD plan.  More details on these operational modes is covered in later sections. 

The number of timing plans required is influenced by a number of factors but largely depends on the traffic 
variability throughout the year, week and day.  The following graphic illustrates traffic variability averaged 
over 7 days and is used to determine how many timing plans are needed and when to conduct the pattern 
changes.   
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Exhibit 5-2 Sample Average Weekday Hourly Directional Volumes 

 

 

When the resources are available, the following timing plans should be investigated for three different 
volume levels with three different directional preferences, as follows: 

Exhibit 5-3 Sample Directional Coordinated Timing Plans 

Volume Level (TR) Plan Number Time of Day (TOD) Directional Preference 

Low 1 Low AM Peak Inbound Flow 
 2 Low Off Peak Balanced 
 3 Low PM Peak Outbound Flow 
Medium 4 Medium AM Peak Inbound Flow 
 5 Medium Off Peak Balanced 
 6 Medium PM Peak Outbound Flow 
High (Peak) 7 High AM Peak Inbound Flow 
 8 High Off Peak Balanced 
 9 High PM Peak Outbound Flow 

Implementation 

The initial timing plans should be implemented and fine-tuned. This implementation should include, as a 
minimum, the following three steps: 

 Field verification of the initial timings of each plan should be performed. This will include verification 
of cycle lengths, splits and offsets. 

 Field assessment of traffic operations resulting from each plan. This will include observations of 
intersection operations for several cycles during peak hours and trial runs along both directions of 
arterials (at the prevailing speed) to ascertain progression. Changes to splits and/or offsets should be 
implemented as necessary. 

 Reassessment of traffic operations resulting from revisions to the timing plans. 

An accurate record of all field revisions to the timing plans should be prepared. 

“After” Conditions 

An “after” study of the new timing plans for comparison to the “before” study results should be performed. 
This effort should occur after a “stabilizing period”. 
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Comparisons between “before” and “after” data should be performed for: 

 System-wide measures-of-effectiveness output from the simulation models, and  

 Field-collected measures such as travel time. 

Also, refer to Chapter 4 for MnDOT’s procedure to time a traffic control signal. 

5.7 Traffic Signal Control Systems 

System Concept 

A system may be defined as an arrangement or combination of interacting or interdependent parts which 
form a unified whole serving a common purpose. The system concept as related to traffic signal control 
includes the methods, equipment, and techniques required to coordinate traffic flow along an arterial or 
throughout an area. 

System Objective 

The major objective of a traffic control system is to permit continuous movement and/or minimize delay 
along an arterial or throughout a network of major streets. This involves the selection, implementation, and 
monitoring of the most appropriate operational plan. Basically, a traffic signal system provides the 
appropriate and necessary timing plans for each intersection in terms of individual needs as well as the 
combined needs of a series of intersections. 

Relationship of Timing Plans to Traffic Control 

In the system concept a timing plan is defined by a combination of control parameters for one or more 
intersections based upon an analysis of demand. Timing plans can be provided as a function of equipment 
at the local intersection, the central control point, or both. Timing plans consist of: 

1. A system Cycle. A specific cycle length is imposed throughout the system covered by the timing plan. 

2. Split. All intersections in the system have defined splits which are the apportionment of the cycle to 
the various phases present at that intersection. 

3. Offset. Each intersection has a unique offset. The offset is the relationship of the beginning of the 
main street green at this intersection to a master system base time. Offsets are generally expressed 
in seconds. Properly established offsets along a street can potentially provide for smooth traffic flow 
without stopping. 

Basis of Selecting Timing Plans 

The selection parameters which define timing plans include: 

1. Historic Data Time of Day information compiled from traffic counts to reflect traffic volumes for 
specified time of day (morning peak, midday, afternoon peak, etc.) and day of week. 

2. Current Data Real time on-street volumes from traffic detection equipment. 

3. Special Data Special events, emergency route assignment, special right-of-way preemption (fire 
equipment, ambulances, buses, etc.) 

Types of Traffic Signal Control Systems 

Many combinations of methods, equipment, and techniques can comprise a traffic signal control system. 
Generally, these systems fall into the following basic types. 
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Time Based Coordinated (TBC) System 

This form of coordination utilizes non-interconnected controllers with auxiliary devices called time based 
coordinators. These devices use the power company supplied frequency to keep time very accurately. 
Various timing plans can be established with time of day and day of week plan changes. Since all 
intersections use the same power source, the time-based coordinators provide coordination without 
physical interconnection. 

Global Positioning System (GPS) receivers have been used for several years to provide a clock sync to ensure 
TBC is maintained. 

Interconnected Pre-timed System 

This type of system was originally developed for electromechanical controllers, but can also be used with 
some of the newer controllers. Local intersections are physically interconnected (usually by a 7-wire cable) 
to ensure coordinated operation. The system provides automatic re-synchronization should a signal go “out 
of step”. The number of timing plans is a function of the number of dials and the number of offsets and splits 
per dial; the most common system consists of a three-dial, three-offset, one-split combination. Timing plans 
are normally selected by a time clock or time dependent programming device. The local controller for one 
intersection may act as master controller for the system. 

Traffic Responsive System 

Basically, this is an interconnected system utilizing a master controller for pattern (Cycle/offset/splits) 
selection. Traffic detectors are used to sample directional volumes and detector occupancy. Volume and 
occupancy metrics determine which of the available patterns is selected (i.e., inbound, outbound, or 
average) based on predetermined thresholds. The master controller may be an analog or a digital computer. 

Interconnected Actuated Systems 

Generally a small system with a master-slave relationship (i.e., two or more fully-or semi-actuated local 
controllers with one acting as system master and controlling cycle length for the other controllers). Offset 
capability is limited. A variation of this system uses a system master, coordinating units, and local actuated 
controllers. The master may be traffic responsive or combination of time clocks. 

Traffic Adaptive System 

Traffic adaptive systems perform “real-time” adjustments to the cycle length, splits and offsets in response 
to traffic demand. Traffic adaptive systems require extensive detection inputs. Complete and accurate traffic 
flow data must be gathered, processed and communicated to the central computer.  

Advanced Traffic Management Systems (ATMS) 

ATMS are capable of monitoring and controlling thousands of intersection controllers using state of the art 
architecture like TCP/IP and NTCIP.  ATMS offer complete traffic and data management including real time 
field reporting for multiple users over distributed local and wide area networks and remote access. 

ATMS offer scalable software solutions that support a range of users including: 

 School zone flashers 

 Freeway management 

 CMS, VMS, DMS 

 CCTV surveillance 

 HOV lane control 

 Reversible lane control signals 
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 Real-time split monitoring and time space reporting 

 Incident detection 

 Light rail control systems 

 Transit priority systems 

 1.5 generation timing plan development using Synchro or PASSER 

 2.0 Generation control (Traffic Responsive and Traffic Adaptive) 

 Integrated video detection 

 Real time preemption log retrieval 

Time-Space Diagrams 

These are prepared to determine the offsets on individual intersections.  

A time-space diagram is a chart on which distance is plotted against time. The location of each signalized 
intersection is plotted along one axis. At each such point the signal color sequence and split are plotted in 
such a manner that through bands are available for each direction of traffic flow. The slope of the through 
band (distance divided by time) is the speed of progression, and width indicates the time available for a 
platoon traveling through systems. 

For two-way streets, the diagram is usually prepared to give equal consideration to each direction of travel. 
Where appropriate types of program controllers are available, separate peak-hour diagrams are prepared 
for streets carrying heavy directional peak volumes; these will favor travel in the peak direction. The cycle 
length may be changed (for the entire system) and the offsets are changed through the use of time clocks in 
the master controller. Sample time-space diagrams for off-peak and evening peak periods are shown in the 
figures below. 

When a coordinated system is established for a certain speed during all periods of the day, supplemental 
signs may be erected which inform the driver of that speed. 

Exhibit 5-4 Sample Time Space Diagrams 
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Complex Timing Systems. Development of timing parameters and programs for the more sophisticated 
signal systems is very specialized and depends greatly on the specific system components and configuration. 
Timing techniques, methodology, and philosophy are receiving considerable attention. Extensive research 
in these areas is continuing. Computer programs have been developed for timing networks such as Synchro. 

Control Philosophies for Computerized Traffic Signal Systems 

The progress of the state of the art in traffic signal control systems is a function of the technological 
development of computer applications and control philosophies. Generally, control philosophies may be 
categorized as follows: 

First Generation 

These programs are basically of the table look-up type. A number of essentially fixed timing patterns have 
been precomputed and stored. Control plans are selected based on time of day or on sensing certain 
demand parameters at strategically located detectors. As threshold positions are reached, alternative 
predeveloped and stored control plans are implemented. This procedure is used in most of the presently 
operational digital computer controlled systems. 

Second Generation 

This type of control program is still based on a background cycle, but provides for on-line, real time 
computation of control plans and strategies. It utilizes a prediction model to predict near-term (e.g., 15-
minute) changes in traffic demand. Current conditions and these predictions are then used in an on-line 
optimization program to compute splits and offsets. 

1.5 Generation Control 

1.5 GC utilizes on-line data collection and predetermined algorithms to generate input data to the TRANSYT-
7F timing program. A new timing plan is computed and compared to the existing timing plan. Currently, the 
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operator must decide whether the improvement is worth implementing on either a temporary or permanent 
basis. 

Comparison 

The FHWA sponsored extensive research in evaluating the first and second generations of control under the 
Urban Traffic Control System (UTCS) program. The abstract of the Executive Summary of the Evaluation 
Study states: 

“The First Generation...was found to be operationally effective, was the least expensive to apply, and should 
be given primary consideration for implementation. Second Generation proved effective on arterials, was 
only slightly more costly to implement than [first generation], and should be given consideration for areas 
with substantial arterial development.” 
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6 SYNCHRO AND SIMTRAFFIC 

The information following this sheet is a handout from the Synchro and SimTraffic training manual. 

  

 

 

 

  



MnDOT Traffic Signal Timing and Coordination Manual                                     

Page | 6-2 Synchro May 2017 

 

 

This page is intentionally left blank 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  MnDOT Traffic Signal Timing and Coordination Manual 
 

May 2017  Synchro and SimTraffic 

 

 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

   

 

 

 

Synchro and SimTraffic 
Training Course 

 
 

 

 

  

 

 

 

 

 

Page | 6-3



  MnDOT Traffic Signal Timing and Coordination Manual 
 

May 2017  Synchro and SimTraffic 

 

 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

Synchro and SimTraffic Course   ii  

TABLE OF CONTENTS 

1. COURSE INTRODUCTION .................................................................................................................................................. 1-1 

1.1 BACKGROUND .......................................................................................................................................................................... 1-1 
1.2 COURSE OBJECTIVES .................................................................................................................................................................. 1-1 
1.3 SYNCHRO ................................................................................................................................................................................. 1-2 
1.4 SIMTRAFFIC ............................................................................................................................................................................. 1-3 
1.5 WHICH MODEL TO USE? ........................................................................................................................................................... 1-3 
1.6 TO RUN SYNCHRO ..................................................................................................................................................................... 1-4 
1.7 ADDITIONAL INSTRUCTIONS FOR TRAINING.................................................................................................................................... 1-4 

2. LEVEL I – DAY 1 ................................................................................................................................................................. 2-1 

2.1 MAP VIEW INPUT ..................................................................................................................................................................... 2-1 
2.2 DATA ENTRY SETTINGS............................................................................................................................................................... 2-3 
2.3 LANE SETTINGS ....................................................................................................................................................................... 2-10 
2.4 VOLUME SETTINGS .................................................................................................................................................................. 2-15 
2.5 TIMING SETTINGS INPUT .......................................................................................................................................................... 2-18 
2.6 PHASING SETTINGS INPUT ........................................................................................................................................................ 2-25 
2.7 SIMULATION SETTINGS ............................................................................................................................................................. 2-29 
2.8 DETECTOR SETTINGS ................................................................................................................................................................ 2-34 
2.9 SYNCHRO DATA ENTRY QUICK START ......................................................................................................................................... 2-38 

3. LEVEL I – DAY 2 ................................................................................................................................................................. 3-1 

3.1 ANALYSIS OF INTERSECTIONS ....................................................................................................................................................... 3-1 
3.2 INTERSECTION OPTIMIZATION ..................................................................................................................................................... 3-5 
3.3 NETWORK AND MULTI-SYSTEM OPTIMIZATION ............................................................................................................................... 3-6 
3.5 PROGRAM REPORTS ................................................................................................................................................................ 3-10 
3.6 SYNCHRO INTEGRATION WITH SIMTRAFFIC .................................................................................................................................. 3-14 
3.7 3D VIEWER ............................................................................................................................................................................ 3-20 

4. LEVEL II ............................................................................................................................................................................. 4-1 

4.1 CALCULATIONS ......................................................................................................................................................................... 4-1 
4.2 TIME SPACE AND PLATOON DISPERSION DIAGRAMS ....................................................................................................................... 4-7 
4.3 ADVANCED INPUTS .................................................................................................................................................................... 4-9 
4.4 FILE AND PROJECT MANAGEMENT ............................................................................................................................................. 4-18 
4.5 OPTIMIZATIONS ...................................................................................................................................................................... 4-21 
4.6 DATABASE ACCESS AND UTDF .................................................................................................................................................. 4-23 
4.7 ADVANCED SIMTRAFFIC FEATURES ............................................................................................................................................ 4-28 

 

5/30/2015

Page | 6-4



  MnDOT Traffic Signal Timing and Coordination Manual 
 

May 2017  Synchro and SimTraffic 

 

 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

   

Synchro and SimTraffic Course  1-1 

1. COURSE INTRODUCTION 
1.1 Background 
This course and workbook cover the Synchro signal timing and analysis software, the 
SimTraffic simulation and animation package and the 3D Viewer. This course is broken down 
into the following levels: 

� Level I. The Level I course material can be found in Section 2 through 3 of this 
workbook and is a 2-day class. The objective of this course is to familiarize the 
participants with the input requirements for Synchro and SimTraffic and to review 
and understand the outputs. Through the use of a hands-on example, students will 
build a Synchro file of a signalized intersection network. Students will also learn to 
optimize this network, review and modify the results with the time-space diagram, 
overview of animation in SimTraffic and creating reports.  

� Level II. The Level II course material can be found in Section 4 of this workbook. This 
course is intended for individuals with working knowledge of Synchro and 
SimTraffic. Attendance at any of the Level I courses satisfies this prerequisite for the 
Level II course but is not required. The focus of the course will be on Synchro 
calculations, optimizations, and advanced example problems. 

1.2 Course Objectives 
The main emphasis of this course will focus on building, optimizing and analyzing a signal 
network with Synchro and simulating and animating the results with SimTraffic.  

At the end of each course, you will be able to: 

Level I  
� Create a map of the street and intersections in the Synchro program with and 

without the use of a background map (DXF or Bitmapped). 
� Enter the appropriate lane, volume, timing, simulation and detector information 

into Synchro. 
� Optimize individual intersection cycle length, splits and offsets within Synchro. 
� Optimize a network of signals for cycle length and offset. 
� Display and modify Synchro’s time space diagrams. 
� Understand the results displayed in the Synchro program. 
� Integrate Synchro data with the SimTraffic and 3D Viewer Programs. 
� Create reports to display timing information and measures of effectiveness. 

Level II  
� Understand the basic calculations used in Synchro to provide a better 

understanding of what is being output by the program. 
� Understand how Synchro performs an optimization. 
� Apply some of the features that are available, such as the UTDF. 
� Create some advanced examples of unique coding situations in Synchro and 

SimTraffic. 
� Apply some workarounds for Synchro and SimTraffic 

Page | 6-5
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1.3 Synchro  
Synchro is a complete software package for modeling and optimizing traffic signal timings.  
The key features of Synchro include: 

� Capacity Analysis. Synchro models intersection capacity, delay and LOS for signals, 
unsignalized intersections and roundabouts based on the Highway Capacity Manual 
(HCM, 2000 and 2010 versions).   

� Optimization: Synchro allows you to quickly generate optimum timing plans for 
isolated intersection and networks of signals to minimize delays (see page 3-5).  

� Actuated Signals: Synchro uses a Percentile method to model actuated signals (see 
page 4-1).  Synchro can model skipping and gap-out behavior and apply this 
information to delay modeling. 

� Time-Space Diagram: Synchro has colorful, informative Time-Space Diagrams. Splits 
and offsets can be changed directly on the diagram (see page 4-7). 

� Integration with SimTraffic, CORSIM (version 5) and HCS (version 3): Synchro 
features preprocessor to these software analysis packages.  Enter data once with 
easy-to-use Synchro, and then perform analyses with these software packages. 

Synchro is a macroscopic traffic software program that is based on the signalized intersection 
capacity analysis as specified in the Highway Capacity Manual (HCM). Macroscopic level 
models represent traffic in terms of aggregate measures for each movement at the 
intersections. Equations are used to determine measures of effectiveness such as delay and 
queue length. Traditional HCM based models do not account for "bottleneck" situations 
where upstream traffic deficiencies reduce the amount of traffic reaching downstream 
intersections. For example, if an upstream bottleneck occurs, macroscopic models assume 
the demand volume reaches the subject intersection. 

The HCM was recently updated (the 2010 HCM). Synchro 8.0 does include a report for the 
past 2000 HCM and the current 2010 HCM. In addition, Synchro has a data screen for the 
2010HCM methods (one does not exist for the 2000HCM).  

Macroscopic Model Limitations 
There are a number of important limitations to macroscopic models that users must be 
aware of. Below is a summary of, but not an all inclusive list of some limitations of Synchro, 
the HCM 2000 and the HCM 2010 Computational Engine. 

Limitation Synchro 8.0 HCM2010 HCM2000 

Turn Pocket Overflow All three methods have this limitation. If vehicles are spilling out of a turn pocket or thru vehicles are 
blocking a turn pocket, this delay that would occur in the field is not included in the model’s delay 
output.  

Spillback and Starvation 
Delay caused by closely 
spaced intersections 

Synchro includes a method to model 
this delay when intersections  are 
close to each other. 

The HCM methods do not include any delay for queue spillback 
or starvation.  

Actuated Green Time 
Calculations 

Synchro determines actuated greens 
based on a Percentile method. 

The HCM 2010 includes a 
comp engine that 
determines actuated 
greens.  

The HCM2000 methods do not 
calculate the actuated green. This 
is an input the user is expected to 
enter.  

Right Turn on Red 
Adjustment 

Synchro calculates a RTOR value and 
increases the capacity. 

In the HCM methods, the RTOR is a volume input by the user 
and becomes a volume reduction (not a capacity increase). 

As noted in text to the 
right, Synchro is based on 
the methods of the HCM. 
However, there are 
important differences 
between Synchro and the 
HCM.  

Synchro basically uses the 
same methods for 
Saturation Flow and 
Volume adjustments. 
However, the 2010 HCM 
now includes a comp 
engine to calculate 
effective green times. 
Synchro uses its Percentile 
Method since its inception 
when the software was 
released in 1994.  
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Synchro and SimTraffic Course  1-3 

Refer to the table in section 4.1 for additional situations where the Synchro results will vary 
from the HCM Methods.  

1.4 SimTraffic 
SimTraffic is a microscopic model used to simulate a wide variety of traffic controls, including 
a network with traffic signals operating on different cycle lengths or operating under fully 
actuated conditions. SimTraffic also models unsignalized intersections, roundabouts and 
channelized right turn lanes. 

In SimTraffic, each vehicle in the traffic system is individually tracked through the model and 
comprehensive operational measures of effectiveness are collected on every vehicle during 
each 0.1-second of the simulation. Driver behavior characteristics (ranging from passive to 
aggressive) are assigned to each vehicle by the model, affecting the vehicle's free-flow speed, 
queue discharge headways, and other behavioral attributes (see the SimTraffic driver 
parameters, page 4-32). The variation of each vehicle's behavior is simulated in a manner 
reflecting real-world operations. 

Since SimTraffic is microscopic, the model measures the full impact of queuing and blocking. 
This is a situation where SimTraffic may show more delay when compared to Synchro. 

Microscopic Model Disadvantages 
SimTraffic is categorized as a microsimulation model. For all if it’s strengths, there are 
disadvantages or limitations to consider. Some of these include, but are not limited to: 

� Computer time and storage requirements for microscopic models are large, usually 
limiting the network size and the number of simulation runs that can be completed. 

� SimTraffic does not optimize signal timings, it performs an experiment on the data 
that it is given. If changes are required, these must be done manually (in Synchro) 
and the model simulated again.  

� Calibration of simulation models is a time consuming, trial and error process. There 
is no single answer on how to calibrate a model. It is case dependent for the study 
area. 

� A single error or modeling problem can cause inaccurate results at all study 
intersections. This problem may create an artificial bottleneck preventing vehicles 
from moving downstream to be measured. 

1.5 Which Model to Use? 
The intention is to use Synchro and SimTraffic as companion models. Synchro to determine 
macro level LOS and delays, and SimTraffic to simulate and animate to determine the 
'problems' that may not be fully realized with a macro-level model. 

In summary: 

� Synchro may show more delay when upstream bottlenecks exist. 
� SimTraffic may show more delay when queuing and blocking problems exist.  

  

Synchro is used as the 
input editor for SimTraffic. 
But, as noted in the text of 
this manual, the results 
could be quite different. 
This is due to the nature 
of how the models 
determine measures. 
Synchro is macroscopic 
and SimTraffic is 
microscopic. Generally, 
microscopic models are 
more realistic, however 
they also are more time 
consuming and do not 
provide optimized results. 
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1-4   Synchro and SimTraffic Course 

1.6 To Run Synchro 
1. Select the Start Menu, then choose Programs→Trafficware→Synchro. 

2. The first time using Synchro you will be asked for a product key code.  This 
number will be listed on your invoice or press [Use as Demo] if you want to use 
the demo version. 

1.7 Additional Instructions for Training 
The software used for the training course is a temporary license key. Each time the software 
is launched in the training room, you will be asked to activate the software. Peform the 
following steps: 

� Double click on icon on desktop 
� Check the box to Accept the License Agreement 

 
� Choose “Activate”  
� Select OK on the Application Activation (information will be filled out for you) 

 
� Choose “Activate Later” 

 
� Select OK multiple times to open Synchro 

The Additional Instructions 
for Training are only 
required in the training 
room. On your PC at your 
office, the license will be 
activated over the internet 
(or phone) and these 
additional steps will not be 
required to launch the 
software. 
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2. LEVEL I – DAY 1 
2.1 Map View Input 
The MAP view includes the drawing area and the map information buttons. The drawing 
area of the MAP view is where you create your network links and nodes. 

To activate the MAP view, press the Map view button or press the [F2] key from 
anywhere in the program. By default, Synchro will show the MAP view when you 

start the program.   

 

How to Add a Link 

1. Select the Add Link button  or press the [A] key. 
2. Position the mouse cursor on the MAP view where you want the link to start, and 

click the left mouse button. The status indicators, at the lower-right corner of the 
settings, show the East and South coordinates in feet (meters). Note: To cancel 
adding a link, press [Esc]. 

3. Release the mouse button and move the cursor to the position on the map 
where you want the link to end. Click the left mouse button again. Refer to the 
status bar at the bottom of the settings to see the length and direction of the link 

To draw links that are orthogonal or at 45 degrees, hold the [Shift] key while creating your 
link.  

To draw a curved link, right click on the link and choose Add-Curvature. Use the squares to 
move the link to the desired curvature. Synchro will recalculate the link distance. 

How to Add an Intersection 
To create an intersection, simply create two or more links that cross each other. If you have a 
node that is connected by exactly two links, this is defined as a bend node. Three or more 
links (up to eight) will create an intersection node. 

It is not necessary to 
determine the exact length
of the links. It is sufficient 
to determine the distance 
to within 20 or 30 feet (6 
to 8 meters). The 
minimum distance for a 
link is 70' (center of 
intersection to center of 
intersection distance). 

Synchro uses the link 
distance and speed to 
calculate travel time. The 
travel time is used in the 
determination of arrival 
patterns, which is then 
used in the delay 
calculations. 

In the Map view, hold your 
cursor over the button to 
see a pop-up text 
description of the button. 

 

 
In version 9.0, the toolbar 
can now be moved 
throughout the map and 
can be customized based 
on user preference. 

When creating external 
links, make these long 
enough to hold the 
queues that would build 
during a simulation.  In 
SimTraffic, the queues 
are limited by the link 
distances. 

Intersections cannot be 
created on curved links. 
Be sure to add all 
intersections, then curve 
links. 

Page | 6-9



  MnDOT Traffic Signal Timing and Coordination Manual 
 

May 2017  Synchro and SimTraffic 

 

 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

2-2   Synchro and SimTraffic Course 

Bends 
A node with exactly two links is a bend.  A bend is a special case of an unsignalized 
intersection.  

  
Bend nodes increase the time for calculations. Excessive bends and short links cause 
SimTraffic to simulate at a slower rate.  

How to Delete a Link 
To remove a link from the map: 

1. Select the link by clicking on it with the left mouse button. 

2. Press [Delete] or select the Delete Link button .  
3. Select [Yes] to the question, "Delete Link, are you sure?" 

The link will be removed from the screen. 

How to Delete an Intersection 
To remove an intersection from the map: 

1. Select the intersection by clicking on it with the left mouse button.  

2. Press [Delete] or select the Delete Node button . 
3. Answer [Yes] to the question, "Delete Intersection, are you sure?" 

Any through links going through this intersection will be joined together.  Any other links 
going to adjacent intersections will be shortened to preserve data at adjacent intersections. 
Any joined links will be redrawn. 

How to Move an Intersection or External Node 
To move an intersection or external node on the map: 

1. Select the Move Node button  or press the [M] key. 
2. Select an intersection, or the end of an external link, by clicking on it with the left 

mouse button. Note: If you decide to cancel moving a node after starting, you 
can cancel the operation by pressing [Esc], or clicking the mouse button at the 
original node location. 

3. Drag the intersection, or node, to the new location and click the left mouse 
button. 

In Version 6 and later of 
Synchro, bend nodes are 
needed less frequently due 
to the use of curved links. 
The main purpose of bends 
now will be to create a 
downstream taper. 

If you make a mistake, 
Synchro will let you Undo 
the command. Synchro 
remembers the last 100 
commands (such as 
adding a link, optimizing 
splits, etc). You can also 
Redo. Use the buttons on 
the toolbar, the File 
Commands under Edit, or 
[Ctrl]+Z to Undo and 
[Ctrl]+Y to Redo. 

To draw a link that crosses 
a link and does not create a 
node (overpass/underpass), 
hold the [Ctrl] key while 
drawing the link. 

Create a bend at the 
location of a mid-block lane 
drop (or add). 
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If an external node is moved onto an existing intersection, or node, it will be combined with 
that intersection, or node. Intersections cannot be moved onto another intersection or 
external node. 

When moving an intersection, it is possible that the realigned links will have new directions 
in such a way that lane groups will be changed. For example, if the relative angle between 
two links is changed from 180º to 90º, there will no longer be a through lane group for these 
links. Synchro preserves the lane group data. If a movement changes from NBL to NBT, for 
example, the data for NBL will be transferred to NBT. 

Link Directions 
Links are directional. The angle is shown in the lower left hand corner of the Map View as 
you are creating the link. North is always up (zero degrees). Directions are then based on the 
angle as noted in the table and graphic below.  

The graphic and table assume drawing from the center node point. For instance, a link 
created at 35 degrees would be labeled as SW (toward the intersection) and NE away from 
the intersection.  Synchro will allow up to eight links.  

 
The exception to the above table is when you have two links within the angle ranges. For 
example, if you have a link at 0 degrees and one at 34 degrees. Based on the table, both 
would be SB towards the intersection. However, Synchro will only allow one link to be 
labeled as SB. Therefore, the link closest to zero degrees will be labeled as SB. The other will 
be labeled with the closest diagonal direction.   

Link Menu Options  
Synchro now includes additional options from the Link Menu. To access 
the Link Menu, right click on the link within the Map View. The new 
options in the Link Menu include; Street Name Up, Move Street Name, 
Hide Street Name, Switch Diagram Position and Move Volume Diagram. 

Select Intersection   
Use the Select-Intersection button or the [F8] key to bring up a list of the intersections in 
your network.  This will bring up the SELECT INTERSECTION window. 

Choosing an intersection from the list and pressing [OK] will switch the current window to 
that intersection.  The Map View will be centered on the selected intersection.   

2.2 Data Entry Settings 
Data can be input, edited and viewed with the data entry setting buttons after links and 
nodes have been created in the MAP view.  

WB

90o

180o

270o

0o

45o

135o225o

315o

NW

NBNE

EB

SE

SB SW Link Angle Approach Heading
Towards Int. Away from Int.

326 - 34 SB NB
35 - 55 SW NE
56 - 124 WB EB

125 - 145 NW SE
146 - 214 NB SB
215 - 235 NE SW
236 - 304 EB WB
305 - 325 SE NW

Remember, hold the [Shift] 
key to create links that are 
Orthogonal (N, S, E, W) or 
at 45 degree angles. 

Note: To center the MAP 
view, press [Ctrl]+[C] and 
the click where you want 
the map to be centered. 

The on-line Help is always 
available in Synchro and 
SimTraffic. From anywhere 
in the program, press the 
[F1] key to bring up the 
Help file. 

The Help file is fully 
searchable (PDF format). 
Click on the Search button 
and perform a search on 
your keyword or text. 

See page 2-10 for details on 
changing the name of the 
approach direction. 

Use the Transform Map 
button to rotate an entire 
network. 
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2-4   Synchro and SimTraffic Course 

The data entry buttons are grayed out and not accessible until either a link or node is 
selected on the map.  

 

Full View Data Entry 
Data entry in Synchro can be performed with a traditional full screen view or a MAP view 
side entry. In full view data entry, the MAP view will disappear. To activate, highlight an 
intersection from the MAP view and select the desired data entry button along the top of 
Synchro.  

When in the full view of the PHASING and TIMING settings, press the [F9] key to move focus 
between blue (directional) and yellow (node) sections.  

The full view data entry screens will show all available movement headings. The available 
movement headings will depend on the layout of the links. For instance, a T-intersection will 
have 6 columns visible and a 4-leg intersection will have twelve columns visible.  

The direction headings are based on the angle of the link as drawn in the MAP view (north is 
always up, or zero degrees). 

Side View Data Entry 
In addition to a full view data entry screen, data can also be entered with a side view screen. 
This view displays the data entry rows on the left side of the MAP view allowing you to see 
the data update as you enter. To activate the side view data entry, double click on a link 
approaching an intersection.  

Background Images 
Synchro allows the ability to import a DXF, SHP, SID, JPG or BMP file as a background image. 
In addition, version 8.0 has added the ability to import a background via Bing™ images.  

A background image is just 
that… an image that lies in 
the background. The 
image is an excellent tool 
to help you quickly create 
your network. However, it 
will have no impact on 
your results. 
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Select Backgrounds Window 
To add, remove, or adjust backgrounds; select File→Select Background.  

If no files are attached, the user is prompted for a file or multiple file(s).  The files can have 
the extension JPG, JPEG, BMP, DXF, or SHP as defined above.  

 
The list of files is shown in the Background File List as shown as “A” above. This file list 
includes the following:  

� Filename is the background image filename including the path. 
� Type is the type of file (Bitmap, SHP, DXF, JPG).  
� X, Y is the Synchro coordinate for the upper left hand corner of the image. 
� X2, Y2 is the Synchro coordinate for the lower right hand corner of the image. 
� X Sc, Y Sc is the image scale factor. 
� Color allows you to change the color of a GIS shape file. 
� Hide will hide the background image when checked. 
� Remove will remove the image from the background. 

Use the Add File(s) button (“B”) to select one or more files.  

The Compress JPEG Files button (“C”) will prompt you for JPEG files. The selected files will be 
loaded and resaved with higher compression, but less quality.   

The Convert SID files area (“D”) provides access to the MRSIDDECODE.EXE, freeware utility. 
This is an unsupported DOS tool to help convert SID files into JPG.  

See the following section for item (“E”) setting the bitmap scale and offset. See the section 
below for item (“F”) on importing and image from Bing™.  

To set the scale and 
coordinates for a BMP or 
JPG, double click on the 
coordinates of the file. This 
is Item E in the image to 
the right. 

DXF and SHP files are 
scaled images. Therefore, 
you simply import these 
and they will be at the 
proper scale. 

A JPG and BMP is a 
pixilated image that 
requires scaling. 

This Compress function 
will alter your existing JPG 
files and reduce the image
quality.  Use this feature 
to reduce the file size of 
background bitmaps. 
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2-6   Synchro and SimTraffic Course 

Set Bitmap Scale and Offset 

When loading a bitmap file (bmp or jpg) it is necessary to set the scale and base point. From 
the Select Background window, double click the scale settings (“E”) to set the bitmap scale 
and offset. The SET BITMAP SCALE AND OFFSET window will appear as shown below. 

 
The upper-left corner of the bitmap will have bitmap coordinates (0,0) in pixels. In an existing 
Synchro file, it is necessary to match a point on the bitmap to a node in the Synchro file.  

1. Click [Find] for world coordinates and select an intersection on the Synchro map. 
This will set the World coordinates for the base point 

2. Click [Find] for bitmap coordinates and select the point on the bitmap in the 
center of the previously selected bitmap. This will set the Bitmap coordinates for 
the basepoint. The bitmap will be placed so that the bitmap intersection is 
coincident with the Synchro intersection. 

It is necessary to set the scale of the map. To help set the scale, Synchro allows you to 
measure distances on the bitmap and in an existing Synchro map.  

1. Click [Measure] for Feet (or Meters) and select the first point on a link of known 
length. Within a new file, simply type in the distance of a known street length. 

2. Click on the second point of the Synchro point with known length. This will set N 
in the formula, N feet per M pixels. 

3. Click [Measure] for Pixels and select the starting point of the same link on the 
bitmap.  

4. Click on the second link point on the bitmap. This will set M in the formula N feet 
per M pixels. 

Using Bing™ to Add a Background Image  
Synchro 8 now allows you to import images directly from Bing™. This feature will greatly 
assist in importing internet based images and ensuring that the scaling is appropriate. It will 
also be useful to create a mosaic of images that will properly align. To use this option, an 
internet connection must be available during the import (not necessary after the image is 
captured).  

It is very important to 
keep the size of the files 
used as small as possible.  
All of the bitmaps and 
other files are loaded into 
RAM and accessed 
whenever the map view 
changes. 

You can hide/unhide 
images of interest to help 
keep the PC memory 
footprint reasonable. 
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In a new or existing Synchro file, use the command select File→Select Background  and 
select the Use Bing ™ Aerials button. 

After selecting the Use Bing™ Aerials button, there is a new window Get Map dialog (see 
below) that uses Bing™ (aka Virtual Earth). 

Get Map Dialog Options 

 
Set Reference 

After pressing Set Reference menu (“A” in the figure above), click the mouse on the Bing™ 
map to choose a reference point. You will see a pushpin on the selected point followed by a 
Set Synchro Reference Point window. Select a corresponding point on the Synchro MAP View 
or to manually enter a World Coordinate (see the image below). The Map and Synchro points 
will denote the same geographic point to tie the world map to the Synchro coordinates. 

 
Set Boundaries 

Press the Set Boundaries menu (“B” in figure in above) and choose the 1st and 2nd boundary 
points and set their position on the Bing™ map by clicking the mouse in the opposite corners 
of the desired map location. The boundary points will be shown as red pushpins and will 
mark the map area to be converted to the background image.   
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2-8   Synchro and SimTraffic Course 

Preview Selection and Image Zoom 

Press the Preview Selection menu (“C” in the figure above) to preview the map and adjust its 
scale by clicking on Image Zoom menu and choosing Zoom In/Zoom Out (see next step). 
Bing™ does not provide the maximum zoom for all locations, so previewing the map and 
using Zoom Out if necessary may guarantee that the map will be saved correctly to the 
background image. 

Image Zoom 

After choosing the Preview Selection menu, use the Image Zoom → Zoom Out or Image 
Zoom → Zoom In (“D” in the figure above) to achieve the desired image scale. If Zoom In is 
not available, then the image is at the closest zoom possible for the area. Using the Zoom 
Out will give a lower resolution (quality) image, however the file size will be reduced. If you 
use the highest quality (fully zoomed in) option, the file size of the image will be higher and it 
will take longer to download the image(s). 

Save Selection 

Select the Save Selection menu (“E” in the figure above)  to save the selected map area to a 
single JPG or multiple JPG files. There may be certain restrictions to the size of a single image 
file, so saving to the multiple files allows one to create a background for a bigger map area. 
The program automatically creates a folder with a set of the multiple image files to cover the 
selected background image. 

Show Map  

The Show Map menu (“F” in figure in the figure above) will return to the Bing™ world map to 
select a different area to be converted to the background image. 

Map Settings 
Use the command Options→Map-Settings to open the MAP SETTINGS Window. This 
window can be used to control the view of the Map View. 

Often, it is nice to turn on the Intersection Paths in the Map Settings when coding your 
networks. 

Basic Node Settings 
To activate the NODE settings, double click on an intersection or select an intersection and 
press [Enter]. 

Node Number 

All intersections and external nodes are assigned a unique node number. used to identify the 
node in reports and data exported to CORSIM, HCS and UTDF files. 

Zone 

Synchro allows intersections to be assigned to zones. Zones are useful for analyzing a section 
of a network. Use zones to keep the timings for some intersections constant while the 
timings for other intersections are changed. 

Node Coordinates 

The NODE settings allow the X, Y and Z coordinates to be entered exactly. The coordinates of 
the nodes are used in the layout of the map and the geometry of intersection approaches. 

Use the [Esc] key to cancel 
a command. For instance, 
if you have clicked on the 
[Color] button in the Map 
Settings window, use [Esc] 
to back-up without 
changing the color. 

The Node number will 
establish the order that 
intersection reports are 
printed. 

Zones can be used to 
optimize sections of your 
file; print portions of your 
file and to set network 
settings for a section of 
your file. 
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The X, Y and Z coordinate settings provide a convenient method for moving intersections to 
exact coordinates. The coordinates are for the center point of the intersection. For traffic 
engineering purposes, it is good enough to have the coordinates to within 20 feet.  

To create an overpass, assign a higher Z coordinate elevation to the nodes of the overpass 
link. The Z elevation is only used for visual purposes. 

Description 

The Description cell is a convenient location to type notes about the intersection. The 
information will appear at the bottom of the Intersection Reports. 

Default Settings 
The following settings have a [Default] button available: 

� Network Settings (Synchro) 
� Report Settings (Synchro and SimTraffic) 
� Map Settings (Synchro and SimTraffic) 
� Driver and Vehicle Parameters (SimTraffic) 
� Interval Parameters (SimTraffic) 

Using the [Default] button loads in the defaults for the given dialog, window or view. 

The defaults are read from a no intersection file (defaults.syn) in the Trafficware directory.  
When a user has a file with preferred defaults settings, it can be saved as the “defaults.syn” 
file and placed in the Trafficware directory (or wherever Synchro is installed). If an 
organization wants to have standard settings for everyone, they can deploy a defaults.syn to 
all users.  Also see Section page 2-37 for information on default detector settings. 

View Ports in Synchro 
Users have the ability to create up to four view ports in Synchro. 

 

Scenario Manager Dialog 
The Scenario Manager is used to populate the report header and footer information. 
In the past, updating the Scenario Manager for a new file (scenario) was often 
overlooked. In Version 8, the Scenario Manager dialog window appears when you 
save a Synchro project with another name as well as when you create a new Synchro 
project. 

 

 

Some organizations may 
lock down the application 
directory. Therefore, the 
administrator may need to 
change or deploy the 
defaults file. 

Synchro defaults are 
stored in the 
“Defaults.SYN” file. The 
SimTraffic defaults are 
stored in the 
“Defaults.SIM” file. If you 
are sharing your defaults, 
be sure to send both files.

Page | 6-17



  MnDOT Traffic Signal Timing and Coordination Manual 
 

May 2017  Synchro and SimTraffic 

 

 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

2-10   Synchro and SimTraffic Course 

2.3 Lane Settings 
From the MAP view, click on the desired intersection with the Right mouse button and select 
Lanes. 

From anywhere in the program, press [F8] and select the desired intersection from the list. 

Then push the Lane Settings button  or the [F3] key. 

The LANE Settings displays a grid in which you can enter lane and geometric information. 

 

Lanes 
Under the appropriate picture, enter the number of lanes for that lane group.  

For each lane group, enter the number of lanes as a value between 0 and 8, or select the 
lane configuration from the drop down list. 

For the through lane group, specify whether it shares with left or right traffic by pressing [R] 
or [L] selecting the appropriate configuration from the list. 

Changing the Name of the Approach Direction 
To change the name of an approach direction, right click on the column label of the LANES, 
VOLUMES, TIMINGS window, or SIMULATION OPTIONS settings. Double click on the desired 
direction name to reassign the direction. To reset the direction to the "natural" map 
direction, select "Free". 

This feature is intended to reclassify diagonal approaches into orthogonal approaches (NB, 
SB, EB, WB). This feature is not intended to rotate an entire intersection or map. North must 
always be up on the Map View. (Also see page 2-3, Link Directions.) 

Take Note 

Don’t forget to use the 
keyboard numbers (1-8) to 
enter lanes to speed up 
lane entry. The [L] key will 
add a shared left to a 
through and the [R] key 
will add a shared right to a 
through lane. 

Synchro 9 now includes 
Templates that can be 
used to populate the 
approach geometry. 
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Approach Movements 

Synchro will allow 6 movements per 
approach. This includes 1 through, 1 U-
turn, 2 lefts and 2 rights. The through is 
defined as the opposing direction.  

Consider the graphic of the six-leg 
intersection at the right. Traveling from 
node 1-2-5 is assigned the EBT direction, 
1-2-4 is the EBL, 1-2-3 is the EBL2 (hard 
left), 1-2-1 is the U-turn, 1-2-6 is the EBR 
and 1-2-7 is the EBR2 (hard right). 

If you do not have two opposing directions that line up (i.e, EB and WB), then there would be 
no through movement defined. If you want a through movement to be defined, the 
opposing link must be labeled with the opposing direction. You could change the approach 
name (as defined above) to create the through movement.  

Street Name 
Naming a street will cause its name to appear on the map. If a street has several segments, 
the name will be placed on a segment long enough to fit the name, or on an external link. To 
change the size of the street name, see Options→Map-Settings. 

Link Distance 
Link distances can be used to adjust the length of the link for Synchro only. The calculated 
link distance is shown in blue. Overridden distances appear as red. To revert to the calculated 
distance, press [F12] when in the cell. 

The link distances are the distance from intersection center point to center point. When 
determining link distances for queuing analysis, Synchro will subtract 80 feet (24m) from the 
distance to account for the space inside intersections. 

Geodetic coordinates accurate within 20 feet are adequate for traffic modeling purposes. 

Link Speed 
The Link Speed should be set to the legal safe speed that you expect along the arterial after 
the traffic signals along the link are optimized. To set a default speed for newly created 
intersections or change all of the speeds, use the Options→Network-Settings command.  

Set Arterial Name and Speed 
Select a direction button to propagate the name and speed up and down the entire arterial 
in the selected and opposing direction. For instance, choose the [EB] option will set the 
street name and speed for the arterial in the eastbound and westbound directions. 

Travel Time 
Travel Time is recalculated when either the speed or distance fields are changed.  The 
calculated value will appear in blue type.  However, you may override this field manually, 
which will appear in red type. You can force the field to re-calculate based on the speed and 
distance fields at any time by pressing [F12]. 

Ideal Saturated Flow 
Enter the ideal saturated flow rate for a single lane in this field. Synchro defaults to the HCM 
default of 1,900 as suggested by the HCM. 

EBL2

3

21

4

5

6
7

EBL
EBT
EBR

EBR2

EBU

EB

WB

NB

SB SW

NE

A rule about Synchro and 
SimTraffic is that any 
entered volume will be 
shared with the next 
available adjacent lane, 
even if the dropdown lane 
diagram does not show 
this. 

Assume in the graphic to 
the left that the EBR and 
EBR2 are shared with the 
EBT lane. All shared lanes 
are coded in the through 
lane group. However, 
there is no choice for a 
shared EBR2 in the lane 
group diagram. Simply 
code a volume for the 
EBR2 and this will be 
shared with the first 
adjacent lane.

Changing the Link 
Distance in the LANE 
settings changes the 
internal link length. This 
setting does not change 
the coordinates of the 
underlying intersections. 
Synchro stores the link 
length independently from 
the coordinate distances. 

It is always best to move 
the node to the correct 
location and NOT to over-
ride the Link Distance.

Use the command [Ctrl]+[U] 
to open a U-turn column. 

The 2010 HCM suggests 
using an ideal saturated 
flow rate of 1,750 pc/hr/l 
for areas with less than 
250,000 population.  
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2-12   Synchro and SimTraffic Course 

Lane Width 
Enter the average lane widths for each lane group in feet (meters). 12 feet (3.6 meters) is the 
default. The lane width affects the saturated flow rate.  

For SimTraffic, Lane width affects the drawing and the Headway Factor that will influence 
headways and saturated flow rates. 

Grade 
Enter the percentage grade for each approach. The default is zero percent. The grade affects 
the saturated flow rate. The grade is the slope for traffic approaching the intersection. Use a 
negative grade for downhill. In SimTraffic, the grade will change the Headway Factor. 

Area Type 
Enter "CBD" or "Other" depending on whether the intersection is in a Central Business 
District or in another type of area. The default is "Other ". The area type affects the saturated 
flow rate (Synchro) and Headway Factor (SimTraffic). 

Storage Length and Lanes 
Refer to the Simulation Settings, page 2-29. 

Right Turn Channelized 
This field is active for the rightmost movement. The choices are None, Yield, Free, Stop and 
Signal. If this value is changed, it will also be updated for unsignalized analysis. This value is 
only used for simulation 

Curb Radius 
Controls the graphics and layout in SimTraffic. It is measured from center point to curb. 

Add Lanes 
Add Lanes controls how many add lanes are for the right turn movement. Set to zero (0) for a 
yield or merge. Set to the number of turning lanes for add lanes.  The default value is zero (0) 
for no add lanes. 

 

Link Is Hidden 
The LANE SETTINGS screen has a Link Is 
Hidden checkbox for each link (street). If 
the checkbox is checked, the 
corresponding link is not visible.  

Synchro requires a node to have 3 links before it is considered an intersection (allowing 
signal timing). This Link Is Hidden option can be useful for locations where you require the 
node to be an intersection. The dummy link could be hidden since it will have no lanes or 
volumes. For example, a mid-block ped crossing, gate or ramp meter could use this option. 

Many of the inputs in the 
LANE window are used to 
calculate the saturation 
flow for the subject lane 
group. The ideal 
saturation flow is used as 
the base. Adjustments 
are then made to reduce 
or increase the saturation 
flow of the lane group 
based on: 

- The number of lanes 
- The width of the lane 
- The percent heavy 

vehicles 
- Grade of the 

approach 
- Parking and busses 
- Area type (CBD or 

othear) 
- Lane utilization and 

movement type 
(left/right) 

- Pedestrians and 
bicycles 

Channelized rights only 
apply to SimTraffic. Refer to 
page 2-20 for special notes 
about channelized rights. 

Page | 6-20



  MnDOT Traffic Signal Timing and Coordination Manual 
 

May 2017  Synchro and SimTraffic 

 

 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

   

Synchro and SimTraffic Course  2-13 

Hide Street Name in Node Title 
The LANE SETTINGS window has a Hide Name in Node Title checkbox for each link (street). If 
the checkbox is checked, the corresponding street name is not used in the node title. The 
street name will still be visible in the MAP VIEW unless you use the Link Menu command to 
hide/show the street name. 

Lane Utilization Factor 
When there is more than one lane in a lane group, the traffic will not use all the lanes 
equally. The Lane Utilization Factor affects the Saturated Flow Rate (changing this will not 
impact SimTraffic). This value can be overridden. If the actual per lane volumes are know, 
the Lane Utilization factor can be calculated per the following example: 

 

Right Turn Factors 
The Right Turn Factor fields are calculated but can be overridden. The right turn factors 
represent how much the interference from right turning traffic reduces the saturated flow 
rate (turning speed is used for SimTraffic, see page ). 

Left Turn Factors 
The Left Turn Factors are calculated but can be overridden. The left turn factors represent 
how much the interference from left turning traffic reduces the saturated flow rate (turning 
speed is used for SimTraffic).  

Saturated Flow Rates 
The saturated flow rates are the actual maximum flow rate for this lane group after adjusting 
for all of the interference factors. The saturated flow rates represent the number of lanes 
multiplied by the Ideal Saturated Flow Rate and interference factors due to heavy vehicles, 
buses, parking maneuvers, lane widths, area type, grade, and turning movements. The HCM 
explains all of these calculations in detail.  

The Saturated Flow rates are used in capacity and delay calculations, and for optimization 
calculations. The Saturated Flow rates are not used by SimTraffic. The Headway Factor is 
used to calculate an equivalent flow for use in the simulation. 

These fields are calculated but can be overridden. 

Right Ped Bike Factor 
This factor is calculated based on the number of pedestrians and bicycles are crossing the 
right turn movement.  The factor takes into account the amount of green time for the 
pedestrians and the bicycles as well as the number of downstream receiving lanes.   

Left Ped Factor 
This factor is calculated based on the number of pedestrians and bicycles are crossing 
permitted left turn movements.  The factor takes into account the amount of green time for 
the pedestrians and vehicles, the amount of oncoming traffic and the number of 
downstream receiving lanes.   

fLU =
Total App. Vol.
(No. of Lanes) x 
(High Lane Vol.)

200 vph

100 vph
   =

(100 + 200)
(2 x 200)

   = 0.75

The lane utilization factor 
can have a large impact 
on the results. If vehicles 
do not use the lanes 
equally, a field study 
should be performed to 
determine the fLU. 

This will not change
your SimTraffic 
analysis. 

Synchro implements the 
2000 HCM model for 
permitted left turn factors. 
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2-14   Synchro and SimTraffic Course 

Right Turn on Red 
This field is used to specify whether Right Turns on Red (RTOR) are allowed.  This field can 
also be used to allow Left Turns on Red from a one-way to a one-way. 

Synchro now fully models Right Turns on Red.  Synchro automatically calculates a Saturated 
Flow Rate for RTOR and applies this flow rate to movements when they are red.   

This field is also used when modeling in SimTraffic and CORSIM. 

Saturation Flow Rate (RTOR) 
Synchro automatically calculates saturation flow rate for Right Turns on Red.  This saturation 
flow rate is applied to a movement whenever the movement has a red signal.  This 
calculation is also made for Left Turns on Red for crossing one-way streets. 

The calculation of the RTOR Saturation Flow Rate is quite complex and is based on the signal 
timing, the volumes of the subject approach, and the volumes of any merging approaches.   

It is possible to override the RTOR saturation flow rate to a measured value or hand 
calculated value.  Overriding RTOR sat flow is not recommended because overridden values 
will not be updated when the volumes or signal timings change.  The RTOR Sat Flow is very 
sensitive to changes in volumes and timings. 

sRTOR = Minimum(sRTOR1, sRTOR2) = RTOR Saturation Flow Rate 

sRTOR1 = saturation flow rate based on gaps in merging traffic 

sRTOR2 = limit to saturation flow rate based on through traffic blocking access to stop bar 

  

The sRTOR value is NOT
the volume that will make
the RTOR. The volume of
RTOR (vRTOR) can be
calculated as: 

vRTOR = sRTOR x (1-g/C) 
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2.4 Volume Settings 
From the MAP view, click on the desired intersection with the Right mouse button and select 
Volumes. 

From anywhere in the program, press [F8] and select the desired intersection from the list. 
Then push the Volume Settings button or the [F4] key. 

The VOLUME Settings displays a grid in which you can enter traffic volume information.  

 

 

Traffic Volumes 
In the appropriate cell, enter the hourly traffic volumes for each movement. Enter this 
number as vehicles per hour.  

Only enter traffic volumes for the targeted design hour. To develop timing plans for other 
times of the day, you could use the UTDF Volume table (see page 4-23, Database Access and 
UTDF).  SimTraffic will simulate this volume based on the interval times you set-up (see page 
4-28). If you use an interval of 10 minutes in SimTraffic, approximately 1/6 of the hourly 
volume will be simulated. 

Conflicting Pedestrians 
Enter the number of pedestrians, per hour, that conflict with the right turn movement during 
the permitted phase. This number affects the Right Turn Factor and the Saturated Flow Rate 
shown in the LANE window for the permitted right turns. SimTraffic will simulate the 
equivalent number of peds. 

Conflicting Bicycles 
Enter the number of through bicycles that conflict with right turns. If bicycles cross the right 
turn traffic ahead of the intersection, enter 0. This input will affect the Right Ped-Bike factor 
in the LANE settings. 

Peak Hour Factor 
The traffic volumes are divided by the Peak Hour Factor (PHF) to determine the traffic flow 
rate during the busiest 15-minute period during the hour. Also see page 4-30, Using the Peak 
Hour Factor Adjustment in SimTraffic. 

Keep in mind that the 
volumes in this window 
are hourly volumes. If you 
simulate less than 60 
minutes in SimTraffic, the 
equivalent proportion of 
vehicles will be modeled. 
Before gathering results 
from SimTraffic, you will 
probably want to simulate 
a 60 minute period. 
Special cases may require 
simulations of more or less 
time. 

Conflicting Bicycles do not 
need to be entered for left 
turns. It is assumed that 
they will clear during the 
queue clearance time for 
vehicles. 
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2-16   Synchro and SimTraffic Course 

From the HCM: 

"The bus blockage 
adjustment factor, fbb, 
accounts for the impacts 
of local transit buses that 
stop to discharge or pick 
up passengers at a near-
side or far-side bus stop 
within 250 ft of the stop 
line (upstream or down-
stream)." 

Synchro includes a show 
Volume Balancing button 
on the Map View. Click on 
the [VB] button to display 
the unbalance of traffic 
volumes between 
intersections. This can be 
used in conjunction with 
volume diagrams for 
quick editing 
adjustments.

Growth Factor 
The growth factor can be used to adjust the traffic volumes.  The raw volume data is 
multiplied by the growth factor when calculating Adjusted volumes and Lane Group volumes. 
The growth factor can be 0.5 to 3.0. By default, SimTraffic will use the growth factor that is 
input. This can be modified in the SimTraffic Intervals window. 

Heavy Vehicles 
Enter the percentage of vehicles that are trucks or buses for this movement. This value 
affects the saturated flow rate shown in the LANE window. The default for this field is 2%. 

In SimTraffic, the heavy vehicle fleet volume for each movement is equal to the volume 
multiplied by the Heavy Vehicle percentage.  The light vehicle fleet volume is equal to the 
remaining volume. Heavy Vehicle fleet traffic will be assigned one of the 4 truck types or a 
bus type.  The Light Vehicle fleet traffic will be assigned to a car or carpool vehicle type.  Also 
see page 4-31, Vehicle Parameters. 

Bus Blockages 
Enter the number of busses per hour that stop and actually block traffic. This value affects 
the saturated flow rate shown in the LANE window. The default for this field is zero busses 
per hour. Enter bus blockages for each lane group that is affected by the blockage. 

Adjacent Parking Lane, Parking Maneuvers 
If there is on street parking for this approach, enter "Yes" for Adjacent Parking Lane and the 
number of maneuvers per hour for Parking Maneuvers. This value affects the saturated flow 
rate shown in the LANE window. The default for this field is "No" adjacent parking lane. 
Enter parking maneuvers for each lane group that is affected by the blockage. See the HCM 
for additional information. 

This value will change the Headway Factor, thereby reducing the saturation flow in 
SimTraffic. You will not see vehicles making parking maneuvers in SimTraffic. 

Traffic From Mid-block 
The Traffic From Mid-block field tells Synchro what proportion of the traffic came from 
driveways and unsignalized intersections, not the next signalized intersection. A value of 50 
indicates that 50% of the traffic is from driveways.  

Also refer to the topic “Traffic from Mid-Block” in the Synchro Studio Users Guide for details 
on how Synchro handles unbalanced flow between 
intersections. 

Link O-D Volumes 
Link O-D Volumes allows detailed control over the 
origin and destination of two adjacent intersections. 
Link O-D Volumes can be used to reduce or eliminate 
certain turn combinations. The most common use is to 
prevent vehicles from turning left twice at a freeway 
or wide median arterial. 

The LINK ORIGIN-DESTINATION VOLUMES window 
displays Movement Weighting Factors that control how volume is allocated between input 
and output volumes.  

If you change one of the weighting factors, the other volumes will be dynamically updated to 
balance. 

Synchro allows you to 
change the Analysis 
Period, T. Traditional 
analysis (HCM based) has 
the peak 15 minute period 
converted to hourly 
volumes with the PHF. If 
the analysis period is 
changed to a value greater
than 15, the PHF will be 
changed to 1.0 and is not 
editable. The Analysis 
Period is changed within 
the Network Settings. 
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Traffic in Shared Lane 
can be overridden to 
control lane assignment 
in Synchro. This setting 
will not have any 
impact on SimTraffic 
simulations. In 
simulations, individual 
vehicles choose their 
lanes based on lane 
change algorithms.

Adjusted Flow 
The Adjusted Flow (vph) is the entered volume modified by the Peak Hour Factor and 
Growth Factor (Adjusted Flow = Input Volume/PHF x Growth Factor). 

Traffic in Shared Lane 
Traffic volumes assigned to exclusive and shared lane are proportioned to each lane as 
follows. 

 Vehicles are counted as passenger car equivalents (PCE) as follows 

  Throughs: 1 

  Rights: 1.18 

  Protected Lefts: 1.05 

  Permitted Lefts:  1 / [0.95 * (900 – vOp)/900], (max 6.67)  

  Permitted plus protected Lefts:  2/ [0.95 + 0.95 * (900 – vOp)/900], (max 1.82) 

  vOp = through volume opposed.   

Traffic is assigned so that PCEs are balanced between lanes.  The assignment of traffic to the 
shared lane is between 10% and 90% of the turning traffic. 

This simplified left turn factor removes the interdependence of lane assignments from the 
permitted left turn factor (see the Synchro Studio User Guide) calculation.  As a practical 
matter, the need for a permitted left-turn factor is somewhat nullified by this lane 
assignment procedure. 

Lane Group Flow 
The Lane Group Flow shows how volumes are assigned to lane groups. 

If there are no turning lanes, the turning volume is assigned to the through lane group. The 
shared lanes are part of the through lane group and the exclusive lanes are part of those 
movements' lane groups. 
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2-18   Synchro and SimTraffic Course 

Phase numbers are the 
labels assigned to the 
individual movements 
around the intersection. 
For an eight phase dual 
ring controller, it is 
common to assign the 
main street through 
movements as phases 2 
and 6. Also, it is common 
to use odd numbers for 
left turn signals and the 
even numbers for through 
signals. A rule of thumb is 
that the sum of the 
through movement and 
the adjacent left turn is 
equal to seven or eleven. 

2.5 Timing Settings Input 
From the Map View, click on the desired intersection with the Right mouse button and 
select Timing. 

From anywhere in the program, press [F8] and select the desired intersection from the list. 

Then push the Timing Settings button  or the [F5] key. 

The TIMING settings are displayed with information about the timing and phasing. 

In the TIMING settings, there is a column for every vehicle movement and every vehicle 
movement can have multiple phases. There is also a column for a pedestrian only phase. To 
make a pedestrian only phase, assign a phase number to this column.  

 

 

Lanes and Sharing 
Refer to the Lane settings, page 2-10. 

Traffic Volume 
Refer to the Volume settings, page 2-15. 

Phase Templates 
Phase templates allow phase numbers to be set automatically. 

To set phases for an east-west arterial use the menu command Options� Phase-
Templates� Intersection-to-East-West.  

To set phases for a north-south arterial use the menu command Options� Phase-
Templates� Intersection-to-North-South. Phases 2 and 6 are normally used for the main 
street. Thus, two templates are provided for each type of arterial.  

To edit the phase templates use the menu command Options� Phase-Templates� Edit-
Template-Phases.  
 

The TIMING Settings 
includes the most complex 
data entry items. 
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The turn type “permitted 
plus protected” does NOT 
indicate the order of the 
phase. The left turn may 
be a lead or a lag, and 
depends on the Lead/Lag
setting in the PHASING 
settings. 

 

Turn Type 
The turn type row allows for the easy setting of Left turn and Right turn treatments. 

Using the Turn Type settings makes it easy to set phase numbers.  If you prefer, the phase 
numbers can be set also. 

Left Turn Type 

The eight types of left turn treatment are: 

1. Permitted: There is no protected left turn signal, the left is allowed to operate 
with the adjacent through. Left turns must yield to oncoming traffic. 

2. Protected: There is a left turn signal. Left turns are only allowed during the left 
turn phase. 

3. Permitted + Protected: There is a left turn signal and traffic is also allowed to turn 
left on a green ball when there is a gap in oncoming traffic. With permitted plus 
protected phasing, it is common to use a signal with five heads for the left turn 
lane. 

4. Split: Left and through traffic share a single protected phase. This type of phasing 
is commonly used if a lane is shared between left and through traffic. Split 
Phasing is also used if there might be a problem with-head on collisions between 
oncoming left turns. If there is a through approach, either both or neither of the 
two approaches must use Split phasing. If there is no through approach, such as 
at a T intersection, then the left turn treatment should always be split. 

5. Dallas Permitted: A special type of phasing developed in the Dallas, TX area.  The 
left turn lane has its own signal head.  The left signal head is louvered to make it 
invisible from adjacent lanes.  The ball in the left lane displays the same phase 
displayed to oncoming through traffic.  This configuration eliminated the lagging 
left turn trap problem. 

6. Dallas Permitted plus Protected: A special type of phasing developed in the 
Dallas, Texas area.  The left turn lane has its own signal head.  The left signal head 
is louvered to make it invisible from adjacent lanes.  The ball in the left lane 
displays the same phase displayed to oncoming through traffic.  This 
configuration eliminated the lagging left turn trap problem. 

7. NA: No phase selected.   Left turns are prohibited. 
8. Custom: A non-standard left turn phase combination is selected.   

A research report NCHRP 
3-54 studied the best 
traffic signal display for 
protected/permitted left 
turn control.  The resulting
recommendation is to use 
a four section signal head 
with a flashing yellow 
arrow for the permitted 
left turn interval.  This 
type of arrangement 
allows for the safe 
implementation of lead-lag
permitted plus protected 
phasing.  There is no need 
for special louvers or 
positioning of the signal 
heads. 

Extensive information can 
be found by doing a web 
search on Flashing Yellow 
Arrow.
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2-20   Synchro and SimTraffic Course 

Synchro will automatically 
enter the phase numbers 
based on the phase 
template and turn 
treatment you have 
selected. For instance, if 
you are using the East-
West template and enter 
‘Prot’ for the EBL, 
Synchro will place a 
phase 5 in the EBL 
Protected Phase row. 

Right Turn Type 

If there is right turn traffic, there is an option for the right turn treatment.  There are eight 
choices. 

1. Perm: Permitted, right turns go on green ball but yield to pedestrians. 
2. Prot: Protected, right turns go on green ball and are protected from pedestrians. 
3. Over: Overlap, right turns go on a compatible left turn phase. 

Overlap should not be used as a substitute for Right Turn on Red.  See Right Turn on 
Red for guidance on which type to use.  Overlap should only be used if the 
movement actually has a green arrow during the overlapping phase. 

4. Pm+Ov: Permitted plus Overlap, allows both if applicable. 
5. Pt+Ov: Protected plus Overlap, allows both if applicable. 
6. Free: Free turn with acceleration lane, must still yield to pedestrians. For a free 

right turn, code the permitted phase as F or Free.  
7. Free should not be used as a substitute for Right Turn on Red.  See Right Turn on 

Red for guidance on which type to use. Free should only be used if the movement 
has an acceleration lane downstream. 

8. NA: No right turn phase entered.  Right turns are prohibited 
9. Custom: Non-standard right turn phases are entered. 

Protected and Permitted Phases 
The Phase rows are used to assign one or more phases for each movement. During protected 
phases, traffic can move without conflict. During permitted phases, left turning traffic must 
yield to oncoming traffic and right turn traffic must yield to pedestrians. Conflicting phases 
have the phase number shown in red. Permitted Left Turns do not conflict with movements 
bound for the same link. Permitted through movements do not conflict with left turns bound 
for the same link. 

Most signals in North America use dual ring controllers, which have two phases active at 
once. For further details on dual ring control, please refer to the Synchro Help file, 
Background Timing chapter, and subtopic on Ring Structure. 

Notes on Channelized Rights 

The channelized right settings (see page 2-12) do not have any impact on your Synchro 
analysis and are intended for SimTraffic modeling. However, the following could be 
considered for the given channelized right turn code. 

� Yield: assign the right turn the same phase as the adjacent through and any non-
conflicting left that exists. Set the RTOR (see page 2-14) equal to Yes. 

� Stop: same suggestions as for the Yield control 
� Free: Set the phase to Free 
� Signal: Set the appropriate phase number desired since the movement is controlled 

by the signal. 
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Splits for phases within a 
ring are not required to 
add up. Synchro will 
extend a phase to make 
the rings equal. This 
extended split is shown in 
gray on the Splits and 
Phasing diagram. 

Additional details can be 
found on controller types 
in the Signal Timing 
Background book found in 
the Trafficware directory. 
See the subtopics on 
Controller Types. 

SimTraffic will model a 
roundabout, including 
multi-lane roundabouts. 
The modeling of 
roundabouts in Synchro is 
limited to giving a v/c 
ratio for a single lane 
roundabout. This is to 
mimic the methods of the 
2000 HCM. 

Controller Type 
Use the Controller Type field to indicate what type of controller you are using. The choices 
are: 

Pretimed: This signal has no actuation. All phases are set to Maximum recall. 

SemiAct-Uncoordinated: The main street phases have maximum recall and will always show 
to their maximum green time. Side street phases may be actuated and can be skipped or 
gap-out early. Signals with semi-actuated operation have a variable cycle length and are not 
coordinated. 

Actuated-Uncoordinated: No phases have maximum recall. All phases are actuated and can 
be skipped or gap-out early. 

Actuated-Coordinated: With Coordinated operation, the controller operates on a fixed cycle. 
Side street phases are actuated and can be skipped or gap-out. Any unused time is added to 
the main street phases.   

Unsignalized: With this setting the intersection has no signal at all. Unsignalized intersections 
have stop signs and yield signs to control traffic and is based on the 2000 HCM. 

Roundabouts: Synchro models single lane traffic circles or roundabouts using the HCM 2000 
method. Go to the HCM 2010 Settings for the 2010 Roundabout methods. 

Sign Control 
If Control Type is set to Unsignalized, this intersection becomes unsignalized and the third 
row is Sign Control. 

Detector and Switch Phases 
Detectors in the subject lane group will call and/or extend the Detector Phases.  The 
function of the detector is set in the DETECTORS settings in the Detector Type row. Only 
one phase number can be entered for the Detector Phase. 

The Switch Phase is a secondary phase that extends the entered phase when it is green. This 
setting does not place a call and does not call the primary Detector Phase when the entered 
switch phase is green.   

This setting can be used for the permitted phase of a permitted plus protected left turn. Do 
not use with a lagging left turn because the protected left will not get called while the 
permitted phase is green. The default for permitted plus protected is to have the Detector 
Phase equal to the Protected Phase and Switch Phase set to none. 

Cycle Length 
The Cycle Length is the amount of time it takes a signal to go through its entire sequence 
once and return to the same place. 

Increase Cycle and Split Times 

In previous versions of Synchro, the Cycle was limited to 900 seconds and the Maximum Split 
to 840 seconds. In some instances, a long cycle can be useful to model dummy intersections 
that can stop traffic for an extended period of time. The Cycle Length in the NODE SETTINGS 
and the Maximum Split in the PHASE SETTINGS may now have values up to 3000 sec (50 
min). The Cycle Length should not exceed 3000 seconds. 

Two examples for using this would be a draw bridge or rail crossing. At the location of the 
stop, create a dummy intersection (create a T-intersection). Keep in mind that this dummy 
link can be hidden. Then enter a phase for the main street (say phase 1) and a Hold phase. 
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Total Split 
The Total Split is the current split time, given in seconds.  It is the amount of green, yellow, 
and all-red time assigned for each phase. When multiple phases are used for a movement, 
the Total Split is the sum of all phases. The splits for the intersection can be calculated 
automatically by selecting the Optimize→Intersection-Splits, command from the menu. 

Splits and Phasing Diagram 

 
The Splits and Phasing diagram is shown at the bottom of the TIMING Settings.  It is a 
graphical representation of the current splits and phasing and can be used to adjust the 
splits.  To adjust the splits with the mouse, move the mouse to the right side of a yellow + all 
red band on the current Splits and Phasing diagram. Hold down the left mouse button and 
move the mouse right or left to adjust the split.  

Next to the movement diagram is a phase number identified with the phase symbol (ø) and 
inside the green band is the split time in seconds.  For the diagram above, the southbound 
left is ø7 and has a 10s split.  Remember that the split time includes the Yellow plus All Red 
time. 

Lock Timings 
The Lock Timings field is used to prevent the timing from changing. To preserve the timing 
for one or more intersections, put an X in this field for each of the intersections. If you 
optimize the network, these intersections' timing plans will not change, but the other 
intersections will be optimized around them. 

Offset Settings 
The settings in the Offset Settings box determine to which phase the offset is referenced and 
the value of the Current Offset. Each intersection is given one offset that can be referenced 
to any part of any phase. The offset value represents the amount of time after the master 
intersection when the reference point for this phase occurs.  

Reference Phase 

Select the phase(s) to reference offsets from. This is usually the phase for the main street.  

Offset Referenced To 

Select the point you wish to have offsets referenced to. The graphic below shows the offset 
reference points for  

 

TS2 - 1st Green

Begin of Green

170 Style (NEW)

Begin of Yellow

Begin of Red

FDW
Time

Be sure to choose the 
offset reference style to 
match your controller 
type. If not, this could 
cause problems when 
entering the data into the 
controller. Delays may be 
higher simply because 
greens don’t occur as 
expected in Synchro. 

Synchro will optimize the 
offsets (discussed later), 
but the end user must 
ensure that this data is 
properly input into the 
controller. 

Synchro 5 and earlier used 
Single Yield points, as 
compared to flexible and 
multiple. For most analysis 
situations, Single Yield 
points can be used. This 
topic is quite advanced, 
and will be discussed in 
more detail in the Level II 
class. You can also refer to 
the Synchro Help topic on 
Offsets for a detailed 
description. 
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A master intersection is 
not required. If you do not 
specify a master 
intersection, the offset will 
be referenced to an 
arbitrary time line. 

Note: These Median Type 
and Median Width fields are 
only used for 2000 HCM 
Unsignalized analysis to 
perform unsignalized analysis 
with two-stage gap 
acceptance. SimTraffic does 
not use the median type or 
width.  SimTraffic 6 is not 
able to model two-stage gap 
acceptance or medians at 
this time. 

Current Offset 

The Current Offset for the intersection, in seconds, is the amount of time the reference 
phase begins (or ends) after the master intersection.  

Yield Points 

The Yield Point affects when the Coordinated Phases will “yield” to side street phases.  This 
setting affects whether there is a single yield point for all phases; or multiple yield points. 

Master Intersection 

The Master Intersection always has an offset of zero. In Synchro there is zero or one master 
intersection for each compatible cycle length used in the network.  

Mandatory Stop on Yellow 

Traditionally, SimTraffic will allow at least two vehicles to proceed during a signal phase, 
even if the Total Split is set to 3 seconds. In some instances, it is desirable to create a dummy 
intersection to meter traffic (i.e., allow 1 vehicle to proceeds every X seconds). This could be 
useful for modeling security gates, ramp 
meters, etc. 

To do this, check the Mandatory Stop on Yellow at the bottom of the NODE SETTINGS. This 
will allow only one simulated vehicle to pass through a short green signal. No sneaker 
vehicles will be allowed during the yellow interval. 

Pedestrian and Hold Phases 
The far right columns allow an entry of pedestrian only or phase hold. If there is a phase 
dedicated solely for pedestrians, set the phase number for this column to a valid phase 
(often an even number larger than 8, such as 10). This is a phase where all vehicle 
movements are red and pedestrians can walk anywhere in the intersection. Set the phase 
number to blank to remove the pedestrian phase. 

Lost Time Adjustment 
Total lost time is calculated as startup lost time plus yellow plus all red, as shown below. 

tL = Yi + L1 – e =  Total Lost Time 

 Yi = Yellow plus All-Red Time 

 L1 = startup lost time = 2.5 seconds by default 

 e = Extension of effective green = 2.5 seconds by default 

The Lost Time Adjustment is the startup lost time minus extension of effective green. The 
default for startup lost time and extension of effective green is 2.5 seconds, so the Lost Time 
Adjustment defaults to zero. The extension of the effective green is time vehicles continue to 
enter after yellow interval begins.  

 tLA = L1 – e = Lost Time Adjustment 

 tL = Yi + tLA 

Sign Control 
If Control Type is set to Unsignalized, this intersection becomes unsignalized and the third 
row is Sign Control. 

There are three options are Free, Yield or Stop. 
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Median Type 
Enter the type of median that this link CROSSES.  It is not the median for the link itself.   

Median Width 
This row appears in the SIGNING window for unsignalized intersections. 

This field is active when a Raised or TWLTL is specified for the Median Type.  Enter the 
number of vehicles that can be stored in the median. Do not enter the distance of the 
median width.  

Right Turn Channelized 
 This row appears in the SIGNING window for unsignalized intersections. 

This field is active for the rightmost movement. Enter yield or free if this movement has a 
triangular island and yields or merges with oncoming left turn traffic.  One or more right 
turns must be selected.   

Roundabout Radius 
Inside Radius, Outside Radius control the size of the roundabout. 900' is the maximum. This 
information is only used by SimTraffic. 

Roundabout Lanes 
Roundabout number (#) of Lanes is where to set the number of internal lanes within the 
roundabout, up to 4 lanes. This information is only used by SimTraffic. 

Roundabout Speed 
Roundabout Speed Limit is the internal speed of vehicles within the roundabout. This 
information is only used by SimTraffic. 

Max Exit Lanes 
Two Lane Exit controls how many of the internal lanes exit for the subject approach. This 
information is only used by SimTraffic.   

  

Synchro 8.0 now provides 
full modeling of the 2010 
HCM methods. Enter 
Roundabout for Control 
Type and then choose the 
“HCM 2010” button.  
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2.6 Phasing Settings Input 
From the Map View, click on the desired intersection with the Right mouse button and 
select Phasing. 

From anywhere in the program, press [F8] and select the desired intersection from the list. 
Then push the Phasing Settings button or the [F6] key. 

The PHASING settings are displayed with information about the phase settings. 

In the PHASING screen, there is a column for each phase. If there is no left turn phase, there 
is no column for left turns. 

  

Minimum Initial 
This field is the minimum initial green time for a phase.  This is the shortest time that the 
phase can show green.  A typical value would be 4 seconds. This value is also called 
minimum green by some controllers. 

Minimum Split 
The Minimum Split is the shortest amount of time allowed for this phase. 

The Minimum Split is only used for Optimizations and not used in calculation. This is the 
shortest amount of time that will be allowed for this split when an optimization is 
performed. It is a user defined parameter. This could be considered the minimum Maximum 
Split. 

The minimum split must at least be long enough to accommodate the Minimum Initial 
interval plus the yellow and all red time. When Synchro automatically assigns splits, it will 
make sure all splits are greater than or equal to their minimum splits. (This assumes the cycle 
length is long enough to accommodate all splits.)  

If the Minimum Split shown is red, it indicates a minimum error. The Minimum Split must be 
greater or equal to the Minimum Initial plus clearance time (Y + AR). If this phase has a 

The Minimum Split is only
used for Optimizations and 
not used in calculation. 
This is the shortest 
amount of time that will 
be allowed for this split 
when an optimization is 
performed. It is a user 
defined parameter. This 
could be considered the 
minimum Maximum Split. 

Keep in mind that you can 
set your own Network 
defaults for some Phasing 
parameters. These 
defaults can be updated in 
your Defaults.syn file 
located in your Trafficware 
directory. See page 2-9 for 
additional details. 
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pedestrian phase, the Minimum Split must be greater or equal to the sum of the Walk time, 
the Flashing Don't Walk time, the Yellow time and the All-Red time.   

Maximum Split 
The Maximum Split is the current split time, given in seconds. It is the amount of green, 
yellow, and all-red time assigned for each phase. 

The Maximum Green time would be the Maximum Split minus the Yellow and All-Red.  

Yellow Time 
Yellow Time is the amount of time for the yellow interval. Normally, this value should be set 
to between 3 and 5 seconds, depending on the approach speed, the cross street width, and 
local standards. 

All Red Time 
All Red Time is the amount of time for the all red interval that follows the yellow interval.  

Phase Lagging 
 The first two phases within a ring-barrier sequence are considered phase partners.  The 3rd 
and 4th phases within a ring-barrier sequence if used are also phase partners.  Phase Lagging 
is used to swap the order of phase partners.  Normally phase partners are 1 and 2, 3 and 4, 5 
and 6, 7 and 8. See below for an example of leading and lagging phases. Phase 1, 2, 5 and 6 
are in barrier 1 and phase 3, 4, 7 and 8 are in barrier 2. The dark vertical line (at the end of 
phase 2/5) represents the barrier point. 

 

Allow Lead/Lag Optimize? 
If it is okay for this phase to be either leading or lagging, set this field to "Yes". If this phase 
must be lagging or must be leading, set this field to "Fixed".  

Vehicle Extension 
This is the also the Maximum Gap.  When a vehicle crosses a detector it will extend the green 
time by the Vehicle Extension time. 

Minimum Gap 
This is the minimum gap time that the controller will use with volume-density operation.  If 
volume-density operation is not used, set this value to the same as the Vehicle Extension. 

Time Before Reduce  
When using volume-density operation, this is the amount of time before gap reduction 
begins. 

Phase 1 Leading

Phase 5 Lagging Phase 7 Lagging

Phase 3 Leading

Examples of Leading and Lagging Phases

For actuated movements, 
the Maximum Green may 
not be experienced. If the 
volume is low, a phase 
may “gap-out” and allow 
other phases to begin 
earlier. Synchro fully 
models actuated 
movements, so don’t be 
fooled into thinking that 
the Maximum Green you 
have entered is the actual 
time allocated to a 
movement. Review the 
Percentile Green times and 
the Actuated Effective 
Green times. 

Review:
A ring is a term that is 
used to describe a series 
of conflicting phases that 
occur in an established 
order. Phasing in any one 
ring cannot operate 
together. 

A barrier (compatibility 
line) is a reference point in 
the preferred sequence of 
a multi-ring controller unit 
at which all rings are 
interlocked. Barriers 
assure there will be no 
concurrent selection and 
timing of conflicting 
phases for traffic 
movements in different 
rings.

If the Allow Lead/Lag 
setting is set to “Yes”, 
Synchro may set some 
phases to lagging during 
the network cycle length 
OR network offset 
optimization. If you do not 
want a left phase to lag, 
be sure you set this 
setting to “Fixed”. 

Review the topic on left 
turn trapping in the Signal 
Timing Background PDF 
document in the 
Trafficware directory. You 
can find this topic by doing
a search on the word 
‘trap’. 
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Time to Reduce 
When using volume-density operation, this is the amount of time to reduce the gap from 
Vehicle Extension (or maximum gap) to Minimum Gap. 

 

Recall Mode 
Each phase can have a recall of None, Minimum, Maximum, or Ped.  The coordinated phases 
can have C-Max or C-Min. 

No Recall: The phase can be skipped.  

Minimum Recall: The phase will always come on to its minimum, the phase can not be 
skipped. 

Maximum Recall: The phase will always show its maximum and has no detection. The phase 
cannot skip or gap out, nor can it be extended. 

Pedestrian Recall: The phase will always show a walk phase. The phase can't be skipped or 
gap out until the walk and don't walk intervals have passed. 

C-Max: Phase shows for its maximum time starting at its scheduled start time. 

C-Min: Phase shows for its minimum time starting at its scheduled start time.  Coordinated 
movements must have detectors.  No affect with By Phase yield points except with lead-lag 
phasing. 

Dual Entry 
Select Yes to have this phase appear when a phase is showing in another ring and no calls or 
recalls are present within this ring and barrier. 

V
eh

ic
le

E
xt

en
si

on
*

(o
r G

ap
)

Beginning of Phase Due to Actuation or Recall

Actuation

Beginning of Extensible 
Portion or of Rest if  No Further
Demand

Time Before Reduce*

Phase Ends

Phase Green Ends 
Due to Gap. 

* - Indicates Preset Timing 

Min. Initial*

Yel.*

Red*

Preset Max. Green (Effective Only w ith Conflicting Demand)

Yel.*

Red*

Phase Ends

Extensible Green 

Added Initial*

Time To Reduce*

Minimum Gap*

The graphic illustrates the 
minimum initial, vehicle 
extension, minimum gap, 
yellow, red and maximum 
preset green. 

The C-Max, C-Min, Dual 
Entry and Inhibit Max are 
advanced controller 
features. Synchro 5 used 
C-Max, Dual Entry set to 
Yes and Inhibit Max set to 
Yes. It is common to use 
the defaults of Synchro 5 
for many operations. 
These features will be 
discussed in more detail in 
the Level II class. 
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Fixed Force Off? 
Used for Actuated-Coordinated signals only.  When Yes, a non coordinated phase can show 
more than its maximum time when it starts early. 

Pedestrian Phase 
Set this field to yes if there is a pedestrian phase for this movement. 

Setting Pedestrian Phase to No will disable the ped phase and the input fields for walk, don't 
walk, and ped calls. 

Walk Time 
This is the amount of time for a pedestrian walk phase. 

Flashing Don't Walk Time 
This is the amount of time for a pedestrian Flashing Don't Walk phase. 

Pedestrian Calls 
This is the number of pedestrian push button calls for this phase.  This value is only needed if 
this phase has a pedestrian push button.  
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2.7 Simulation Settings 
From the MAP view, click on the desired intersection with the Right mouse button and select 
Simulation Options. 

From anywhere in the program, press [F8] and select the desired intersection from 
the list. Then push the Simulatin Options Settings button or the [F10] key. 

The SIMULATION OPTIONS setting displays a grid in which you can enter SimTraffic 
simulation specific information. 

 

Lanes and Sharing 
Refer to the Lane settings, page 2-10. 

Traffic Volume 
Refer to the Volume settings, page 2-15. 

Storage Length 
The Storage Length is the length of a turning bay in feet (meters). If an intersection has a left 
turn storage bay of 150 feet (45 meters), enter "150" ("45") in this box. If the left or right turn 
lane goes all the way back to the previous intersection, enter "0".  

Storage Length data is used for analyzing potential blocking problems, such as through traffic 
blocking left turn traffic, and left turn traffic blocking through traffic. If "0" is entered, no 
blocking analysis is performed. 

Code Storage Lanes to reduce lane changes in SimTraffic. Mandatory lane changes can cause 
blocking of multiple lanes.  Storage bays reduce the number of lane changes. 

  

In the Lanes and 
Sharing row, code the 
number of lanes as they 
exist at the stop bar. Next, 
code any storage length 
on the left and right 
(independent of the 
movements that use the 
storage). Finally, enter the 
number of storage lanes 
on the left and right. 

Refer to the examples in 
the text. 
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Storage Lanes 
Code the number of lanes in the right or left storage bay.  This value only appears when the 
storage length is greater than 0.  By default the number of storage lanes is equal to the 
number of turning lanes.   

This field can be overridden so that some of the turning lanes are full travel lanes, or so that 
some of the through lanes can be storage lanes. 

A red value indicates an override, while a blue value indicates that the number of storage 
lanes is calculated. 

Examples of using Storage Length and Storage Lanes 

 

Taper length 
The Taper Length affects the visual MAP view drawing. In SimTraffic, the Taper Length 
impacts when vehicles can start entering the storage. The default is 25 ft (7.5 m). 

Lane Alignment 
When adding a lane, lanes are added on the right or left. The setting will allow the user to 
specify how lanes align through an intersection. The choices are as follows: 

A. Left  
B. Right 
C. L-NA (left, no add)  
D. R-NA (right, no add)  

The default is Right for right turns, Left for left turns and through, and Right-NA for U-turns. 

 

Lane Alignment:
Left

Lane Alignment:
Right

Lane Alignment:
Left - NA

Lane Alignment:
Right - NA

B

A C

D

To see the intersection 
paths, go to Options>Map-
Settings and check the box 
for Intersection Paths. 
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Consider the examples in below. Part A shows an example where the EBT and NER are green 
at the same time. There are four upstream lanes (two EBT and two NER) flowing into four 
downstream lanes. In order to prevent a conflict, the EBT is forced to use the left lanes 
downstream by setting the Lane Alignment to L-NA. The NER is forced into the downstream 
right lanes by setting the Lane Alignment to R-NA.   

Part B shows a T intersection with continuous flow in the eastbound direction. In this case, 
the EBT and SBL are allowed to operate without conflict. To do this, set the EBT Lane 
Alignment to R-NA and the SBL to L-NA.  

 

Lane Width 
Refer to page 2-12. 

Enter Blocked Intersection 
The Enter Blocked Intersection setting controls simulation modeling gridlock avoidance. The 
four options for modeling blocked intersections are "Yes", "No", "1" and "2". The default 
value is "No", for intersections and "Yes", for bends and ramp junctions.  We suggest that 
you set Enter Blocked Intersection to "No", for high speed approaches and movements. 

A vehicle will slow for an intersection, if there are 4 other vehicles ahead of it, but behind the 
stop bar.   

A side street of an unsignalized intersection can be set to 1 or 2. This will allow 1 or 2 vehicles 
to enter a blocked intersection from the side.  This can help the capacity of driveways. 

Median Width 
The Median Width is used to set the width of the median. Left turn lanes are considered to 
be positioned in the median even if they are not defined as storage lanes. 

This setting can be overridden.  

Link Offset 
The Link Offset setting is used to offset the roadway alignment to the right or left of the 
centerline. This can be used to create a dog-leg intersection, if there are no internal stop bars 
(seethe figure below).  

For an onramp or other acute intersection, use a positive link offset value for on-ramp, and a 
negative link offset value for an off-ramp. In the figure below, w is the width of the mainline 
lanes used as the link offset for each ramp. 

Eastbound Through
Lane Alignment:
L-NA

Northeast Right
Lane Alignment:
R-NA

Eastbound Through
Lane Alignment:
Right - NA

A B Southbound Left
Lane Alignment:
Left - NA

Barrier

  If vehicles are allowed to 
enter blocked intersections, 
gridlock within the roadway 
network could occur.  This 
parameter should be used 
with caution.
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Crosswalk Width 
The Crosswalk Width is used to control the width of the crosswalk and the location of the 
stop bar. The stop bar is located on the upstream end of the crosswalk. 

 

TWLTL Median 
The two-way left turn lane (TWLTL) Median setting draws a TWLTL in the median. The 
median will be colored with the pavement color and dashed yellow lines will be added.  
Storage taper lengths still apply. Setting the TWLTL “on” (check) will also set the TWLTL for 
the reverse link.  

Notes about driveways 

Avoid placing too many driveways along your link. Some driveways with short storage and 
taper lengths can be used.  To reduce space of driveway intersections, set crosswalk width 
on the main street to 4ft. and draw the driveways at 90 degree angles. 

Vehicles will not initiate or complete lane changes within an intersection. Too many 
driveways reduce opportunities for lane changes. 

The TWLTL Median setting on one end of a link sets the TWLTL Median on the reverse end of 
the link. 

Headway Factor 
SimTraffic applies the Headway Factor to model Saturated Flow Rates for individual lane 
groups.  Headway Factor is not used in any of the capacity calculations in Synchro.  

The Headway Factor is based on the Ideal Saturation Flow, lane width factor, the grade 
factor, the parking factor, the bus stops factor, and the area factor. The headway factor is 
magnified by 30% because at cruise speeds, about 30% of the time per vehicle is taken by 
vehicle passage and 70% by the headways. 

Corner Point

Corner Point

Width Left

Width Right

Cross 
Walk 
Width

The TWLTL Median is visual 
only. Vehicles will not use 
the TWLTL 
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3.0
*****

1900*3.1 −=
Idealfafbsfpfgfw

HWF  = Headway Factor 

Where: 

 HWF = Headway Factor 

 fw = Adjustment Factor for Lane Width 

 fg = Adjustment Factor for Grade 

 fp = Adjustment Factor for Parking 

 fbs = Adjustment Factor for Bus Stops 

 fa = Adjustment Factor for Area Type 

 Ideal = Ideal Saturation Flow Rate 

The Headway Factor is calculated but can be overridden. 

Turning Speed 
This is the Turning Speed for vehicles in miles/hour (km/h) while inside the intersection. 

Synchro does not use this information. It is only used when modeling in SimTraffic. 

The NETWORK settings have a network wide turning speed option. This setting affects the 
turn speed in CORSIM. 

For large intersections or intersections with large turning radii, increase the Turning Speeds. 
This will give improved capacity in SimTraffic.  

The Turning Speed should be adjusted if you are using SimTraffic to model a freeway section. 

Turning speed is adjusted by driver speed factor. 

Lane Change Distances 
The Lane Change Distances are used for calibration of SimTraffic lane changing logic. Editing 
these values will not affect Synchro or CORSIM.  

Refer to page 4-32 for additional details. 
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2.8 Detector Settings 
From the MAP view, click on the desired intersection with the Right mouse button and select 
Detector Options. 

From anywhere in the program, press [F8] and select the desired intersection from 
the list. Then push the Detectors Settings button or the [F11] key. Clicking on a map 
detector also activates. The DETECTOR settings display a grid in which you can enter 

detector information.  

 

Number of Detectors 
This is the number of longitudinal detector sets, not the number across the lanes. Detectors 
are numbered from the stop bar back, detector 1 is at the stop bar. You can enter up to 5 
detectors. 

Detector Phase 
The Detector Phase is primary phase for a detector. This is the same as the Detector Phase 
setting in the TIMING settings. 

There is only one detector phase and one switch phase per lane group. 

Switch Phase 
The Switch Phase is a secondary phase that extends the entered phase when it is green. This 
setting does not place a call and does not call the primary Detector Phase when the entered 
switch phase is green (per NTCIP specifications).   

This setting can be used for the permitted phase of a permitted plus protected left turn. Do 
not use with a lagging left turn because the protected left will not get called while the 
permitted phase is green. The default for permitted plus protected is to have the Detector 
Phase equal to the Protected Phase and Switch Phase set to none. 

  

Page | 6-42



  MnDOT Traffic Signal Timing and Coordination Manual 
 

May 2017  Synchro and SimTraffic 

 

 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

   

Synchro and SimTraffic Course  2-35 

Leading Detector, Trailing Detector 
Leading and Trailing Detector settings maintain backward compatibility with earlier versions 
of Synchro.  The Detector Template method in Version 7 allows the user to specify the 
position, size, and call/extend value of each detector rather than accept the assumed 
geometry in the Leading/Trailing Detector method.  The Detector Template automatically 
updates the Leading/ Trailing Detector fields. 

Detector n Position 
This is the distance from stop bar to the trailing edge (closet to stop bar) of detector n. This 
setting is for all lanes in the lane group. 

Refer to the example below. In this example, detector 1 (D1) has a position of zero feet, 
detector 2 (D2) has a position of d2, detector 3 (D3) has a position of d2 plus d3, and 
detector 4 (D4) has a position of d2 plus d3 plus d4. 

 

Detector n Size 
This is the size of the detector in the traveled direction.  The default for detectors made from 
Leading Distance is 6 ft (1.8m). This setting is for all lanes in the lane group. 

Detector n Type 
The options are Calling, Extend, Cl+Ex; Calling places a call when the phase is yellow or red.  
Extend places a call when the phase is green.  Options for delay, queue, and extend detectors 
are set by using a non-zero time for these options. 

All detectors modeled in Synchro are presence detectors, not passage (or pulse) detectors. 

Detector n Channel 
Enter the detector number used by the controller.  If there is a different detector channel for 
each lane, enter each value separated by columns. Traditionally the detector number is the 
same as the phase number, and one channel is used for all the detectors for a phase.  Newer 
installations may have a separate detector input for each lane to allow volume counts.  If the 
detector channels across three lanes (left to right) are 11,12, and 13; enter “11,12,13”. 

Detector n Extend 
Detector Extend, or "carry over" is specified in tenths of a second.  This value extends the call 
for the specified value after the call drops.   

D2D3

d3

Stop 
Bar

d2

D4 D1

d4

D = Detector
d = Distance
s = Size of Detector 

s4 s3 s2 s1

D2D3D4 D1

The Detector Channel is 
not currently used by 
Synchro or SimTraffic, but 
can be imported and 
exported in UTDF data 
access.  In the future 
there may be a conversion 
program to convert counts 
by detector number into 
counts by turning 
movement for use by 
Synchro. 
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One application is to have 3 seconds extend time on advance detectors, and 0 extend time at 
the stop bar, in conjunction with a gap time of 0.5 seconds.  This will allow the advance 
detectors to hold the phase green, while the stop bar detectors will not. 

Detector 1 Queue 
Enter the Queue time here to have the stop bar detector act as a queue detector, the old 
name is “Type 3 detector”.  A queue detector will extend the phase during the first q 
seconds, then be silent.  Queue detection is useful for extending the phase during the queue 
clearance time, then later allowing the advance detectors to extend the phase.   

If the stop bar detector extends the phase for 3 seconds, this will create 3 seconds of green 
after the last vehicle enters the intersection. This vehicle will be well beyond the intersection 
during the clearance interval. This will create extra delay for the opposing movements. 

Detector 1 Delay 
Enter the Delay time here to have the stop bar detector act as a Delay detector.  A delay 
detector will not place a call on red or yellow, until the vehicle has been there for at least d 
seconds.  A delay detector will extend normally on green.  Delay detectors are useful for right 
turn lanes with right turn on red allowed; If a vehicle is able to turn on red within, for 
example, 10 seconds, it is not necessary to bring up this phase. 

Detector Template 
Detector Templates allow the user to define the number, position, type and size of each 
detector.  Default templates named Left, Thru, and Right are used to setup detectors for 
new approaches.  You can modify these templates, but you cannot remove them.  It is 
recommended that you setup templates for all of the standard detector layouts your agency 
uses.  Give them names such as “Thru 300” for through detectors located 300 feet in 
advance of the stop bar. 

Add Template 
Activate the Detector Template Editor by selecting Options→Detector Templates, or by 
double clicking on the left column of the DETECTOR settings. The Detector Template Editor 
allows the user to define additional templates in separate columns. Data fields are identical 
with the DETECTOR settings.   

 
The inputs on the Template are the same as those in the DETECTOR settings, except for the 
detector phase and detector channel.  
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Select the [New] button to create an empty template and specify the template name. 

Select the [Copy] button to duplicate the active column. The copied column will be inserted 
to the right. Data can be edited and template renamed. 

The [Delete] button will remove the active column. The default Left, Thru and Right columns 
cannot be removed. 

Use the Update Lane Detectors to Template [This Template] button to update all lane groups 
with that detector template name. 

Use the Update Lane Detectors to Template [All Templates] button to update all lane groups 
with any detector template name. 

Detectors associated with a template are not automatically updated when the template is 
modified. Therefore, apply the Update Lane Detectors to Template button after modifying a 
template. 

There is no cancel button. Use the undo command to rollback to the previous settings. 

Default Detector Settings  
The default detector settings are saved in the same defaults.syn file as all other default 
values. To load Detectors Templates you have to press Defaults in the Detector Template 
Editor and set the check box Load Detector Templates. After that you can use the saved 
default detector settings from defaults.syn or choose a Synchro file to load those templates. 
Also you can load Network Defaults by setting the “Load Network Defaults” checkbox. 

  
The same Load Defaults window will appear if you press “Defaults” button in the Network 
Settings window. 
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Note: Be sure to check 
and establish appropriate 
pedestrian timings in the 
PHASING settings. 

An existing conditions 
analysis is important to 
establish a base line, if 
there is an existing 
condition. This will assist 
the analyst in 
determining if the 
alternatives truly are 
better (and how much 
better). 

Be sure to save your work 
frequently! Your data is 
stored in the SYN file and 
backed up in the ~YN file 
every time you save your 
work.

2.9 Synchro Data Entry Quick Start 
Entering data in Synchro can be intimidating for first time users. The purpose of this section 
is to give the basic steps that are required to quickly get your data entered. For a basic 
intersection, the steps would be as follows: 

1. Draw your links then enter your lane and volume data for your intersection (see the 
sections on the Map View, Lane Settings and Volume Settings). 

2. Choose the appropriate Phase Template (Options→Phase-Templates) to match your 
numbering convention. This step is necessary so Synchro can use the appropriate 
template when setting up Turn Types and phase numbers. 

This step is not required if you want to use the Synchro default template (North/South 
template) or if you are coding an unsignalized intersection or roundabout. 

3. Choose your controller type. For signalized intersections, this can be set to a 
pretimed, semi-actuated uncoordinated, actuated-uncoordinated or actuated-
coordinated (see page 2-21).  

4. For unsignalized intersections, this can be set to an unsignalized (stop or yield 
controlled) or roundabout intersection.  

5. Select the appropriate Turn Type for your left and right turns. This is the step where 
you will define how your turning movements are phased (protected, permissive, 
free, etc.). If you have defined the Phase Template in step 3, Synchro will 
automatically assign phase number for your turn treatments based on the diagram 
shown above. During this step, also identify your leading 
and lagging phases as necessary.  

If this is an unsignalized or roundabout intersection, you 
would select the appropriate sign control (stop, free or yield). 

6. Input the appropriate phasing parameters (detailed in the 
section on Phasing Setting Inputs, page 2-25). 

7. Enter the appropriate Cycle Length. If you are not performing an existing conditions 
intersection analysis, you can determine the cycle length by performing an 
intersection cycle length optimization (see page 3-5) or a network cycle length 
optimization (see page 3-7). 

8. Adjust the phase splits with the Splits and Phasing diagram using your mouse. Move 
your mouse cursor to the right side of a yellow + all red band and it will change to 

the shape shown here . Hold down the left mouse button and move the mouse 
right or left to adjust the split.  

9. For coordinated systems, enter your offset parameters (current offset, reference 
style and reference phase as shown on page 2-22). 

10. If you plan to simulate, enter the necessary simulation settings, see page 2-29. 
11. For detailed entry of detectors, see page 2-34. 
12. Use the command Options→Scenario-Manager and update the Scenario 

information. This will appear on the Reports. 

 

If you do not plan to use 
your timing data for 
controller inputs (such as 
a planning study), the 
template phase you use is 
irrelevant. The primary 
purpose of setting up the 
phase templates is to 
match how they are in 
your controller.  However, 
if your system is 
coordinated, use your 
main street direction 
phases as the coordinated 
phases. 
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Synchro delay 
calculations will differ 
from the Webster/HCM 
based on differences in 
the methodology. 
Synchro uses a percentile 
delay method for 
calculating the delay for 
signalized intersections. 
In Synchro, the delay is 
based on five differing 
volume and cycle lengths 
(percentile volumes and 
green times). The delay 
answer is then a 
weighted average of five 
representative delays. 
The Webster/HCM 
method uses one cycle 
and one average volume 
to represent the analysis 
period. 

Generally, the results will 
be similar if the actuated 
green times are used in 
the HCM method. 

If you use the Optimize→
Intersection-Cycle-Length 
command, the intersection
will be set to the Natural
Cycle Length. 

3. LEVEL I – DAY 2 
3.1 Analysis of Intersections 
Percentile Green Times 
There are five scenarios modeled. They are called the 90th, 70th, 50th, 30th, and 10th 
percentiles.  Traffic volumes for each approach are adjusted up or down to model these 
percentile scenarios.  By adjusting the traffic for different scenarios, the actuated signals can 
be modeled under a range of traffic conditions. 

If traffic is observed for 100 cycles, the 90th percentile would be the 90th busiest, the 10th 
percentile would be the 10th busiest, and the 50th percentile would represent average 
traffic. 

The expected number of vehicles, λ or 50th percentile, is the hourly flow rate divided by the 
number of cycles per hour.  

���������	
��������������
��
��������
The expected number of vehicles for a given percentile can be calculated using a Poisson 
distribution. The simplified formula to determine adjusted volumes is thus: 

��
For each percentile scenario and phase, a green time is given. The range of green times for 
each phase gives an indication of how often the phase will max-out, gap-out, or be skipped. 
Details on actuated green time calculations is shown in Section D. 

Next to each green time is a code indicating how the phase terminates.  Here is a list of 
codes. 

sk Phase is Skipped pd Phase held for pedestrian button or recall

mn Phase shows for Minimum Time mr Phase has max-recall

gp Phase gaps-out dw Main street phases dwells or green

hd Phase held for other ring to cross 
barrier. 

cd Coordinated phase

mx Phase maxes out. 

 

Actuated Cycles 
There are five scenarios modeled. They are called the 90th, 70th, 50th, 30th, and 10th 
percentiles.  Traffic volumes for each approach are adjusted up or down to model these 
percentile scenarios.  By adjusting the traffic for different scenarios, the actuated signals can 
be modeled under a range of traffic conditions. 

If traffic is observed for 100 cycles, the 90th percentile would be the 90th busiest, the 10th 
percentile would be the 10th busiest, and the 50th percentile would represent average 
traffic. 

For each of the percentile scenarios, this is the expected cycle length.  This value is the sum 
of the actuated splits for each phase. 

λ = v *
C

3600

vP = v +  z *  (v * C / 3600)    *
3600

C

For coordinated and pre-
timed signals, the actuated 
cycle will be the same as 
the Current Cycle Length. 
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Capacity, c is based on 
the saturation flow 
multiplied by the green to 
cycle (g/C) ratio. 
Therefore, if v/c > 1.0, to 
reduce this you can 
reduce volume, v; 
reallocate green time, 
g/C; or increase the 
saturation flow, s 
(increase lanes). 

Synchro strictly follows 
the methods of the 2000 
HCM for unsignalized 
intersections. This 
method does not provide 
for a queue delay. 
Therefore, a queue delay 
will not be reported for 
any unsignalized 
intersection. If this is 
important, then consider 
simulating the network 
with SimTraffic. 

Actuated Cycle Length 
 The Actuated Cycle Length (CL) is the average cycle length for five percentile cycle lengths.  

Natural Cycle Length 
Natural Cycle Length is the shortest cycle length that will give acceptable capacity. In general, 
intersections have an optimum cycle length that provides the best level of service. The 
Natural Cycle Length is the cycle length this intersection would operate at if it were to 
operate independently of all other intersections.  

Actuated Effective Green 
This value represents the average green time observed while the signal is operating in 
actuated mode (average of five Percentile green times).  This value may be less than 
Maximum Green time if the phase is skipped or gapped out. The actuated green time may 
be higher than the Maximum Green time for Coordinated and Dwelled phases. This value is 
used for the HCM Signal Report calculations. 

Actuated Green to Cycle Ratio 
This if the average actuated green time divided by the actuated cycle length. This value 
indicates what portion of the green per cycle is given to this subject movement. 

Volume to Capacity Ratio 
The movements Volume-to-Capacity Ratio (v/c Ratio) is the v/c ratio using actuated green 
times and cycle lengths. If this value exceeds 1.0, this indicates that the volume is exceeding 
the available capacity.     

Control Delays 
This is the Percentile Delay for each lane group. This is based on five percentile volumes and 
green times.  

Queue Delay 
Queue Delay is an analysis of the affects of queues and blocking on short links. This delay 
includes the analysis of Spillback and Starvation. Additional details on Queue Delay and 
queue interactions can be found in the Synchro Help topic, Queue Interactions. 

Total Delay 
Total Delay is the lane group Control Delay plus the Queue Delay. 

Level of Service 
The Level of Service for the lane group is calculated by taking the Delay and converting it to a 
letter, between A and F, based on the length of the delay.  

Signalized Unsignalized 
LOS Total Delay Per Vehicle (s) Control Delay Per Vehicle (s) 

A � 10 � 10
B >10 and � 20 >10 and � 15 
C >20 and � 35 >15 and � 25 
D >35 and � 55 >25 and � 35 
E >55 and � 80 >35 and � 50 
F >80 >50

Keep in mind that the unsignalized delay does not include queue delay. 
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Important: Queue 
lengths are determined in 
different methods 
between Synchro and 
SimTraffic. Therefore, it is 
likely that they will not 
match. 

Synchro is a macroscopic 
software package and 
uses analytical methods 
for calculating the queue. 
In other words, equations 
are used to determine the 
queue length. When 
volume exceeds capacity, 
the limits of the 
equations are exceeded. 

SimTraffic is a 
microscopic simulation 
program that actually 
“observes” the queues. 
The model simulates the 
vehicle and reports 
whenever a vehicle is 
traveling less than 10 ft/s 
and is behind a queue of 
vehicles. This distance 
then gets reported. At the 
end of the period, 
SimTraffic determines the 
maximum, the average of 
2 minute maximums, and 
the 95th percentile queue.

The delay shown in the 
TIMING Settings is the 
Percentile delay. This is 
the same delay that will 
be shown in the ‘INT:’ 
reports.

For two-stage gaps, the 
Critical Gap is the combined 
single stage tC. When two-
stage, each stage is 1 
second less. 

Approach Delay 
 This is the delay for the direction approach based on the weighted average of the lane 
groups for this direction. 

Approach Level of Service 
 This is the approach LOS based on the approach control delay using the same table above. 

Queue Lengths 
The Queue Length rows show the 50th Percentile and 95th Percentile Maximum Queue 
lengths.  The 50th percentile maximum queue is the maximum back of queue on a typical 
cycle and the 95th percentile queue is the maximum back of queue with 95th percentile 
traffic volumes.  

If traffic were observed for 100 cycles, the 95th percentile queue would be the queue 
experienced with the 95th busiest cycle. The 50th percentile queue would represent the 
queue under average traffic. 

The ~ and # footnote indicate that the volume modeled exceeds capacity. The ~ footnote 
indicates that the approach is above capacity and the queue length could be much longer. 
The queue length is theoretically infinite and blocking problems may occur. The value shown 
for the 50th percentile queue is sufficient to hold one cycle of traffic. This will prevent 
capacity problems from being compounded by insufficient storage space. 

The # footnote indicates that the volume for the 95th percentile cycle exceeds capacity. This 
traffic was simulated for two complete cycles of 95th percentile traffic to account for the 
affects of spillover between cycles. If the reported v/c <1 for this movement, the methods 
used represent a valid method for estimating the 95th percentile queue. In practice, 95th 
percentile queue shown will rarely be exceeded and the queues shown with the # footnote 
are acceptable for the design of storage bays. 

The m footnote indicates that volume for the 95th percentile queue is metered by an 
upstream signal. 

Critical Gap 
The critical gap, tC, is defined as the minimum length of time interval in the major street 
traffic stream that allows intersection entry for one minor street vehicle. The value in 
Synchro is the value that is defined by equation 17-1 from the HCM.  

This value can be over-ridden. 

This value is only used for HCM unsignalized calculations and will have no impact on the 
SimTraffic simulation. 

Follow-up Time 
The follow-up time is the time span between the departure of one vehicle from the minor 
street and the departure of the next vehicle using the same major street gap, under a 
condition of continuous queuing on the minor street. The value in Synchro is the value 
defined by equation 17-2 after adjusting for heavy vehicles. 

This value can be over-ridden. 

This value is only used for HCM unsignalized calculations and will have no impact on the 
SimTraffic simulation. 

Maximum v/c Ratio 
 This field shows the maximum Volume-to-Capacity ratio of all individual v/c ratios.  
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Intersection Delay 
 The Intersection Delay field shows the average delay for the intersection and it is calculated 
by taking a volume weighted average of all the delays. This delay will be the Synchro Control 
delay which is based on the Percentile method.  

Intersection Level of Service 
 This LOS will be on the Synchro Control delay. The Level of Service for the intersection is 
calculated by taking the Intersection Delay and converting it to a letter using the Table 
previously described. 

Intersection Capacity Utilization 
This is the Intersection Capacity Utilization (ICU) for the intersection based on the ICU 2003 
method. Full details of the ICU can be found in the topic, Intersection Capacity (ICU) Report 
in the Synchro Help file. There is also an ICU document and spreadsheet in your Program 
Files/Trafficware directory. 

ICU Level of Service 
The ICU Level of Service (LOS) gives insight into how an intersection is functioning and how 
much extra capacity is available to handle traffic fluctuations and incidents.  ICU is not a 
value that can be measured with a stopwatch, but it does give a good reading on the 
conditions that can be expected at the intersection.  

A letter A to H based on the table and the Intersection Capacity Utilization. Note that the ICU 
2003 includes additional levels past F to further differentiate congested operation. 

LOS ICU Level of Service 
A �55.0%* 
B >55% to 64.0% 
C >64% to 73.0% 
D >73% to 82.0% 
E >82% to 91.0% 
F >91% to 100.0% 
G >100% to 109.0% 
H >109% 

Warning Indicators 
The lower right cells of the Synchro window indicate potential intersection coding errors or 
timing problems when Red. Green indicates no errors. 

Conflict indicates a phase or coincident phase(s) serve conflicting movements.  Look at the 
Protected Phasing row for red phase numbers.  No conflict checking is performed on 
permitted phases. 

v/c > 1 indicates that Volume exceeds capacity for one or more movements.  It may also 
indicate volume was coded without lanes or green time.  Look at the v/c row for values 
greater than 1 or for "No Cap" errors. For congested intersections, a v/c >1 error may be 
unavoidable.  

Min Err indicates that one or more splits violate minimum timing requirements.  Look at the 
Total Split row for values in red.  Also compare the Maximum Split in the PHASING settings 
to the Minimum split.  A Min Err may also occur if timings are too short for pedestrian 
timings. 

Do not confuse the ICU 
LOS and the delay LOS. 
They are based on 
different criteria so they 
are not comparable.

The ICU is shown for un-
signalized intersections 
since it represents the 
potential capacity for the 
intersection if it were to be 
signalized. 
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Note: Each project does 
not require every 
optimization menu 
command. For instance, 
whenever you change the 
cycle length (manually, 
intersection-optimize or 
network-optimize) the 
splits are automatically 
optimized. Therefore, it 
would be redundant to 
optimize the splits after 
optimizing the cycle 
length. 
See page 4-22 for 
additional examples of 
when to use these menu 
commands. 

Synchro attempts to 
provide enough time 
during the split 
optimization to clear 90th

percentile traffic flows. 
This ensures enough time 
is available for volume 
fluctuations. 

3.2 Intersection Optimization 
Optimize-Intersection Splits 
The Optimize→Intersection-Splits command will automatically set the splits for all the 
phases. Time is divided based on each lane group's traffic volume divided by its adjusted 
saturated flow rate. The Split Optimizer will respect Minimum Split settings for each phase 
whenever possible. See page 4-21 for additional information. 

Optimize-Intersection Cycle Length 
The Natural Cycle length is the lowest acceptable cycle length for an intersection operating 
independently.  The natural cycle length appears on the TIMING Settings. 

The Optimize→Intersection-Cycle-Length command will set the intersection to the Natural 
Cycle Length. 

The Natural Cycle Length will be one of three possibilities. 

1. Shortest Cycle Length that clears the critical percentile traffic. 
2. Cycle Length with the lowest Performance Index, provided lowest PI cycle is less 

than cycle found in (1).  This option is used to give reasonable cycles for 
intersections over capacity. 

3. If no cycle is able to clear the critical percentile traffic, but a shorter cycle is able 
to give satisfactory v/c ratios, the shorter cycle length will be used.  This is a 
special case to handle near capacity intersections with permitted left turns. 

Optimize-Intersection Offsets 
To change a single intersection's timing plan so that it works best with its neighbors, click on 
an intersection to select it, then choose the Optimize→Intersection-Offsets command. This 
command tests all possible offsets and lead-lag combinations. This command chooses the 
timing plan for this intersection that minimizes delays on links between this intersection and 
its immediate neighbors.   

For each offset and lead-lag combination Synchro will reevaluate the departure patterns at 
this and surrounding intersections and recalculate delays.  Synchro will also recalculate 
skipping and gap-out behavior at actuated-coordinated intersections.  

When optimizing offsets, Synchro will look at offsets every 16 seconds around the cycle.  
Synchro will take those with the lowest delay score and look at offsets nearby every 4 
seconds.  Synchro will then take those with the lowest delays and look at offsets nearby 
every 1-second. 

If you optimize the cycle 
length, the splits will be 
automatically optimized to 
fit into the new cycle 
length. 

This command only 
changes the selected 
intersection. It does not 
make any changes to 
surrounding intersections. 
There may be better 
timing plans available by 
changing the timings of 
surrounding intersections, 
but Optimize-Intersection 
Offsets and Phasing will 
not find them. To find the 
best timing plans overall, 
use the 
Optimize→Network-
Offsets command. 
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3-6   Synchro and SimTraffic Course 

CF = Max(CF1, CF2) + Ap 
+ Av + Ac 

Where, 
CF = Coordinatability 

Factor 
CF1 = Initial 

Coordinatability 
Factor from Travel 
Time 

CF2 = Initial 
Coordinatability 
Factor from Volume 
per Distance 

Ap = Platoon 
Adjustment 

Av = Volume 
Adjustment 

Ac = Cycle Length 
Adjustment 

3.3 Network and multi-system optimization 
Synchro contains a number of optimization functions.  It is important to understand what 
each function does and use the optimizations in the correct order. 

Step 1: Single Intersection Timing Plans 

The first step is to make timing plans for each individual intersection. This is the process of 
determining the phase sequences, left turn treatments and any other special phasing 
patterns. If this is an existing condition, the single intersection timing plan may already be 
established. 

Step 2: Partition Network (Optional) 

The next step is to divide the network into subsystems.  This step is optional.  It is up to 
engineering judgment to decide whether to partition a network. This will change the zone 
names. 

Step 3: Optimize Network Cycle Length 

The next step is to determine a system cycle length.  It is possible to assign a different cycle 
length to each zone and create multiple zones (see below). 

Step 4: Optimize Offsets, Lead-lag Phasing 

After determining a system cycle length (or several cycle lengths), the last step is to optimize 
offsets.  Use the Synchro command Optimize→Network-Offsets. 

Tips to Improve Optimizations 
Be sure to set the Maximum Cycle Length using the Option→Network-Settings command. 
Congested intersections may be set to the Maximum Cycle Length in many situations. 

If there are permitted left turn movements with a v/c of greater than 1, consider making a 
protected left turn phase or prohibiting left turns at this intersection. 

If you find that there are blocking problems between closely spaced intersections, consider 
using alternative phase orders, such as lagging lefts, lead-lag phasing, or split phasing. If you 
set the Allow Lead/Lag Optimize? field in the PHASING settings to "Yes" then Synchro will 
try both leading and lagging for that phase. 

When optimizing Offsets, optimizing the Lead-Lag Phasing slows down the optimization 
process. If you want a faster optimization, turn off Allow Lead/Lag Optimize?. 

The Cycle Length Optimization can take quite a while.  Consider limiting the number of cycles 
evaluated. 

Coordinatability Factor 
The Coordinatability Factor (CF) is a measure of the desirability of coordinating the 
intersections. Several criteria are used in an attempt to determine whether coordination is 
warranted. These criteria are used to determine a CF on a scale from 0 to 100 or more. Any 
score above 80 indicates that the intersections must be coordinated to avoid blocking 
problems; any score below 20 indicates the intersections are too far apart, or coordination is 
otherwise not desirable.  

The CF is used with the Partition Network optimization. Intersections with CF values above 
the threshold CF are placed in the same zone or signal system.  

Step 2 is used to break 
networks into Zones. If 
you already have your 
zones determined, you 
can skip Step 2. 
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Example: Assume you 
have node 1 and 2 with a 
Coordinatability Factors 
equal to 60 between them. 
If you choose the Partition 
Network strategy “Divide 
Sometimes (50)”, the two 
nodes will be placed in the 
same zone since 60 is 
greater than 50. If you 
choose the Partition 
Network strategy “Divide 
Often (70)”, the two nodes 
will be placed in different 
zones. 

To see a detailed listing of 
the factors of the CF select 
the File�Create Report 
command and include a 
report for 
Coordinatabilities, or 
double-click on any link 
while the CFs are 
displayed. 

To answer the question, 
‘why were these two 
intersections coordinated 
together?’, look at their 
natural CF. To answer the 
question, ‘why are these 
two intersections not 
coordinated together?’, 
look at their current CF. 

The CF is also used with cycle length optimization when uncoordinated intersections are 
allowed. Intersections with CF values below the threshold CF are allowed to be independent 
and uncoordinated.  

 

Summary of Coordinatability Factor  

To see CFs select the Show Natural Coordinatability Factors button or the Show Current 
Coordinatability Factors button. The CF for each link will appear on the map.  

Current versus Natural Coordinatability Factor  

The Current Coordinatability Factor uses the current cycle length and timings to calculate the 
CF. The Natural Coordinatability Factor uses the intersection's natural cycle lengths. The 
Natural CF is used to initially determine which intersections should be coordinated. The 
Current CF is used to analyze the current timing plan and justify whether or not to coordinate 
additional intersections.  

Partition Network (Optional Step) 
Choose Optimize→Partition-Network to divide a network into multiple systems.  Each 
intersection is assigned a zone.  Existing Zone assignments will be changed.  This command 
does not actually change timings, but it sets up the network to have multiple cycle lengths 
when Optimizing Network Cycle Lengths. 

The partition network optimization calculates Coordinatability Factors (CFs) for each pair of 
adjacent intersections. Any intersections with a CF above the threshold value are put into the 
same zone.  

The CF value will range between 0 and 100.  When choosing a Partitioning strategy the 
number in parenthesis is the threshold CF. If One System is selected all connected 
intersections will be placed in the same zone. 

Optimize-Network Cycle Lengths 
Choose the Optimize→Network-Cycle-Lengths command to optimize cycle lengths for the 
network. 

Optimize Network Cycle Lengths Options 

Minimum, Maximum, and Increment Cycle Length: Enter the minimum and maximum cycle 
lengths to evaluate. The optimizer will evaluate every cycle length between the minimum 
and maximum at increment intervals.  If the values are set to 60, 100, and 10; the optimizer 
will evaluate cycle lengths of 60, 70, 80, 90, and 100 seconds.  

Allow Uncoordinated: This option will recommend some intersections to be uncoordinated.  
The number in parentheses is the threshold Coordinatablity Factor (CF). Intersections will be 
made independent when the following apply: 

1. CF with all neighbors is less than threshold CF. 
2. Space required for one cycle of traffic less than 80% of storage space. 
3. If the sum of Minimum Splits exceeds the Evaluation Cycle, the intersection will 

be set to uncoordinated. 

Allow Half Cycle Length: This option will place some intersections at half cycle length.  This 
option can give snappier operation and less delay at less congested intersections.  Half Cycle 

If Allow Half Cycles is 
selected, only even 
numbered cycle lengths 
will be evaluated.  If min, 
max, and incr are set to 
80, 120, and 5, and half 
cycles are allowed, the 
optimizer will evaluate 80, 
86, 90, 96, 100, 106, 110, 
116, and 120. 

The best cycle length is 
found by calculating a 
performance index.  

The PI is calculated as 
follows. 

PI = [D * 1 + St * 10] / 
3600 

D = Delay in Seconds 
St = Stops 
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3-8   Synchro and SimTraffic Course 

Intersections will be given a cycle length of 1/2 the evaluated cycle.  Intersections will be half 
cycled when they meet the following criteria: 

1. Natural Cycle ≤ Evaluation Cycle / 2 
2. Space required for one cycle of traffic less than 120% of link storage space. 

Preserve Files: With this option a file is saved for each cycle length.  These files can be loaded 
afterwards for evaluation or used for a multi-file comparison report.  The files are given the 
name "filename-050.sy5" where filename is the name of the file and 50 is the cycle length. 

Offset Optimization:  Choose Quick to evaluate many cycle lengths quickly.  Choose Medium 
or Extensive to analyze several cycle lengths in detail. 

Automatic: The automatic option will automatically select the best cycle length based on the 
cycle with the lowest Performance Index (PI). It is possible to have each zone assigned a 
different cycle length. 

Manual: The manual option will create a table of cycle lengths with MOEs listed.  The user 
can choose the “best” cycle length.  Each zone can be assigned its own cycle length or all 
zones can be assigned a single cycle length. 

Manually Selecting a Cycle 

After performing a manual cycle length optimization, the SELECT CYCLE LENGTHS window 
will appear.  Each cycle has MOEs listed for Percentile Delay, Stops, Fuel Consumption, 
Unserved vehicles, Dilemma vehicles and speed.   

Master Intersection 

In Synchro there is one or zero master intersections for each cycle length. Half cycled 
intersections share the master.  When changing offsets it is possible to combine two masters 
into the same cycle length and only one intersection will remain master. 

A common misconception is that there is one master per zone.  This is not true, there is one 
master per cycle length.  Two zones with one cycle length can have only one master, even if 
they are not physically connected. 

Optimize-Network Offsets 
The final step to Network optimization is to optimize offsets.  This step should be performed 
after the cycle length has been determined. 

Choose the Optimize→Network-Offsets command.   

Scope 

Choose Zone and enter a zone to perform optimizations on a group of intersections.  To 
select multiple zones, separate the zones with a comma. 

Choose Entire Network to optimize the entire network. 

Optimizations 

Optimize Splits will perform a Split Optimization for all intersections in the current scope.  
Cycle lengths are not affected.  Perform this step if volumes or geometry has changed since 
the cycle length has changed. 

Offset Optimization Speed controls how many optimization passes are performed and the 
step size of each pass.  

The objective of the 
network offset 
optimization is to minimize 
the delay. 

Often, users will ask if a 
direction can be ‘favored’. 
Since delays are already 
volume weighed, Synchro 
directly favors the 
directions with the higher 
volume. 
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The Step Size controls how many offsets are looked at with incremental offset optimization.  
Using a value of 1 will check offsets in 1-second intervals.  Using a value of 2 will check offsets 
in 2-second intervals and take less time.  It is recommended that offsets be optimized with a 
step size of 4 first and followed with a step size of 1. 

[OK] starts the optimization process.  All of the checked optimizations will be performed in 
order. 

Do not select Optimize Splits after performing a cycle length optimization.  These values are 
already optimized and any incremental optimization will be lost. 

Allow Lead/Lag Optimize? is enabled for some passes.  This feature will try reversing phase 
orders to improve coordination.  This optimization is only performed for phases with Allow 
Lead/Lag Optimize? set to Yes. 

Weighing 

Optimize Splits will perform a Split Optimization for all intersections in the current scope.  
Cycle lengths are not affected.  Perform this step if volumes or geometry has changed since 
the cycle length has changed. 
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3-10   Synchro and SimTraffic Course 

3.5 Program Reports 
Printing Windows 
To print the current window type [Ctrl] + [P]. This will print the currently active Map View, or 
the TIME-SPACE DIAGRAM to the current printer. When you select the File→Print-Window 
command from the VOLUME, LANE, TIMING, PHASING, SIMULATION or DETECTOR screen, 
a report is created containing information from that view. 

Select Reports Window 
When choosing the File→Create-Report command, the Select Report(s) window appears. 
From this window you can select the reports to include and options for each report. 

 

Zoom in the Report Preview 
A Zoom control has been added to the Report Preview window to preview the report using a 
bigger or smaller scale.  

Intersection Reports 
There are 7 Intersection Reports. These begin with ‘Int:’ for the name in the Select Reports 
box.  These reports provide information about individual intersections.  Each of these reports 
can be customized with the Options panel of the right sides.  The Lanes, Volumes, Timings, 
Phasings and Simulation Settings reports contain the same information found in the data 
entry screens.  The Queues report contains information about queues and blocking. 

Intersection Queue Report 
The Intersection Queue report contains information about Maximum Queue Lengths, 
Blocking Information and Queue Delays. 

The Queue report shows the 50th Percentile and 95th Percentile Maximum Queue lengths. 
See the User Guide for further details. 

The ~ footnote indicates that the approach is above capacity for the 50th percentile traffic 
and the queue length could be much longer.  The queue length is theoretically infinite and 
blocking problems may occur. 

The # footnote indicates that the volume for the 95th percentile cycle exceeds capacity. This 
traffic was simulated for two complete cycles of 95th percentile traffic to account for the 
affects of spillover between cycles. 

Queue Delay is an analysis of the affects of queues and blocking on short links. 

If you choose the ‘Int:’ 
reports with delay, this is 
the same delay as found in 
the TIMING Settings. 

Use the Header button to 
change the header and 
footer information on your 
report.

Choose the Graphics
button to  change fonts, 
row shade colors, 
horizontal lines, fonts and 
picture attributes. 

Save-Text will print the 
selected report to a text 
file. This can be opened 
with any text editor. It can 
also be opened with a 
spreadsheet (tab 
delimitated) and formatted 
for your special reports. 

Use File>Print-Window to 
print the current Map View 
to your printer. 
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Additional Details can be 
found in the Intersection 
Capacity Utilization 2003
book. A copy of this book 
can be obtained from 
Trafficware. 

The HCM Signal Report 
now includes a RTOR 
reduction calculation. The 
Lane Group Flow is now 
equal to the Adjusted Lane 
Group flow minus the 
RTOR reduction. 

Base Capacity is the capacity of the lane group if unimpeded. Capacity is the lane group 
saturation flow multiplied by the lane group green to cycle ratio. 

The Starvation Capacity Reduction is the reduction to the base capacity due to starvation.  

Spillback Capacity Reduction is a reduction to the base capacity caused by a short 
downstream link becoming filled up. 

Intersection Capacity (ICU) Report 
The Intersection Capacity Utilization provides a straightforward method to calculate an 
intersection's level of service. The method simply takes a sum of the critical movements 
volume to saturation flow rates. 

ICU is an ideal solution for traffic planning purposes. Its intended applications are for traffic 
impact studies, future roadway design, and congestion management programs. The ICU is 
not intended for operations or signal timing design. The primary output from ICU is 
analogous to the intersection volume to capacity ratio. Other methods such as Synchro and 
the HCM should be used for operations and signal timing design.  

The ICU does not provide a complete picture of intersection performance, but it does 
provide a clear view of the intersection's volume related to its capacity. Compared to delay 
based calculations, the ICU is relatively easy to calculate and does not include the 
opportunities for guessing and manipulation found in the HCM. 

The ICU is timing plan independent. It makes no analysis about the currently implemented 
signal timing plan. The ICU can be applied to an unsignalized intersections and give 
information about the ultimate capacity of an unsignalized intersection if it were signalized. 

HCM 2000 Signal Report 
This report provides a full implementation of the HCM 2000 Signalized Operations method. 
See page 4-3 for details on how Synchro delays compare to HCM delays. 

Synchro delay calculations (Int: Reports and TIMING Settings) will differ from the HCM Signal 
Report based on differences in the methodology. Synchro uses a percentile delay method for 
calculating the delay for signalized intersections. Details on this methodology can be found in 
the Synchro Help topic "The Percentile Delay Method". The HCM Signal Report strictly 
follows the methods of the year 2000 Highway Capacity Manual, Chapter 16. 

Refer to the note on page 3-1 for additional information. 

HCM Unsignal Report (2000) 
The HCM Unsignalized Report is based on the HCM 2000 Chapter 17. 

HCM 2010 Signal Report 
This report is for the 2010 HCM Signal methods as described in Chapters 18 and 31 and as 
implemented in the available computational engine. 

HCM 2010 Pedestrian Report 
This report is based on the 2010 HCM Pedestrian methods for signalized intersections. 

HCM 2010 Bicycle Report 
This report is based on the 2010 HCM Bicycle methods for signalized intersections. 

HCM 2010 Roundabout Report 
This report is based on the 2010 HCM Roundabout methods. 

From page 10-7 of the 
HCM: 

"The portion of the urban 
street being analyzed 
should be at least 1 mi 
long in a downtown area 
and 2 mi long elsewhere 
for the LOS speed criteria 
to be meaningful. Study 
lengths shorter than 1 mi. 
should be analyzed as 
individual intersections 
and the LOS assessed 
according to individual 
intersection criteria.”
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Arterial Level of Service Report 
The Arterial Level of Service report contains information about the speed and travel time for 
an arterial.  This report mirrors the reports used in the Arterials section of the HCM (year 
2000), Chapter 15 with concepts defined in Chapter 10. The Arterial report can also be 
compared with field travel time studies. 

A report is created for each direction of the arterial. 

Network Measures of Effectiveness Report 
The MOE reports display quantitative information about the performance of intersections 
and the network. 

The MOEs can include delays, stops, fuel consumption, queuing penalty, dilemma vehicles 
and emissions. 

The network reports can display information about each approach, each intersection, for an 
arterial, and for the entire zone or network selected. 

Multi-File Comparison Report 
The Multi-file Comparison Report is used to compare multiple alternatives (files) side-by-
side.  

The report could be used to compare a before and after condition, or the report can be used 
to compare MOEs for two or more different timing plans.   

The first page of the comparison report lists each alternative with its scenario information 
and basic statistics. 

Succeeding pages list the MOEs with one column for each alternative.  The MOE information 
follows all of the rules for the Network report. 

To create a multi-file comparison report, choose ‘Detailed Multifile Comparison’ in the Select 
Reports window and select the MOE’s that you want to include. Then select [Print] or 
[Preview] and a window will appear asking which files to compare. If you do not see your 
files, type *.syn (*.syn for Synchro 6 files) in the File Name box. All of the files that you want 
to compare must be in the same directory. When you see the files you want to compare, 
click on the first one, then hold the [Ctrl] key and select the second, third, fourth and so on 
and select [Open]. 

Phases: Timings Report 
Timing Report, Sorted by Phase Number option provides information about the signal timing 
parameters determined by Synchro.  

Most of these values are the same values shown in the TIMING settings or PHASING settings.  

The Timing report (Phases: Timings) also includes a start time, an end time, a yield/force off 
and yield/force off 170. These times are phase references to the beginning of the system 
clock. The 170 yield (to the coordinated phase) is referenced to the beginning of the flashing 
don’t walk. 

Actuated Start and Green Times Summary 
The Actuated Phase Start and Green summary report shows the green time for each phase 
along with the phases' start time.  This information is provided for each of the five percentile 
scenarios. This report is helpful for looking at actuated signals in coordination, to see if 
phases may be starting early. 
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Actuated: Details 
The Actuated Phase Start and Green summary report shows the green time for each phase.  
This information is provided for each of the five percentile scenarios. This report is helpful for 
looking at actuated signals to see the range of green times. 

Actuated Phase Details 
The Actuated Phase Details report shows the green and yellow time for each phase alongside 
the time to clear the queue and the time to gap out.  This information is provided for each of 
the five percentile scenarios. This report is helpful to observe in detail the operation of 
actuated phases. 

Permitted Left Turn Factors Report 
The Permitted Left Turn Factors report provides information about the lanes and saturation 
flow rates. It is roughly equivalent to the HCM's Supplemental Worksheet for Permitted Left 
Turns. 

For details on all of these values, refer to the 1997 HCM, pages 9-17 to 9-22. The value Flt is 
the permitted left turn factor that is seen in the LANE window. 

Coordinatability Analysis Report 
The Coordinatability Analysis report gives information about Coordinatability factors and 
elements used to calculate them.  

Each element that affects the Coordinatability Factor (CF) is shown, along with the affect it 
has on the CF. A CF ranges from 0 to 100 or more. Any value above 50 means that 
coordination is recommended. The higher the CF, the more likely that this link will benefit 
from coordination. 

The factors used to determine Coordinatability are as follows: 

Travel Time 
Traffic to Storage Space 
Proportion of Traffic in Platoon 
Main Street Volume 
Increase in Cycle Lengths needed for coordination 

 

FLT is calculated based on 
maximum green times 
rather than actuated green 
times. This may cause the 
Synchro FLT to vary slightly 
from the HCM calculations.
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3.6 Synchro Integration with SimTraffic 
SimTraffic is a companion product to Synchro for performing microscopic simulation and 
animation. SimTraffic uses a Synchro *.syn file for input.  

SimTraffic includes the vehicle and driver performance characteristics developed by the 
Federal Highway Administration for use in traffic modeling. The underlying formulas 
represent over 20 years of research into traffic modeling. 

SimTraffic Operation 

Loading Files 

Select the File-Open button or the File→Open menu command to load a file. SimTraffic 7/8 
uses Synchro 7/8 style *.syn files for data inputs. 

If you are working with a file in Synchro, you can start SimTraffic by pressing the 
SimTraffic-Animation button or pressing [Ctrl]+[G]. 

Recording and Playback 

Seeding Network 

After a file is loaded, the network is seeded. Network seeding 
fills a network with vehicles, so that there will be vehicles in the 
network when simulation begins. The length of seed time can be 
changed with Options→Intervals-and-Volumes command. 

Simulation Recording 

In SimTraffic there are three ways to create traffic simulations. 
Simulations can be recorded and subsequently played back. 
Alternatively, simulations can be created while animating. 

The Record-Simulation button or [Ctrl]+[E] will perform simulation and record 
information for animation, reports, and static graphics. The length of time recorded 

can be changed with the Options→Intervals-and-Volumes command. 

The Simulate-While-Playing button  ([F5]) will simulate traffic while animating 
(SimPlay). The SimPlay option is useful for quickly viewing traffic. Simulations created 
with SimPlay cannot be used for reports and static graphics.  

In many cases, it is possible to change traffic volumes or signal timings and simulate while 
playing without re-seeding the network. This makes it possible to simulate many similar 
timing plans quickly. To change data without reseeding, it is necessary to start SimTraffic 
from Synchro. 

Playback 

The Speed-Control box shows the current speed and allows the user to change the speed 
quickly. Click on the center red bar to stop playback or SimPlay. Pressing [F2] will also pause 
playback or SimPlay. 

The Stop Simulation button [F2] will stop the simulation playback.  

Clicking on the right bars will play or SimPlay at 1/2x, 1x, 2x, 4x, and 8x speed. If 
simulation data is recorded, it will be played back, otherwise new simulation data will be 
SimPlayed. The simulation may not actually play at the full speed with a large network or on 
a slow computer. To speed animations, consider animating a small part of the network. 

By default, SimTraffic will 
seed for 3 minutes and 
record for 10 minutes. 
These are good values to 
use to get your model ‘up 
and running’. To simulate 
to print reports, it is 
suggested that you record 
your model for 60 minutes 
to see the full impact. 

If you have coded a 
Synchro file, you have also 
created the inputs for 
SimTraffic. To begin the 
simulation and animation, 
you simply need to press a 
button. 

Refer to page 4-28 for 
advanced SimTraffic 
operation. 

A rule of thumb seed time 
is to look at the Arterial 
LOS Report from Synchro 
for all arterials in the 
network. Use the longest 
travel time value; convert 
this to minutes and 
multiple by 2. Use this as 
your SimTraffic Seed time. 
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Clicking on the left bars will play in reverse at 8x, 4x, 2x, 1x, and 1/2x speed. 

The Go-Back-in-Time-to-Beginning-of-Recorded-History button or [<] key returns to 
the start of recorded history. 

The Frame-Reverse button or [-] key takes the animation back 0.5 seconds. SimTraffic 
simulates traffic at 0.1 s increments but only records traffic data at 0.5 increments. A 

frame is therefore 0.5 s. 

The Frame-Advance button or [+] key takes the animation forward 0.5 seconds. 
SimTraffic simulates traffic at 0.1 s increments but only records traffic data at 0.5 

increments. A frame is therefore 0.5 s. 

The Skip-to-the-End-of-Recorded-History button or [>] key sets the animation at the 
end of recorded history. 

The Playback-Time box shows the starting and ending times of recorded history on the left 
and right sides. The center number indicates the current animation time. The needle in the 
playback time box can be dragged to quickly go to a specific time. 

Multiple Simulation Runs 

The Record-Multiple Runs button or [Ctrl]+[M] will perform and record a simulation 
on multiple runs. A dialog will appear allowing the user to select the number of runs 
to simulate and record and the starting random number seed. The random number 

seed will be incrementally increased by one for the simulated runs. For instance, 1, 2, 3, 4 
and 5 if starting from 1 with 5 runs. 

The Run Number of Recorded History will allow the user to load a recorded 
history file if multiple runs have been performed. Choose the number of the 
run you would like to animate with the drop down list. The number will be 
the random seed number that was used. It is possible to have a blank value in 
the drop-down list. This indicates a simulation run without a run number 
extension. 

In the reports, the user is allowed to have the report generator average the results for some 
of all of the runs performed.  

History Files 

SimTraffic records the animation data into a history file. Normally this file has the same name 
as the *.syn file but has the extension hst. If you have recorded multiple runs (see above), 
the hst file will be formatted as filename-#.hst. The '#' will indicate the random seed number 
that was used during the recording.  

Making Presentations with Prerecorded Data 

If you are planning to make a presentation, it is helpful to have a *.hst file with the 
animations pre-recorded. To insure that the *.hst file is valid and does not require re-
seeding, close SimTraffic and restart SimTraffic to verify that the history file can be loaded 
without re-seeding. 

When copying files between computers or directories, be sure to copy the *.syn, *.sim, *.hst 
and image files (if appropriate) so that all data is transferred. The demo version can play but 
not record history files. 

Sometimes the *.hst file may need to be destroyed or may require re-recording. The 
following actions can render a *.hst file invalid. 

The run numbers are used 
on the same input data and 
time intervals to get a 
statistical average of varied 
random seeds. 

This History file is 
preserved so that 
animations can be 
displayed later and reports 
can be created without re-
seeding and re-recording. 

Recording your file with 
one random seed is much 
like watching your traffic 
in the street for 1 hour 
and saying this represents 
all days. Just like in the 
real world, random events 
can cause differences in 
simulation results. It is 
suggested that you record 
your model with 5 to 10 
simulation runs to help 
reduce the variability in 
results. 
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3-16   Synchro and SimTraffic Course 

� Changing data in the *.SYN file. Zoom settings are exempt. 
� Changing any simulation options or parameters in SimTraffic. Map Settings and 

zoom positions are exempt. 
� Changing the data files if volume or timing data is used. 
� Use the SimTraffic-Animation button in Synchro to change data without re-

seeding.  

Screen Recorder in SimTraffic 

A new feature to record the SimTraffic animation is now included. To create a video, choose 
the Video Recorder [VR] button on the upper-ride side of the SimTraffic toolbar.  

 
After selecting the VR button, the Video Recorder Settings dialog will appear. The upper left 
of the dialog include Predefined Settings. You can select one of the three options for a larger 
or smaller file. The larger file will be larger in size, but will have a better video quality. The 
actual size of the video depends on the length of the recording. It is suggested that you try 
smaller formats first and move up to improve quality as needed.  

The three options will use predetermined settings for Screen Size, Frames per second, 
choice of video (for local machine or web) and Video Quality. These values can be modified 
to meet the desired needs. 

Once the settings are determined, use the [Select] button to browse to a directory and enter 
a filename. The format will be a Window Media Video (WMV) file. Finally, choose the 
[Generate] button to create your video. 

Analyzing Part of a Network or a Single Intersection with SimTraffic 

SimTraffic analyzes all intersections in a file or network. There is no provision for modeling 
part of a network or zone within a file. 

To analyze part of a network, do the following: 

1. In Synchro, select the desired intersection(s) on the map. Multiple intersections 
can be selected by dragging a rectangle around them. 

2. Choose the File→Save-Part command. 
3. Start SimTraffic from the Windows start bar and Open the sub-network file. 

Map Settings 

Use the command Options→Map-Settings to change the appearance of the map.  

Map Zooming and Scrolling 

 
To scroll around the map, choose the Pan button or press the [End] key. To 
deactivate, select the button again or press [Esc]. In addition, holding the 
mouse wheel button down will allow you to drag the map.  

 
To view the map closer, choose the Zoom-In button or press [Page Down]. It 
may be necessary to scroll to put the map in the center of the MAP view first. 

It is possible to load 
multiple copies of 
SimTraffic to display 
multiple versions of a 
network at the same time. 
Choosing the SimTraffic-
Animation button from 
Synchro will not start a 
second instance of 
SimTraffic; it simply loads 
the current file into the 
already started instance of 
SimTraffic. 
Multiple instances of 
SimTraffic can be started 
by choosing the SimTraffic 
icon on the Windows Start 
bar. 
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To view more of the map, choose the Zoom-Out button or press [Page Up]. 

 
To view the entire map, choose the Zoom-All button or press [Home]. 

 
To view a specific section of the map, use the Zoom-Window button or press 
[Ctrl]+[W]. Then click on the upper-left corner of the viewing area. Then click on 
the lower-right corner of the viewing area. 

 
To view the map at a specific scale, use the Zoom-Scale button. Then enter the 
desired scale to view the map in feet per inch (meters per inch). This command 
assumes 100 pixels per inch on your screen. 

 To return to the previous view, press [Ctrl]+[Bksp].  

Signal Status 
Click with the mouse in the middle of the intersection to display the status of an actuated or 
pretimed signal. Click in the Signal status window and press [delete] to close the window. 

Vehicle Status 
Click with the mouse on a vehicle to display the status of a vehicle.  Vehicle status can be 
used to help explain vehicle behaviors. Click in the Vehicle status window and press [delete] 
to close the window. 

Reports, Graphics, and MOEs 
To create a report select the File→Create-Report command.  Select the reports desired.  The 
following sections describe the reports available. 

Simulation Summary Report 
The Simulation Summary report lists the intervals and their properties, and some overall 
statistics about the number of vehicles serviced. 

The summary report can be used to keep track of the intervals simulated, the volume 
adjustments made, and the timing plan(s) used. 

Measures of Effectiveness 
Total Delay is equal to the travel time minus the time it would take the vehicle with no other 
vehicles or traffic control devices. 

Delay per Vehicle is calculated by dividing the total delay by the Number of Vehicles.   

The Number of Vehicles is not a fixed number because some vehicles are in the area 
analyzed before the interval begins and some are in the area after the end of analyzed after 
the interval ends.  

The Stopped Delay is the sum of all time slices where the vehicles are stopped or traveling at 
less than 10 ft/s (3 m/s).  Normally the Stopped Delay will be less than the total delay. 
Stopped delay also includes all time spent by denied entry vehicles while they are waiting to 
enter the network. 

Stop Delay/Vehicles is calculated by dividing Stop Delay by the Number of Vehicles. 

The Total Stops is a count of vehicle stops.  Whenever a vehicle's speed drops below 10 ft/s 
(3 m/s) a stop is added.  A vehicle is considered going again when its speed reaches 15 ft/s 
(4.5 m/s). 

Stops /Vehicles is calculated by dividing the number of Stops by the Number of Vehicles. 

Remember, Synchro 
results will vary from 
SimTraffic. Synchro is 
macroscopic, deterministic 
model and SimTraffic is a 
stochastic simulation 
model.  
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3-18   Synchro and SimTraffic Course 

The Travel Distance is simply a summation of the vehicle distance traveled.  This distance 
includes the curve distance within intersections. 

The Travel Time is a total of the time each vehicle was present in this area.  The travel time 
includes time spent by vehicles Denied Entry. 

The Average Speed is calculated by dividing Total Distance by Total Time. Average Speed is 
weighted by volume and includes stopped time and denied entry time. The time use in 
calculation for Average Speed does not include time spent by denied entry vehicles while 
they are waiting to enter the network.  Average speed may thus be higher than Total Time 
divided by Total Distance. 

Fuel Used is calculated with the fuel consumption tables .  The fuel used in each time slice is 
determined by the vehicle's fleet (car, truck, or bus), speed, and acceleration. 

The Fuel Efficiency is calculated by dividing the Total Distance by the Fuel Used. 

Emissions data are calculated with the vehicle emission tables.  The vehicle's speed and 
acceleration determine the emissions created in each time slice.  There is no emission tables 
available for trucks and busses.  SimTraffic assumes trucks and busses emit exhaust at three 
times the rate of cars. 

Vehicles Entered and Vehicles Exited is a count of how many vehicles entered and exited the 
link or area in the interval(s).  If this is a network or arterial summary, the Vehicles Entered 
and Vehicles Exited do not count a vehicle moving from one intersection to the next within 
the arterial or network. The Entered and Exited counts for a network or arterial will thus be 
less than the sum of the counts from each intersection. 

The Hourly Exit Rate is the Vehicles exited at an hourly rate.   If the intersection is above 
capacity and the input volume is not constrained upstream, this value might be used as the 
capacity for this movement 

Denied Entry is a count of vehicles that are unable to enter a link due to congestion.  Denied 
Entry includes external links and mid-block vehicle sources.  The report lists the number of 
vehicles denied entry at the start and end of the period.  This is useful to see if congestion is 
getting worse or better.  Denied Entry can also be used to determine the Network 
Throughput.  In a congested network lower values of Denied Entry indicate increased 
throughput. 

Density is the average distance per vehicle over the simulation period.  It is only available by-
lane, and by-approach but not by-movement; multiple movements can share a lane. 

Ocupancy is the average number of vehicles in a lane or approach over the simulation 
period. 

Queuing and Blocking Report 
The Queuing and Blocking report gives information about the maximum queue length for 
each lane and the percentage of time critical points are blocked. 

A vehicle is considered queued whenever it is traveling at less than 10 ft/s (3 m/s). A vehicle 
will only become “queued” when it is either at the stop bar or behind another queued 
vehicle. 

The Maximum Queue is the maximum back of queue observed for the entire analysis 
interval. The Average Queue is average of all the 2 minute maximum queues. 

In Synchro, the queue 
length is calculated by 
integrating the arrival 
pattern of the arriving 
vehicles and determining 
the height of the shape for 
the 50th and 95th 
percentile volume levels. 
Basically, this would be 
similar to entering data 
into an equation to get a 
resulting queue length 
(this is true with any 
macroscopic model). This 
equation is NOT limited by 
the turn pocket length that 
is coded. For instance, say 
the turn pocket in the 
above graphic is 250'. It 
would be possible that the 
Synchro queue that is 
reported is greater than 
250'.

In SimTraffic, the queue 
length reported for a 
movement IS limited by 
the turn pocket length, 
just like in the real world. 
SimTraffic simply observes 
the maximum queue. So, 
if you have a left turn 
pocket of 250', then you 
could not achieve a 
SimTraffic left turn queue 
of greater than 250'. Any 
spillover from the left turn 
pocket would be reported 
in the adjacent lane queue 
length. 
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A standard deviation is also calculated using the sum of squares for each 2 minute interval.  
The 95th Queue is equal to the Average Queue plus 1.65 standard devidations. The 95th 
Queue is not necessarily ever observed, it is simply based on statistical calculations. 

 
Upstream Block Time is the proportion of time that the upstream end of the lane is blocked. 
The Queuing Penalty is a rough measure of how many vehicles are affected by the blocking.  
Storage Bay Distance is the length of a turning bay. Storage Block Time is the proportion of 
time that a lane is queued at the top of the storage. B## is a column that is not always 
present and is used for reports on the queue for a bend link. 

Actuated Signals, Observed Splits Report 
The actuated signal report displays information about the actual times observed in actuated 
signals.  This report can be used to show how an actuated signal will perform with detailed 
modeling.  This report can be helpful to compare the affects of adjusting gap settings, 
detector layouts, recalls and so on.   

Static Graphics 
To display static graphics, choose the Graphics→Show-Static-Graphics command.  Select the 
display desired. 
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3.7 3D Viewer 
SimTraffic can create a 3D file which 
can be viewed with the Trafficware 
3D Viewer. The three primary modes 
of the viewer for playback of 
SimTraffic data in a 3D environment 
include scene, ride, and track.  The 
ability to create scenery to enhance 
the default background is also 
available in the 3D Viewer. 

To create the 3D file, use the 
command Animate→Create 3D 
Graphics File. A file with an S3D 
extension will be created in your 
project directory. 

Use the 3D Viewer button to launch the 3D Viewer application. Refer to Chapter 25 
of the Synchro Studio User Guide for full details on using 3D Viewer. 

A Scene is a three-dimensional rendering of a SimTraffic network.  A scene is generated 
when the user creates a 3D graphics file using SimTraffic.   

Create Digital Videos 
3D Viewer can be used to create digital video in .AVI format.  Digital video can then be copied 
to other computers for playback, even if 3D Viewer is not installed.   

3D Viewer generates digital video are based on “Tours”.  Tours can then be used as input to 
the video generation process.  

Add Buildings and Scenery 
Users can add buildings and scenery to 3D Viewer scenes to create realistic simulations.  To 
add a building, tree or other model, navigate to the location in the scene near the point 
where the model is to be placed.  Select the model from a model list. 

Changing the Size of a Model 

To change the size of a selected model object, hold “Shift” key and rotate the mouse wheel. 
The model object will be proportionally increased or diminished. To make the size change 
slower, hold “Ctrl” key.   

Also, you can change length, width and height of a selected object using Models pane by 
editing L, W and H values. 

Adding a Custom Model in 3ds Format 

In the “Models Preview” window, there is a button “Import Models”. You can browse for an 
existing .3ds file to include in the list of the “Custom Models” category. 

A New Button for the Tour Panel – Filming 
The Filming button becomes enabled in the record mode and has the two states – “pause 
filming” and “resume filming”. 
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4. LEVEL II 
4.1 Calculations 
In this section, some of the calculations used by Synchro are discussed. 

Delay Calculations 
In Synchro, there are three (3) options for reporting the signalized intersection delays. This 
includes:  

� The Synchro Control Delay (Percentile Methods); 
� The 2000 HCM Signals Delay, and;  
� The 2010 HCM Signals delay. 

The Delay that is shown in the TIMING Settings window and the ‘Int:’ reports are the Synchro 
Control Delays.  

The 2010 HCM Signal Delays are shown in the HCM 2010 Settings window and in the 
Reports. This window and report provides full implementation of the 2010 HCM methods.  

To see the 2000 HCM delay, create an HCM 2000 Signals Report (use the command 
File→Create-Report and choose the ‘HCM 2000 Signals’ in the Select Reports window). This 
report provides a full implementation of the 2000 HCM methodology.   

The following sections will further define these calculations. 

HCM (2000) Signals Delay Calculation 
When you use the command File→Create-Report and choose the ‘HCM 2000 Signals’ in the 
Select Reports window, you will get a year 2000 HCM Signals report (uses the 2000 HCM 
Methods). For these methods, one cycle length is used to represent the analysis period and 
the user is required to input actuated green times.  Synchro calculates this actuated green 
time for the user based on the average of fiver percentile greens (defeined below). The g/c 
ratio, v/c ratio and delay calculations are based on the actuated green times and cycle 
length.  

HCM (2010) Signals Delay Calculation 
When you use the command File→Create-Report and choose the ‘HCM 2010 Signals’ in the 
Select Reports window, you will get a HCM Signals report. Or, you can navigate to the HCM 
2010 Settings window. This is based on the methods of the year 2010 HCM. The 2010 HCM 
methods have a computational engine that will calculate an actuated cycle length and  
actuated effective green times. The g/c ratio, v/c ratio and delay calculations are based on 
this actuated green times and cycle length. 

Synchro Control Delay (The Percentile Delay Method) 
In Synchro, the delay shown in the TIMING Settings window is the Synchro Control delay. If 
you create a report other than the HCM Signal Reports, the delay shown will be the Synchro 
Control delay. This is based on the Percentile Delay method. Basically, the Percentile Delay 
method calculates the delay for five percentile volume levels (10th, 30th, 50th, 70th and 90th). 
The delay result is then the weighted average of the five percentile scenarios. 

Percentile Scenarios 
To account for variations in traffic, Synchro models traffic flow under five percentile 
scenarios, the 90th, 70th, 50th, 30th, and 10th percentile scenarios based on a Poisson 
distribution.   

Important: When you 
input the Total Splits in 
the TIMING Settings, 
these are the Maximum 
Splits for any actuated 
movement. The time used 
is actually based on five 
Percentile green times that 
vary based on the flow 
level. 

For example, assume you 
have phase 1 EBL that you 
entered a Maximum Split 
of 20 seconds. If the 
movement is actuated, it 
may not receive this full 
20 seconds. Look at the 
Actuated Effective Green 
time to see the actual time 
used in the calculations. If 
you would like Synchro to 
use this full 20 seconds, 
then set the Recall to Max.

The year 2010 HCM is no 
longer just a printed 
manual. Volume 4 of the 
HCM includes electronic 
materials. Within this 
volume is a computational 
engine that performs the 
calculations. This includes 
a method to calculate an 
effective green for 
actuated movements.  
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The traffic volumes for each scenario are adjusted up or down according to the following 
formulas. 

The expected number of vehicles, λ, is the hourly flow rate divided by the number of cycles 
per hour.  
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The variance, or standard deviation, in traffic is the square root of the expected number of 
vehicles for a Poisson arrival. 
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The expected number of vehicles for a given percentile can be calculated using a Poisson 
distribution. A Normal Distribution can be used if the expected number of vehicles is greater 
than 6.  This gives the formula: 

"# � ��� $ %&� � ����'  ��������
��
��������
 

z is the number of standard deviations needed to reach a percentile from the mean.  It can 
be determined from this table. 

Percentile Z
10 -1.28
30 -0.52
50 0
70 0.52
90 1.28

 

The simplified formula to determine adjusted volumes is thus: �
�(��$ )%*+,�* �����-. * ����� �
/ ���(�≥���

 

Using five scenarios instead of one has several advantages.  Even though an approach is 
below capacity, it may be above capacity for the 90th percentile traffic. By modeling the 90th 
percentile traffic, it is possible to better model nearly saturated intersections.  

Using multiple scenarios allows actuated signals to be modeled under multiple loading.  The 
complex operation of actuated signals will vary under the five scenarios and give a range of 
expected green times over the course of an hour.  

If 100 cycles are observed, 
the 90th percentile cycle 
will represent the 10 
busiest cycles.  Each of 
these scenarios will 
represent 20% of the 
cycles actually occurring. 
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Refer to the Calculations Handout ‘Percentile Flow’. Also, refer to the sample file ‘C:/Class 
Files/Level 2/01 Calculations.xls’. 

Actuated Signal Considerations 
To estimate the delay for actuated signals, it is necessary to determine how skipping and 
gapping behavior will change their timings.  These actuated timings are then used with the 
Percentile Delay formulas. 

The key to determining actuated behavior is to predict if each phase will be skipped and 
when each phase will gap out.  Once these behaviors are determined, the green and red 
times from the actuated signals can be used to model delays. 

Determine Skip Probability. Synchro assumes a phase will be skipped if there is a greater 
than 50% chance of zero vehicles during red time. 

Determine Queue Clear Time. This is the startup lost time plus the service time for any 
vehicles that arrived during red plus vehicles arriving during the clearance time.  

Determine Time to Gap-Out. This is the time from when the queue clears until there is a 
50% chance of gap-out. It is dependent on the detector placement and vehicle extension 
time.  

Percentile Delay Summary 
The basic premise of the Percentile Delay Method is that traffic arrivals will vary according to 
a Poisson distribution.  The Percentile Delay Method calculates the vehicle delays for five 
different scenarios and takes a volume weighted average of the scenarios.  The five scenarios 
are the 10th, 30th, 50th, 70th, and 90th percentiles.  It is assumed that each of these 
scenarios will be representative for 20% of the possible cycles. 

� For each scenario, traffic for each approach is adjusted to that percentile. 
� If the signal is actuated or semi-actuated, the skipping and gap-out behavior for 

these traffic conditions are used to determine the green times for each scenario. 
� If the signal is in coordination, an arrivals flow pattern is calculated to account for 

the effects of coordination. 
� Delays are calculated using the adjusted volumes and calculated green times. 
� Estimating actuated operation or coordination arrivals may require that the 

calculations be performed iteratively. 
� If the signal is near-saturation or above saturation, additional time will be added to 

account for vehicles carried over between cycles. 

How Do the Delay Methods Compare? 
As discussed above, there are three options for reporting the delay in Synchro. These three 
methods are macroscopic, deterministic methods all based on the methods of the Highway 
Capacity Manual.  In addition, SimTraffic can provide a microscopic simulation result.  

The results between the methods can vary quite drastically (macro vs. micro differences 
were discussed in early portions of the class). To illustrae some differences, consider a 
variety of case studies. Open the file ’00 HCM Methods Compared.SYN’.   

Case 1:  Isolated Pretimed Signal 

For this example, refer to node 1 in the referenced file. This interseciton is isolated, operates 
with a pretimed signal, uses NEMA phasing convention and includes protected lefts for all 
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4-4   Synchro and SimTraffic Course 

four approaches. In addition, the storage lengths are generally adequate and blocking 
problems are not expected to be significant.  

The table below summarizes the delay results for the three macroscopic methods and from 
SimTraffic as an illustration.  

 
As can be noted, the results for each scenario match closely. This is expected since the green 
times are fixed, there is no coordination and no potential storage blocking issues.  

Case 2:  Isolated Fully Actuated Signal 

For this example, refer to node 2 in the referenced file. This interseciton is isolated, is fully 
actuated, uses NEMA phasing convention and includes protected lefts for all four 
approaches. In addition, the storage lengths are generally adequate and blocking problems 
are not expected to be significant. 

 
The results for the study still show relatively close values for each method. There is a little 
more discrepency and that can mostly be associated with the effective green times.  

Case 3:  Actuated-Coordinated Signal in a System 

For this example, refer to node 3 in the referenced file. This interseciton is located in a 
system, is actuated-coordinated, uses NEMA phasing convention and includes protected lefts 
for all four approaches. In addition, the storage lengths are generally adequate and blocking 
problems are not expected to be significant. 

 
In this example, the results are beginning to vary more significanlty when comparing the 
2010 methods to the Synchro and 2000 HCM results. This is mostly associated with how each 
method handles vehicle arrivals. This is discussed in more detail later.  

Case 4:  Actuated-Coordinated Signals, Closely Spaced 

For this example, refer to node 4 in the referenced file. This interseciton is located in a 
system, is actuated-coordinated, uses NEMA phasing convention, includes protected lefts for 
all four approaches and is closely spaced to node 18. 

 

Control Type: Pretimed (Node 1)

EBL EBT EBR WBL WBT WBR NBL NBT NBR SBL SBT SBR Delay LOS
Synchro 42.6 24.2 4.7 69.7 25.4 6.3 44.4 46.7 9.4 93.8 40.3 8.8 31.2 C
2010 HCM Report 33.4 C
2000 HCM Report 41.7 23.9 16.1 67.7 25.1 19 43.8 45.7 30.2 90.9 39.7 30.4 32.7 C
SimTraffic 49.4 29 22.4 87.3 24.7 12.8 48.5 40.7 19.3 80 37.8 14.5 34.9 C

Method
Total

26 34 45 55

Movement

Control Type: Act-Uncoord (Node 2)

EBL EBT EBR WBL WBT WBR NBL NBT NBR SBL SBT SBR Delay LOS
Synchro 45.4 26.1 5 57.9 24.2 6.4 42.6 46.5 9.6 74 31.1 8.2 29.9 C
2010 HCM Report 26.5 C
2000 HCM Report 41.6 26.6 17.1 51.4 23.4 18.4 51 33.6 26.3 61.3 26.3 23.4 29.4 C
SimTraffic 50.7 29.3 23.2 68.4 22.7 12.2 48.5 43.1 21 102 34.7 15.9 34.3 C

Method
Movement Total

23 25 38 36

Control Type: Act-Coord (Node 3)

EBL EBT EBR WBL WBT WBR NBL NBT NBR SBL SBT SBR Delay LOS
Synchro 34.2 10.5 1 60.8 15.6 2.2 44.2 52.9 9.7 75.8 33.4 8.1 22.5 C
2010 HCM Report 36 D
2000 HCM Report 31.5 11.5 2.8 54.6 16.7 6.8 54.3 46.9 31.2 42.1 29.2 25.9 22 C
SimTraffic 34 22.6 14.7 59.5 19.6 11.9 49 44.9 19.6 68.5 32.8 14.4 27.9 C

Method
Movement Total

33 37 41 42

The simulation results show 
in the tables are the 
averages of 10 simulation 
runs. Each run was seeded 
for 10 minutes and 
recorded for 60 minutes.  

Simulation models do not 
include a LOS 
measurement. The 
SimTraffic LOS shown in 
the tables uses the HCM 
criteria for Control Delay. 
It should be recognized 
that SimTraffic does not 
report Control Delay, but 
movement Delay/Vehicle. 
The LOS show is for 
illustration purposes only. 

The 2010 HCM results only 
show the approach delays. 
This is due to the format 
of the HCM 2010 report 
from Synchro. This report 
is based on the HCM 
computational engine 
spreadsheet.  
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The results now show drastic differences. Synchro does include a queue delay measurement 
and the HCM methods do not. SimTraffic shows a much greater delay given the compounded 
nature of the congestion.  

Summary of Synchro’s Macro Model Differences 
Item Synchro HCM 2000 Report HCM 2010 Report 

Percentile 
Method

Synchro uses a Poisson 
distribution to determine 
five representative volume 
levels (10th, 30th, 50th, 
70th and 90th Percentiles)  

Uses a single volume 
analysis. This single volume 
would be the same as 
Synchro’s 50th Percentile 
Volume. 

Uses a single volume analysis. 
This single volume would be the 
same as Synchro’s 50th Percentile 
Volume. 

Actuated 
Green Inputs 

In Synchro, the user 
inputs the actuated 
parameters such as 
minimums and 
maximums. The Actuated 
Green time is calculated 
for five percentile 
scenarios. 

This will use the average of 
Synchro’s five Percentile 
green times. Note: in 
traditional HCM 2000 
analysis, the user was 
required to input the 
actuated green times.  

For fully actuated conditions, the 
effective green times are 
determined by the HCM 2010 
computational engine. The HCM 
comp engine does not currently 
provide effective green times for 
actuated coordinated signals. 
Synchro will use the effective 
green times it uses for the 2000 
HCM methods.

Dual Ring 
Control

All three methods use dual ring, NEMA phasing. However, traditional 2000 HCM methods use 
single ring operation.  

Progression 
Factor (PF)
(see note 1) 

Synchro explicitly 
calculates the PF based on 
upstream arrivals (via 
integration, see note 1) 

The HCM Report will 
calculate the PF from 
Synchro Percentile 
integration. This is the 
Percentile Delay Coordinated 
divided by the Percentile 
Delay Uncoordinated. 

Currently, the HCM comp engine 
only considers isolated 
intersections. Synchro will 
calculate a Platoon Ratio and an 
Upstream Filtering Factor.  

Right Turn on 
Red (RTOR) 
(see note 2) 

Synchro calculates the 
RTOR and makes a 
saturation flow 
adjustment. This will 
increase the capacity for 
the movement. 

The HCM methods subtract the RTOR volume from the analysis. 

Queue Delay  Synchro includes a 
component for Queue 
Delay. 

The HCM methods do not include a Queue Delay component.  

Complex
Geometry 

Synchro can model 
intersections with up to 6 
legs (8 in some cases). 

The HCM methods are limited to 4 legs intersections.  

 

Control Type: Act-Coord, Close Spaced Intersections (Node 4)

EBL EBT EBR WBL WBT WBR NBL NBT NBR SBL SBT SBR Delay LOS
Synchro 58.2 245 < 61.4 206 < 44.6 48.8 < 164 31.1 < 167.6 F
2010 HCM Report 37.9 D
2000 HCM Report 52.4 36.1 < 50.7 29.6 < 54.3 37.2 < 81.4 29.1 < 37.7 D
SimTraffic 380 317 91.1 54.3 23 17.1 44.4 48.1 39.6 3250 2253 2175 356 F

Method
Movement Total

38 32 44 46
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4-6   Synchro and SimTraffic Course 

1. Progression Factor. In Synchro, there is no progression factor or arrival type factor. 
The delays are explicitly calculated by integrating the arrival patterns over the 
departures (saturation flow). For the HCM reports, Synchro calculates a PF.  

 
2. RTOR. In Synchro, the RTOR is a saturation flow increase. For the HCM methods, the 

RTOR is a volume reduction. These RTOR vehicles that are excluded are often low 
delayed vehicles so the only ones left are those that are getting delayed. Also, the 
result shown is the Delay per Vehicle. Since the HCM method has a higher aggregate 
delay, and a lower number of vehicles in the denominator, the delay per vehicle will 
be higher.  

3. Queue Delay. Synchro adds delay caused by spillback and starvation between 
adjacent, closely spaced intersections. The HCM methods do not account for spillback 
or starvation. Note: Nether method accounts for spillback out of turn pockets. 

  

Green Y+ 
AR

Red

Arrivals from 
upstream 

turning traffic

Arrivals from 
upstream 

through traffic

Arrival Profile
Departure Profile

Shaded Area = Delay
(By integration with Synchro 
Percentile Method)
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4.2 Time Space and Platoon Dispersion Diagrams 
Time-space diagrams can be used to see graphically how traffic flows between intersections. 
To view a time-space diagram, first click on the desired intersection or the desired link to 

select it, then press the Time-Space Diagram button  or the [F7] key. 

The Parts of a Time-Space Diagram  

  

Synchro's time-space diagrams display time along the horizontal axis and distance along the 
vertical axis. 

The following information summarizes each part of the time-space diagram above. 

  Toolbar- These buttons change the views of the TIME-SPACE DIAGRAM 
window.  

  Street Names and Offsets- These are the street names of the intersection 
shown. The top name is the name of the street with the time-space diagram 
being shown. The bottom name is the name of the cross street.  Underneath 
the street names is the intersection offset.  The offset is referenced to the 
reference phase even if it is not one of the approaches in the diagram. 

  Direction Icon- These icons indicate the direction of the street in question. 

  Street and Intersection Diagram- The vertical line represents the street with 
the time-space diagrams. The horizontal lines are crossing streets. 

  Traffic flow lines or Traffic Density Diagram- The diagonal and horizontal 
lines show traffic flow. 

  Timing Bands. The red, green, and yellow bands indicate the phase of the 
signal for each part of the cycle.  The green bands for an actuated signal may 
start or end early.  The times shown are actuated times and this represents 
the phases gapping out early.  Select [Max] to show maximum green times. 

 

Select the Legend button 
to display a color-coded 
legend. The legend shows 
the color for the flow lines 
and the through and left 
timing bands.  If the 
[Queue] button is 
selected, the legend will 
include queue interaction 
color-coding. 
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4-8   Synchro and SimTraffic Course 

Time-Space Options 

Scrolling 

To scroll or move the time space diagram vertically, use the arrow buttons, the arrow keys, 
or by clicking and dragging on the diagram (away from the timing bands). 

Bandwidth option 

The bandwidth option shows arterial bandwidths. Bandwidth is the part of the cycle that 
allows the vehicles to go through all intersections without stopping.  Synchro shows both 
arterial bands and link bands.   

Vehicle Flow Option 

This diagram also shows the speed and position of the vehicles. Each line represents one or 
more vehicles.  

Percentile Options 

These scenarios represent 90th, 70th, 50th, 30th, and 10th percentile cycles for the hour for 
which volume data is given.  If you looked at 100 cycles, the 90th busiest cycle is the 90th 
percentile.  The 50th percentile represents average traffic conditions. 

Show Delays 

To show the average delays for each movement and the intersections overall, push in the 
Show Delays button. 

Show Super Saturated 

When this option is enabled, lane groups operating above capacity are shown with their 
queues filled at the beginning of green. When this option is off, the time-space diagram 
assumes that all queues are cleared at the end of green 

Time-Space Diagram Options 
The command Options→Time Space Diagram is used to change the scale of the diagrams, 
change the flow line colors and turn on or off some of the flow directions or flows to left 
turns. 

Time and Distance Scale 

For the time scale, enter a number between 16 and 96.  

Enabling Flow Lines and Changing their colors. 

Viewing traffic flows for four movements simultaneously can be a bit overwhelming. There 
are options to limit the movements shown simultaneously. 

Adjusting Splits and Offsets 

To change an offset for any phase, click and drag on the timing bands away from any phase 
boundaries.  The cursor will change into a hand shape before and during offset adjustment.   

To change a split for a phase, click and drag on the timing bands at a phase boundary.  The 

cursor will change into a splitter shape  before and during split adjustment.  This feature 
changes the maximum splits. 

 

  

Time-space and flow 
diagrams are useful to 
visualize the traffic flows 
along an arterial route. 
They can also be used to 
fine-tune your offsets. 
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4.3 Advanced Inputs 
In this section, some of the advanced input features of Synchro and SimTraffic will be 
discussed. 

Phase Templates 
Phase templates allow phase numbers to be set automatically. Below is the Synchro default. 

 

 
To edit the phase templates, use the menu command Options→Phase-Templates→Edit-
Template-Phases. 

Enter phase numbers for each through and left movement.  Local standards may have the 
phases mirrored from Synchro's defaults.  Use default phase templates to setup phase 
numbers matching the agencies standard phasing scheme. 

Ring and Barrier Designer 
To activate, use the menu command Options→Ring-and-Barrier Designer.  

The Ring and Barrier Designer allows up to 32 phases to be entered in one of 64 
fields.  This allows for the modeling of complex phasing strategies.  Phase numbers 
are entered into the appropriate barrier, ring and position (BRP) fields in the four 
rings and four barriers.  

The following displays the default phase assignments within the Ring and Barrier 
Designer.  The values in the table can be modified to meet your particular needs. To 
revert back to the default phasing layout, select the Standard button. 

 

 

In general, changing the 
template will not have an 
impact on the results 
shown in Synchro. 
However, the measures 
could change if you are in 
a coordinated system and 
you do not update your 
coordinated phases for the 
modified template 
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4-10   Synchro and SimTraffic Course 

When to use: 

� Group Control (Multiple intersections on one controller) 
� 5 or more legs 
� Single ring controller, more than 4 phases 
� Diamond interchange 
� More than 9 phases 

Not needed for: 

� Split phasing 
� Lagging phases 
� Standard 8 phase controller 
� Single ring controller up to 4 phases 
� 8 phase controller + 9 
� Many two intersection configurations 

The rules to consider for the Ring and Barrier Designer are: 

A ring is a term that is used to describe a series of conflicting phases that occur in an 
established order. Phases from any ring are sequential and cannot time with the other 
phases within the ring. 

A barrier (compatibility line) is a reference point in the preferred sequence of a multi-ring 
controller unit at which all rings are interlocked. Barriers assure there will be no concurrent 
selection and timing of conflicting phases for traffic movements in different rings. All rings 
cross the barrier simultaneously to select and time phases on the other side. 

A phase within a given ring can operate with any phase in any other ring within the same 
barrier. The graphic below illustrates the 64 positions allowed by Synchro. The number, such 
as 111, shown in the box indicates the Barrier-Ring-Position (BRP). So, 123 indicates barrier 1, 
ring B, position 3. 

 
So, given the rules, the phase placed in 111 MUST be allowed to operate with a phase in 121, 
122, 123, 124, 131, 132, 133, 134, 141, 142, 143 and 144. 

131 132 133 134

121 122 123 124

111 112 113 114

141 142 143 144

Barrier 1

Ring A

Ring B

Ring C

Ring D

231 232 233 234

221 222 223 224

211 212 213 214

241 242 243 244

Barrier 2

331 332 333 334

321 322 323 324

311 312 313 314

341 342 343 344

Barrier 3

431 432 433 434

421 422 423 424

411 412 413 414

441 442 443 444

Barrier 4
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Example - Twice Per Cycle Left Turns Example  

For this example, refer to the file ‘C:\Class Files\Level 2\03a Twice per cycle left turns.SYN’. 

One problem often experienced during long cycle lengths is the situation where a queue in a 
left-turn lane backs up into a through lane and reduces the capacity of the through 
movement. One option is to use a "Twice Per cycle Left-Turn" (TPCLT) to reduce this left-turn 
"spill-over" problem. During TPCLT, a protected left-turn phase is serviced twice per cycle as 
a leading and lagging left-turn that minimizes the blockage problem for the lagging through 
movement.  

TPCLT Operation 

This operation differs from conditional-service that only allows a protected left-turn phase to 
be re-serviced if the opposing through movement gaps out. TPCLT is typically used during 
congested periods when all phases tend to max out. For this example, the desired TPCLT 
sequence is as follows: 

80" cycle / EBL is the Twice Per Cycle Left-Turn (TPCLT). 

In Synchro, you would create dummy phase (call it phase 25) that operates in Ring B, barrier 
1 as show in the Ring and Barrier Designer below. 

 
Next, it is just a matter of specifying that the EBL phase operates during phase 5 and phase 
25. To do this, enter a 5 then a 25 (separated with a space, comma or ‘+’ symbol) in the 
Protected Phases row for the EBL. 

Notice that the left-turn is now serviced twice per cycle using phase 5 and 25. The resulting 
Splits and Phasing diagram is as follows (03b Twice per cycle left turns. SYN): 

  

Keep the ring rules in 
mind. For the design of 
this example, ring B will 
service phase 5, 6 then 
15. Phase 5, 6 and 15 
MUST be allowed to 
operate with phase 1 
and/or 2 without conflicts 
since all of these phases 
are in barrier 1. 
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4-12   Synchro and SimTraffic Course 

Yield Points 
The Yield Point affects when the Coordinated Phases will “yield” to side street phases. This 
setting affects whether there is a single yield point for all phases; or multiple yield points. 

The Figure below illustrates how a single yield point works.  The main street phases have a 
single scheduled end time.  If the next up phases have no calls, the other phases start at this 
point.  If there are no calls for any of the phases 3, 7, 4 and 8; phases 1 and 5 can start early 
and the signal will return to the main street phases sooner.   

 

The next figure illustrates how yield point By Phases works.  The main street phases stay on 
until the scheduled start time of a conflicting phase.  If phases 3 and 7 have no calls, the 
signal will not yield to phases 4 and 8 until their scheduled start times. 

 
Flexible yield points allow the signal to yield any time between the single point and the 
phases scheduled start time.  Flexible Yield Points can be useful with low volume side streets; 
the side streets have a wider range of time to yield the signal. 

Using a Single Yield Point in conjunction with Fixed Force Off? makes the most time available 
for side street phases.  By Phase can be helpful when providing coordination to side street 
phases.  It is sometimes possible for the phase to be skipped because its yield time occurs 
before the platooned traffic arrives. 

With modest amounts of traffic on one of the next up phases (phases 3 and 7 in the above 
examples), the signal will usually yield at the first available point and act like the single yield 
point.  The other options are more applicable for lower volume side phases (200 vph or less). 

The Yield Point is closely related to Fixed Force Off?, and Actuated Main street phases.   

If the main street phases are coordinated, use a single or flexible yield point.  Otherwise the 
main street phases will not yield early.  The exception being for lead-lag phasing. 

Here are some notes 
about Synchro’s 
implementation of Yield 
Point. Synchro models 
flexible yield points the 
same as single yield 
points.  This will be 
equivalent except for 
when the 1st up actuated 
phases are low volume. 
 With By Phase yield 
points, Synchro models a 
single yield point for each 
barrier.

The Yield Point setting is 
found in the Offset Setting 
box in the TIMING 
Settings. 
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Coordinated Recall 
Coordinated Maximum (C-Max): Used with coordinated signals only. This option is available 
for phases selected as the reference phase in the Offset Settings. Phase shows for its 
maximum time starting at its scheduled start time. 

Coordinated Minimum (C-Min): Used with coordinated signals only. This option is available 
for phases selected as the reference phase in the Offset Settings. Phase shows for its 
minimum time starting at its scheduled start time.  Coordinated movements must have 
detectors.  No affect with By Phase yield points except with lead-lag phasing. 

 

Dual Entry 
Dual Entry can be set to Yes or No for the given phase.   

Select Yes to have this phase appear when a phase is showing in another ring and no calls or 
recalls are present within this ring and barrier. 

Normally, even phases are set to Yes and odd phases are set to No.  Recall has priority over 
dual entry. Below are examples for a typical eight phase, dual ring controller. 

Examples: 

Phases 1 2 

Dual Entry No Yes 

Recall None None 

If there are no calls on phases 1 or 2, phase 2 will show when phase 5 or 6 is showing. 

 Phases 1 2 

Dual Entry No Yes 

Recall Min None 

If there are no calls on phases 1 or 2, phase 1 will show when phase 5 or 6 is showing. 

 Phases 1 2 

Dual Entry No No 

Recall None None 

If there are no calls on phases 1 or 2, no phase from this ring will show when phase 5 or 6 is 
showing. 
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4-14   Synchro and SimTraffic Course 

Fixed Force Off? 
Used for Actuated-Coordinated signals only.  When Yes, a non coordinated phase can show 
more than its maximum time when it starts early. 

In the figure below, Phase 4 can start early due to phase 3 being skipped.  With Fixed Force 
Off? set to Yes, phase 4 can use all of phase 3’s unused time.  Otherwise this time would 
revert to the main street phases 

   

The amount of time available for side street phases and their starts can also be manipulated 
by the Yield Point and using Actuation for the Coordinated phases. 

Cluster Editor 
To activate, use the menu command Options→Cluster-Editor.  

The Cluster Editor allows multiple intersections to share one controller (Group Control). This 
is often used in conjunction with the Ring and Barrier Designer. 

Click on map to add or remove intersections from the cluster. 

Each intersection has a color associated with it in the Splits and Phasing diagram.  

 
On the Splits and Phasing diagram the top number identifies the node number proceed with 
a # symbol.  In the diagram above, the two intersections modeled are intersection #1 and 
intersection #2.   

Clicking on the movement diagram within the Splits and Phasing diagram will jump to the 
intersection selected.  For instance, if the TIMING Settings for intersection #1 is active, 
holding the cursor over any of the movement diagrams for intersection #2 will change the 
cursor to a hand symbol.  Clicking will now change the TIMING Settings information to 
intersection #2. 

How to Code an Overlap 
An overlap is a green indication that allows traffic movement during the green intervals of 
and clearance intervals between two or more phases (parent phases). A common application 
of the use of overlaps is at a diamond interchange using one controller for both ramps. The 
figure below shows the phase assignments for a typical diamond interchange with overlaps. 

Set Fixed Force Off to Yes 
to give more time to side 
streets, set Inhibit Max to 
No to give all extra time 
back to the main street. 

The cluster editor is 
intended for use with 
closely spaced 
intersections. The 
advantage to operating 
multiple intersections with 
one controller is that 
phases at the intersections 
are controlled by barrier 
and phase positions, not 
by an offset. With an 
offset relationship, you 
may experience ‘early 
release’ which may be 
undesirable with close 
intersections. 
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In this illustration, overlap A operates with its parent phases 1 and 2 and overlap B operates 
with its parent phases 5 and 6. 

To code this with Synchro, you do not need to define a new phase number for overlap A and 
B in the Ring and Barrier Designer. To code this, simply enter 2 and 1, separated with a 
space, in the Protected Phases row for the WBT movement for the left side intersection. 
Next, enter a 6 and 5, separated with a space, in the Protected Phases row for the EBT 
movement for the right side intersection. See the figure below. 

 
The listed phases will become the Detector Phases. The phase listed first will be used for split 
optimization.   

Example – Four Phase Sequential Phasing  

Open the file 04a 4-phase sequential phasing.syn. This is 
an example of how to code the 4-phase scheme shown in 
the diagram below.  

For these types of examples, it is very important to draw a 
diagram. Once you have labeled your movements, coding 
the intersection simply becomes a process of entering 
phase numbers.  

In this example, the two intersections will operate under 
group control. To attach the intersections, use the Cluster 
Editor. Select node #1 and switch to the TIMING Settings. 

Activate the CLUSTER EDITOR using the command 
Options→Cluster-Editor. 

Click on node #2 to add this intersection to the cluster and 
select [OK]. 

Since this is 4-phase sequential, no modifications are 
necessary to the Ring and Barrier Designer. In the TIMING 

1

2

Pay careful attention to 
Detector Phases.  They 
are key to controlling split 
optimization, as well as 
skipping and gapping 
behavior with the actuated 
green times and in 
SimTraffic.  

At node 1 
  SEL = Perm Phase 1 
  NBL = Prot Phase 
3/Perm Ph 2 
  SBL = Perm Phase 2  

At node 2 
  EBL = Perm Phase 4 
  WBL = Perm Phase 4 
  NBL = Perm Ph 2 
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Settings [F5] for intersection 1, begin entering the phase number as shown in the diagram to 
the right. For instance, the NBL is protected phase 3, permitted phase 2. The SBL is permitted 
phase 2 and the SBT is protected phase 2.  

Refer to the file 04b 4-phase sequential phasing.syn for the completed example.  

Now you can simulate this example by clicking on the SimTraffic Animation button or press 
[Ctrl]+[G] to start SimTraffic. 

Example - Coding a Diamond with Leading Alternating Phasing  

In this example, you will code a diamond interchange to operate with Leading-Alternating 
timing. The Synchro Help file has detailed information on this type of diamond operation. For 
full details, open the Synchro Help, and search for “Leading Alternating” (use the quote 
symbols during the search. 

Open the file 05a Diamond for Lead-Alt.syn. In this example, the network has been created 
and the lanes and volumes have been entered. It has also been pre-determined that leading-
alternating operation will be used.  

The two intersections will operate under group control. To attach the intersections, use the 
Cluster Editor. Select node #1 and switch to the TIMING Settings. 

Activate the CLUSTER EDITOR window by using the menu command Options→ Cluster-
Editor. 

Click on node #2 to add this intersection to the cluster and select [OK]. 

The next step to creating a Leading Alternating Timing plan is to set up the appropriate ring 
structure in the Ring and Barrier Designer. The key is to allow one movement to operate on 
both sides of the dual ring barrier. The ring structure for this dual ring, Leading Alternating 
diamond controller is as follows: 

 

 

2

N. Ramp

16

S. Ramp

5

4

N. Ramp

S. Ramp

 12

N. Ramp

 6

S. Ramp

8

1

N. Ramp

S. Ramp

ø1 ø2+1
ø5

ø2

ø6

ø4+12

ø8+16

ø6+5
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Notice that the ramp movements are allowed to cross the barrier by reassigning their phase 
number (4+12, 8+16). For instance, the north ramp westbound movement is allowed to 
operate within the right barrier as phase 4. It is then allowed to cross into the left side barrier 
and continue to operate as phase 12.  

To set up this structure, switch to the TIMING Settings and activate the Ring and Barrier 
Designer. Within the Ring and Barrier Designer, select the button [Diamond 4]. 

The Ring and Barrier Designer will automatically appear as shown below: 

 
Select [OK]. 

At node 1, change the westbound ramp to phase 4+12. Set the NBL to protected Phase 1. 
The NBT is assigned phase 2 + 1. The SB movements are assigned phase 2. 

At node 2, set the eastbound ramp to phase 8+16. The NB movements are assigned phase 6. 
The SBL is assigned phase 5 (protected) and the SBT becomes phase 6+5. 

In the PHASING settings, insure that no Pedestrian Phase is set for phase 12 and 16 and set 
the Minimum Split and the Maximum Split as the travel time between the intersections. For 
this example, use 6 seconds. Set the Recall for phases 1, 5, 12 and 16 to Minimum. 

The next step is to find the best timing plan for this interchange. Use the 
Optimize→Intersection-Cycle-Length command to set the intersection to the Natural Cycle 
Length. The Natural Cycle length is the lowest acceptable cycle length for an intersection 
operating independently. Synchro will automatically optimize the intersection splits when 
you perform this step. 

Refer to the file 05b Diamond for Lead-Alt.syn for the completed example.  

Now you can simulate this example by clicking on the SimTraffic Animation button or press 
[Ctrl]+[G] to start SimTraffic. 

  

For a diamond with 
leading-Alt, the phase 
sequence is fixed. 
Therefore, uncheck (turn 
off) the Allow Lead/Lag 
Optimize? for all phases. 
This will ensure that the 
phase order does not 
change during 
optimization. 
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4.4 File and Project Management 
Merge Files 
Use the File→Merge-File command to combine or merge two files. 

The Merge command can combine some data, such as volumes, one file with other data such 
as lane geometry and timings from another file. 

To Merge files, use the following steps. 

1. Open the file to be overlaid.  If some intersections exist in both files, start with 
the file that will be overwritten. 

2. Select the File→Merge-File command. 
3. Select the filename of the second file to merge. 
4. The MERGE OPTIONS window will appear. Select options and press [OK]. 

To merge a small file into a bigger file 

1. Open the large file first. 
2. Select File→Merge-File and choose the smaller file.  Check all of the merge 

options on, and merge by ID. 

To merge two files from separate areas 

1. Open one file first.  Use Translate Map command if necessary to adjust 
coordinates. 

2. Select File→Merge-File and choose the other file.  Check all of the merge options 
on, and merge by location. 

To change coordinates of a file 

1. Open the file with correct coordinates first. 
2. Select File→Merge-File and choose the file with incorrect coordinates.  Check all 

of the merge options on, and merge by ID. 

Save Part of a File 
The File→Save-Part command can be used to split a file into sections or to save part of a file 
into a separate file. 

To use this command: 

1. Select one or more intersections to include.   
2. Select the File→Save-Part command.  Choose a filename for the new section.  If 

you choose an existing filename, its data will be overwritten. 

Team Management 

The Save Part command can be useful for allowing multiple people to work on the same file.  
Parts of a large network can be saved as separate files.  Each team person can work on each 
piece of the network.  The pieces can be combined later using the File→Merge command. 
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Example - Merging two files together  

For this example, refer to the file ‘C:\Class Files\Level 2\05b Diamond for Lead-Alt.syn’ and 
‘C:\Class Files\Level 2\01 Prob 1.syn’. 

In this example, you can merge two separate files into one larger file. The actual field 
distance between the South Ramp and G Avenue along C Street is 1500’. In the Diamond file, 
the southern external link (link 3-2) has already been changed to 500’ (using the Intersection 
Properties to move the node coordinate). In the Prob 1 file, the northern external link (link 7-
72) has been changed to 1000’. The coordinate of node 3 (diamond file) and the coordinate 
of node 72 (Prob 1 file) do not match. When merged, we want these two nodes to connect.  

Open the Diamond file. Use the Transform Map button and change the coordinate system 
around node 3 as shown in the Transform Map View below.  

  
Save the Diamond file and open the Prob 1 file. Use the command File→Merge and merge 
the Diamond file into the Prob 1 file. Be sure to use the ‘By Location’ option for this merge 
since you are merging two separate files together. 

 
Delete the node that connects to two networks together. The combined files has been 
Saved-As, 06 Prob 2.syn and can be found in your Level 2 directory. 

If you attempt to merge 
files prior to adjusting the 
world coordinates, the 
location of the nodes will 
not be in the appropriate 
location. 

Try merging the file ’01 
Prob 1.syn’ and ‘05b 
SPUI.syn’. This will allow 
you to see how the SPUI 
option works compared to 
the diamond option. 
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Saving Part of a larger network and merging back into the larger network 

For this example, refer to the file ‘C:\Class Files\Level 2\07 Grid Network.syn’.  

This is an example of how you can use the file management features to save a smaller 
portion of a larger file, modify the data in the smaller file and then merge this new data back 
into the larger file. 

To do this, first use the Save-Part command to save the four intersections in the northwest 
corner (nodes 11, 12, 21, and 22). Synchro will suggest a name (filename-P01.syn). You can 
use this name for the saved part, or choose your own.  

After performing the Save-Part, open this smaller file and change some of the data (Lanes, 
Volumes and Timings). Save the file again and return to the larger file. Now, use the Merge 
command, however use the ‘By ID’ feature. Synchro will now merge in the new data from 
the smaller file for matching node numbers. It is important that you do not change the node 
numbers in the smaller file prior to this merge. 

 

Merging files can be a 
great time saving feature. 
For instance, assume you 
have created 5 files all 
based on the same basic 
lane data. Now, assume 
you want to change the 
lanes to be equal in all five 
files (maybe due to data 
entry errors, or proposed 
improvements). 

Open one of the files (File 
1) and edit the Lane data 
then Save the file. Next, 
open File 2 and Merge in 
the Lane data (by ID) from 
the updated File 1. Do the 
same for File 3, 4, 5, etc. 
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4.5 Optimizations 
Intersection Split Optimization 

Optimizing Splits by Percentile 

When optimizing splits, Synchro first attempts to provide enough green time to serve the 
90th percentile volumes.  If there is not enough cycle time to meet this objective, Synchro 
attempts to serve the 70th percentile traffic and then the 50th percentile traffic.  Any extra 
time is given to the main street phases. 

Other rules 

If two or more lane groups move concurrently, the maximum volume to saturation flow rate 
is used to set the split. 

If two rings are used, the maximum sum of ratios is used for this barrier. 

All phases are assigned a split greater than or equal to their Minimum Split. 

If there are permitted left turns, the entire process above is done repeatedly.  

If a lane group is served by two or more phases, its volume will be divided among the phases 
serving it.  

If there is a shared turning lane plus an exclusive turning lane, the calculations are repeated 
even further. 

At low volume intersections, there may be extra time available even after accommodating 
the 90th percentile traffic.  In these cases, extra time is given to the coordinated phases for 
coordinated intersections and is divided evenly among phases at uncoordinated 
intersections.  

Intersection Cycle Length Optimization 
Synchro will test all possible cycle lengths for this intersection to determine the shortest 
cycle length that clears the critical percentile traffic for each phase. 

The table below shows what the acceptable Critical Percentile Traffic for each range of cycle 
lengths. 

Cycle Length Critical Percentile Traffic
40 - 60 90th
61 - 90 70th

91+ 50th  (v/c ≥ 1) 

Over-Capacity Cycle Length Optimization 

The cycle length optimization will choose the cycle length with the lowest performance 
index.  The PI is calculated as follows. 

PI = [D * 1 + St * 10] / 3600 (0���(
�1��	���
�0��
!�2���(
��
�� �
�� �����2
��������������
 ��
������������
The Percentile Signal Delay adds 450 seconds of delay for each unserved vehicle.  

Shorter cycle lengths may also have other operational benefits.  Queue lengths are generally 
shorter and storage bays can operate more efficiently. 

  

By attempting to optimize 
for the 90th percentile, 
Synchro gives splits that 
will clear the queue 90% 
of all cycles.  Low volume 
approaches have more 
variability in traffic than 
high volume approaches, 
and will tend to give lower 
v/c ratios. 
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Network Cycle Length Optimization 

Performance Index 

The best cycle length is found by calculating a performance index. 

The PI is calculated as follows. 

PI = [D * 1 + St * 10] / 3600 (0���(
�1��	���
�0��
!�2���(
��
�� �
�� �����2
��������������
 ��
������������
The percentile delay and the PI count an unserved vehicle as contributing 450 seconds of 
delay.  This causes the cycle length to stop increasing once adding capacity for 1 vehicle will 
increase delay to other vehicles by 450 s or 7.5 minutes. In general, shorter cycle lengths 
have shorter uniform delay and will be favored when comparing delays of various cycle 
lengths.  

Network Offset Optimization 

Cluster vs. Individual Optimization 

During passes 1, 3, and 5; Synchro performs individual intersection offset optimization.  With 
individual optimization, the intersection's offset is set to a representative sample of every 
possible value between 0 and the cycle length -1.  With each offset traffic flow bands, the 
actuated green times, and the delays are recalculated. The offset resulting in the lowest 
delays is selected.  The delays for subject intersection and its neighbors are considered.  In 
some cases the timing of the subject intersection can affect delays at an intersection two or 
more links away. 

During passes 2 and 4, Synchro performs cluster optimization.  With cluster optimization, 
Synchro finds groups of intersections that are connected and treats them as a single group.  
Synchro will adjust the offsets of the entire group together. 

Consider an arterial of 4 intersections.  With cluster optimization, the left two intersections 
will have their offsets adjusted together while the right two intersections are held constant.  
Whenever a group of two or more intersections are connected to the remainder of the 
network via a single link, they will be treated as a dangling cluster.  Dangling cluster 
optimization works well with linear arterial(s). 

Another type of cluster is a CF cluster.  If two or more intersections have Coordinatability 
Factors between them of 90 (or 70) or more, they are considered a cluster and have their 
offsets optimized together. CF Cluster optimization helps with situations when two or more 
intersections are very close have a lot of traffic between them.  Without CF cluster 
optimization, these intersections would tend to be optimized for the benefit of each other 
only and not for the surrounding intersections. 
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4.6 Database Access and UTDF 
Universal Traffic Data Format (UTDF) is a standard specification for transferring data 
between various software packages.  UTDF can also be used to share data between software 
and traffic signal controller hardware.  UTDF is also useful for storing multiple volume counts 
and multiple timing plans for the same intersection.  

 
UTDF uses text files to store and share data.  Both comma delimited (*.csv) and column 
aligned (*.dat) text files are supported.  The graphic to the right shows the typical flow of 
data using UTDF.  

Version 6 Volume Data Files 
There are several formats for the volume data files. The following is an example of the 
Problem 1 file Volume database file.  

 
This data can be easily modified and saved within a spreadsheet. The advantage to opening 
this with a spreadsheet is that it will allow the user to edit the data with formulas. For 
instance, another worksheet tab could be inserted that was a calculation based on the first 
worksheet. 

Using Excel to Create UTDF Volume File  

Open the file C:\Class Files\ Level 2\UTDF Files\Sample Volume Adjustments for UTDF.xls. 
This spreadsheet is an example impact study. It has been simplified to include only 1 peak 
period (PM). The worksheets (tabs) are linked together, with the final sheet being a tab that 
can be saved to Volume.csv format. This can then be imported into Synchro for analysis. 

Spreadsheet or 
Text Editor
(edit *.csv)

Synchro binary 
data file (*.syn)

Open Format UTDF 
(*.csv, or *.vol)

Third Party 
Software

Version 6 Format:
- Volumes.csv
- Lanes.csv
- Timings.csv
- Phasing.csv
- Layout.csv
- TMC*.vol

Open

Save-As

Version 7 Format:
- Combined CSV
  (all data stored in
   one combined file)

Version 6 has six separate 
UTDF file types and 
formats. For this course, 
the volume.csv, tmc#.vol 
and timing.csv formats will 
be discussed.  

The Volume.csv is useful 
for working with 
spreadsheets.  

The TMC#.vol format can 
be used to transfer data 
from Petra software to 
UTDF to Synchro. 

The Timing.csv and 
Volume.csv formats are 
created to allow SimTraffic 
simulations of multiple 
timing and volumes in one 
simulation run (see page 
4-31). 

In version 6 format, you 
can write multiple Synchro 
files to a common UTDF 
file. When you write 
Synchro data to an 
existing file, it is added to 
the bottom of the UTDF 
file. The existing data is 
not overridden.  
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You can attempt to modify any of the sheets, although this has already been set-up. Notice 
that some changes are linked to other sheets, including the final worksheet which is the 
UTDF format. 

Click on the last sheet in the spreadsheet. Save the spreadsheet first. Next, use the Excel 
Save-As command and save this one sheet as a CSV format. 

Open the file 06 Prob 2.syn. Import the 2010 Opening Day volumes into this file. Save the file 
with a new name. The file that has imported volumes in it is called 08 Prob 2 w 2010 Open 
Day.syn. This file has NOT been optimized. Attempt to optimize the system. 

Reading Volume Data 

The Volume file(s) stores turning movement counts.  The volume file(s) stores the 
intersection number along with the date, and time of the volume data. 

To read Volume data from the Volume file do the following: 

1. Activate the DATABASE ACCESS window, press [Ctrl] + [D]. 
2. Select the [Read Volumes] tab. 
3. Select the File Style.   
4. Press [Select] to select the file or directory for the data file(s).  
5. If desired, select a time or range of times.  If the times are blank, all times will be 

read. 
6. Select a day of the week to limit dates by. 
7. Select an intersection, a zone, or entire network. 
8. Choose an Averaging Method. 
9. Choose Set PHF if your data is in 15 minute intervals and you want to 

automatically calculate PHFs. 
10. Choose [Read].  

The Volume data from this Synchro file will now be in the Volume file. 

Writing Volume Data 

The VOLUME file(s) stores turning movement counts.  The volume file stores the intersection 
number along with the date, time, and source of the volume data. 

To write Volume data to the Volume file do the following: 

1. Activate the DATABASE ACCESS window, press [Ctrl]+[D]. 
2. Select the [Write Volumes] tab. 
3. Select the File Style.   
4. Press the [Select] to select the file or directory for the data file(s).  
5. Enter the date and time for this volume data.  Times are entered in military 

format as hhmm. 
6. Enter a comment for this data.  A comment can indicate who or what collected 

the data. 
7. Select an intersection, a zone, or entire network. 
8. Choose [Write].  

The Volume data from this Synchro file will now be in the Volume file. 

The header information is 
important. If the header 
shows ’60 Minute Counts’, 
then ensure that the 
volumes you have entered 
are hourly counts. The 
other format accepted is 
’15 Minute Counts’. 

If the counts are hourly 
counts, then you will not 
be able to have Synchro 
calculate the PHF. 

Be sure to set the ‘Scope’ 
to the appropriate setting 
when you are reading and 
writing data. 
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Using UTDF to read TMC style counts 

For this example, use the Synchro file ‘C:\Class Files\Level 2\09a 120th Street.syn’. The TMC 
files are in the directory ‘C:\Class Files\Level 2\TMC’.  

This is an example of how to use the UTDF Read volume feature to read a 15-minute volume 
count. The files are turning movement count (TMC) files that were created with the PETRA 
software.  

Open your turning movement count file with Petra (*.pwf file). Use the command 
File→Export, choose the Save as Type ‘AAP (*.vol)’. For the filename, enter a number only. 
This number MUST match the node number of the intersection in Synchro. Select the [Save] 
button and you’ll see an AAP Export Dialog. Select the banks with data and press [OK]. The 
TMC file will be stored in your directory with the format TMC#.vol.  

Open one of the TMC files and observe the format. It is important that the heading states ’15 
Minute Turning Movement Count’ and that the Reference # matches the Node ID number in 
Synchro. In addition, the Filename must be TMC#.vol where the # must be the same as the 
node number. For the image shown below, this is the TMC for node 10. 

Try the following example: 

1. Open your Synchro File (09a 120th Street.syn) 

2. Select Database Access, press [Ctrl] + D 

3. Select the "Read Volume" tab. 
4. For file style, use the "By Int, TMC Style (TMC###.VOL)" 
5. Choose [Select] and locate the directory with the TMC#.vol file. 
6. For times, select the appropriate range and select the "Set PHF" check box if you 

want Synchro to calculate the PHF. To find the A.M. peak, set the range from 700 
to 900, or whatever time period you are interested in. 

7. Press the "Read" button. Now, import this data into the Synchro file. Try different 
time periods and averaging methods. 

  

 

 

 

The Maximum Peak hour 
will be determined By 
Intersection. Therefore, if 
you set your queuy across 
multiple times, the peak 
hour could differ at 
intersections. 

If you are looking for a 
system peak, you would 
need to determine this 
time off-line. Then, you 
could set your import 
limits to only include this 
system peak hour. 

This process discusses how 
counts from a JAMAR
count board, and PETRA
software can be converted 
to a format that can be 
read by Synchro. 
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Timing Data 

The TIMING file stores information about the timing plans including splits, cycle lengths, and 
offsets. This data can vary by time of day and thus multiple Timing records for each 
intersection are allowed. 

  
To write Timing data to the Timing file do the following: 

1. Activate the DATABASE ACCESS, press [Ctrl]+[D]. 
2. Select the [Timings] tab. 
3. [Select] a filename for the timings file.  Use the extension .CSV for comma 

delimited.  
4. Enter a name for the timing plan with up to 8 characters.  Examples of a plan 

could be AMPEAK or MIDDAY. 
5. Select an intersection, a zone, or entire network. 
6. Choose [Write].  

The Timing data from this Synchro file will now be in the Timing file. 

To read Timing data from the Timing file into Synchro, do the following: 

1. Backup your Synchro data file. 
2. Activate the DATABASE ACCESS, press [Ctrl]+[D]. 
3. Select the [Timings] tab. 
4. Choose a timing plan from the list of existing names. 
5. Select an intersection, a zone, or entire network. 
6. Choose [Read].  

UTDF 2006 (Version 7) 
The version 7 UTDF has been reformatted to contain all the data in one combined file. The 
data is divided by sections in the comma delimited (CSV) format. The UTDF Combined file 
can be accessed through the File→Open, File→Save-As, File→Merge and File→Save-Part 
commands. 

The new combined file format contains multiple sections so that a single file can completely 
define a network.  The combined format includes the data previously found in the LAYOUT, 
LANES, and PHASING files.  These individual file formats will be phased out in the future.  The 
combined file includes sections for Network, Nodes, Links, and Timing Plan allowing a better 
mapping of data. 

The single combined file and its respective sections now include all data available in Synchro. 
Refer to Chapter 16 of the Synchro Studio 7 User Guide for full details 

To add timing data to an 
existing UTDF file, simply 
write the new data to an 
existing timing file. The 
new data will be added to 
the bottom of the Timing 
file. 

The filename does not have 
to be named Timing.csv. 
Use any filename that is 
logical to you. 
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Reading and Writing UTDF Data 

Data for UTDF 2006 is stored in one combined file. Data is separated into sections as detailed 
in the Synchro Studio User Guide. Often, users want a sample UTDF compatible format. The 
best way to see this is to open an existing Synchro file and create (write) the data to UTDF. 

To write out a UTDF file, do the following: 

1. Open the Synchro file for which you want to write data out. 
2. Select the menu command File→Save-As.  
3. Choose Comma Delimited from the ‘Save as Type’ dropdown 
4. Enter a ‘File name’ and press [Save].  
5. The data from this Synchro file will now be in CSV file. 

Synchro CSV data can be modified with a text editor or a spreadsheet. See the topic on 
Editing UTDF Data with Other Software below.  

To read CSV data into an existing Synchro file, do the following: 

1. Backup your Synchro file. 
2. Select the menu command File→Merge.  
3. Choose a CSV file from the list and press [Open].  

The data from the selected CSV file will now be in the Synchro file. This process does not 
create new links or nodes, and does not move or renumber nodes. It will merge in data from 
the Data Settings screens for matching node numbers.  

To read CSV data into a new Synchro file, do the following: 

1. Select the menu command File→Open.  
2. Choose Comma Delimited from the ‘Files of type’ dropdown 
3. Choose a CSV file from the list and press [Open].  

The data from the selected CSV file will now be in the Synchro file. This process imports all of 
the CSV data into the Synchro file, including nodes and links. 

Editing UTDF Data with Other Software 

The UTDF 2006 file is a comma delimited (CSV) file. To edit the CSV files simply open the files 
with a spreadsheet such as Microsoft® Excel. Be sure to save the file as comma-aligned and 
not as Excel format. If you have created any formulas in your spreadsheet, be sure to first 
save the file in spreadsheet format. Then, save the file to UTDF CSV format. 

If there is data in the CSV 
file that you do not want to 
merge, delete from the CSV 
file prior to merging.

Page | 6-93



  MnDOT Traffic Signal Timing and Coordination Manual 
 

May 2017  Synchro and SimTraffic 

 

 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

**
*H

A
N
D
O
U
T*
**
 

4-28   Synchro and SimTraffic Course 

4.7 Advanced SimTraffic Features 
This section covers the advanced features of SimTraffic.  For many simulations, these 
parameters can be left at the defaults. 

Intervals and Volume Adjustments 
Choose the Options→Intervals-and-Volumes command to activate the Intervals page. 

Intervals 

Each column represents an interval.  Normally a simulation has a "seed" interval followed by 
one or more recorded intervals. 

The purpose of the Seed Interval is to fill the network with traffic.  The Recorded Interval(s) 
follow the seed interval and these intervals are recorded for animation, reports, and static 
graphics.   

It is possible to have a congested peak interval of say 15 minutes, followed by an off-peak 
interval to see how quickly the network recovers from congestion. Multiple intervals can also 
be used to simulate multiple timing plans and the transition between timing plans. 

Setting the Seed Time 

The seeding time should be long enough for a vehicle to traverse the entire network 
between the two most distant points including all stops.  The seeding time should also be 
longer than the maximum cycle length in the network.  After the seeding time, the number 
of vehicles entering the network per minute should be about the same as the number of 
vehicles exiting the network per minute.  Look at the Vehicle Counts in the Status window 
during seeding and recording to see how many vehicles are entering and exiting the network.   

If one or more movements are above capacity, the number of entering vehicles will always 
exceed the number of exiting vehicles, and equilibrium will not be achieved.  In this case, the 
seed time should be long enough so that the number of exiting vehicles per minute stabilizes 
at a fixed value. 

Volume Adjustments 

The volumes simulated come from the Traffic Volumes in the *.SYN file or from an external 
data file.  These volumes can be adjusted by a number of factors.  

Set Growth Factor Adjust to adjust for growth factors.  The growth factors are input in 
Synchro's Volume Settings and are 100% by default. 

Set PHF Adjust to adjust for peak hour factors.  Volumes are divided by the PHF.   

Set AntiPHF Adjust to unadjust for peak hour factors.  The PHF increases the hourly count for 
the peak 15 minute period.  The volume for the remaining 45 minutes will thus be decreased 
from the hourly rate 

Set Percentile Adjust to create a pulse of traffic based on Poisson arrivals.  The percentile 
adjust can be used to model a 95th percentile queue or to see how a network fares with 
peaking traffic conditions. 

Database Parameters 

The last two rows of the Intervals page are used in conjunction with external data files.  See 
Data Access for more information about using data files. 
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The Federal Highway 
Administration (FHWA) is 
currently in the process of 
creating guidelines 
regarding the number of 
simulation runs. This falls 
under the Next 
Generations Simulation 
(NGSIM) project. Current 
thinking is to suggest that 
the user simulates each 
model with 4 or 5 runs 
with varying random 
seeds. Check the NGSIM 
website for details: 

www.ops.fhwa.dot.gov/Tr
avel/Traffic_Analysis_Tools
/ngsim.htm 

Timing Plan ID is used to specify a timing plan from a timing data file.  The timing data file 
may contain more than one set of timing plans and the timing plan ID specifies which one to 
use.   

Data Start Time is used to identify which volume counts to load from a volume data file.  A 
volume data file may contain multiple volume counts, each marked with a different set of 
dates, times, and intersection ID numbers.   

Random Number Seed 

SimTraffic uses random numbers to determine when new vehicles and pedestrians enter the 
network and for choosing vehicle paths through the network.  The random number seed can 
be used to generate the same sequence of vehicle entries or to create a new sequence each 
time.   

If random number seed is zero (0), SimTraffic will choose a random number seed at random.  
All simulations with random number seed 0 should be unique from each other. 

Trip Generation 

Trips are added to entry links based on 
the volume counts at the intersection.  

Trips are also added mid-block if mid-
block traffic is specified or a volume 
source is needed to balance traffic. If 
both balancing and a mid-block source 
exist, the mid-block entry will be the 
maximum of the two. 

For each 0.1 s slice a vehicle is created 
when R36000 < vl  

vl = hourly traffic volume of link or mid-block source.  

R36000 = a random number between 0 and 35999 

Consider the graphic above with the EB entry volume of 500 vph. Over an hour there are 
36000 chances to add vehicles and about 500 of the random numbers will be less than 500 
and about 500 vehicles will be created. For example, if random number 498 is selected, a 
vehicle will be created and placed in the network if it is OK to enter. If it is not, it will be held 
in denied entry until it is OK to enter. There must be space on the link to allow a vehicle to 
enter.  

Link Volumes are calculated independently for cars and for heavy vehicles. The heavy vehicle 
volume is equal to the adjusted volume times the Heavy Vehicle percentage. The car volume 
is equal to the remaining adjusted volume. Entering Heavy Vehicles are assigned to a Truck 
or Bus vehicle type based on their percentage of the total Heavy Vehicle Fleet. Entering Cars 
are assigned to a Car or Carpool vehicle type based on each type's percentage of the total 
Car Fleet. 

Multiple Simulation Runs 

The Record-Multiple Runs button or [Ctrl]+[M] will perform and record a 
simulation on multiple runs. A dialog will appear allowing the user to select the 
number of runs to simulate and record and the starting random number seed. 
The random number seed will be incrementally increased by one for the 
simulated runs. For instance, 1, 2, 3, 4 and 5 if starting from 1 with 5 runs. 

Entry Volume 
= 500 vph

For any given time period 
more or less vehicles will 
appear. Looking at many 
time periods, the vehicles 
will exhibit a Poisson arrival 
distribution.
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The Run Number of Recorded History will allow the user to load a recorded history file if 
multiple runs have been performed. Choose the number of the run you would like to 
animate with the drop down list. The number will be the random seed number that was 
used.  It is possible to have a blank value in the drop-down list.  This indicates a simulation 
run without a run number extension. 

In the reports, the user is allowed to have the report generator average the results for some 
of all of the runs performed. 

Creating a Multi-Simulation Report 

SimTraffic will generate a report that averages the results of multiple runs.  Check the 
'Multiple Runs' box prior to selecting the [Print], [Preview], or [Save-Text] buttons.  A dialog 
box will appear showing the History (HST) files for each simulation run recorded. The format 
of the history file will be 'filename-#.hst' where # indicates the random seed number.  Select 
the runs you want to average by holding the [Ctrl] key and clicking on the desired filenames. 
 The resulting report will be the average of the files you have selected.  To see the results for 
the individual history files, create a report that selects only the desired history file. 

Using the Peak Hour Factor Adjustment in SimTraffic 

In SimTraffic, there are several methods to account for the peaking conditions, or peak hour 
factor (PHF) within an hour simulation. One method would be to simulate 4 intervals of 15 

minutes using the UTDF feature (see the topic, DATABASE ACCESS in the SimTraffic 
help file). In this case, SimTraffic reads the 15-minute counts from a database and 
let the simulation model handle the peaking of the volumes. You can then get 
reports in SimTraffic for each interval and an aggregate total.  

Another approach would be to use the PHF adjust in SimTraffic. In this case, set one 
of four intervals with the PHF adjust, and the other three intervals with the anti-
PHF adjust. 

Consider an example where you have a total of 1000 vph in the system with a PHF 
of 0.8. If this peak occurs during interval 2 (assumes 4-15 minute intervals 
simulated), do the following: 

1. Int 1: Set Anti PHF, Volume simulated = (1000/4)*(1 - (1/PHF- 1)/3))=250*(1-(1/.8-
1)/3))=229 veh 

2. Int 2: Set PHF Adjust, Volume simulated = (1000/4)/0.8=313 veh 
3. Int 3: Set Anti PHF, Volume simulated = 229 
4. Int 4: Set Anti PHF, Volume simulated = 229 
5. Total Volume for hour = 229*3 + 313 = 1000 vph. 

Database Access 

The database access feature allows volume counts and timing plans to be read from an 
external data file.  The database feature is useful to model multiple intervals with more than 
one timing plan or volume count. 

The data files are UTDF style comma separated files (CSV).   

The Data Options page can be accessed with the Options→Database-Access command. 

Volume Data Options 

To read volume counts from a data file, check the Read Volumes box.  This feature is most 
useful when two or more counts will be simulated in two or more intervals. 

Only the separate values 
for each run can be shown 
for the Performance 
Reports. Queues, Actuated 
Timings and Simulation 
Summary will be the 
average of the runs only. 

Database Access uses 
UTDF files. See the section 
on UTDF beginning on 
page 4-23. An example of 
using this feature can be 
found on page 4-31. 
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Timing Data Options 

To read timing plans from a data file, check the Read Timings box. This feature is most useful 
when two or more timing plans will be simulated in two or more intervals.  This feature can 
be used to model transitions between timing plans. 

SimTraffic UTDF Example 

For this example, refer to the Synchro file ‘C:\Class Files\Level 2\10 Using ST UTDF 
Feature.syn’. In addition, you will use the files ‘Timing for ST UTDF.csv’ and ‘Volume-with ST 
UTDF.csv’. 

This is an example of how to use the SimTraffic UTDF (database) 
access feature. Use these files to setup different timing intervals 
for the two timing plans (in the Timing database file) and for 
volumes from the volume database file. 

To get SimTraffic to read from a database, there still is some set-
up required. Once you launch SimTraffic, stop the recording. 
Then use the command Options→Database-Access. Check the 
'Read Volumes from UTDF Data File' box and then select where 
your UTDF database file is. Be sure to choose the appropriate 
Data Date. 

Then, check the ‘Read Timings from UTDF Data File’ and select 
where the timing data file is. Select a default timing plan. 

Switch to the Intervals tab use the [Insert] button to insert the 
desired number of intervals. For volumes, select the appropriate 
Data Start Time for each interval. Also, choose the appropriate Timing Plan ID for the timing 
plan you want to simulate for each interval. 

Vehicle Parameters 
The Vehicle Parameters page can be accessed with the Options→Vehicle-Parameters 
command. 

Vehicle Name is used to identify the vehicle type in the Vehicle Status window. 

Vehicle Occurrence defines what percentage of the vehicle fleet is made up of this vehicle 
type. The default “percentages” are shown below. 

Car1 Car2 Truck SU SemiTrk1 SemiTrk2 Truck DB Bus Carpool1 Carpool2 

64% 16% 60% 10% 5% 5% 20% 16% 4% 

 

The fleet mix will add up to 100% for trucks and 100% for car types. 

Maximum Speed is used in conjunction with the Maximum Acceleration to determine the 
acceleration available at a given speed.   

Vehicle Length is used to determine the length of each vehicle type.   

Vehicle Width is used for the width of the vehicle.  This value is used for graphics only and 
has no affect on the simulation model. 

Vehicle Fleet is used to assign a vehicle type to a fleet.  The fleet can be car, bus, truck, or car 
pool. 

Normally, you do not want 
to modify the vehicle 
parameters. These should 
only be used for unique 
situations, or if you have 
access to better data. 
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Vehicle Occupancy is the number of people per vehicle.  SimTraffic does not currently use 
this value. 

The Default button will reload the default parameters for all the vehicles. 

Driver Parameters 
The Driver Parameters page can be accessed with the Options→Driver-Parameters 
command. 

Yellow Decel is the maximum deceleration rate a driver is willing to use when faced with a 
yellow light.   

The Speed Factor is multiplied by the link speed to determine the maximum speed for this 
driver.  

Courtesy Decel Rate (CDR) is the amount of deceleration a vehicle will accept in order to let 
allow an ahead vehicle in an adjacent lane to make a mandatory lane change.  

Yellow React is the amount of time it takes the driver to respond to a signal changing to 
yellow.  

Green React is the amount of time it takes the driver to respond to a signal changing to 
green.   

Headways are the amount of time between vehicles drivers try to maintain. Normally, you 
would not want to modify this setting. You could modify the Headway Factor (see page 2-32) 
for individual links. 

Gap Acceptance Factor is an adjustment to the approach gap times.  This is the gap vehicles 
will accept at unsignalized intersections, for permitted left turns, and for right turns on red.   

A driver will defer making a Positioning Lane change when there is Positioning Advantage 
more vehicles ahead in the target lane than the current lane. Higher Values are associated 
with more conservative drivers and cause drivers to line up in the correct lane. Lower Values 
are associated with aggressive drivers and cause drivers to avoid lining up in the correct lane 
until reaching the mandatory lane change point.  

A driver will make a Desired Lane change when there is Optional Advantage less vehicles 
ahead in the target lane than the current lane. Higher Values are associated with more 
conservative drivers and cause drivers to have unbalanced lane use. Lower Values are 
associated with aggressive drivers and cause drivers to use lanes evenly.  

Mandatory Lane Change Distance Factor (MLCD) is the factor the mandatory lane change 
distances are multiplied by. The default values are: 

 Driver Type 1 2 3 4 5 6 7 8 9 10 

MLCD Factor (%) 200 170 150 135 110 90 80 70 60 50 

The Positioning Distance Adjustment Factor (PDA) is used to multiple the Positioning 
Distance value for each driver type. The default values are: 

  Driver Type 1 2 3 4 5 6 7 8 9 10 

PDA Factor (%) 150 140 130 120 110 95 90 80 70 60 

 

The Mandatory Distance values and Positioning Distance values are shown in the Synchro 
Simulation Settings screen. The values (as illustrated below) are the values used for each 

When vehicles are created, 
they are randomly 
assigned a driver type 
between 1 and 10.  Each 
driver type represents 
10% of the driving 
population with driver type 
1 being the most 
conservative and driver 
type 10 being the most 
aggressive. 

These percentages cannot 
be changed. If you wanted 
more aggressive drivers, 
you could modify the 
parameters for the more 
conservative driver types. 

The range of values for 
Positioning and Optional 
Advantage is 0.5 to 20 
vehicles. If all vehicles 
ahead are moving, they 
count as a fraction of a 
vehicle depending on the 
speed of the slowest 
vehicle ahead. 
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driver type (DT) multiplied by the factors illustrated in the tables above. For instance, a DT 1 
Mandatory Distance for a single lane change is 750’ x 200% = 1500’. The Mandatory Distance 
for a DT 10 is 750’ x 50% = 375’. 

The Positioning and Mandatory values are used to control how vehicles will make lane 
changes. Increasing these values will force vehicles to make lane changes sooner. Increased 
values would therefore cause queues to be longer if vehicles need to position for 
downstream lane changes. 

Normally, it is best to edit the Lane Change Distances by link in the Synchro. If you change 
the Driver Parameters page in SimTraffic, the change will be universal to the entire network. 

 

  

Create SSAM Export 
In SimTraffic, there is a new Animate→ Create SSAM Export. If this option is checked, 
SimTraffic creates a *.trj file during the simulation recording. This file describes the position 
of the vehicles throughout the simulation. It is a binary file compatible with FHWA’s 
Surrogate Safety Assessment Model (SSAM).  SSAM can be used to analyze the frequency of 
narrowly averted vehicle-to-vehicle collisions.  

There are several points that may be discussed and adjusted: 

1. Vehicle speed is in km/h or mph depending if the system is metric or not.  

2. Time period is 0.5 sec  
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7 MODEL CALIBRATION 

Today, traffic engineers and other practitioners are generally in agreement that a properly timed traffic 
signal system will reduce travel time, delays, vehicle stops, and fuel consumption. Numerous research 
studies and successful timing projects in cities across the United States in the last twenty years have 
supported this theory. Based on “before-and-after” studies, many of these studies have reported reductions 
in travel time, stops, delays and fuel consumption in the range of 10 percent to 40 percent and benefit-to-
cost ratios as high as 100-to-1. In recent years, air quality improvements have been added to the list of 
benefits. 

The benefits of improved signal timing are especially desirable for several reasons. First, the benefits are 
realized directly by the motoring public (and their passengers) who use the transportation system. Second, 
there is no discrimination regarding the distribution of these benefits; all consumers reap the rewards of 
reduced traffic congestion, reduced fuel consumption, operating cost savings, and improved air quality. And 
finally, these benefits continue to be realized year-after-year.  

However, to truly realize the benefits of a properly timed signal system, it is critical to evaluate the results 
of the signal timing project that was performed. 

7.1 Computer Model Measures of Effectiveness 

Computer modeling is one of the more important tools in traffic engineering. If a traffic system is modeled 
on a computer, it is possible to predict the effect of multiple traffic timing plans on the system’s operational 
performance, as expressed in terms of measures of effectiveness (MOEs), which include average vehicle 
speed, vehicle stops, delays, vehicle-hours of travel, vehicle-miles of travel, fuel consumption, and pollutant 
emissions. The MOEs provide insight into the effects of the signal timing project, and they also provide the 
basis for optimizing that strategy. 

Computer modeling has the following advantages over a field experiment: 

 It is less costly. 

 Results are obtained quickly. 

 The data generated by computer modeling include several measures of effectiveness that cannot be 
easily obtained from field studies. 

 The disruption of traffic operations, which often accompanies a field experiment, is completely 
avoided. 

 Many schemes require significant physical changes to the facility, which are not acceptable for 
experimental purposes. 

 Evaluation of the operational impact of future traffic demand must be conducted by using simulation 
or an equivalent analytical tool. 

 Many variables can be held constant. 

The availability of traffic modeling and optimization programs greatly expands the opportunity for the 
development of new traffic signal timing plans. Since the results generated by the model can form the basis 
for selecting the most effective candidate among different timing plans, the eventual field implementation 
will have a high probability of success. 

In Chapter 6, there was an introduction to Synchro 6 reporting. The following sections will highlight in more 
detail some of the computer model results that can be obtained from the Synchro 6 program. 
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7.2 Computer Model Calibration 

Calibration is the process of adjusting input data and model parameters in order to ensure that the 
simulation results from the models match observed traffic performance in the field. Calibration is an 
important step in a signal timing project because the development of optimal timing plans depends on how 
closely the model represents the existing conditions. Calibration should be based on the knowledge of the 
existing conditions in the network and correct interpretation of the model outputs.  

Calibration really serves two purposes: 

 It is a “final” check on the quality of the general input data, and 

 It involves the “fine-tuning” of the traffic parameters to ensure that their modeling are realistic. 

The following general steps should be taken, at a minimum, once all base data have been coded in the model 
and initial runs have been made to clear up obvious coding problems: 

 Before continuing any further, double check the base input data. 

 Compare the following measures of effectiveness (MOE’s) to ensure that the values are consistent 
with the way you know the system operates: 

 Degrees of saturation 

 Delay and average travel times; and 

 Maximum queue length, or maximum back of queue, depending on the model. 

 If you are not certain of the actual system operation, or if any of the above MOEs do not “measure 
up” as expected, conduct field studies to verify field conditions. 

 For the more sophisticated models, conduct field studies for the significant advanced modeling 
features (i.e., such as the linked flow movements within CORSIM). 

 Vary the appropriate model parameters to bring the simulated or estimated results into better 
agreement with the field data. 

 Always, continually look for overlooked data errors. 

This process demands a thorough understanding of the results and outputs of the various models. Recall 
that the same MOE may be calculated differently by several programs, and may not even include the same 
basis of measure. 

Data Verification 

Verifying the accuracy of input data is both an important and continuous task. It is so critical to do this early 
in the process, because if a significant error is not discovered until, for example, the design process has been 
completed, a considerable amount of work and computer runs may have to be repeated. Nonetheless, do 
not conclude that all data are correct after this final check. You must be continuously on the alert for data 
errors throughout the calibration, design and evaluation stages. 

The process at this step is relatively simple. Have a person who has not been intimately involved in the 
coding process carefully review all input data to insure that they agree with the original sources. The key 
data item to check should include as a minimum: 

 Traffic volumes, particularly if a data preprocessor was used to develop more detailed relationships. 

 Capacity parameters (saturation flow rates and lost times) if these were based on field studies. If they 
are estimated, make sure that the values are reasonable for the conditions. 

 Speeds and other related data. 

 Signal timing. 
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Degree of Saturation 

As described in Chapter 4, the degree of saturation is defined as: 

Y = vC / sg x 100 (%) 

where, 

Y = degree of saturation expressed here expressed as a percentage; 

v  =  volume in vph, 

C =  cycle length in seconds, 

s  =  adjusted saturation flow in vphg, and 

g  = effective green (split time - lost time). 

g = G - SLT + EEG, or 

g = G + Y + R - L 

and, G = actual green time, 

 SLT = start-up lost time, 

 EEG = extension of effective green, 

 Y,R = yellow and all-red time, and 

 L = total lost time. 

The degree of saturation, also the volume-to-capacity ratio (v/c), is an indicator of the level of congestion 
on the particular link. At high degrees of saturation, traffic on the link experiences substantial delays and 
frequent cycle failures. You should compare the degree of saturation for each link with what you know to 
be the existing conditions in the field. Significant differences between the predicted and actual intersection 
operations indicate that the input data may need adjustments. For example, if critical intersections are 
indicated as saturated in the program (X is approaching or exceeding 100%) and, if so, check whether this is 
not actually occurring. 

Timing and Lost Time 

If re-examining the volumes does not clear up the problem, check the timing and lost time. Of course, the 
cycle length should have been coded correctly, so the likely culprit is the phase length and/or lost time. 

For pre-timed controllers, the timing is trivial to check, but this may also indicate the need for a field check 
of a particular controller. 

Actuated control is a different story. Theoretically, minor (actuated) movements should be operating near 
saturation. If the models say they are not, the estimates of the green times are likely not correct (unless of 
course all phases are operating on recall, thus destroying the purpose of actuated control). 

As with timing data, lost time can be a source of highly sensitive fluctuations in the intersection measures of 
effectiveness.  

Maximum Queue Length or Back of Queue 

Compare the predicted maximum queue length (MQL), or maximum back of queue (MBQ), with field 
observations for selected links. The following should be kept in mind when making the comparisons of model 
outputs and field data: 
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 The maximum queue length estimated by most models is the maximum physical length of the queue, 
which occurs just after the beginning of the green.  

 The maximum back of queue is not the queue length at the beginning of the green, but the farthest 
point the queue extends upstream during the cycle, usually several seconds into the effective green. 

If the estimated queue length is significantly different than observed in the field in an average cycle, then 
the volumes, saturation flows, or signal timing data should be checked. 

Delay and Travel Time 

The average delay (sec/veh) predicted by the models should be compared with field measurements for a 
number of representative links (through and left-turn movements). These comparisons should, however, be 
made with caution, since the definition of delay used in the models may not be the same as the definition 
used by the measurement technique. For example, TRANSYT estimates the total approach delay for a link. 
If the average stopped delay is measured in the field, it should be converted to the total delay for comparison 
with most model estimates. 

Another source of error occurs when the link is saturated, since the estimate for random and saturation 
delay produced by the models may lead to a total estimate which is significantly greater than that measured 
in the field. For example, comparison of the field measurements with TRANSYT’s uniform delay estimate 
may produce a better result in this case.  

Travel time measurements also should be conducted and compared with model estimates (if available) to 
verify that the model reasonably represents existing condition. Travel times are obtained using floating cars 
on test routes representing the predominant traffic patterns in the study area. Travel time, including the 
delay and stops at signals, should be recorded for every link and then compared to the model outputs. 

Substantial differences between measured and predicted travel times typically indicate input error in cruise 
speeds, link volumes, saturation flows and/or signal timing data. Again, travel time estimates may be 
unrealistic at saturated intersections. In this case, the degree of saturation and the maximum back of queue 
are better measures of performance for the purpose of model calibration. 
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8 TIMING PLAN IMPLEMENTATION AND EVALUATION  

Proper implementation of the timing plans is crucial to a successful system retiming project.  A major 
component to proper implementation involves a thorough understanding of field equipment, specifically 
detection and the controller.  There is no replacement for experience so this section only touches on 
implementation.   

8.1 Implementation and Field Verification 

There are four basic steps in the implementation process as follows: 

 The timing plan must be developed (i.e., output from Synchro) 

 The timing plan must be converted into a form that is compatible with the traffic signal controller 

 The timing plan must be transferred into the traffic signal controller in the field or remotely 

 The timing plan must be fine-tuned in the field  

Install timing plan into controller and put plan into operation during an off peak time. Check timing, observe 
operation and make any necessary changes. 

The traffic signal operation should be observed for all time periods serviced by the new timing plans 
immediately following implementation.  Seemingly small errors can have dramatic impact on traffic 
operations, so new timing plans must be observed in operation.  If excessive stops and delays are observed, 
timing adjustments should be made. It may be necessary to observe the signal operation again after a period 
of time to allow traffic to stabilize. A series of timing adjustments may be necessary. 

8.2 Traffic Controller Timing Inputs 

A portion of an Econolite controller manual has been included at the end of this chapter. 

Synchro reports many of the parameters required implementing the timing data into the controller. These 
include: 

 The controller cycle length, 

 The movement split in seconds or percent, and, 

 The reference phase offset. 

There are, however, certain checks and calculations that must be performed before implementation into a 
coordinated system controller unit. These include, but are not limited to: 

 Can the cycle length handle all of the green, clearance, walk, and flashing don’t walk intervals? 

 Do all splits satisfy their minimum requirement? 

 Are the permissive periods set correctly (some controllers have the ability to automatically determine 
the permissive periods)? 

 If coordinated phase split extension is used (see the definition in the Econolite literature), are the 
remaining phases allocated adequate time? 
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8.3 Econolite Controller Timing 

Data source: Econolite Controller Manual 

Offset Change by Smooth Transition 

When changing offset by smooth transition, the coordination module establishes a new offset by moving 
the current offset toward the desired offset by the shortest percentage route possible. This movement will 
normally not be over 50 percent of the cycle length and will be accomplished by moving the actual offset 1 
percent for each 6 percent of the local master cycle length. 

Therefore, if the desired offset is changed, the actual offset will equal the desired offset within three local 
cycle lengths or less. The direction in which the offset is moved is determined by the coordination module 
by comparing the desired offset to the current offset. If the desired offset is greater than the current offset 
by no more than 50 percent, the module will move the offset point by adding. This procedure will lengthen 
the local cycle by a maximum of 20 percent until the desired offset is reached. If the desired offset is less 
than the current offset or greater by more than 50 percent of the current offset, the module will move the 
offset point by subtracting 1 percent from the offset for each 6 percent of the cycle length. This will shorten 
the cycle by a maximum of 16.6 percent until the desired offset is reached. 

If the coordination module determines that the offset should be changed by subtracting, it will compare the 
controller minimum cycle length to the current cycle length in effect to determine if the cycle can be 
decreased. If decreasing the cycle will shorten the cycle below the controller minimum cycle, the 
coordination module will force the offset to be changed by adding. This may cause the offset change to take 
more than three cycle lengths to complete. 

It is possible to program the coordination module to inhibit the smooth transition subtract operation. This 
will result in all offset changes being made by adding time. 

Offset Change by Dwell 

The coordination module can make offset changes by smooth transition or by dwelling. The option of offset 
changes by dwelling is selected by programming the dwell to a value other than zero (0). This will inhibit 
smooth transition and force all offset changes to be made by dwelling in the coordinated phase.  

The coordination module will hold the controller in the coordinated phase while dwelling. The period of time 
that the module will dwell in the coordinated phases is from 1 to 99 percent of the cycle length. After the 
dwell period the coordinator, will release. the coordinated phases to serve calls. The dwelling operation will 
then be preempted until the desired offset is reached.  

Split 

Each of the six cycles of the coordination module will operate in any of four splits. A split is the division of 
the cycle time period into sections (split intervals) which establish the maximum amount of time that will be 
allocated to each timing phase (see the figure on the following page). The maximum time allocated to a 
phase is controlled by the split interval setting for the phase. The coordinator provides a split interval for 
each phase, including the coordinated phase. The split intervals are numbered from 1 to 8, with the split 
interval number corresponding to the phase number. Each split interval is variable from 0 to 99 percent of 
the cycle length. However, the sum of the split intervals for each timing ring of the controller should not 
exceed 100 percent. In addition, the sum of the split interval for each timing ring of a concurrent group 
should normally be equal.  
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Split Intervals  

The maximum time allocated to a phase is entered as a percentage of cycle length in the split interval 
corresponding to the phase. This percentage value should be the total maximum time that the phase will be 
allowed to time, including yellow and red clearance time. In the example shown in the figure on the following 
page, each of the four phases has been assigned an equal portion of the cycle. Thus, the split interval entry 
for each phase will be 25 percent.  

 

The coordination module uses the controller's force-off capability to control the maximum time for each 
phase. Using the split interval value for the phase and the phase yellow and red clearance times, the 
coordination module establishes a point within the cycle when force off should be applied to terminate the 
phase, thus limiting the timing of the phase. The coordination module calculates the force-off point 
according to the following formula:  

 Force-Off Point  = Coordinated phase split interval + phase timing split interval + sum of the 
split intervals prior to the phase timing - (phase timing yellow + red clearance 
percent). 

Using the example of the figure above, the force-off points will be calculated as follows: 

 2 Force-Off Point  = 25% (1) + 25% (2) - 4% (2 clearance) 

  = 46% 

 3 Force-Off Point  = 25% (1) + 25% (3) + 25% (2) - 4% (3 clearance) 

  = 75% 

 4 Force-Off Point  = 25% (1) + 25% (4) + 50% (2 + 3) - 4% (4 clearance) 

  = 75% 
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Coordinated Phase Split Extension  

The coordination module normally sets the coordinated phases to operate in the nonactuated mode. 
However, it is possible to program the coordinated phases to operate in the actuated mode. In either mode, 
the controller is held in the coordinated phases by applying the hold command. This effectively inhibits 
actuated operation. At the yield point the coordinator removes the hold command, releasing the 
coordinated phase. If the coordinated phase is actuated, it then can begin extending. The amount of 
extension is controlled by the coordinated phase split extension interval (split interval 0). At the end of the 
extension period, the coordinator applies a force off to the coordinated phases, thus causing them to yield 
to calls on other phases. This operation allows the coordinated phase split to be increased based on traffic 
demand.  

To insure that the remaining phases are allocated a full split interval, the coordinator cycle is modified based 
on the amount of coordinated phase extension. This is shown in the figure below. In this example the 
coordinated phase is allowed to extend 10 percent. This makes the end of the coordinated phase from 25 
percent to 35 percent. This would normally have been a portion of the phase 2-split interval. Without 
modifying the cycle this implies that the phase 2 split would be reduced by 10 percent. To prevent this from 
occurring, the cycle is shifted by the coordinated phase extension. Thus, if there are continuous calls on 
phase 2 causing the phase to use its full split interval, the phase will now end at 60 percent instead of 50 
percent. This same operation also occurs in phases 3 and 4. However, if each phase uses its maximum 
allotted split time, the split of the last sequential phase will be reduced. The coordinator will try to extend 
the split of the last phase. However, if it determines that the extension will require the phase to be 
terminated after local zero, the coordinator will apply force off to the phase at 99 percent. This will normally 
result in a coordination error causing an offset error. As soon as the controller reenters the coordinated 
phase, the coordinator will begin a smooth transition or dwell operation to correct the offset error. 

 

The maximum amount that the coordinated phase can extend is controlled by the coordinated phase split 
extension interval. This can be set from 0 to 99 percent. If the coordinated phase gaps out before the 
maximum amount, the actual extension amount will be used in extending the split of the other phases.  
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If the phase following the coordinated phase (phase 2 in the example shown in the figure above) does not 
have a demand prior to the end of the coordinated phase split extension, the split of the remaining phases 
will not be extended. This is because the coordinated phase extension did not actually use any of the phase 
2 split time, being there was no demand on the phase.  

Free to Coordinated Transition  

After initial power-on of the controller or after the coordination module has been returned to the remote 
or coordinated mode following a Free or Remote Flash command, the coordination module remains in the 
Free mode until a sync pulse is detected. This first sync pulse loads the current coordination commands and 
starts the local master cycle timer. This pulse also starts a coordination pick-up cycle. During this cycle one 
detector call is placed on all phases and the controller is allowed to continue running Free. The coordinator 
then monitors the controller checking for the start of the coordinated phase green interval. When both 
coordinated phases if a dual ring intersection) have reached the beginning of the green interval, the 
coordinator places the controller into coordinated operation. This point is used as the first local zero point. 
The local cycle timer is started and the coordination module begins controlling the controller timing based 
on the current offset of the local cycle. This pick-up scheme provides a smooth and orderly transition of the 
intersection into the coordinated system. During the pick-up cycle, the cycle complete display is set to the 
message UP to indicate that the coordinator is in the pick-up cycle.  

Permissive Periods  

The coordination module provides two types of permissive period operations. The permissive period 
controls the time period during which the coordination module releases hold on the coordinated phases, 
allowing the controller to begin servicing calls on the remaining phases. If a call is not detected during the 
permissive period, hold is reapplied to the coordinated phases, causing the controller to rest in the 
coordinated phases until the next permissive period. Permissive period operation always starts at the 
coordinated phase yield point. This is defined as the point in the local cycle equal to the coordinated phase 
split interval minus clearance times. 

The first type of permissive operation consists of standard single or dual permissive periods that are 
controlled by operator entries. The second type of permissive operation consists of automatically computed 
permissive periods for each sequential phase. This method does not require any permissive period data 
entries by the operator. All permissive periods consist of vehicle and pedestrian periods, with each timing 
together. The length of the pedestrian period is automatically determined by the walk plus pedestrian 
clearance timing of the phase being controlled by the period.  

Yield Point  

All permissive period timing begins at the yield point. This is the point within the cycle at which the 
coordination module releases hold on the coordinated phase and allows the controller to begin servicing 
calls. The yield point is automatically determined by the coordination module based on the coordinated 
phase split interval and pedestrian and vehicle clearance times. If the coordinated phase is operating as a 
standard nonactuated phase, the yield point is calculated according to the following formula:  

 Yield Point  = Coordinated phase split interval - (Pedestrian + vehicle clearance time) 

Using the example shown in the figure on the following page, the uncoordinated phase 1, yield point is 
calculated as follows: 

 Yield Point  = 25% - (7+4)% 

  = 14% 
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The yield point calculation changes if the coordinated phase is operating fully actuated. In this case, the 
coordinated phase pedestrian movement times normally and, thus, is not held at the end of the walk timing. 
In this case, the yield is calculated according to the following formula: 

 Yield Point  = Coordinated phase split interval - vehicle clearance time 

Thus, using the same example of the figure above, if the coordinated phase was actuated, the yield point 
would be 21 percent instead of 14 percent. 

Operator Controller Permissive Periods 

The operator controlled permissive periods are variable from 0 to 99 percent of the cycle length and are 
capable of either dual or single permissive operation. 

Dual Permissive Operation  

If dual permissive operation is used, the Vehicle Permissive Period 1 and its associated pedestrian permissive 
period time first. This period always begins timing at the coordinated phase yield point (see the figure 
above). During this first permissive period, the coordination module allows the controller to serve vehicle or 
pedestrian calls on only the first phase(s), or B phase, following the coordinated phase. The coordination 
module determines which phase(s) is the B phase based on the phase sequence programming of the 
controller configuration PROM and by checking which phases are set to the NO-PHASE mode. 

The second permissive period, or Vehicle Permissive Period 2, begins timing at an adjustable time period 
after the yield point. This period is the Vehicle Permissive Period 2 Displacement and is adjustable from 0 to 
99 percent of the cycle length. During the second permissive period, the coordination module allows the 
controller to serve calls on all remaining phases except the first permissive phase(s). The module applies 
Phase Omit to the first permissive phase(s) during the second permissive period. The pedestrian permissive 
period portion of the second permissive period controls the pedestrian calls on the second phase(s), C Phase, 
following the coordinated phase. The pedestrian calls on the remaining phase(s) of the controller are not 
controlled.  
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If the controller yields to a call during the first permissive period, the coordination module allows the 
controller to serve all remaining phase calls in normal sequence. Thus, if a yield occurs during the first 
permissive, the second permissive period is inhibited from starting because it is no longer required. 

Single Permissive Operation  

The second permissive period is capable of being eliminated to give a single permissive period operation. 
With single permissive operation, only the Vehicle Permissive Period 1 and its associated pedestrian 
permissive period are timed. Both permissive periods begin timing at the yield point. During the permissive 
period, the coordination module allows the controller to yield to a call on any phase. The pedestrian 
permissive period portion of the permissive period, however, only controls the pedestrian call on the first 
phase following the coordinated phase. Single permissive operation is selected by setting the Vehicle 
Permissive 2 displacement to zero. The Vehicle Permissive Period 2 setting is then ignored by the 
coordination module. 

Two-Phase Controller Dual Permissive 

The coordination module provides a special dual permissive operation in a two-phase controller. (A two-
phase controller is any KMC-2/4/3 using only two phases.) During the first permissive period the coordinator 
checks for calls on the second phase and yields if a call is present. If a call is not present, then the coordinator 
holds the coordinated phase until the second permissive period starts. It then rechecks calls on the second 
phase and will allow the controller to yield if a call is present. If the controller yields during the first 
permissive, the coordinator will not time the second permissive. Thus, the coordinator will only allow the 
controller to yield once to the second phase.  

Pedestrian Permissive  

During single or dual permissive operation the pedestrian permissive period is automatically calculated by 
the coordinator. The period is determined by the walk plus pedestrian clearance and split interval of the 
phase being controlled. If a pedestrian call is not detected during the pedestrian permissive, the coordinator 
inhibits pedestrian operation by applying pedestrian omit to the phase. This will be cleared at the next local 
zero. If the controller yields to a vehicle call during the pedestrian permissive period, pedestrian call will be 
answered up to the beginning of the phase.  

Automatic Permissive Periods  

The coordination module is capable of automatically computing permissive periods. In this operation the 
coordination module assigns each sequential phase a specific vehicle and pedestrian permissive period. The 
length of the vehicle permissive period is determined by the phase split interval and minimum time. The 
phase minimum time is equal to the auto permissive minimum green or the phase minimum green time, 
whichever is larger, plus the yellow and red clearance time. The auto permissive green time allows the phase 
minimum to be set to a low value but still insures that the auto permissive period provides sufficient green 
time if the controller yields to the phase at the end of the permissive. This is especially useful on left-turn 
phases where the minimum is set to zero. An auto permissive green time is provided for each cycle. The 
pedestrian permissive is determined by split interval and walk, pedestrian clearance, and yellow plus red 
clearance timing. Automatic permissive operation is selected by setting the value of Vehicle Permissive 1 
and Vehicle Permissive 2 Displacement to zero (0). This allows the automatic permissive operation to be 
selected on a cycle-by-cycle basis. It should be noted that the default permissive operation, after initial turn 
on of the coordinator, is automatic permissives.  

During automatic permissive operation the timing of a permissive period for a phase is determined by the 
controller's phase sequence (as determined by the configuration PROM and phases set to NO PHASE). The 
permissive period for the first phase(s) following the coordinated phase times first. If a call is not received 
within the permissive period, the coordinator applies phase omit to the phase and begins timing the 
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permissive period for the next sequential active phase(s). This operation continues for each sequential 
phase(s). This allows a phase to be serviced only within its permissive period. However, if the coordination 
module yields the controller to a phase, the controller is allowed to service the remaining phases in the 
normal manner. The automatic permissive periods do, however, continue to time and will inhibit servicing 
a phase if there is not sufficient time remaining. 

Calculating Automatic Vehicle Permissives 

All automatic permissive periods begin timing at the yield point. The period of each vehicle permissive is 
determined by the phase split interval and minimum time. The coordinator calculates the end point of the 
permissive period according to the following formula: 

 Vehicle Permissive End Point = Coordinated phase split interval  

  + Sum of the split intervals of the permissive phase and all phases 
prior to it  

     - Permissive phases minimum time  

     - Coordinated phase clearance time  

     + Coordinated phase extension 

Using the example shown in the figure on the following page, the end of phase 2 vehicle permissive will be 
calculated as follows: 

 2 Vehicle Permissive End Point = 25% (1) + 25% (2) - 9% - 4% 

      = 37% 

Thus, if a phase 2 call is not received prior to the cycle reaching 37 percent, phase 2 will be omitted and the 
permissive period for phase 3 will start. The end point of the phase 3 vehicle permissive is calculated in a 
similar manner: 

 3 Vehicle Permissive End Point = 25% (1) + 50% (2 + 3) - 9% - 4% 

      = 62% 

The coordinator continues the permissive timing until the cycle reaches the permissive end point of the last 
sequential phase or until the controller returns to the coordinated phases. Thus in the example in the figure 
on the following page, the permissive timing would end when the cycle reached 87 percent. 
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Calculating Automatic Pedestrian Periods  

Each vehicle permissive period has a separate pedestrian permissive period that times concurrently with it. 
The pedestrian permissive period is the time period during which the controller is allowed to answer 
pedestrian calls. This period is determined by the walk plus pedestrian clearance and split interval of the 
phase being controlled. However, the pedestrian permissive can never be longer than the vehicle permissive. 
If the vehicle permissive ends prior to the end of the pedestrian permissive, the pedestrian permissive is 
terminated.  

If a pedestrian call is not detected during the pedestrian permissive period, the coordination module inhibits 
the controller from servicing any further pedestrian call by applying pedestrian omit to the phase. This is 
then cleared at the next local zero. However, if the controller yields to a vehicle call during the pedestrian 
permissive period, pedestrian calls will be answered up to the beginning of the Vehicle Phase Green.  

The coordination module calculates the end point of the pedestrian permissive period according to the 
following formula:  

     Pedestrian Permissive End Point = Coordinated phase split interval  

  + Sum of the split intervals of the permissive phase and all phases 
prior to it  

  - Permissive phases walk time  + pedestrian clearance + yellow + 
red time 

        - Coordinated phase clearance time 

Using the example of the figure above, the phase 3 pedestrian permissive end point is calculated as follows: 

 3 Pedestrian Permissive End Point = 25% (1) + 75% (2 + 3) - (12 + 4) - 4% 

     = 55% 

Thus, when the cycle reaches 55 percent, pedestrian omit would be applied to phase 3 unless a pedestrian 
call was present. 
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8.4 Post Implementation Evaluation 

Field evaluation of new timing plans is substantially more complicated than the estimating of benefits from 
computer outputs, but it is more significant because it is physical “proof”. Such field verification of benefits 
is often necessary to justify the cost of signal optimization projects. 

Field evaluation is a complex task requiring careful planning, execution, and analysis. Evaluations are 
typically “before” vs. “after” in nature and are usually conducted through floating car techniques. Typical 
measures of effectiveness include travel time, or delay, and number of stops. Fuel consumption is also 
sometimes measured, although it is difficult to accurately measure fuel consumption in the field. A sufficient 
number of floating car runs must be made to be representative of the traffic movements in the system to 
assure that, if statistically improvements exist, they can be measured at a reasonable level of confidence. 
Measured benefits can be translated into monetary values, compared with the sum of capital costs and any 
recurring maintenance costs in order to determine cost-effectiveness. 

Field Conditions 

Since the objective of a field evaluation is to test the performance of the new timing plan, the conditions in 
the project area should be as identical as possible in the existing condition (i.e., “before” condition) and 
those expected after the new timing plans are implemented (i.e., “after” condition). Unrelated design 
changes in the system, such as adding a lane or a left-turn bay, or traffic management schemes should be 
avoided. These changes could affect the results obtained in the field, possibly leading to inconclusive 
statements about the performance of the implemented timing plan. 

Since measurable improvements to the traffic operations could potentially result in the system attracting 
additional traffic from parallel congested systems, field measurements for the “after” condition should be 
conducted as soon as possible after the timing plans have been implemented and fine-tuned. That is, an 
acclimation period intended to allow traffic stabilize is not necessary and is not recommended. The data 
collection schedule should also be planned to avoid any activities that change the normal traffic patterns in 
the project area. Common examples include holidays, return to school, street blockages from construction 
work, etc. 

Data Collection Periods 

Field data on system performance should be collected at the same times of the day that were modeled. For 
example, if signal timing plans were developed for the AM peak, off-peak and PM peak, the test periods for 
field data collection should be identical so that the implemented timing plans correspond to the traffic 
patterns at those times. This requirement applies to field measurements for both the “before” and “after” 
conditions. 

Duration of Data Collection 

The time required for data collection varies with the number of signals in the system, the number of timing 
plans, available personnel and equipment, and other considerations particular to the specific system. Ideally, 
you should plan to collect data for two weeks, 3-5 days a week, for both the “before” and “after” conditions. 
This would ensure a minimum of 8-10 days of good data. An even longer period might be needed if unusual 
traffic conditions occur in the system, or if other circumstances degrade the quality of the data collected.  

Resource constraints may necessitate cutting back the data collection period to one week before and one 
week after. This will naturally reduce the degree of confidence you will have in the evaluation. 
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Measures of Effectiveness 

The specific MOEs recommended to be measured in the field evaluation are travel time and stops. Travel 
time is preferred to delay because it takes into account the improvements in mid-block travel due to 
improved progression. It is also easier to measure.  

Manual field data should be recorded on log sheets. If computerized data collection methods are used, the 
MOEs will be automatically recorded by the system. For manually collected travel time data, only the 
“cumulative travel time” needs to completed in the field. The link travel times may then be computed in the 
office by subtracting the cumulative travel time at the beginning of the link from the corresponding value at 
the end of the link. The cumulative time in the system is also computed in the office by removing travel times 
on links that are outside of the system  (i.e., exit/entry links). The total cumulative times in the system should 
be averaged and compared to give an assessment of the improvement. 

Sample Size Requirements 

Ideally, only the timing plan would vary between the “before” condition and the “after” condition. However, 
traffic measurements will generally vary by time of day, day of week, car type, driver, etc. Effort should be 
made to minimize this variation by using the same car and driver in each case and collecting data under 
similar conditions. To help overcome these variations, the sample size should be adequate and should be 
set to provide a level of confidence of not less than 80%. Note that different MOEs may require different 
sample sizes. 
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 Glossary of Signal Timing Terms 

ACTIVE WARNING SYSTEM FOR A RAILROAD GRADE CROSSING (ACTIVE WARNING DEVICES) - the railroad 
flashing light signals with or without warning gates, together with the necessary control equipment used to 
inform road users of the approach or presence of trains at highway-railroad grade crossings.  

ADVANCE PREEMPTION - notification of an approaching train is forwarded to the traffic signal controller unit 
by the railroad equipment for a period of time prior to the activation of railroad active warning devices.  

ADVANCED WARNING FLASHER (AWF) - an advanced warning device located on main street approaches to 
a high speed signalized intersection, which can provide advanced warning to the motorists on the main 
street that the traffic signal system will be turning yellow during their approach. 

AUXILIARY EQUIPMENT - Separate devices used to add supplementary features to a controller assembly.  

BARRIER - A barrier (compatibility line) is a reference point in the preferred sequence of a multi-ring 
controller unit at which all rings are interlocked. Barriers assure there will be no concurrent selection and 
timing of conflicting phases for traffic movements in different rings. All rings cross the barrier simultaneously 
to select and time phases on the other side.  

BIU - A module used to interface the controller with the field terminals and detector loops in a TS2 cabinet.  

CABINET - An outdoor enclosure for housing the controller unit and associated equipment.  

CALL - A registration of a demand for right-of-way by traffic (vehicles or pedestrians) to a controller unit. 

Serviceable Conflicting call:  

 Occurs on a conflicting phase not having the right-of-way at the time the call is placed.  

 Occurs on a conflicting phase which is capable of responding to a call.  

 When occurring on a conflicting phase operating in an occupancy mode, remains present until given 
its right-of-way.  

CHECK - An output from a controller unit that indicates the existence of unanswered call(s).  

CLEAR STORAGE DISTANCE - The distance available for vehicle storage measured between 6 feet (2 meters) 
from the rail nearest the intersection to the intersection STOP BAR or the normal stopping point on the 
highway. At skewed crossings and intersections, the 6 feet (2 meters) distance will be measured 
perpendicular to the nearest rail either along the centerline, or edge line of the highway as appropriate to 
obtain the shorter clear distance. 

CLEAR TRACK GREEN INTERVAL - the time assigned to clear stopped vehicles from the track area on the 
approach to the signalized intersection (Also see Track Clearance Phase Time).  

CONCENTRATION - The largest of Scaled Occupancy or Scaled Volume expressed in percent.  

CONFIRMATION LIGHTS - Indicator lights mounted on the mast arms confirm that preemption is in 
operation, when an authorized emergency vehicle approaching an EVP-equipped signalized intersection 
enroute and making a call for preemption. 

CONNECTOR - A device enabling outgoing and incoming electrical circuits to be connected and disconnected 
without the necessity of installing and removing individual wires leading from the control unit.  

 Not Used Connections - The “Not Used” connector pin termination’s are used exclusively to prevent 
interchangeability with units already in use not in conformance to this publication. These connector 
pins are not to be internally connected.  
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 Reserved Connections - The “Reserved” connector pin termination are used exclusively for future 
assignment by NEMA of additional specific input/output functions. The control unit does not 
recognize any “reserved” input as valid nor shall it provide a valid output on a “Reserved” output.  

 Spare Connections - The “Spare” connector pin termination are exclusively for manufacturer specific 
applications. A controller Assembly wired to utilize one of these connections may not be compatible 
with all manufacturer’s control units.  

CONTROLLER ASSEMBLY - A complete electrical device mounted in a cabinet for controlling the operation of 
a traffic control signal.  

CONTROLLER UNIT - A controller unit is that portion of a controller assembly that is devoted to the selection 
and timing of signal displays.  

 Digital Controller Unit - A controller unit wherein timing is based upon a defined frequency source 
such as a 60-hertz alternating current source.  

 Multi-ring Controller Unit - A multi-ring controller unit contains two or more interlocked rings which 
are arranged to time in a preferred sequence and to allow concurrent timing of all rings, subject to 
the restraint on BARRIER.  

 Single-Ring controller unit - A single-ring controller unit contains two or more sequentially timed and 
individually selected conflicting phases so arranged as to occur in a established order.  

COORDINATION - The control of controller units in a manner to provide a relationship between specific green 
indications at adjacent intersections in accordance with a time schedule to permit continuous operation of 
groups of vehicles along the street at a planned speed.  

COORDINATOR - A device, program or routine which provides coordination.  

CRITICAL PHASE MOVEMENT - The longest of either the Pedestrian Clearance Interval, the Minimum Green 
Interval, or Leading Flash Time of AWF (if present). 

CYCLE  - A complete sequence of signal indications for all phases. 

CYCLE - The total time to complete one sequence of signalization around an intersection. In an actuated 
controller unit, a complete cycle is dependent on the presence of calls on all phases. In a pretimed controller 
unit unit it is a complete sequence of signal indications.  

CYCLE LENGTH - The time period in seconds required for one complete cycle.  

DENSITY - A measure of the concentration of vehicles, stated as the number of vehicles per mile per lane.  

DESIGN VEHICLE - the longest vehicle permitted by the road authority on a roadway.  

DETECTION -  

 Advisory Detection - The detection of vehicles on one or more intersection approaches solely for the 
purpose of modifying the phase sequence and/or length for other approaches to the intersection.  

 Passage Detection - The ability of a vehicle detector to detect the passage of a vehicle moving through 
the zone of detection and to ignore the presence of a vehicle stopped within the zone of detection.  

 Presence Detection - The ability of a vehicle detector to sense that a vehicle, whether moving or 
stopped, has appeared in its zone of detection.  

 Zone of Detection - The area or zone that a vehicle detector can detect a vehicle.  

DETECTOR - A device for indicating the presence or passage of vehicles or pedestrians.  
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 Bi-directional Detector - A detector that is capable of being actuated by vehicles proceeding in either 
of two directions and of indicating in which of the directions the vehicles were moving.  

 Calling Detector - A registration of a demand during red interval for right-of-way by traffic (vehicles or 
pedestrians) to a controller unit.  

 Classification Detector - A detector that has the capability of differentiating among types of vehicles.  

 Directional Detector - A detector that is capable of being actuated only by vehicles proceeding in one 
specified direction.  

 Extension Detector - A detector that is arranged to register an actuation at the controller unit only 
during the green interval for that approach so as to extend the green time of the actuating vehicles.  

 Infrared Detector - A detector that senses radiation in the infrared spectrum.  

 Light-Sensitive Detector - A detector that utilizes a light-sensitive device for sensing the passage of an 
object interrupting a beam of light directed at the sensor.  

 Loop Detector - A detector that senses a change in inductance of its inductive loop sensor by the 
passage or presence of a vehicle near the sensor.  

 Magnetic Detector - A detector that senses changes in the earth’s magnetic field caused by the 
movement of a vehicle near its sensor.  

 Magnetometer Detector - A detector that measures the difference in the level of the earth’s magnetic 
forces caused by the passage or presence of a vehicle near its sensor.  

 Nondirectional Detector - A detector that is capable of being actuated by vehicles proceeding in any 
direction.  

 Pedestrian Detector - A detector that is responsive to operation by or the presence of a pedestrian.  

 Pneumatic Detector - A pressure-sensitive detector that uses a pneumatic tube as a sensor.  

 Pressure-Sensitive Detector - A detector that is capable of sensing the pressure of a vehicle passing 
over the surface of its sensor.  

 Radar Detector - A detector that is capable of sensing the passage of a vehicle through its field of 
emitted microwave energy.  

 System Detector - Any type of vehicle detector used to obtain representative traffic flow information.  

 Side-Fire Detector - A vehicle detector with its sensor located to one side of the roadway.  

 Sound-Sensitive Vehicle Detector - A detector that responds to sound waves generated by the passage 
of a vehicle near the surface of the sensor.  

 Ultrasonic Detector - A detector that is capable of sensing the passage or presence of a vehicle through 
its field of emitted ultrasonic energy.  

 Video Detection - A detector that is responds the Video image or changes in the Video image of a 
vehicle.  

DETECTOR MODE - A term used to describe the operation of a detector channel output when a presence 
detection occurs.  

 Pulse Mode - Detector produces a short output pulse when detection occurs.  

 Controlled Output - The ability of a detector to produce a pulse that has a predetermined duration 
regardless of the length of time a vehicle is in the zone of detection.  

 Continuous-Presence Mode - Detector output continues if any vehicle (first or last remaining) remains 
in the zone of detection.  

 Limited-Presence Mode - Detector output continues for a limited period of time if vehicles remain in 
zone of detection.  

DEVICE -  
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 Electromechanical Device - A device which is characterized by electrical circuits utilizing relays, step 
switches, motors, etc.  

 Electronic Device - A device which is characterized by electrical circuits utilizing vacuum tubes, 
resistors, capacitors and inductors, and which may include electromechanical components and solid 
state devices.  

 Solid State Device - A device which is characterized by electrical circuits, the active components of 
which are semi-conductors, to the exclusion of electromechanical devices or tubes.  

DIAL - The cycle timing reference or coordination input activating same. Dial is also frequently used to 
describe the cycle.  

DISSIPATION OF QUEUED VEHICLES, PER LANE - This is the time needed to allow all vehicles stored between 
the rail crossing stop line and the signalized intersection to move forward and clear the intersection. This 
should be used when the railroad tracks are close to the roadway. The time to clear a queue of passenger 
cars can be estimated by the following formula: t = 4 + 2n; where t is the time to clear the queue in seconds, 
n is the number of vehicles in the queue per lane. This formula assumes that all the queued vehicles can 
accelerate at, or close to, the rate of passenger vehicles. 

DWELL - The interval portion of a phase when present timing requirements have been completed.  

EARLY RELEASE - A term used to describe the servicing of a coordinated phase in advance of its programmed 
begin time as a result of unused time from non-coordinated phases. 

EMERGENCY VEHICLE PREEMPTION (EVP) - A system installed on authorized emergency vehicles and at 
traffic signals which allows the authorized emergency vehicles to travel through signalized intersections in a 
safe and timely manner. A typical system works as follows:  An authorized emergency vehicle approaching 
a signalized intersection enroute to a call has an activated emitter (a strobe light oscillating at a specified 
frequency). The oscillations are detected by an EVP detector mounted on the signal mast arm. The signal 
controller terminates any conflicting phases to bring up the through phase for the authorized emergency 
vehicle. Indicator lights mounted on the mast arms indicate that preemption is in operation. An optional 
system can respond to vehicle sirens, using the siren as the emitter and a microphone array as the detector. 
This system is allowable when requested by local agencies, but only outside of the eight-county metro area. 
This system must be specified in the project plans and specifications, and must be pre-approved by MnDOT. 

ENTRY -  

 Dual Entry - Dual entry is a mode of operation (in a multi-ring controller unit) in which one phase in 
each ring must be in service. If a call does not exist in a ring when it crosses the barrier, a phase is 
selected in that ring to be activated by the controller unit in a predetermined manner.  

 Single Entry - Single entry mode of operation (in multi-ring controller unit) in which a phase in one 
ring can be selected and timed alone if there is no demand for service in a nonconflicting phase on 
parallel ring(s).  

EQUIPMENT RESPONSE - The time for a traffic signal controller to respond. Less than a second for most 
traffic signal controllers. Check controller manufacturers. 

EXTENSION UNIT - The timing interval during the extensible portion which is resettable by each detector 
actuation. The green interval of the phase may terminate on expiration of the unit extension time.  

FLASHER - A device used to open and close signal circuits at a repetitive rate.  

FLASHER CONTROLLER ASSEMBLY - A complete electrical device for flashing a traffic signal or beacon. 

FLASHERS INTERVAL - Interval from the time the railroad flashers begin flashing to the time the train arrives 
at the crossing. This time must be equal to or greater than the minium 20 seconds required by the MN 
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MUTCD. The MN MUTCD states that, circuits controlling automatic flashing light signals shall provide for a 
minimum operation of 20 seconds before the arrival of any train on such track. 

FLASHING LIGHT SIGNAL - the signal at rail crossing display toward approaching highway traffic the aspect 
of two red lights in a horizontal line flashing alternately when indicating the approach or presence of a train. 

FLASHING YELLOW ARROW INDICATION - The Flashing Yellow Arrow (FYA) head is a signal that uses a flashing 
yellow arrow indication for permissive left turns instead of using a green ball.  It is a 4-section FYA signal 
head with a red arrow on top, followed by a steady yellow arrow, a flashing yellow arrow, and then a green 
arrow on the bottom. 

FORCE OFF - A command to force the termination of the Green extension in actuated mode or Walk Hold in 
the nonactuated mode of the active phase. Termination is subject to presence of a serviceable conflicting 
call.  

FULL-TRAFFIC-ACTUATED CONTROLLER ASSEMBLY - A type of traffic-actuated controller assembly in which 
means are provided for traffic actuation on all approaches to the intersection. 

 Isolated Controller Assembly - A controller assembly for operating traffic signals not under master 
supervision.  

 Master Controller Assembly - A controller assembly for supervising a system of secondary controller 
assemblies.  

 Master-Secondary Controller Assembly - A controller assembly operating traffic signals and providing 
supervision of other secondary controller assemblies.  

 Occupancy Controller Assembly (Lane-Occupancy Controller or Demand Controller, and Presence 
Controller) - A traffic-actuated controller which responds to the presence of vehicles within an 
extended zone of detection.  

 Pedestrian-Actuated Controller Assembly - A controller assembly in which intervals, such as 
pedestrian WALK and clearance intervals, can be added to or included in the controller cycle by the 
actuation of a pedestrian detector.  

 Pretimed Controller Assembly - A controller assembly for the operation of traffic signals with 
predetermined: 

 Fixed cycle length(s). 

 Fixed interval duration(s). 

 Interval sequence(s).  

 Secondary Controller Assembly (slave) - A controller assembly which operates traffic signals under the 
supervision of a master controller assembly.  

 Semi-Traffic Actuated Controller Assembly - A type of traffic-actuated controller assembly in which 
means are provided for traffic actuation on one or more but not all approaches to the intersection.  

 Traffic-Actuated Controller Assembly - A controller assembly for supervising the operation of traffic 
control signals in accordance with the varying demands of traffic as registered with the controller by 
detectors.  

GAP REDUCTION - A feature whereby the “unit extension” or allowed time spacing between successive 
vehicle actuation’s on the phase displaying the green in the extensible portion of the interval is reduced.  

HOLD - A command that retains the existing Green interval.  

INTERCONNECTION - in the context of this document, the electrical connection between the railroad active 
warning system and the traffic signal controller assembly for the purpose of preemption.  

INTERCONNECT - A means of remotely controlling some or all of the functions of a traffic signal.  
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INTERVAL - The part or parts of the signal cycle during which signal indications do not change.  

 Minimum Green Interval - The shortest green time of a phase. If a time setting control is designated 
as “minimum green,” the green time shall be not less than that setting.  

 Pedestrian Clearance Interval - The first clearance interval for the pedestrian signal following the 
pedestrian WALK indication.  

 Red Clearance Interval - A clearance interval which may follow the yellow change interval during which 
both the terminating phase and the next phase display Red signal indications.  

 Sequence, Interval - The order of appearance of signal indications during successive intervals of a 
cycle.  

 Yellow Change Interval - The first interval following the green interval in which the signal indication 
for that phase is yellow.  

INTERVAL SEQUENCE - The order in which signal intervals occur during a phase. 

LEADING FLASH TIME OF AWF - the amount of time the Advanced Warning Flasher is operating prior to the 
yellow phase. 

LIGHT RAIL TRANSIT (LRT) - a type of electric transit railway with a "light volume" traffic capacity compared 
with "heavy rail." Light rail may be on exclusive, semi-exclusive or nonexclusive right-of-way, high or low 
platform loading, multi-car trains, single cars, automated or manually operated.  

MANUAL -  

 Manual Operation - The operation of a controller assembly by means of a hand- operated device(s). 
A push-button is an example of such a device.  

 Manual Push-button - An auxiliary device for hand operation of a controller assembly.  

MAXIMUM GREEN - The maximum green time with a serviceable opposing actuation, which may start during 
the initial portion.  

MAXIMUM PREEMPTION TIME - The maximum amount of time needed following initiation of the 
preemption sequence for the traffic signals to complete the entire sequence and clear the minimum track 
clearance distance of any vehicles prior to the arrival of the train at the crossing. This is the total of Right-of-
Way Transfer Time, Track Clearance Phase Time, and Separation Time. This time should equal to or greater 
than the Railroad Warning Time. 

MEMORY -  

 Detector Memory - The retention of a call for future utilization by the controller assembly.  

 EPROM - Read-Only, non-volatile, semiconductor memory that is erasable (via ultra-violet light) and 
reprogrammable.  

 FEPROM - Read-Only, non-volatile, semiconductor memory that is electrical erasable 
reprogrammable.  

 Nonlocking Memory - A mode of actuated-controller-unit operation which does not requiredetector 
memory.  

 Non-Volatile Memory - Read/Write memory that is capable of data retention during periods when AC 
power is not applied for a minimum period of 30 days.  

 PROM - Read-Only, non-volatile, semiconductor memory that allows a program to reside permanently 
in a piece of hardware.  

 RAM - Semiconductor Read/Write volatile memory. Data is lost if power is turned off.  

 ROM - Read-Only, non-volatile, semiconductor memory manufactured with data content, 
permanently stored.  
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 Volatile Memory - Read\Write memory that loses data when power is removed.  

MINIMUM GREEN ON CONFLICTING PHASE - The longest Minimum Green on a non-clear track phase. On 
many traffic signal controllers the minimum green can be shortened during preemption. A Minimum Green 
of less than 10 seconds should not be used on high speed approaches. 

MINIMUM TRACK CLEARANCE DISTANCE - For standard two quadrant railroad warning devices, the 
minimum track clearance distance is the length along a highway at one or more railroad tracks, measured 
either from the railroad stop line, warning device, or 12 feet (4 meters) perpendicular to the track centerline, 
to 6 feet (2 meters) beyond the track(s) measured perpendicular to the far rail, along the centerline or edge 
line of the highway, as appropriate, to obtain the longer distance. 

MMU - A device used to detect and respond to improper and conflicting signals and improper operating 
voltages in a traffic control system.  

MODULAR DESIGN - A device concept such that functions are sectioned into units which can be readily 
exchanged with similar units.  

NTCIP - National Transportation Control ITS Communication Protocol.  

OCCUPANCY -  

 Actual - The percent of time that vehicles passing a point occupy the roadway during a period in time. 
Typically expressed in Percent of occupied per Hour or Vehicles per Hour per Lane.  

 Scaled - The percentage that the Actual Occupancy when compared to a stated maximum. The stated 
maximum is considered to be 100% use of the roadway.  

OFFSET - Offset is the time relationship, expressed in seconds or percent of cycle length, determined by the 
difference between a defined point in the coordinated green and a system reference point.  

OMIT PHASE (Special Skip, Force Skip) - A command that causes omission of a selected phase.  

OVERLAP - A Green indication that allows traffic movement during the green intervals of and clearance 
intervals between two or more phases.  

PASSAGE TIME - The time allowed for a vehicle to travel at a selected speed from the detector to the stop 
line.  

PATTERN - A unique set of coordination parameters (cycle, value, split values, offset value, and sequence).  

PEDESTRIAN CLEARANCE TIME - the time interval provided for a pedestrian crossing in a crosswalk, after 
leaving the curb or shoulder, to travel to the far side of the farthest traveled lane or to a median of sufficient 
width for pedestrians to wait. The longest pedestrian clearance interval on the non-track clear phase should 
be used. Some signal controllers include the WALK as part of the preemption, check with signal controller 
manufacturer. the MN MUTCD allows the Pedestrian Clearance to be shortened during preemption if 
needed. This should be considered a temporary action. If decreasing the pedestrian clearance is required, 
the roadway agency must work with the railroad company to increase the time to provide the proper 
pedestrian safety. 

PHASE -  

 Traffic Phase - Those green, change and clearance intervals in a cycle assigned to any independent 
movement(s) of traffic.  

 Conflicting Phases - Conflicting phases are two or more traffic phases which will cause interfering 
traffic movements if operated concurrently.  

 Nonconflicting Phase - Nonconflicting phases are two or more traffic phases which will not cause 
interfering traffic movements if operated concurrently.  
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 Pedestrian Phase - A traffic phase allocated to pedestrian traffic which may provide a right-of-way 
pedestrian indication either concurrently with one or more vehicular phases, or to the exclusion of all 
vehicular phases.  

 Phase Sequence - A predetermined order in which the phases of a cycle occur.  

 Parent Phase - A traffic phase with which a subordinate phase is associated.  

 Vehicular Phase - A vehicular phase is a phase which is allocated to vehicular traffic movement as 
timed by the controller unit.  

PHASE SEQUENCE - The order in which the traffic phases occur during a cycle. 

PORTION -  

 Extensible Portion - That portion of the green interval of an actuated phase following the initial portion 
which may be extended, for example, by traffic actuation.  

 Initial Portion - The first timed portion of the green interval in an actuated controller unit: 

 Fixed Initial Portion: A preset initial portion that does not change. 

 Computed Initial Portion: An initial portion which is traffic adjusted. 

 Maximum Initial Portion: The limit of the computed initial portion. 

 Minimum Initial Portion: (See “Fixed Initial Portion.”) 

 Added Initial Portion: An increment of time added to the minimum initial portion in response to 
vehicle actuation. 

 Interval Portion - A discrete subdivision of an interval during which the signals do not charge.  

PREEMPTION - The transfer of the normal control of signals to a special signal control mode for the purpose 
of servicing railroad crossings, emergency vehicle passage, mass transit vehicle passage, and other special 
tasks, the control of which require terminating normal traffic control to provide the priority needs of the 
special task.  

PREEMPTOR, TRAFFIC CONTROLLER - A device or program/routine which provides preemption.  

PREFERRED SEQUENCE - Normal order of phase selection within a ring with calls on all phases.  

PREEMPTION - the transfer of normal operation of signals to a special control mode. Signals are commonly 
preempted by trains or by emergency vehicles. 

PRE-SIGNAL - Supplemental highway traffic signal faces operated as part of the highway intersection traffic 
signals, located in a position to control traffic approaching the railroad crossing and intersection. The signal 
faces control vehicles in advance of the railroad tracks and their operation shall be integrated into the 
railroad preemption program. The signal faces may be located on either the near or far side of the railroad 
tracks, including mounting on the same cantilever signal structure(s) as the railroad active warning devices. 

PRIORITY CONTROL - a means by which the right-of-way is obtained or modified.  

PROGRESSION - The act of various controller units providing specific green indications in accordance with a 
time schedule to permit continuous operation of groups of vehicles along the street at a planned speed.  

QUEUE CLEARANCE TIME - the time required for the design vehicle stopped with its nose at the start of the 
minimum track clearance distance to start up and move far enough to clear its tail end from the minimum 
track clearance distance. If pre-signals are present, this time should be long enough to allow the vehicle to 
move through the intersection, or clear the tracks if there is sufficient clear storage distance.  If the crossing 
is a significant distance from the intersection it may not be necessary to clear all of the vehicles through the 
intersection. The time interval necessary to allow a vehicle to move from the track area to a safe location 
can be determined by summing the values of the following: the time needed for the vehicle ahead to begin 
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to move out of the way (t1) and the time needed for a design vehicle in a standing queue to accelerate and 
move off the tracks (t2). 

The time before a vehicle ahead begins to move can be estimated by: 

t1 = 2+1.4n 

where t1, is the time (in seconds) it takes for the vehicle to begin moving and n is the number of vehicles 
queued ahead of the critical vehicle (n = distance/20 feet). 

The time a design vehicle takes to transverse the tracks: 

   

where t2 = time (seconds) required for the design vehicle to accelerate to a position of safety once the queue 
in front of it has begun to move;  

L = length of the design vehicle(feet);  

    D = minimum track clearance distance (feet); 

a =acceleration of the passenger design vehicle.  

       (passenger design vehicle, 4.4 ft/sec2;  

       SU (Single Unit Truck) design vehicle, 2.5 ft/sec2;  

       MU (Multiple Unit Truck) design vehicle, 1.6 ft/sec2) 

RAILROAD WARNING TIME - Interval from the time the traffic signal controller is notified that a train is 
approaching to the time the train arrives at the crossing. This interval must be greater than or equal to the 
time required by the Maximum Preemption Time. 

RED CLEARANCE INTERVAL - A clearance interval, which follows the yellow change interval, during which 
both the terminating phase and the next right-of-way phase display a red indication. 

RED CLEARANCE - The longest red clearance interval on a non-clear track phase.    

RED INDICATION, MINIMUM (Red Revert) - Provision within the controller unit to assure a minimum Red 
signal indication in a phase following the Yellow change interval of that phase.  

REST - The interval portion of a phase when present timing requirements have been completed.  

RIGHT-OF-WAY TRANSFER TIME - the sum of the Equipment Response time, Critical Phase Movement time, 
the Yellow Change Interval, and the Red Clearance Interval, if these last two are not included in the 
Pedestrian Clearance Time. This is the worst case time required before the controller can begin servicing the 
track clear phase. 

RING - A ring consists of two or more sequentially timed and individually selected conflicting phases so 
arranged as to occur in an established order.  

SCLC - A protocol for transfer of data between the controller, MMU and BIUs in a TS2 cabinet.  

SEPARATION TIME - The time during which the minimum track clearance is clear of vehicular traffic prior to 
the arrival of the train, typically 4 - 8 seconds. The Separation Time is particularly important when:  

(1) The railroad tracks are relatively far from the intersection (a long queue needs to be cleared). 

(2) High train speeds. 

t2 =
2(L+D)

a
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(3) High percentage of trucks and buses in traffic. 

SIGNAL - A device which is electrically operated by a controller assembly and which communicates a 
prescribed action (or actions) to traffic.  

SPEED - The speed of vehicles passing a point in the roadway during a period in time. Typically expressed in 
Average Miles per Hour or Average Miles per Hour per Lane.  

SUPPRESSORS -  

 Suppressor, Radio Interference - A device inserted in the power line in the controller assembly 
(cabinet) that reduces the radio interference.  

 Suppressor, Transient - A device which serves to reduce transient over-voltages.  

SPLIT - The segment of the cycle length allocated to each phase or interval that may occur (expressed in 
percent or seconds). In an actuated controller unit, split is the time in the cycle allocated to a phase. In a 
pretimed controller unit, split is the time allocated to an interval.  

SWITCH -  

 Auto/Manual Switch - A device which, when operated, discontinues normal signal operation and 
permits manual operation.  

 Flash Control Switch - A device which, when operated, discontinues normal signal operation and 
causes the flashing of any predetermined combination of signal indications.  

 Power Line Switch (Disconnect Switch) - A manual switch for disconnecting power to the controller 
assembly and traffic control signals.  

 Recall Switch - A manual switch which causes the automatic return of the right-of-way to its associated 
phase.  

 Signal Load Switch - A device used to switch power to the signal lamps.  

 Signal Shut-Down Switch - A manual switch to discontinue the operation of traffic control signals 
without affecting the power supply to other components in the controller cabinet.  

TERMINALS, FIELD - Devices for connecting wires entering the controller assembly.  

TIME BASE CONTROL - A means for the automatic selection of modes of operation of traffic signals in a 
manner prescribed by a predetermined time schedule.  

TIMING -  

 Analog Timing - Pertaining to a method of timing that measures continuous variables, such as voltage 
or current.  

 Concurrent Timing - A mode of controller unit operation whereby a traffic phase can be selected and 
timed simultaneously and independently with another traffic phase.  

 Digital Timing - Pertaining to a method of timing that operates by counting discrete units.  

 Timing Plan - The Split times for all segments (Phase/Interval) of the coordination cycle.  

TRAIN DETECTION INTERVAL - Interval from the time the train is first detected to the time the train arrives 
at the crossing. This time must be equal to or greater than the time required by the Maximum Preemption 
Time. Depending on the type of train detection being used the railroad flashers may not begin flashing when 
the train is detected.  

TRACK CLEARANCE PHASE TIME - Either the Dissipation of Queued Vehicles per lane or Queue Clearance 
Time. If the railroad crossing is a significant distance from the intersection, it may not be necessary to clear 
all of the vehicles through the intersection, and Queue Clearance Time will be used. 
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TRAFFIC PHASE - The assignment of right-of-way, change clearance intervals to a traffic movement or group 
of traffic movements. 

TRAFFIC SIGNAL SYSTEM - A group of traffic signals interconnected to provided synchronized operation. 

VOLUME -  

 Actual - The count of vehicles passing a point in the roadway during a period in time. Typically 
expressed in Vehicles per Hour or Vehicles per Hour per Lane.  

 Scaled - The percentage that the Actual Volume is when compared to a stated maximum. The stated 
maximum is considered to be 100% use of the roadway.  

YELLOW CHANGE INTERVAL - The first interval following the green right-of-way interval in which the signal 
indication for that phase is yellow. 

YIELD - A command which permits termination of the green interval. 
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Benefits 
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Capacity Analysis, 3-64 
Causes of Delay, 2-8 
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Critical lane volumes, 3-3 
Cross Completely, 4-6 
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CYCLE, A-2 
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d1, 3-55 
d2, 3-55 
d3, 3-55 
Data Analysis Tools, 5-4 
Data Collection, 2-1 
Data Collection Periods, 8-0 
Data Verification, 7-2 
Definitions, 2-7 
Degree of Saturation, 3-54, 7-3 
Delay, 2-8, 3-55 

Field measured, 7-4 

Delay and Travel Time, 7-4 
Delay Study, 2-7 
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Detection, 3-33, A-2, A-3 
Directional Counts, 2-2 
Don't Walk, 4-4 
Double (Dual) Entry, 3-16 
Dual Ring Control, 3-9 
Duration of Data Collection, 8-0 
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Evaluation of Results, 7-1, 8-1 
Example 2-1, 3-2 
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Example 2-2, 4-25 
Example 2-3, 4-7 
Example 2-4, 3-4 
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Extensible portion, 3-11 
Extension limit, 3-11 

F 

Field  Measured Benefits, 8-0 
Field Conditions, 8-0 
Field Verification, 8-1 
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Flashing “Don’t Walk”, 3-13 
Flashing Don't Walk, 4-4 
Floating Car Method, 2-8 
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Flow ratio, 3-54 
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Gap reduction, 3-14 
Gap Reduction, 3-14, 4-19 
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Implementation and Field Verification, 8-1 
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Initial Intervals, 3-12 
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Initial Timing, 4-17 
Interconnected Actuated Systems, 5-13 
Interconnected Pre-timed System, 5-13 
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Introduction, 1-1 
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Lag Phase, 3-16 
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Left Turn Trapping, 3-29 
Level of service, 3-56 
License Plate Technique, 2-9 
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Traffic Signal Control Systems, 5-12 
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Travel Time & Delay Studies, 2-7 
Travel Time Study, 2-7 
Turning Movement Counts, 2-2, 2-3 
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Unit extension timing, 3-11 
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Yellow interval, 4-22 
Yellow Lock, 3-15 
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MnDOT Metro - Checklist for Consultant Signal Optimization Projects 

(last updated: 5/10/2017) 

 

1. Use Peak 15 min * 4 Volumes in Volume Window with PHF of 1.0 

- We use this for calculating the number of cars on the worst possible cycle so we like to see inflated 
numbers in the timing window which we use to determine split times for any given cycle. 

 

2. Correct Phase Numbers and Phasing in Timing Window 

- Double-check all phase numbers and phasing in the Synchro Files to make sure they are correct 
based on the plan sheets as it’s a pain to change things in the field when implementing the timing. 

 

3. Prot/Permissive Lefts 

- Don’t allow lagging with permissive lefts in both directions in “Allow lead/lag?” in Timing Window 
of Synchro 

- Do allow lagging at T-intersections and left turns only in one direction (e.g. ramps) 

- We don’t like to omit the left turn phase on a 5-section head unless it is a shared lane situation, 
but we will be open to omitting the left turn phase in prot/permissive operation for Flashing Yellow 
Arrow heads. 

 

4. Need C-Max in Timing Window for Coordinated Phases 

- Make sure C-Max is selected in the Timing Window or else Synchro won’t match how the signal 
controller refers to offsets 

 

5. Minimum Splits 

- We want the minimum splits 8 sec greater than the min green time. This is because the controller 
needs to fit in the coordinated clearance (not the phase clearance) and ph. 2 &  

6 yellow+all-red are rarely over 7.5 sec.  It’s also nice to have a 1 sec cushion so 8 sec greater than 
the min green time has worked well. 

 Mainline 28 sec (assuming 20 sec min green) – Note: Make sure the Max Initial time in the controller 
is not greater than your lowest mainline split 

 Cross St. 15 sec (assuming 7 sec min green) 

 Split Phase 15 sec (assuming 7 sec min green) 

 Protected Lefts 15 sec (assuming 7 sec min green) 

 Prot/Perm Lefts 13 sec (assuming 5 sec min green) 
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6. Choosing Cycle Lengths 

- Synchro often chooses a cycle length that is too short so you may need to increase the cycle length 
from 10-30 sec in order to get the cushion you need for the mainline green time.  Check the amount 
of green time needed for the mainline through phases (using the 3+2n procedure described below) 
and make sure there is at least 10 sec of cushion unless the intersection is very overcapacity.  If the 
intersection is very overcapacity, try to get the split equal to the amount of green time needed if 
you can. 

- Look at various cycle lengths that are close to each other to see if progression in both directions 
is improved by a particular cycle length as the spacing of the intersections may favor a certain cycle 
length. 

 

7. Cutting Splits (3+2n Procedure) 

 For each timing plan, divide 3600 by the cycle length to get the number of cycles per hour. 

 Take the volume (peak 15 min volume * 4) and divide by the number of cycles per hour to get an 
average number of vehicles expected each cycle for the peak 15 minutes.   

 Using the formula 3 + 2n, where n=avg number of vehicles per cycle as calculated in step 4, determine 
the amount of green time needed for the movement per lane.  For example, if the peak 15 min volume 
is 250 vph, and it is a single left turn lane with a 150 sec cycle, the amount of green time needed will 
be 2(10.4 cars per cycle) + 3 sec start up time, or 23.8 sec of green time.  So if we had a 3 sec yellow 
and a 2 sec all-red for the left turn, a good tight split would be 29 secs.  The 10.4 cars per cycle came 
from 250 vph/24 cycles per hour for a 150 sec cycle length (3600 sec/150 sec per cycle). 

 If the left turn was a double left in this example, the amount of green time needed would be 2(10.4 
cars per cycle) divided by 2 because of two left turn lanes + 3 sec startup time.  So the double left 
would need 13.4 sec of green or a good tight split of 18 to 19 secs. 

 It's important to cut splits for all movements and for all timing plans because Synchro gives too much 
green time to the cross street and left turns at under-capacity intersections.  If we used Synchro's 
splits, we would have too many stragglers when we just want to clear the queue that's there and get 
back to the mainline.  By cutting the splits, it opens up possibilities for better progression in both 
directions so that's why it's the crucial key step before looking at progression. 

 We are open to having a little more cushion on the splits (extra 5 sec or so) for the offpeak plans that 
will be running on weekends since those peak 15 minute counts are from Mon-Fri at Noon which may 
be different than periodic surges in the evening or weekends. 

 Once you cut the splits, you should then have Synchro reoptimize the offsets and lead/lag sequence 
while keeping the splits fixed.  Synchro then may find a better option for two-way progression with 
the tighter splits. 

 

8. Protected Lefts Should Typically Be Lead-Lag on Cross Street 

- We have found some efficiency gains by letting one-side go and then the other side go so opposing 
left turns don’t have to worry about running into each other.  This also reduces frustration for 
protected lefts who would see an adjacent red instead of an adjacent green ball while they are 
waiting on the red arrow.  Typically, we run the lowest volume side first so the heavier side can use 
the extra green time with the Floating Force Off set to No.  However, this isn’t necessary if 



 MnDOT Traffic Signal Timing and Coordination Manual 

May 2013 Metro Checklists Page | D-5 

progression works better with the heavier side going first.  Also, you may want to consider having 
leading lefts if the cross street throughs are both heavy with light left turns so that the throughs 
can take advantage of extra time for the cross street. 

 

9. Time Space Diagram 

- Have Synchro files set up with 70th percentile for viewing Time-Space Diagram to best represent 
typical traffic flow.  The scale in the Time-Space Diagram Options should be set to 48 seconds per 
inch for Time and 1000 ft per inch for distance to best view flows when fine-tuning. 

- The final step we want you to do is to see if you can improve Synchro's offsets and lead/lag 
sequence through manual adjustment of the Time Space Diagram.  It is nice to have the back end 
of the platoons lined up from one intersection to the next if possible. 

 

10. Sim Traffic Analysis 

- Use UTDF to run actual 15 minute volumes (not peak 15 min * 4) when running Sim Traffic for 
realistic runs 

 

11. Things to Consider when Choosing Best Timing Plan 

 Good progression on Syncho Time-Space Diagram is most important  

 Use SimTraffic in peak periods (no need to run SimTraffic in undercapacity offpeak periods) to analyze: 

1) Storage Issues 

2) Interaction between close intersections 

3) Overcapacity roads where cumulative shockwaves may not be evident in the Synchro Time 
Space Diagram 

 Look at Delay, Stops, and Travel Time in Synchro and SimTraffic to weigh the best timing plans for 
close calls.  SimTraffic should get greater weight. 

. 
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Metro Checklist for Synchro Files 
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